
 

    
 

 

 

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

  

 

 

 

 

 

Competency Based Learning Materials (CBLM) 

 

Graphic Design 
 

Level-3 

 

Module: Applying Graphic Design Concepts and 

Guidelines 

(Code: CBLM-ICT-GD-01-L3-EN-V1) 

 

 

National Skills Development Authority (NSDA) 

Prime Minister’s Office, 

 People’s Republic of Bangladesh 

National Skills Development Authority 

Prime Minister’s Office 

Government of the People’s Republic of Bangladesh 



 

 

    
 

 



 

 

   
 

 
Copyright 

 

National Skills Development Authority 

Prime Minister's Office 

Level: 10-11, Biniyog Bhaban,  

E-6 / B, Agargaon, Sher-E-Bangla Nagar Dhaka-1207, Bangladesh. 

Email: ec@nsda.gov.bd 

Website: www.nsda.gov.bd. 

National Skills Portal: http:\\skillsportal.gov.bd 

 

Copyright of this Competency Based Learning Material (CBLM) is reserved by National Skill 

Development Authority (NSDA). This CBLM may not be modified or modified by anyone or 

any other party without the prior approval of NSDA. 

The CBLM on “Apply graphic design concepts and guidelines” is developed based on NSDA 

approved Competency Standards and Competency Based Curriculum under Graphic Design 

Level-3 Occupation. It contains the information required to implement the Graphic Design 

Level-3 standard.  

This document has been prepared by NSDA with the help of relevant experts, 

trainers/professionals. 

All Government-Private-NGO training institutes in the country accredited by NSDA can use 

this CBLM to implement skill-based training of Graphic Design Level-3 course. 

  

file:///C:/Users/md.amir%20hossain/OneDrive/Desktop/Review%20of%20AMIR%20HOSSAIN/Word%20File/www.nsda.gov.bd
file://///skillsportal.gov.bd


 

 

   
 

  



 

 

   
 

 

 

 

 

 

 

 

 

 

Approved by 

 

---th Executive Committee (EC) Meeting of NSDA 

 

Held on ------------------- 

 

 

 

 

 

 

 

 

 

 

 



 

ii 

 



 

iii 

 

Table of Contents 

 

Copyright ....................................................................................................................................................... ii 

List of Abbreviations .................................................................................................................................... iii 

How to use this Competency Based Learning Materials (CBLMs) .............................................................. 1 

Module Title: Applying Graphic Design Concepts and Guidelines .............................................................. 3 

Learning Outcome 1: Interpret fundamentals of graphic design ................................................................. 5 

Information Sheet 1.1: Fundamentals of graphic design ..................................................................................8 

Learning Outcome 2: Work with image ..................................................................................................... 30 

Information Sheet 2: Work with image ........................................................................................................... 32 

Self Check 2.1 ................................................................................................................................................. 48 

Learning Outcome 3: Identify image standards ......................................................................................... 52 

Self Check 3.1 ................................................................................................................................................. 55 

Learning Outcome 4: Create basic designs ................................................................................................. 57 

Self Check 4.1 ................................................................................................................................................. 92 

Learning Outcome 5: Identify career opportunities in the graphic design sector...................................... 96 

Self Check 5.1 ............................................................................................................................................... 104 

Learning Outcome 6: Interpret Online Market places ............................................................................. 106 

Self Check 6.1 ............................................................................................................................................... 120 



 

 

 



 

 

 

 

How to use this Competency Based Learning Materials (CBLMs) 
  

The module, Applying Graphic Design Concepts and Guidelines contains training materials 

and activities for you to complete. These activities may be completed as part of structured 

classroom activities or you may be required you to work at your own pace. These activities 

will ask you to complete associated learning and practice activities in order to gain 

knowledge and skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or 

tasks you are going to learn how to do. Once you have finished reading the 

Information Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to 

help you know how you are progressing.  If you are unable to answer the questions 

in the Self-Check you will need to re-read the relevant Information Sheet. Once 

you have completed all the questions check your answers by reading the relevant 

Answer Keys found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step 

by step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be 

provided where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of 

others in the training room. Should you require assistance or clarification please consult 

your trainer or facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved 

competency in the specified learning outcomes. You will then be ready to move onto 

the next Unit of Competency or Module  
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Module Content 

 

Unit of Competency: Apply Graphic Design Concepts and Guidelines 

Module Title: Applying Graphic Design Concepts and Guidelines  

Module Description: This module covers the knowledge, skills and attitudes required to 

apply graphic design concepts and guidelines. It specifically includes 

interpreting fundamentals of graphic design, working with image, 

identifying image standards, creating basic designs, identifying career 

opportunities in the graphic design sector, and interpreting online 

market places.   

Nominal Duration: 35 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Interpret fundamentals of graphic design  

2. Work with image 

3. Identify image standards 

4. Create basic designs 

5. Identify career opportunities in the graphic design sector 

6. Interpret Online Market places  

Assessment Criteria: 

1.1. Types of graphic design are comprehended. 

1.2. Uses of graphic design are identified. 

1.3. Structure of graphics are interpreted. 

1.4. Software for graphic design is identified. 

1.5. Basic design guidelines are Interpreted. 

1.6. Design brief is interpreted. 

2.1 Appropriate Image modification software is identified and opened. 

2.2 Image sources are identified. 

2.3 Images are successfully Imported from appropriate source. 

2.4 Image separation tools are identified and applied. 

2.5 Separated image is saved. 

3.1 Image properties are identified. 

3.2 Image resolution are identified and interpreted. 

3.3 Image format are identified and selected. 

4.1 Required designs are specified. 

4.2 Appropriate shape and size are identified. 
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4.3 Content area is defined. 

4.4 Contents are inserted and composed. 

4.5 Shapes are modified as per requirements. 

4.6 Typographical design is applied as per requirements. 

4.7 Font attributes are applied as per requirements. 

4.8 Design and color are applied as per requirements. 

4.9 Design is saved in appropriate file format 

5.1 Local and international graphic design and Desktop Publishing (DTP) houses 

are identified. 

5.2 Positions/jobs in the graphic design sector are identified. 

5.3 Hands on graphics arts designer are identified. 

5.4 Graphic design and DTP houses are visited on site and through the internet. 

6.1 Source of carrier opportunities are identified. 

6.2 Account opening procedure is interpreted. 

6.3 Standard profile structure is outlined. 

6.4 Bidding procedure for the jobs are interpreted. 

6.5 Design submission procedure is interpreted. 

6.6 Payment collection methods are identified. 

Contents  

This learning package includes the following:  

1. Fundamentals of graphic design  

2. Work with image 

3. Image standards 

4. Basic designs  

5. Career opportunities in the graphic design sector 

6. Online Market places 
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Learning Outcome 1: Interpret fundamentals of graphic design 

 

Content: 

1. Types of graphic design 

1.1 Vector 

1.2 Raster 

1.3 Bitmap 

2. Uses of graphic design 

3. Structure of graphics. 

3.1 Vector based 

3.2 Bitmap based 

4. Software for graphic design 

4.1 Adobe Photoshop 

4.2 Adobe illustrator 

4.3 Adobe in design 

4.4 Corel draw 

5. Basic design guidelines. 

6. Design brief 

Assessment Criteria:  

1. Types of graphic design are comprehended. 

2. Uses of graphic design are identified. 

3. Structure of graphics are interpreted. 

4. Software for graphic design is identified. 

5. Basic design guidelines are Interpreted. 

6. Design brief is interpreted 

 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 
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 Methodologies  

 

• Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 1: Interpret fundamentals of graphic design 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Develop 

Competency Based 

Training Curriculum. 

1. Instructor will provide the learning materials “Applying 

Graphic Design Concepts and Guidelines 

2. Read the Information 

sheet/s 

2. Information Sheet No:1 Interpret fundamentals of graphic 

design 

3. Complete the Self Checks 

& Check answer sheets. 

3. Self-Check/s 

Self-Check No: 1 Interpret fundamentals of graphic design 

 

Answer key No. 1 Interpret fundamentals of graphic design 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:1- Interpret fundamentals of graphic design 

 

Specification Sheet1 – Interpret fundamentals of graphic 

design 
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Information Sheet 1: Fundamentals of graphic design 

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Comprehend types of graphic design. 

2. Identify uses of graphic design. 

3. Interpret structure of graphics. 

4. Identify software for graphic design. 

5. Interpret basic design guidelines. 

6. Interpret design brief 

1. Graphic design 

Graphic design is a creative discipline that involves visually communicating ideas, 

messages, and information using various design elements. It encompasses the art and skill 

of combining typography, images, colors, shapes, and layout to create visual compositions 

that are aesthetically pleasing, effective, and purposeful. 
 

At its core, graphic design aims to solve visual communication challenges by translating 

complex concepts into visual forms that can be easily understood and appreciated by the 

target audience. It plays a vital role in conveying a brand's identity, establishing a visual 

language, and evoking specific emotions or responses. 
 

Graphic design is not limited to any specific medium and can be applied across various 

platforms, including print, digital, web, packaging, advertising, and multimedia. It involves 

understanding and utilizing design principles such as composition, balance, contrast, 

hierarchy, and color theory to create impactful visuals. 
 

Moreover, graphic design goes beyond creating visually appealing designs; it also involves 

strategic thinking, research, and problem-solving. Designers need to consider the audience, 

objectives, and context to effectively communicate the desired message and achieve the 

intended goals. 
 

Here are concise interpretations of key concepts in graphic design: 
 

Composition: Composition in graphic design refers to the arrangement and organization 

of visual elements within a design space. It involves the deliberate placement and 

relationship between elements such as text, images, shapes, and other graphical 

components. The goal of composition is to create a harmonious, balanced, and visually 

pleasing design that effectively communicates the intended message. 
 

Typography: Typography in graphic design refers to the art and technique of arranging 

and styling typefaces to communicate a message effectively. It involves selecting 

appropriate fonts, determining their sizes, spacing, and formatting, and integrating them 

harmoniously into a design. Typography plays a crucial role in establishing the tone, 

readability, and visual impact of a design. 
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Color theory: Color theory in graphic design refers to the study and application of colors 

to create visually harmonious and impactful designs. It involves understanding the 

properties of colors, their interactions, and the psychological and emotional effects they 

have on viewers. Color theory plays a crucial role in establishing visual appeal, creating a 

mood or atmosphere, and effectively communicating messages. 
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Color Phychology: 
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Balance: Balance in graphic design refers to the distribution of visual elements within a 

composition to create a sense of stability, equilibrium, and harmony. It involves arranging 

elements in a way that feels visually equal and weighted, regardless of their size, shape, or 

color. Balance plays a crucial role in ensuring that a design feels visually pleasing and well-

organized. 

 
 

Contrast: Contrast in graphic design refers to the deliberate use of differences in various 

design elements to create visual interest, emphasize important information, and establish a 

clear visual hierarchy. Contrast involves juxtaposing elements that are distinct or 

dissimilar, such as color, size, shape, texture, value, or typography. By leveraging contrast, 

designers can make certain elements stand out, create visual impact, and enhance the 

overall effectiveness of a design. 
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Hierarchy: Hierarchy in graphic design refers to the organization and arrangement of 

visual elements within a composition to establish a clear and structured order of 

importance. It involves visually prioritizing elements based on their significance and 

guiding the viewer's attention through a design. Hierarchy plays a crucial role in effectively 

communicating messages, establishing visual balance, and creating a sense of order and 

professionalism. 

 
 

Grid system: A grid system in graphic design refers to a framework or structure that 

organizes and aligns elements within a composition. It is a series of horizontal and vertical 

lines that create a modular grid of intersecting rows and columns. Grid systems provide a 

systematic approach to laying out and arranging content, ensuring consistency, alignment, 

and visual harmony in a design. 

 
 

White space: White space, also known as negative space, refers to the empty or unmarked 

areas within a composition in graphic design. It is the absence of visual elements such as 
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text, images, or graphics. Despite its name, white space doesn't have to be white in color 

and can be any background color or even transparent. 
 

 

Visual branding: Visual branding in graphic design refers to the use of visual elements 

and design principles to create a consistent and cohesive visual identity for a brand or 

organization. It involves developing a set of visual assets, such as logos, color schemes, 

typography, imagery, and graphic elements, that reflect the brand's values, personality, and 

essence. The goal of visual branding is to create a recognizable and memorable visual 

representation of the brand that resonates with the target audience. 
 

User experience (UX) design: User Experience (UX) design in graphic design refers to 

the process of creating designs that prioritize and enhance the overall user experience and 

usability of a product, service, or digital interface. UX design focuses on understanding the 

needs, behaviors, and preferences of users to create intuitive, efficient, and enjoyable 

interactions. It goes beyond aesthetics and considers the entire user journey, from initial 

discovery to final interaction. 
 

1.1. Vector graphics 

Vector graphics are a type of digital image 

created using mathematical formulas and 

geometric shapes. Unlike raster graphics, 

which are composed of pixels, vector graphics 

are resolution-independent and can be scaled 

to any size without losing quality.  

 

Here's an interpretation of vector graphics: 
 

Scalability: One of the key advantages of vector graphics is their scalability. Since vector 

images are created using mathematical equations, they can be resized without losing 

sharpness or introducing pixelation. This makes them highly versatile and suitable for 

various applications, from small icons to large banners or billboards. 
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Precision and Clarity: Vector graphics offer precise and clean lines, shapes, and curves. 

Each element in a vector image is defined by mathematical calculations, resulting in smooth 

edges and defined contours. This precision allows for clear and crisp visuals, making vector 

graphics ideal for logos, typography, and illustrations that require high levels of detail and 

accuracy. 
 

Editability: Another significant feature of vector graphics is their inherent editability. 

Since vector images are composed of individual shapes and objects, they can be easily 

modified, resized, and rearranged using vector editing software like Adobe Illustrator. This 

flexibility enables designers to make adjustments and refine their designs with ease, even 

after the initial creation. 
 

File Size Efficiency: Vector graphics tend to have smaller file sizes compared to raster 

graphics. Since they store information about shapes, lines, and colors rather than individual 

pixels, vector files are generally more lightweight. This makes them suitable for web-based 

applications, where smaller file sizes contribute to faster loading times and efficient use of 

bandwidth. 
 

Versatility: Vector graphics can be used in a wide range of applications and contexts. They 

are commonly employed in logo design, iconography, typography, infographics, and 

illustrations. Their scalability and flexibility allow designers to adapt vector graphics for 

various mediums, including print, digital, and even large-format outputs. 
 

Simplified Editing: Vector graphics are particularly useful when it comes to making 

design modifications or customizations. Individual components of a vector image, such as 

shapes, colors, and strokes, can be easily adjusted, manipulated, or replaced without 

affecting the overall image quality. This makes vector graphics an efficient choice for 

iterative design processes or creating variations of a design. 
 

Resolution Independence:  

Unlike raster graphics, which 

have fixed resolutions, vector 

graphics can be scaled up or 

down without sacrificing image 

quality. This inherent 

resolution independence 

ensures that vector graphics 

maintain their clarity and 

sharpness across different display sizes and resolutions. 
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1.2. Raster graphics 

Raster graphics, also known as bitmap graphics, are a type of digital image composed of a 

grid of pixels. Each pixel contains color and brightness information, collectively forming 

the overall image.  

 

 

Here's an interpretation of raster graphics: 
 

Pixel-based: Raster graphics are composed of individual pixels, with each pixel 

representing a single point in the image. The combination of these pixels creates the overall 

visual representation. The resolution of a raster image determines the level of detail and 

sharpness, with higher resolutions having more pixels per inch and greater clarity. 
 

Realistic Representation: Raster graphics excel at capturing intricate details and realistic 

representations of complex images, such as photographs or natural scenes. The ability to 

represent subtle variations in color, tone, and texture makes raster graphics suitable for 

capturing the nuances and intricacies of real-world subjects. 
 

Image Editing: Raster graphics allow for extensive editing and manipulation using 

software like Adobe Photoshop. Since each pixel can be individually modified, designers 

have precise control over aspects like color, contrast, brightness, and effects. This 

flexibility enables retouching, photo manipulation, and creative enhancements. 
 

Resolution Dependency: Raster graphics are resolution-dependent, meaning they have a 

fixed number of pixels that determine their level of detail. Enlarging a raster image beyond 

its original resolution can result in pixelation and loss of quality, as the individual pixels 

become more noticeable. Therefore, it's important to work with raster graphics at their 

intended resolution for optimal results. 
 

File Size: Raster graphics tend to have larger file sizes compared to vector graphics, 

especially at higher resolutions. This is because each pixel requires storage for its color 

information. Consequently, larger file sizes can affect loading times, storage requirements, 

and bandwidth usage, particularly in web-based applications. 
 

Photorealistic Effects: Raster graphics are often used to create photorealistic effects, such 

as shading, gradients, and texture. By manipulating individual pixels, designers can achieve 
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lifelike representations of objects, surfaces, and lighting conditions. This makes raster 

graphics suitable for various applications, including digital artwork, digital painting, and 

photo-based designs. 
 

Output Considerations: Raster graphics are typically used for output in digital and print 

media. They are commonly used in photography, web design, social media graphics, digital 

art, and digital publications. However, when it comes to large-format prints, raster graphics 

may require higher resolutions to maintain quality, as the viewer is likely to be in closer 

proximity to the printed output. 
 

Photo-realistic Images: Due to their ability to capture fine details and subtle variations in 

color, raster graphics are well-suited for representing realistic and highly detailed images, 

particularly in photography and digital art.  

 

1.3. Bitmap 

A bitmap is a type of digital image format that represents graphics as a collection of 

individual pixels.  

 

 

Here's an interpretation of bitmaps in graphics: 
 

Pixel-based Representation: Bitmap graphics, also known as raster graphics, store visual 

information as a grid of pixels. Each pixel in the grid contains color and brightness data, 

collectively forming the image. The arrangement and combination of these pixels 

determine the overall appearance of the graphic. 
 

Resolution Dependency: Bitmap graphics are resolution-dependent, meaning they have a 

fixed number of pixels that determine their level of detail. The resolution of a bitmap image 

is typically measured in pixels per inch (PPI) or dots per inch (DPI). Higher resolutions 

result in more pixels per inch and greater detail, while lower resolutions lead to fewer pixels 

and reduced clarity. 
 

Realistic Rendering: Bitmap graphics excel at capturing complex and realistic visual 

representations. Due to their pixel-based nature, they are well-suited for capturing details, 

textures, and subtle variations in color. This makes bitmaps particularly useful for 

representing photographs, natural scenes, and highly detailed graphics. 
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Image Editing: Bitmap graphics offer extensive editing capabilities using software such 

as Adobe Photoshop. Since each pixel can be individually manipulated, designers have 

precise control over various aspects, including color adjustments, retouching, special 

effects, and creative enhancements. This allows for detailed editing and manipulation of 

the image. 
 

File Size Considerations: Bitmap graphics tend to have larger file sizes compared to other 

graphic formats, such as vector graphics. This is because each pixel in the image requires 

storage for its color information. Consequently, larger file sizes can impact storage 

requirements, loading times, and bandwidth usage, particularly when working with high-

resolution images. 
 

Output Flexibility: Bitmap graphics can be used in a variety of digital and print 

applications. They are commonly used for web graphics, digital artwork, photo editing, 

digital publications, and printing. However, when it comes to resizing or enlarging bitmap 

images, care must be taken to maintain image quality, as enlarging beyond the original 

resolution can result in pixelation and loss of detail. 

 

2. Uses of graphic design 

Graphic design has a wide range of uses and applications across various industries and 

disciplines. Here's an interpretation of the uses of graphic design: 

 

Branding and Identity: Graphic design plays a crucial role in establishing and enhancing 

the visual identity of brands and organizations. It involves creating logos, typography, color 

schemes, and other visual elements that represent the brand's values, personality, and 

offerings. 

 

Advertising and Marketing: Graphic design is essential for creating visually appealing 

and persuasive advertisements and marketing materials. It involves designing print and 

digital ads, brochures, posters, packaging, and other promotional materials that effectively 

communicate messages, capture attention, and engage target audiences. 

 

User Interface (UI) Design: Graphic design is integral to creating intuitive and visually 

appealing user interfaces for websites, applications, and software. UI design focuses on 

optimizing the user experience by designing interfaces that are easy to navigate, visually 

consistent, and visually pleasing. 

 

Web Design and Digital Media: Graphic design is fundamental to web design and the 

creation of digital media. It involves designing website layouts, user interfaces, icons, 

banners, social media graphics, and other digital assets that enhance the online presence 

and user experience. 

 

Print Design: Graphic design has a significant role in print media, including designing 

layouts for magazines, newspapers, books, brochures, business cards, posters, and other 
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printed materials. Print design aims to create visually appealing compositions that 

effectively convey information and engage readers. 

 

Packaging Design: Graphic design plays a crucial role in packaging design, as it helps 

attract attention and communicate the value of a product. Effective packaging design 

incorporates branding elements, graphics, typography, and imagery to create visually 

appealing packaging that stands out on store shelves. 

 

Environmental Design: Graphic design is utilized in environmental design to create 

visually immersive and engaging experiences in physical spaces. It involves designing 

signage, wayfinding systems, exhibitions, museum displays, retail spaces, and event 

branding to enhance the atmosphere, guide visitors, and convey information. 

 

Illustration and Artistic Expression: Graphic design includes illustration and artistic 

expression, where designers create original drawings, digital illustrations, and artwork for 

various purposes, such as books, magazines, advertisements, and online platforms. 

Illustrations can communicate ideas, convey narratives, and evoke emotions. 

 

Information Design: Graphic design is instrumental in information design, where 

designers present complex information in a clear and visually engaging manner. This 

includes creating infographics, data visualizations, charts, and diagrams that simplify 

information, enhance understanding, and aid in decision-making. 

 

Entertainment and Multimedia: Graphic design is utilized in the entertainment industry, 

including the creation of movie posters, album covers, video game graphics, and 

multimedia presentations. It adds visual appeal, captures attention, and conveys the essence 

of the entertainment content.  

 

3. Structure of graphics  

3.1 Vector-based graphics 

Vector-based graphics are a type of digital image format that represents graphics using 

mathematical formulas and geometric primitives such as points, lines, curves, and 

shapes. Here's an interpretation of vector-based graphics: 
 

Mathematical Representation: Vector-based graphics are defined by mathematical 

equations that describe the shapes and properties of the elements in the image. Instead 

of storing pixel-based information like raster graphics, vector graphics store 

mathematical instructions to recreate the image at any size or resolution. 
 

Resolution Independence: Vector graphics are resolution-independent, meaning they 

can be scaled up or down without any loss of quality. Since the image is based on 

mathematical formulas, the shapes and lines remain smooth and sharp regardless of the 

size. This makes vector graphics ideal for designs that need to be reproduced at various 

sizes, such as logos or illustrations. 
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Scalability: Vector graphics can be easily scaled to any size, from tiny icons to large 

billboards, without loss of detail or pixelation. This scalability is achieved by 

recalculating the mathematical formulas to generate the image at the desired size, 

ensuring consistent and crisp output. 

 

Editability and Flexibility: Vector graphics offer extensive editability and flexibility. 

Designers can easily modify and manipulate individual elements, such as adjusting the 

shape, color, size, and position, without compromising the overall quality. This makes 

vector graphics highly versatile and adaptable to different design requirements. 

 

Small File Sizes: Vector graphics typically have smaller file sizes compared to raster 

graphics. Since the file only contains mathematical instructions rather than storing 

individual pixel information, vector files tend to be more compact. This is advantageous 

for web-based applications, where smaller file sizes contribute to faster loading times 

and optimized performance. 

 

Precise and Smooth Lines: Vector graphics are known for their precise and smooth 

lines, curves, and shapes. As the graphics are defined by mathematical formulas, they 

can achieve precise control over the placement and curvature of lines and shapes, 

resulting in clean and visually pleasing designs. 

 

Ideal for Logos and Typography: Vector graphics are widely used for creating logos, 

icons, and typography. The scalability and editability of vector graphics allow for the 

creation of crisp and professional-looking logos that can be easily resized for different 

applications. Similarly, vector-based typography maintains its clarity and sharpness 

regardless of the size or resolution. 

 

Print and Production: Vector graphics are commonly used in print and production 

processes, including commercial printing, vinyl cutting, engraving, and laser etching. 

Vector files can be easily converted to various formats and used across different 

printing technologies, ensuring high-quality output with precise details.  

 

3.2 Raster-based graphics 

Raster-based graphics, also known as bitmap graphics, are digital images composed of 

a grid of pixels. Each pixel contains color and brightness information, and when 

combined, they form the overall image. Here's an interpretation of raster-based 

graphics: 

 

Pixel-based Representation: Raster graphics are composed of a fixed number of 

pixels, each representing a tiny dot of color. The arrangement and combination of these 

pixels create the visual representation of an image. The more pixels in an image, the 

higher its resolution and level of detail. 
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Resolution Dependency: Raster graphics are resolution-dependent, meaning they have 

a fixed number of pixels that determine their level of detail. Higher resolutions result 

in more pixels per inch (PPI) or dots per inch (DPI), resulting in greater detail, while 

lower resolutions have fewer pixels and reduced clarity. When resizing raster graphics, 

it's important to consider the original resolution to maintain image quality. 

 

Realistic Rendering: Raster graphics excel at representing complex and realistic visual 

content. The pixel-based nature of raster graphics allows for the capture of intricate 

details, textures, and subtle variations in color and shading. This makes raster graphics 

well-suited for representing photographs, natural scenes, and highly detailed visual 

elements. 

 

Photo Editing and Manipulation: Raster graphics offer extensive editing capabilities 

using software like Adobe Photoshop. Since each pixel can be individually 

manipulated, designers have precise control over various aspects, including color 

adjustments, retouching, special effects, and creative enhancements. Raster graphics 

are commonly used in photo editing and digital artwork. 

 

File Size Considerations: Raster graphics typically have larger file sizes compared to 

other graphic formats. This is because each pixel in the image requires storage for its 

color information. Larger file sizes can impact storage requirements, loading times, and 

bandwidth usage, especially when working with high-resolution images. Compression 

techniques are often used to reduce file sizes while maintaining acceptable image 

quality. 

 

Output Limitations: Raster graphics have limitations when it comes to scaling and 

resizing. Enlarging a raster image beyond its original resolution may result in visible 

pixelation, where individual pixels become noticeable, leading to a loss of image 

quality. Raster graphics are best suited for applications where the image will be viewed 

at its intended size or smaller. 

 

Versatility in Applications: Raster graphics are widely used in various applications, 

including web graphics, digital artwork, photo prints, digital publications, and screen 

displays. They are compatible with a wide range of software and platforms, making 

them accessible and versatile for different creative and visual communication needs. 

 

Photorealistic Effects: Raster graphics are essential for creating photorealistic visual 

effects, such as textures, shadows, gradients, and complex lighting effects. The ability 

to render precise pixel-based information allows for the accurate representation of 

realistic and detailed visual elements.  
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4. Software for graphic design  

4.1 Adobe Photoshop 

Adobe Photoshop is a powerful and widely used software application for graphic 

design, image editing, and photo manipulation.  

 
Here's an interpretation of Adobe Photoshop: 

 

Image Editing: Adobe Photoshop is renowned for its comprehensive image editing 

capabilities. It provides a wide range of tools and features for adjusting colors, tones, 

and saturation, as well as cropping, resizing, and retouching images. Designers can 

enhance and modify images with precision, making Photoshop an essential tool for 

professional photo editing. 
 

Layers and Masks: Photoshop utilizes a layers-based workflow, allowing designers to 

work with multiple elements and effects independently. Layers can be stacked, 

rearranged, and adjusted to create complex compositions. Masks enable precise control 

over areas of an image, allowing for selective editing and blending. 
 

Graphic Design: Photoshop offers powerful tools for graphic design, allowing 

designers to create and manipulate vector and raster-based graphics. It supports the 

creation of logos, illustrations, typography, and other visual elements used in print and 

digital design projects. Designers can combine images, text, and effects to craft visually 

appealing and engaging designs. 
 

Photo Manipulation: Photoshop is widely used for advanced photo manipulation and 

compositing. Designers can remove objects, change backgrounds, merge multiple 

images, and apply special effects to achieve creative and surreal results. Photoshop's 

extensive tools and filters provide endless possibilities for transforming and 

manipulating photographs. 
 

Retouching and Restoration: Photoshop includes tools and features specifically 

designed for retouching and restoring photographs. Designers can remove blemishes, 

wrinkles, and imperfections, adjust skin tones, and enhance facial features. 

Additionally, Photoshop enables the restoration of old or damaged photographs by 

repairing tears, scratches, and color fading. 
 

Content-Aware Fill: Photoshop's Content-Aware Fill feature intelligently fills in 

selected areas of an image with content that matches the surrounding pixels. It is 

particularly useful for removing unwanted objects or distractions from a photo 

seamlessly. Content-Aware Fill saves time and effort by automatically generating 

realistic replacements. 
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Filters and Effects: Photoshop offers a wide array of filters and effects that can be 

applied to images to create various artistic and stylistic effects. Designers can add blur, 

distortions, gradients, and lighting effects to enhance the visual impact of their designs. 

Customizable adjustment layers enable precise control over color corrections and tonal 

modifications.  

 

4.2 Adobe Illustrator 

Adobe Illustrator is a popular software application used for creating vector-based 

graphics and illustrations.  

 
 

Here's an interpretation of Adobe Illustrator: 
 

Vector Graphics: Adobe Illustrator is primarily used for creating and editing vector 

graphics. Vector graphics are made up of mathematically defined geometric shapes, 

allowing them to be scaled to any size without loss of quality. Illustrator provides a 

wide range of tools and features for creating precise and scalable illustrations, logos, 

icons, typography, and other graphic elements. 
 

Pen Tool and Paths: The Pen tool in Illustrator is a fundamental tool used to create 

and manipulate paths. Paths are the foundation of vector graphics, and they can be used 

to create shapes, lines, curves, and complex forms. Illustrator offers precise control over 

anchor points, curves, and handles, allowing designers to create detailed and intricate 

artwork. 
 

Shape Creation and Editing: Illustrator provides a variety of shape creation and 

editing tools, such as the Rectangle, Ellipse, and Polygon tools. These tools enable 

designers to quickly create basic shapes and modify them using anchor points, handles, 

and path editing techniques. Shapes can be combined, subtracted, or transformed to 

create complex compositions. 
 

Typography: Adobe Illustrator offers robust typographic features, making it a popular 

choice for creating and manipulating text-based designs. Designers can apply a wide 

range of fonts, styles, and effects to text, as well as adjust kerning, leading, and tracking. 

Illustrator allows for precise control over text placement and formatting. 
 

Color and Gradient Tools: Illustrator provides a comprehensive set of tools for 

working with colors and gradients. Designers can select and apply colors from various 

color models, create custom color palettes, and use gradient tools to apply smooth 

transitions between colors. Illustrator also supports global color swatches, making it 

easy to update colors throughout a design. 
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Artboards and Multiple Page Layouts: Illustrator allows designers to work with 

multiple artboards within a single document. Artboards function as separate 

workspaces, enabling the creation of multiple designs or variations within a single file. 

This is particularly useful when working on projects such as multi-page layouts, 

presentations, or sets of related designs. 
 

Integration with Adobe Creative Cloud: Like other Adobe applications, Illustrator 

seamlessly integrates with Adobe Creative Cloud, enabling efficient collaboration and 

smooth workflows. Designs created in Illustrator can be easily shared and transferred 

to other Adobe software, such as Photoshop or InDesign, for further editing or 

incorporation into larger design projects. 
 

Export Options: Illustrator offers a variety of export options to save designs in 

different formats, such as AI, EPS, PDF, SVG, and more. This flexibility allows 

designers to output their work for various purposes, including print, web, mobile, and 

other digital platforms.  
 

4.3 Adobe InDesign 

Adobe InDesign is a professional desktop publishing software used for creating layouts, 

typesetting, and designing print and digital publications. Here's an interpretation of 

Adobe InDesign: 

 

Layout Design: Adobe InDesign is primarily used for creating layouts for print and 

digital media. It provides a wide range of tools and features for arranging text, images, 

graphics, and other visual elements on pages. Designers can create multiple pages or 

spreads, set margins, define grid systems, and establish a consistent visual hierarchy. 
 

Typography and Typesetting: InDesign offers advanced typographic capabilities, 

making it a go-to tool for working with text-heavy designs. Designers can apply precise 

control over font selection, character styles, paragraph formatting, and hyphenation. 

InDesign supports advanced typesetting features like automatic text flow, linking text 

frames, and controlling widows and orphans. 
 

Master Pages and Templates: InDesign allows designers to create master pages and 

templates, which serve as a foundation for consistent page layouts. Master pages 

contain elements that are shared across multiple pages, such as headers, footers, and 

background images. Templates provide a starting point for new projects, ensuring a 

consistent design aesthetic throughout. 
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Image and Graphic Integration: InDesign seamlessly integrates with Adobe 

Photoshop and Illustrator, allowing for easy importing and manipulation of images and 

graphics. Designers can resize, crop, and position images within frames, apply effects 

and filters, and maintain high-quality resolution for print. Vector graphics created in 

Illustrator can be placed and edited directly in InDesign. 
 

Interactive Digital Publishing: InDesign offers features for creating interactive digital 

publications, such as eBooks, interactive PDFs, and digital magazines. Designers can 

add interactive elements like hyperlinks, buttons, multimedia content, and animations 

to enhance the reading experience and engage the audience. 
 

Print Production and Prepress: InDesign provides tools and features for preparing 

designs for print production. Designers can set up print specifications, define color 

profiles, manage color separations, and create print-ready PDF files. InDesign also 

supports prepress tasks, such as preflighting, packaging files, and collaborating with 

printers. 
 

Collaboration and Workflow: InDesign is designed to facilitate collaboration among 

designers, writers, and editors. It allows for easy sharing of InDesign files, supports 

track changes and annotations, and integrates with Adobe Creative Cloud for 

streamlined workflows. InDesign enables multiple team members to work on different 

parts of a project simultaneously. 
 

Cross-Media Publishing: InDesign enables designers to repurpose their designs for 

various media formats. With features like liquid layout, alternate layouts, and adaptive 

design tools, designers can adapt their layouts for different devices and screen sizes, 

such as tablets, smartphones, and web browsers.  
 

4.4 CorelDRAW 

CorelDRAW is a vector-based graphic design software that offers a wide range of tools 

and features for creating illustrations, designs, and layouts.  
 

 

Using CorelDRAW we cam perform following activities: 
 

Vector Graphics: CorelDRAW is primarily focused on working with vector graphics, 

which are based on mathematical equations to create smooth and scalable artwork. 

Designers can create and manipulate shapes, curves, and lines using precise control 

over anchor points, handles, and nodes. This allows for the creation of high-quality 

artwork that can be scaled to any size without loss of quality. 
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Illustration and Design: CorelDRAW provides a robust set of tools and features for 

creating illustrations, logos, icons, and other visual elements. Designers can use 

drawing tools to create and edit vector shapes, apply various artistic effects, and utilize 

features like blending, transparency, and gradients. CorelDRAW also offers advanced 

typography tools for working with text and formatting options. 

 

Layout and Page Design: CorelDRAW includes features for layout and page design, 

allowing designers to create multi-page documents such as brochures, magazines, and 

flyers. It provides tools for arranging and aligning objects, managing layers, and 

creating grids and guides for precise placement of elements. CorelDRAW's layout 

capabilities make it suitable for both print and digital design projects. 

 

Photo Editing: CorelDRAW integrates photo editing capabilities through its 

companion software, Corel PHOTO-PAINT. Designers can seamlessly switch between 

CorelDRAW and Corel PHOTO-PAINT to enhance and edit photos, apply adjustments, 

retouch images, and add creative effects. This integration allows for a comprehensive 

design workflow within a single software suite. 

 

Color Management: CorelDRAW offers color management tools to ensure accurate 

color representation in designs. Designers can work with various color models, create 

custom color palettes, and manage color consistency across different projects. 

CorelDRAW also supports spot colors and Pantone libraries for precise color matching 

in print. 

 

Print and Export Options: CorelDRAW provides extensive print and export options, 

allowing designers to prepare their designs for different output formats. Designers can 

create print-ready files, set up bleeds, manage color separations, and export designs in 

various file formats such as PDF, EPS, and SVG. CorelDRAW also supports web 

graphics optimization for online publishing. 

 

Cross-Platform Compatibility: CorelDRAW is available for both Windows and 

macOS, offering cross-platform compatibility. This allows designers to work 

seamlessly on different operating systems and collaborate with team members using 

different platforms. 

 

CorelDRAW Community: CorelDRAW has a dedicated community of users who 

share knowledge, resources, and tutorials. Designers can access online forums, user 

groups, and learning materials to enhance their skills and stay updated with the latest 

techniques and trends.  

 

5. Basic design guidelines 

Basic design guidelines involve principles and considerations that help create visually 

pleasing, functional, and effective designs. Here are some concise basic design guidelines: 
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1. Simplicity: Keep designs simple and avoid unnecessary complexity to enhance clarity 

and user understanding. A clean and minimalist design reduces cognitive load and 

makes it easier for users to navigate and comprehend the content. 

2. Consistency: Maintain consistent visual elements, such as colors, typography, and 

layout, throughout the design to establish a cohesive and harmonious experience. 

Consistency promotes familiarity, improves usability, and helps users develop patterns 

and expectations within the design. 

3. Readability: Ensure content is legible and easy to read by using appropriate fonts, font 

sizes, line spacing, and contrast between text and background. Good readability 

enhances user comprehension and prevents eye strain, ensuring that information can be 

consumed effortlessly. 

 

4. Hierarchy: Use visual cues like size, color, and placement to establish a clear hierarchy 

of information, guiding users to the most important elements. A well-defined hierarchy 

helps users quickly scan and locate key information, improving the overall user 

experience. 

5. Balance: Distribute visual elements evenly within the design to create a sense of 

balance and visual harmony. Balanced designs appear more aesthetically pleasing and 

provide a sense of stability and order. 

6. Contrast: Utilize contrast between colors, shapes, sizes, and textures to make 

important elements stand out and improve visual impact. Contrast helps draw attention 

to specific elements, creating emphasis and enhancing visual hierarchy. 

7. Alignment: Align elements to a grid or visual guides to create order and improve 

readability, making it easier for users to navigate the design. Proper alignment creates 

a sense of structure and organization, promoting a visually pleasing and coherent 

layout. 

8. White Space: Incorporate appropriate white space (empty areas) around elements to 

reduce clutter, enhance focus, and improve overall aesthetics. White space helps 

separate and distinguish different elements, improving readability and visual clarity. 

9. Visual Feedback: Provide clear visual cues and feedback, such as hover effects or 

button states, to guide users and communicate interactivity. Visual feedback enhances 

user engagement, provides a sense of control, and improves the overall user experience. 

10. Responsiveness: Design with responsiveness in mind to ensure the layout adapts and 

functions well across different devices and screen sizes. Responsive design ensures that 

users can access and interact with the design seamlessly on various devices, enhancing 

accessibility and usability.  
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6. Design brief 

A design brief is a document that outlines the objectives, requirements, and constraints of 

a design project. It serves as a guideline and reference for designers to understand the 

project's scope and deliverables. Some key points need to consider for a design brief: 

 

1. Provide a brief description of the project, including its purpose, goals, and target 

audience. This section sets the context and helps designers understand the project's 

objectives. 

2. Clearly define the scope of the project and specify the deliverables expected from 

the designer. This may include design assets like logos, website mockups, 

packaging designs, or other visual materials. 

3. If applicable, include existing branding guidelines or provide information about the 

desired brand image and personality. This ensures that the design aligns with the 

established brand identity or reflects the desired brand positioning. 

4. Describe the intended audience or users of the design. Include relevant 

demographics, preferences, and behaviors to guide designers in creating designs 

that resonate with the target audience. 

5. Identify any limitations, such as budget, timeline, technical restrictions, or legal 

considerations. These constraints help designers understand the boundaries within 

which they must work and make appropriate design decisions. 

6. Outline specific design requirements, such as color preferences, typography 

choices, imagery style, or other visual elements that should be incorporated into the 

design. This section provides specific instructions to ensure the design aligns with 

the desired aesthetic and communication goals. 

7. Clearly state the key messages or information that the design should convey. 

Specify any desired emotions, tone, or style that should be reflected in the design 

to effectively communicate the intended message. 

8. Provide information about the competitive landscape and examples of designs or 

brands that are relevant to the project. This analysis helps designers understand the 

market context and identify opportunities to create a unique and impactful design. 

9. Include the project timeline with key milestones, such as design concept 

presentation, feedback rounds, and final delivery dates. This ensures that both the 

client and designer have a shared understanding of the project timeline and can 

manage expectations accordingly. 

10. Specify the communication channels and frequency of meetings or updates 

throughout the project. Establishing clear lines of communication and expectations 

helps facilitate effective collaboration between the client and designer.   
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Self Check Sheet 1.1 

 

1. What do you mean by the term Graphic Design? 

 

 

 

 

 

2. What is Typography? 

 

 

 

  

3. What is white space? 

 

 

 

 

4. What is vector graphics? 

 

 

 

 

5. What is Raster graphics? 
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Answer Key 1.1 

 

1. What do you mean by the term Graphic Design? 

Answer: Graphic design is a creative discipline that involves visually communicating 

ideas, messages, and information using various design elements. It encompasses the art 

and skill of combining typography, images, colors, shapes, and layout to create visual 

compositions that are aesthetically pleasing, effective, and purposeful. 

2. What is Typography? 

Answer: Typography in graphic design refers to the art and technique of arranging and 

styling typefaces to communicate a message effectively. It involves selecting 

appropriate fonts, determining their sizes, spacing, and formatting, and integrating them 

harmoniously into a design.  

3. What is white space? 

Answer: White space, also known as negative space, refers to the empty or unmarked 

areas within a composition in graphic design. It is the absence of visual elements such 

as text, images, or graphics. Despite its name, white space doesn't have to be white in 

color and can be any background color or even transparent. 

4. What is vector graphics? 

Answer: Vector graphics are a type of digital image created using mathematical 

formulas and geometric shapes. Unlike raster graphics, which are composed of pixels, 

vector graphics are resolution-independent and can be scaled to any size without losing 

quality 

5. What is Raster graphics? 

Answer: Raster graphics, also known as bitmap graphics, are a type of digital image 

composed of a grid of pixels. Each pixel contains color and brightness information, 

collectively forming the overall image   
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Learning Outcome 2: Work with image 

 

Content: 

1. Image modification software 

2. Image sources  

3. Importing Images  

4. Image separation tools 

5. Saving procedure of separated image 

 

Assessment Criteria:  

1. Appropriate Image modification software is identified and opened. 

2. Image sources are identified. 

3. Images are successfully Imported from appropriate source. 

4. Image separation tools are identified and applied. 

5. Separated image is saved. 

 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 2: Work with image 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Apply 

Graphic Design 

Concepts and 

Guidelines. 

1. Instructor will provide the learning materials 

“Applying Graphic Design Concepts and Guidelines 

2. Read the Information 

sheet/s 

2. Information Sheet No:2 Work with image 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 2 Work with image 

Answer key No. 2 Work with image 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:2-  

 

Specification Sheet 2 –  
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Information Sheet 2: Work with image 

Learning Objectives: 

After completion of this information sheet, the learners will be able to: 

1. Identify appropriate Image modification software. 

2. identify Image sources. 

3. Import Images successfully from appropriate source. 

4. identify and apply Image separation tools. 

5. Save separated image. 

 

1. Image modification software 

Adobe Photoshop: Adobe Photoshop is the industry-standard software for image 

modification and graphic design. It offers a comprehensive range of tools and features, 

including advanced layering, masking, retouching, and color correction. Photoshop allows 

you to manipulate images with precision, create stunning visual effects, and design graphics 

for both print and digital media. It is widely used by professional designers and 

photographers due to its powerful capabilities and extensive support. 

GIMP (GNU Image Manipulation Program): GIMP is a free 

and open-source software known for its versatility in image 

modification and graphic design. It offers a wide range of tools 

and filters for editing and enhancing images, including 

advanced selection tools, layering, and masking. While GIMP 

may have a slightly steeper learning curve compared to 

Photoshop, it provides a cost-effective alternative with a strong 

community support. 

Affinity Photo: Affinity Photo is a 

professional-grade image editing software 

suitable for graphic design. It offers a wide 

range of features, including advanced 

selection tools, retouching capabilities, and 

non-destructive editing. Affinity Photo 

supports both raster and vector editing, 

making it a versatile tool for image 

modification and design. It provides a modern and intuitive interface and is often 

considered a viable alternative to Adobe Photoshop. 

Canva: Canva is an online graphic design platform that 

simplifies image modification and design for users with little 

to no design experience. It offers a user-friendly interface and 

a vast library of templates, graphics, and fonts to create 

visually appealing designs. Canva allows you to modify 

images, add text, apply filters, and customize designs for 

various purposes, including social media posts, 

presentations, and marketing materials. While it may not 
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have the advanced capabilities of professional software, Canva is an excellent choice for 

quick and easy image modifications.  

2. Image sources 

Scanner 

A scanner is a device that captures images from photographic prints, posters, magazine pages, 

and similar sources for computer editing and display. Scanners come in hand-held, feed-in, 

and flatbed types and for scanning black-and-white only, or color. 

 

Digital Camera 

A digital camera is a camera that captures photographs in digital memory. Most cameras 

produced today are digital, and while there are still dedicated digital cameras, many more 

cameras are now incorporated into mobile devices like smartphones, which can, among many 

other purposes, use their cameras. 

 

Internet 

The Internet is a global network of billions of computers and other electronic devices. With the 

Internet, it's possible to access almost any information, communicate with anyone else in the 

world, and do much more. 

 

Image sources is an essential aspect of graphic design as it helps designers understand the origin, rights, and 

permissible usage of images. Here are a few common types of image sources and their implications: 

Stock Photos: Stock photo websites provide a vast collection of licensed images that designers can use for their 

projects. These images are typically created by professional photographers or artists and are available for purchase 

or under specific usage licenses. When using stock photos, it is crucial to review the license terms and comply 

with any restrictions on usage, such as attribution requirements or limitations on commercial use. 

Creative Commons: Creative Commons licenses offer a flexible way for artists and creators to share their work 

while specifying the permissions and restrictions. These licenses vary and can range from allowing unrestricted 

use (including commercial use) to requiring attribution or prohibiting modifications. Designers must carefully 

review the specific Creative Commons license associated with an image and adhere to its terms. 

Public Domain: Public domain images are not protected by copyright, either due to their age or because the 

creator has explicitly dedicated them to the public domain. These images can be freely used, modified, and 

distributed without permission or attribution. However, it's important to verify the public domain status, especially 

for older works, as there may be some exceptions or regional variations. 

Client-Supplied Images: In some cases, clients may provide their own images for use in graphic design projects. 

It is important to obtain clarity from the client about the source and rights of these images. If the client does not 

have the necessary permissions or licenses for the images, it is the designer's responsibility to guide the client 

towards legally sourced alternatives or obtain appropriate rights. 

Self-Created Images: Designers often create their own images through photography, illustration, or other artistic 

means. When using self-created images, designers have full control over the rights and usage permissions. 

However, it's worth noting that certain recognizable elements within the images, such as trademarks or 

copyrighted artwork, may still have separate restrictions on their usage.  

http://www.google.com/imgres?q=picture+of+scanner&hl=en&sa=X&biw=1054&bih=413&tbm=isch&prmd=ivnsu&tbnid=zVInC5JOQyc6MM:&imgrefurl=http://mypcmag.com/2010/11/scanner/&docid=4lYceYBP8eSOhM&w=747&h=501&ei=jgYtTtbrAsTorAer9bmyDQ&zoom=1
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3. Importing Images  

Interpreting image importing refers to the process of bringing images into a graphic design software or 

project for use. Here's an explanation of image importing in graphic design: 

File Formats: Images can be imported into graphic design software in various file formats, such as JPEG, 

PNG, GIF, TIFF, or SVG. Each file format has its own characteristics and best uses. For example, JPEG is 

commonly used for photographs due to its efficient compression, while PNG is suitable for images with 

transparency. Understanding the strengths and limitations of different file formats helps designers choose the 

appropriate format for their specific needs. 

Resolution and Size: The resolution and size of an imported image are important considerations. Resolution 

refers to the number of pixels per inch (PPI) and affects the image's quality and sharpness. Higher-resolution 

images are typically needed for print projects, while lower-resolution images are acceptable for web or digital 

use. The size of an image determines its dimensions in pixels or physical measurements. Designers must 

ensure that the imported image's resolution and size are appropriate for the intended output and won't result 

in pixelation or loss of quality. 

Color Mode: Images can be imported in different color modes, such as RGB (Red, Green, Blue) or CMYK 

(Cyan, Magenta, Yellow, Black). RGB is commonly used for digital design, while CMYK is used for print 

projects. Designers should import images in the appropriate color mode to maintain color accuracy and 

consistency across their designs. 

Transparency: Images with transparency allow for blending or overlaying with other elements without fully 

obscuring them. Importing images with transparency is particularly useful when creating layered designs or 

incorporating them into complex compositions. Formats such as PNG and SVG support transparency, while 

formats like JPEG do not. 

Copyright and Permissions: When importing images into a graphic design project, it is crucial to consider 

copyright and permissions. Ensure that you have the necessary rights or licenses to use the images in your 

design, especially when working with images sourced from third parties. Using copyrighted images without 

proper authorization can lead to legal issues. Alternatively, using royalty-free or properly licensed images 

ensures compliance with copyright laws.  

 

4. Image separation tools 

 

The Marquee Tool  

The Rectangular and Elliptical Marquee Tools in Photoshop are used to create basic selections 

in rectangular or circular shapes. These tools can be used to crop layers by applying the 

selection onto a layer mask, to add selection adjustments, align layers, and more. 

The Marquees Tool is a group of tools found in the Toolbar in Photoshop. The group contains 

the Rectangular Marquee Tool, the Elliptical Marquee Tool, and the Single Row and Single 

Column Marquees. 
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All the Marquee Tools create a selection based on a particular shape, as the name suggests. The 

single column and single row marquees make either a row or column selection one pixel wide. 

The Marquee Tools all provide similar functions, and you can use these tools for various 

helpful functions, such as: 

 

1. Make a quick selection using one of the available shapes. 

 

 
 

2. Quickly crop an image into a circle for a website “About us page.” 

 
3. Create a quick selection of an object or area to add a fill or adjustment layer to an isolated 

area. 
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4. Cut and move objects within an image. 

 

 
 

5. You can also create straight lines that are one pixel wide or high across the page and increase 

the width, if necessary. 

 

 
 

6. Cut and paste sections of a photo onto a new layer. 
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Object Selection Tool Steps 

Open your photo in Photoshop and select the Object Selection tool in the toolbar on the left (in 

the same menu as Quick Selection Tool). 

Now, hover your cursor over your subject and wait for it to turn blue. (Move your cursor in 

tiny circles if it doesn’t immediately turn blue.) 

In an instant, your subject is ready to be selected. 
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Remove a background in Photoshop using the new Object Selection tool 

To erase background material from here, press the shift key while selecting all objects you’d 

like to keep in the photo. This shortcut will auto-select each object for you (showing you the 

marching ants around each entity). 

Next, go to Select > Inverse to invert the selection (meaning that your background is now 

selected instead of your objects). 

 

Remove a background in Photoshop: Object Selection tool selection 

Depending on what you want the background to be (in my case, I want it to be transparent), 

you’ll likely need to unlock your image, so it’s no longer considered a background. 

Next, click the lock on the right side of your image’s layer to unlock it. The layer name will 

change to “Layer 0” if you have no other layers. To remove the background, click the Eraser 

Tool (making sure your brush is large) and start erasing the background. 
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Remove a background in Photoshop: Object Selection tool eraser 

You don’t have to worry about Photoshop losing the selections. If you ever need to reselect 

your objects, select the Object Selection tool and hover over your objects again. 

Remove Background in Photoshop with Quick Action 

In Photoshop Quick Action for removing backgrounds. It was introduced in Photoshop 2021 

(in the Creative Cloud subscription) and provides an Adobe background remover that’s 

effective and easy to use. 

With speed, however, comes less accuracy. Using Photoshop Quick Action will do most of the 

work for you, but the results may fall short of your expectations, depending on your image. If 

that’s the case, you can use any methods described here to polish up the result. 

Quick Action Steps 

1. With your image open in Photoshop, right click your Background layer and click Duplicate 

Layer. In the dialog box that pops up, name your layer (calling it whatever you like) and 

click OK. Click the eye icon to the left of the original layer to turn that layer off. 

2. Make sure your Properties panel is open by going to Window > Properties. (If it was already 

checked, there’s no need to click it; if it isn’t checked, click it to open it up on the right-hand 

side by default.) 

3. In your Layers panel, click your new layer. In the Properties panel (by default this should 

be above your Layers panel), click the Remove Background button under Quick Action. 
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4. The quick action has now removed the background, leaving your layer with a mask around 

the subject. 

 

From here, you can make refinements by going into the mask and adjusting as needed (such as 

around the dog’s feet at the bottom left of the image). While outside the scope of this article, if 

you need help with working with masks 

Remove a Background in Photoshop with the Pen Tool 

The Pen tool is one of the most tried and true ways to remove backgrounds from images in 

Photoshop. It gives you the most control over the outcome. However, because it gives you the 

most control, it can also be the most time-consuming. The Pen tool requires patience. 

Pen Tool Steps 

1. With your image open in Photoshop, right click your Background layer and click Duplicate 

Layer. In the dialog box that pops up, name your layer (whatever you’d like), and click OK. 

Click the eye icon to the left of the original layer to turn that layer off. 

2. Select the Pen tool from the toolbox on the left-hand side (above the Text tool). Zoom in to 

an area of your image to start. Start at the edge of your subject (or a suitable starting point) 

and click to start the first anchor. Then start working your way around your subject, adding 

additional anchors to start outlining your subject. 

If you need to make a curved line, click-hold-drag to produce a curved line, moving the 

mouse to adjust the curve as needed. 

To adjust an anchor point or directional lines for fine tuning, use the Direct Selection tool 

(hidden under the Path Selection tool) in the toolbox. 

To undo an anchor, go to File > Undo or use your keyboard shortcut (Command + Z for macOS, 

Control + Z for Windows). 
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3. Make sure you complete the path once you’re done by meeting up with your first point. 

Once you’ve completed the path and you’re happy with the results, you’ll want to save the 

path. Go to Window > Paths to reveal the Paths panel (it should appear on the right-hand 

side by default). Click the three bar menu at the right and click New Path, and name your 

path. Now your path is saved in the Paths panel. 
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4. Next, right click your new path in the Paths panel and select Make Selection, then click OK 

in the dialog box (leave all defaults for now). This will give you the marching ants outline 

where your path was. 

 

5. Since we don’t want to delete what’s inside the selection, we’ll want to change the selection 

to be everything except the subject. Go to Select > Inverse. You’ll see the marching ants are 

now around the entire image and the subject, essentially selecting the background. 

6. To delete the background, press Delete. You should now see the white/gray checkered 

background instead of your previous background. 
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Magnetic Lasso Tool Steps 

1. With your image open in Photoshop, right click your Background layer and click 

Duplicate Layer. In the dialog box that pops up, name your layer (whatever you’d like), 

and click OK. Click the eye icon to the left of the original layer to turn that layer off. 

2. Select the Magic Lasso tool from the toolbox on the left. Start drawing along the edge of 

your subject with the tool. You’ll see it will start drawing the path for you as you move 

your cursor. Patience is key here, as you’ll want to be slow, steady, and deliberate with 

your moves. 

 

3. Once you’ve started the tool, you’ll need to go around your subject completely and connect 

to your starting point. Once you’ve made it back around to the beginning, click the starting 

point. The selection will then turn into marching ants around your selection. 

 
 

4. Save your selection by going to Selection > Save Selection and giving it a name. 
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5. To delete the background, go to Select > Inverse to invert the marching ants (they should 

now be running around the edge of the image and your subject). Click delete. You should 

now see the white/gray checkered background instead of your previous background. 

Quick Selection Tool Steps 

1. Steps: Removing a Background Image with the Quick Selection Tool 

2. Duplicate the image layer 

With your image open in Photoshop, right-click your Background layer and click Duplicate 

Layer. In the dialog box that pops up, name your layer (whatever you’d like), and click OK. 

Click the eye icon to the left of the original layer to turn that layer off. 

3. Select the Quick Selection tool 

Select the Quick Selection tool from the toolbox on the left (may be hidden under the Object 

Selection tool). 

4. Paint the subject of the image 

Using the tool, start painting your subject. You’ll see the marching ants start appearing 

while you paint. To adjust your tool size, use the [ or ] keys to decrease or increase the size. 

 

5. Clean up the selection path 

If you find you’ve painted outside of the subject, click and hold the Option key (macOS) or Alt 

key (Windows) and you’ll see the center of the tool turn from a + symbol to a - symbol, 

indicating it will now take away from the selection. Paint on the part of the selection you want 

to remove while holding the Option/Alt key. 
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6. Save your selection 

Save the selection by going to Select > Save Selection and giving it a name. This is in case you 

want to come back and make adjustments. 

7. Delete the background 

To delete the background, go to Select > Inverse to invert the marching ants (they should now 

be running around the edge of the image and your subject). Click delete. 

 

5. Saving procedure  

The fastest way to save an image is to head to File > Save. This menu path automatically 

saves the file in its current format. If the file hasn’t been saved before, this action opens 

the Save As window. Don’t worry about the differences between the save options, such 

as Save As and Save a Copy, as we will go over the differences further down.  
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You will find a few options when the Save As window opens. 

 

 

In this window, you can click the drop-down arrow next to Format to select the file format in which 

you’d like to save the image.  

 
There are many different options, but no need to get overwhelmed. It helps to know which file format 

would be best for your situation. Here is a quick list of the most commonly used file formats and what 

they’re best used for. 

Photoshop (PSD) is Photoshop’s own file format and will keep the layers in your project. And is the best 

file format if you’re planning on reopening your file in Photoshop and continuing to work on it. PSD 

files save up to 2GB of data. 

Large Document Format (PSB) is identical to the PSD file format, except that it saves projects that are 

more than 2GB. 

JPEG is the best file format for use online, though it will flatten any layers, so it might be best to utilize 

the Save as Copy option if you’re converting into a Jpeg so that you still maintain a copy of your image 

with layers.  

PNG is the best file format for use online if you’re trying to keep any transparent areas of your image, 

like a deleted background. This format will not retain layers. 



 

47 

 

TIFF is another file format that will retain the layers in your project. It is also a suitable file format to 

use for commercial printing. 

Once you’ve selected the file format you’d like to use, you can name your file and select a destination 

folder where you’d like the file to live once saved. 

 
 

Click Save when you’re done. 
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Self Check 2.1  

Answer the following questions: 

 

1. What is Canva? 

 

 

2. What is scanner? 

 

 

3. Write down the name of some image modification software. 

 

 

4. Write down the name of some image source. 

 

 

5. Write down the name of an image separation tools  
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Answer Sheet 2.1 

1. What is canva? 

Answer: Canva: Canva is an online graphic design platform that simplifies image 

modification and design for users with little to no design experience. It offers a user-

friendly interface and a vast library of templates, graphics, and fonts to create visually 

appealing designs. 

 

2. What is scanner? 

Answer: A scanner is a device that captures images from photographic prints, posters, 

magazine pages, and similar sources for computer editing and display. Scanners come in 

hand-held, feed-in, and flatbed types and for scanning black-and-white only, or color. 

 

3. Write down the name of some image modification software. 

Answer:  

i Adobe Photoshop 

ii GIMP (GNU Image Manipulation Program) 

iii Affinity Photo 

iv Canva 

1. Write down the name of some image source. 

Answer:  

i Scanner 

ii Digital Camera 

iii Internet 

iv Stock Photos:  

v Public Domain 

vi Self-Created Images 

2. Write down the name of an image separation tools  

Answer: Pen tool 
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Job Sheet 2.1 

Job Name: Separate Images from background using pen tools.  

Working Procedure/ Steps: 

1. Maintain OSH and PPE. 

2. Read specification sheet collect tools and equipment. 

3. Interpret the image to determine which software require for this job 

4. Create a folder on your own name. 

5. Remove background from the image as per sample. 

6. Save the file as your own name. 
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Specification Sheet 2.1 

 

Name of the job: Separate Images from background using pen tool. 

Condition for the job: 

1. Use the pen tool. 

2. Select Color mode RGB. 

3. Save the image in png and psd file. 

4. Turn off Computer  

To complete the above task you will need to following equipment per Trainee. 

Required Tools and equipment 

S/N Name of item Specification Unit Quantity 

01 
Personal Computer Latest 

Configuration 

Nos 
1 

02 Keyboard and Mouse Standard Nos 1 

03 Monitor Standard Nos 1 

04 Adobe Photoshop Latest version Nos 1 

Raw Materials 

• N/A 

Required PPE 

• Ergonomic chair 

• Eye protective glass 

• Rubber shoe 
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Learning Outcome 3: Identify image standards 

 

Content:  

1. Image properties. 

2. Image resolution. 

3. Image format. 

Assessment Criteria:  

1. Image properties are identified. 

2. Image resolution are identified and interpreted. 

3. Image format are identified and selected. 

 

 

 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

 Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 
  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 3 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1. Identify Image properties. 

2. Interpret Image resolution. 

3. Identify Image format 

 

1. Image properties 

Image properties in the context of digital images refer to the characteristics and attributes 

that define an image's visual appearance, technical specifications, and behavior. Here's an 

interpretation of some common image properties: 

Dimensions: Dimensions represent the width and height of an image, usually measured in 

pixels. The dimensions determine the physical size of the image when displayed or printed. 

For example, an image with dimensions of 1920x1080 pixels would have a width of 1920 

pixels and a height of 1080 pixels. 

 

Pixel: Pixel refers to a single point of color information within an image. The term "pixel" 

is derived from "picture element." Each pixel represents the smallest unit of a digital image 

and is typically represented as a square or a tiny dot on the screen. 

Resolution: Resolution refers to the level of detail and clarity in an image, expressed as 

the number of pixels per unit of measurement. It is typically measured in pixels per inch 

(PPI) or dots per inch (DPI). Higher resolution images have more pixels, resulting in finer 

detail, while lower resolution images have fewer pixels and may appear pixelated or less 

sharp. 

File Format: File format determines how image data is stored and encoded. Different file 

formats have distinct features, compression methods, and compatibility. Common image 

file formats include JPEG, PNG, GIF, and TIFF. Each format has specific strengths and 

limitations, such as support for transparency, animation, or lossless compression. 

Bit Depth: Bit depth represents the number of bits used to represent the color of each pixel 

in an image. It determines the number of colors or shades of gray that can be displayed. 

Higher bit depth allows for more color variation and smoother gradients. Common bit 

depths include 8-bit (256 colors or shades) and 24-bit (16.7 million colors). 

Compression: Compression is the process of reducing the file size of an image by 

removing redundant or unnecessary data. It can be lossless or lossy. Lossless compression 

reduces file size without sacrificing image quality, while lossy compression achieves higher 

levels of compression but may result in a slight loss of quality. Compression is commonly 

used to optimize image file sizes for web delivery or storage.  

2. Image resolution (pic/high/low) 

Image resolution refers to the level of detail or clarity in a digital image. It is typically 

expressed as the number of pixels contained in an image, usually given as width x height. 

A higher resolution means a greater number of pixels and therefore more detail in the 

image. Resolution can be measured in different units such as pixels per inch (PPI) or dots 

per inch (DPI), which determine the density of pixels in a physical print. Higher resolution 
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images are generally clearer and sharper, while lower resolution images appear more 

pixelated or blocky.  

3. Image format 

Image format refers to the specific file type or structure used to store and encode digital 

images. Different image formats have distinct characteristics, such as compression 

methods, color depth, transparency support, and compatibility with various devices and 

software. 

Here are some commonly used image formats: 

JPEG (Joint Photographic Experts Group): JPEG is a widely used format for photographs 

and complex images. It uses lossy compression, meaning some image quality is sacrificed 

to reduce file size. JPEG files are suitable for web display and sharing due to their relatively 

small size. 

PNG (Portable Network Graphics): PNG is a popular format for images that require 

transparency support, such as logos and icons. It uses lossless compression, which means 

it retains all image data without sacrificing quality. PNG files tend to have larger file sizes 

compared to JPEG. 

GIF (Graphics Interchange Format): GIF is primarily used for animated images and 

graphics with limited color palettes. It supports transparency and animation, but its color 

depth is limited to 8 bits per pixel. GIF files have small file sizes, making them suitable for 

web animations. 

TIFF (Tagged Image File Format): TIFF is a versatile format that supports lossless 

compression and can store high-quality images with multiple layers, transparency, and 

different color spaces. It is commonly used in professional photography and printing, but 

its file sizes tend to be larger. 

BMP (Bitmap): BMP is a basic and uncompressed image format used in Windows 

environments. It supports various color depths but results in large file sizes. BMP files are 

not commonly used for web or sharing purposes due to their file size. 

SVG (Scalable Vector Graphics): SVG is a vector-based image format that uses XML to 

describe graphics. It is resolution-independent and can be scaled without losing quality. 

SVG is commonly used for logos, icons, and illustrations on the web.   
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Self Check 3.1  

Answer the following questions: 

1. What are image properties? 

Answer: Image properties in the context of digital images refer to the 

characteristics and attributes that define an image's visual appearance, 

technical specifications, and behavior. 

2. What is Resolution? 

Answer: Resolution refers to the level of detail and clarity in an image, 

expressed as the number of pixels per unit of measurement. It is typically 

measured in pixels per inch (PPI) or dots per inch (DPI). Higher resolution 

images have more pixels, resulting in finer detail, while lower resolution 

images have fewer pixels and may appear pixelated or less sharp. 

3. What is File Format? 

Answer:  File format determines how image data is stored and encoded. Different file 

formats have distinct features, compression methods, and compatibility. Common image 

file formats include JPEG, PNG, GIF, and TIFF. Each format has specific strengths and 

limitations, such as support for transparency, animation, or lossless compression 

4. What is JPEG? 

JPEG (Joint Photographic Experts Group): JPEG is a widely used format for 

photographs and complex images. It uses lossy compression, meaning some 

image quality is sacrificed to reduce file size. JPEG files are suitable for web 

display and sharing due to their relatively small size  
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Answer Sheet 3.1 

1. What are image properties? 

Answer: Image properties in the context of digital images refer to the 

characteristics and attributes that define an image's visual appearance, 

technical specifications, and behavior. 

2. What is Resolution? 

Answer: Resolution refers to the level of detail and clarity in an image, 

expressed as the number of pixels per unit of measurement. It is typically 

measured in pixels per inch (PPI) or dots per inch (DPI). Higher resolution 

images have more pixels, resulting in finer detail, while lower resolution 

images have fewer pixels and may appear pixelated or less sharp. 

3. What is File Format? 

Answer:  File format determines how image data is stored and encoded. Different file 

formats have distinct features, compression methods, and compatibility. Common image 

file formats include JPEG, PNG, GIF, and TIFF. Each format has specific strengths and 

limitations, such as support for transparency, animation, or lossless compression 

4. What is JPEG? 

JPEG (Joint Photographic Experts Group): JPEG is a widely used format for 

photographs and complex images. It uses lossy compression, meaning some 

image quality is sacrificed to reduce file size. JPEG files are suitable for web 

display and sharing due to their relatively small size 
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Learning Outcome 4: Create basic designs  

 

Content:  

1. Design requirements. 

2. Appropriate shape and size. 

3. Content area. 

4. Content 

a. Text  

b. Image  

c. Vector 

d. Logo 

5. Modifying Shapes 

a. Squire 

b. Rectangle 

c. Ellipses 

d. Polygon 

6. Typographical design. 

7. Font attributes. 

8. Appropriate file format 

9. Saving Design  

Assessment Criteria:  

1. Required designs are specified. 

2. Appropriate shape and size are identified. 

3. Content area is defined. 

4. Contents are inserted and composed. 

5. Shapes are modified as per requirements. 

6. Typographical design is applied as per requirements. 

7. Font attributes are applied as per requirements. 

8. Design and color are applied as per requirements. 

9. Design is saved in appropriate file format. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 Methodologies  
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•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 4 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1. Specify design requirement. 

2. Identify appropriate shape and size  

3. defineContent area. 

4. insert and compose contents 

5. Modify shapesas per requirements. 

6. Apply typographical design. 

7. Apply font attributes. 

8. Apply Design and color. 

9. save design in appropriate file format. 

1. Required Design: 

Element of Design  

These basic components are essential in art and design and how you can visually construct 

pieces. Each element of design is a crucial part of a visual message, and the combination 

of these has an impact on how the design is perceived. You can use these design elements 

alone or in combination with each other, depending on what you're looking to achieve. 
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Lines are the most basic elements of design. They come in all shapes, sizes, and colors. 

Once you start noticing them, you’ll see grids all around you. Lines have direction; they 

can be visible or invisible and can help direct the eye to a specific spot. The thickness of a 

line can also communicate certain cues. Bold and thick lines can draw attention, while thin 

lines are the opposite.  

Most if not all layouts contain invisible lines. Grids are made of multiple lines and lend 

structure to a page. Lines can be used to create demarcation on a specific section of a design. 

Depending on the form of the line, you can convey different moods. A simple line can carry 

so much—for instance, a squiggly line is perceived as young and fun compared to a straight 

line. 

Lines don't necessarily have to be solid. Dashed and dotted lines can also be used and have 

a friendlier feel than a solid line. Straight lines usually come across as a steady and static 

element. On the other hand, curved lines are dynamic and give energy to your design. 

 

 

Shape 

A shape in the elements of design is 

the result of enclosed lines to form a 

boundary. Shapes are two-

dimensional and can be described as 

geometric, organic, and abstract.  

Geometric shapes have structure and 

are often mathematical and precise 

(squares, circles, triangles). You’ll 

notice that the Swiss graphic design 

movement from the 1950s used mostly 

geometric shapes in their designs. Shapes can add emphasis to a layout. 

Organic shapes lack well-defined edges and often feel natural and smooth. Shapes add 

emphasis to a layout. 

Abstract shapes are a minimalist representation of reality. For instance, a stick figure of a 

person is an abstract shape. Logos are mostly represented by abstract figures to show the 

type of business. The icon pack below is a great example of abstract shapes conveying real-

life objects and situations. 
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Depending on the color, form, and size of shapes, we can determine particular moods and 

send messages. For instance, triangles direct the eyes to a specific point and can also 

represent stability. 

We are surrounded by shapes that we may not think about much; we usually think of shapes 

as the main geometric structures. For designers, shape is one of the most important elements 

when it comes to branding development. These figures are at the root of logos and 

illustrations.  

Form (Positive Space) 

On a page, form is the positive element 

over the space, the negative element. A 

dot, line, or shape is a form when placed 

on a page. Unfortunately, form and 

shape are mostly used interchangeably. 

A form can be either two-dimensional 

or three-dimensional. Many also 

believe that form is a shape that 

acquires three-dimensional values, but 

the correct term is volume.  

Form and shape are mutually dependent 

because changing one would affect the 

other. The spatial relationship between form and space can create tension and add 3D 

qualities to your design. Form and space will lend the design lots of visual activity that can 

help keep viewers engaged. To create a 3D effect in your design, you can add shadows, 

stack multiple elements, or play with color.  
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Space (Negative Space) 

Space is the area that surrounds a shape; it 

creates a form within the space. Think of it as 

music: space is the silence between the notes of 

a song. If all the notes were played together, that 

would turn into noise. 

If you look at a design piece, the negative space 

is the area that is not occupied by any elements. 

In essence, it is the background color that you 

are able to see. For instance, abundant negative 

space in a layout results in an open, airy, and light background. The lack of negative space 

can result in a cluttered design. Visually speaking, a layout needs space to achieve a level 

of clarity within the design. Negative space is a very important element to consider as you 

are designing a piece. 

Color 

We can apply color to any of the elements we mentioned before this point. Colors create 

moods and can say something 

different depending on the 

connotations of your chosen color 

scheme. Color can create an emphasis 

on specific areas of your design 

layout. 

This element contains multiple 

characteristics:  

Hue is the name of a color in its purest 

form. For instance, cyan, magenta, 

and green are pure colors.  

Shade is the addition of black to a hue in order to make a darker version.  

Tint is the addition of white to a color to make a lighter version. 

Tone is the addition of grey to make a color muted.  

Saturation refers to the purity of a color. A specific color is most intense when it is not 

mixed with white or black. 

In design, there are two color systems, RGB and CMYK. RGB is a system dedicated to 

digital design. This additive system stands for red, green, and blue. The colors are produced 

by adding primary colors together to create various combinations. This mode should be 

used for designs that will only be used on a screen.  

If you want to output your design as a printed piece, you need to use the CMYK system. 

This subtractive system stands for cyan, magenta, yellow, and black (key). CMYK reduces 

the light that would be reflected on a white background to create color. It is extremely 

important to start a file using the right color system. Converting colors between the systems 

can result in muted and inaccurate colors. 
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Value 

Value refers to the degree of lightness 

and darkness of a specific hue. Yellow 

has a higher value than purple because 

it is closer to white. Value changes 

create contrast on a page. The reason 

you can read this text is that the black 

content contrasts with the white 

background.  

In design, use different tonal values to 

create emphasis in your design. Create 

the illusion of movement by 

overlapping multiple elements with different values. Value is also important in 

photography. You’ll notice that high-value images have a light and airy feel to them, while 

dark value images feel heavy and dramatic. 

Value also defines the spatial relationship between elements. If color values are close 

between the elements and space, then the design will look flat. If there is a strong contrast 

between the elements, then the form will be extremely noticeable. The example below 

features multiple colors with multiple values, which helps add a sense of depth to the 

design. 

Texture 

Texture adds a tactile appearance to 

a design layout. Imagine how a 

design piece would feel if you 

touched it. The goal of texture is to 

add depth to a 2D surface. Texture 

can be applied graphically through 

patterns, either digitally created or 

an image mimicking the desired 

pattern. Below is an example of an 

abstract geometric pattern made up 

of basic geometric elements.  
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2. Appropriate shape and size  

Shapes refer to predefined geometric objects that can be added to your images or designs. 

They are created using the Shape tools available in the Tools panel. The Shape tools allow 

you to draw basic shapes such as rectangles, ellipses, polygons, lines, and custom shapes. 

 

 

 

Geometric shapes 

Geometric shapes refer to predefined basic shapes that have distinct geometric characteristics, 

such as squares, rectangles, circles, ellipses, polygons, and lines. These shapes are created using 

the shape tools available in the tools panel. 

Organic shapes 

Organic shapes refer to irregular, freeform, or naturally occurring shapes that do not have 

distinct geometric characteristics like squares or circles. Organic shapes are often inspired by 

elements found in nature, such as plants, animals, or fluid forms. These shapes can add a sense 

of dynamism, flow, and a more natural feel to your designs. 

Adobe Illustrator is an industry-leading tool to create vector graphics. And it all starts with the 

most basic shapes. The skills to create those geometric shapes Illustrator offers are essential 

because many complex shapes are built by the basic shapes. In the tutorial below, we will 

explore shape tools and beyond to ease us in vector illustration. We will start with a single 

shape and build our way up.  

Adobe Illustrator offers options to make basic geometric shapes under the Shape Group or 

Shape Tool. The Rectangle Tool is located in the tools panel as default. You can click the 

rectangle icon to draw rectangles and squares. When you click and hold (long click) the 

rectangle icon, you will see a pop-up menu that shows you a list of built-in shapes and their 

associated keyboard shortcuts. Once you select, the icon will remain the last used tool within 

the Shape Tool group. 
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3. Content area  

The term "content area" refers to the workspace or canvas where you create and manipulate 

your artwork. It is the main area where you can draw, design, and arrange your graphical 

elements. The content area in Illustrator is a rectangular space that represents the size and 

dimensions of your document. 

When you open Adobe Illustrator, the content area is the white or transparent area in the 

center of the application window. It is within this space that you can create and edit vector 

graphics, illustrations, logos, icons, and other visual elements. You can use various tools, 

such as the Pen Tool, Shape Tools, and Brush Tools, to draw and modify objects within the 

content area. 

4. Content 

a. Text as a content 

Entering text this way is useful for adding a few words to your artwork. 

• Select the Type tool or the Vertical Type tool. 

• The pointer changes to an I-beam within a dotted box. The small horizontal line near 

the bottom of the I-beam marks the position of the baseline, on which the text rests. 

• (Optional) Set text-formatting options in the Control panel, Character panel, or 

Paragraph panel. 

• Click where you want the line of text to begin. 

• Enter the text. Press Enter or Return to begin a new line of text within the same type 

object. 

• When you finish entering text, click the Selection tool     to select the type object. 

Alternatively, Ctrl-click (Windows) or Command-click (Mac OS) the text. 
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Enter text in an area: 

 

Define the bounding area: 

• Select the Type tool        or the Vertical Type tool      and drag diagonally to define a rectangular 

bounding area. 

• Draw the object you want to use as the bounding area. (It doesn’t matter if the object has stroke or fill 

attributes, because Illustrator automatically removes them.) Then select the Type tool        , the Vertical 

Type tool            the Area Type tool         or the Vertical Area Type tool  and click anywhere on the 

object’s path. 

• (Optional) Set text-formatting options in the Control panel, Character panel, or Paragraph panel. 

• Enter the text. Press Enter or Return to begin a new paragraph. 

• When you finish entering text, click the Selection tool        to select the type object. Alternatively, 

Ctrl‑click (Windows) or Command-click (Mac OS) the text. 

If you enter more text than can fit within an area, a small box 

containing a plus symbol (+) appears near the bottom of the 

bounding area. 

You can resize the text area or extend the path to display the 

overflow text. You can also thread the text into another object. 

Import text into a path/shape 

Place text from a supported file right inside an object, such as a 

shape. You can place text from files in the .txt or .rtf formats, or 

files from word-processing applications. For example, you can 

place text from a .rtf file into a polygonal shape. 
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• Create a path/shape using any drawing tool, such as the Rectangle tool, Shaper tool, or the Pen tool. 

You'll place the text file within this shape. 

• Choose File > Place and select the text file you want to place. 

• Click Place. 

• After the text file is loaded in the place gun, click the path of the shape. 

• The text is placed inside the shape. You can now apply the desired styles and effects to it.  
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b. Image as a Content 

Insert Image in Illustrator 

Step 1: Open an Existing or new Adobe Illustrator File. If you have already created a file, 

you need to add an image to that; then, after opening the saved document, you can proceed 

ahead with a new image into the document. Else, if you want to try creating a new 

document and try seeing how adding an image works in Illustrator, then accordingly, you 

can go for the Illustrator icon on the desktop or open Illustrator directly from the search 

menu and launch the program. 

 

Step 2: If you already have a saved file, you can access it from the File menu. Using the 

file menu, select Open and pick the file saved on your hard drive. The shortcut for the 

same is Ctrl+O. If the file is recently opened, you can access it from opening a recent file 

option as well. 
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Step 3: Once the document is open, from the file menu, go to the Place option. This shortcut 

for the place is Shift + Ctrl + P. 

 

Step 4: This opens up a dialog box from where you can choose the image you wish to add to 

your document. Choose the correct one, and you will have the option to place it anywhere on 

the document with the help of your mouse cursor. Drag the mouse cursor as per your 

preference, and the image will be proportionally placed on the path of the mouse cursor. 
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Step 5: Once the image is placed, you can further resize or re-position the image. For that, use 

the anchor points on the bounding box of the image. Drag on it as you want to resize the image. 

It is always better to hold the shift key while dragging to get an even result while resizing the 

image. 

 

In order to move the image, you can either drag the photo using the mouse cursor or use the 

keyboard navigation keys. While using the keyboard arrow keys, if you combine the shift key, 

it will move a longer distance than using the normal arrow key. 

Step 6: If you want to crop the image, simply click on the image and go to the crop image 

option on top of the document. After that, using the mouse, crop the image as you need. Once 

the cropping is exactly as per your need, press Enter to confirm. 
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Step 7: For transforming the image for applying various options like move, rotate, reflect, scale, 

shear, etc., use the transformation tool. For opening the transformation tool, right-click on the 

image and select transform. Next, hoover to the corresponding options panel as shown in the 

below image. The panel contains all the above options, from rotating to scale. 
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5. Modifying Shapes 

Use of Rectangle Tool 

 

1. Select the Rectangle Tool. Or press L on your keyboard 

2. Click and drag on the artboard to define the shape 

3. Release the mouse button to finalize the rectangle 

Make a perfect square 

If you think about it, a perfect square is just a unique rectangle, where all sides are at the 

same length. 

With the Rectangle Tool Selected 

You can create a perfect square by holding the Shift key while dragging 

 

apply a fill color and a stroke color 

Shapes in Adobe Illustrator have at least two properties: stroke and fill. 

 



 

73 

 

Use the Selection Tool (click on the icon below or press V on your keyboard) to select 

any shape(s) in view 

double-click the color fill (the solid square) or the stroke (the outline) at the bottom of 

the Tools panel to select a color with the color picker 

 

 

 
Create rectangles with specific dimensions 

Select a shape from the shape group, in this case, rectangle. 

Click once (anywhere) on the artboard (as opposed to click and drag as shown before) 

Type the desired dimension for the shape as well as the unit 
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You can save some brainpower by letting Adobe Illustrator do the math as well. 

 

 
Make an ellipse/oval/circle 

Creating ellipse/ovals or circles is very similar to creating rectangles. The Ellipse Tool is 

tugged under the rounded rectangle tool. 

 
Select Ellipse Tool or Press L 

Click and drag on the artboard to the desired dimension 

 

 
You may create a perfect circle by holding the Shift key while dragging 
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Use polygon shapes and triangle shapes 

The Polygon Tool is the hexagon icon in the Shape Group. In short, most of the 

functions are identical to shapes we have covered before: 

Click and drag to draw 

Drawing from the center by holding the Alt key (Windows) or the Option key (Mac OS) 

Change Fill and Stroke color 

But a few things are unique to the Polygon Tool 

Straighten up the shape orientation by holding the Shift key while dragging 

 
Move the pointer in rotating motion to rotate the shape while creating the polygon. 
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If the polygon shape is already created, you can always cover over a corner and rotate after 

your pointer turns into a double-arrowed curve below. 

 
Change the number of sides in two methods 

Method 1: Press the up or down arrow key while dragging 

 
Use Line Segment Tool 

It will be amiss if we don't cover the essential line drawing tool: Line Segment Tool. This 

tool is located next to the Text Tool. You can find its icon in the tools panel (/) 
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The use of the tool is pretty straightforward—the simple click and drag. 

 

Like many shape tools in Adobe Illustrator, you can hold the Shift key while dragging to 

constrain the angle to multiples of 45 degrees. It's hands-down the quickest way to draw a 

straight line, esp. horizontal and vertical lines. 

 
Duplicate shapes 

There are quite a few ways to duplicate shapes inside the program. I will walk you through 2 

of the most common ones. 

 

Method 1: The good ole Copy and Paste 

Press command on a Mac (or Ctrl on a PC) + C to copy 

Press command on a Mac (or Ctrl on a PC) + P to paste 

You can also find the commands in Edit>Copy and Edit>Paste, but hotkeys are always a 

much-recommended alternative. 

 

You don't control where things go, but this method is intuitive and quick. 

 

Method 2: Hold the Alt key (Windows) or the Option key (Mac OS) and drag 

 
Edit shapes 

Shapes you create in Adobe Illustrators are live, which means you can easily edit them on the 

fly. Here are a few ways of changing the properties: 

 

Select the shape using the Selection Tool (V), then the pointer turns into a double-arrow and 

drags to adjust the size 
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Similarly, hover over the corner, then the pointer turns into a double-arrowed curve and 

moves around to rotate 

 
Tip: Hold the Shift key to maintain the original ratio 

 

How to draw rounded corners 

You may have noticed the tiny circles inside the corners of a shape. They are your besties 

when it comes to creating rounded corners. 

 

Select the corner point using the Direct Selection Tool (A) 

Drag until you are happy with the size 

 

 

 

6. Typographical design. 

Text Tool 

Access the Text Tool from the tool panel. The icon for the Text tool is an uppercase ‘T.’ 

 
Creating Floating Text 

Select the Text Tool. 

Single click where you’d like to add unbounded text. 
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Type what you want your text to say. 

NOTE: You can also copy text from somewhere else and paste it at this point instead of 

typing it in. 

 
 

When you’re finished entering your text content, hit esc on your keyboard. 

 

Changing Text Settings 

Settings for your text are found in the Properties panel. 
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Font and size are changed in the Character panel in the properties panel. 

Click the dropdown box where the current font is listed. 

NOTE: Illustrator’s Default font is Myriad Pro. It’s good practice to pick something other 

than the default font. 

Single-click on the font you want to use. 
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Click the dropdown next to the current font size. The default size is “12 pt.” 

 
Click on the size you want your font to be. 
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Change Text Color 

Select the text you want to change using the Selection Tool. 

 

 
The color settings are in the Appearance panel found in the Properties panel. 

Click on the color swatch for Fill. 

 
The Swatches panel will open. 

 
Click the color you want to use. 
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Typography 

Typography refers to the art and technique of arranging typefaces, fonts, and other visual 

elements in a visually appealing and effective manner. It is a key component of graphic 

design and communication, focusing on the creation and arrangement of type to convey 

meaning, evoke emotions, and enhance readability.  

Step 1: Create your text 

a.) Type your text using the Type tool and apply a font of your choice on the text. 

 

b.) Select the text and assign no fill color. Add the outline color on the text.  

 

c.) Use Pen tool to draw an object to be used as a spine for the typography. Spine is an outline 

shape that defines the central area of the text body. 
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Step 2: Create a blend object 

In this step, we'll learn how you can combine the shapes and colors between two or more 

objects to create a blend object. 

a.) Create rectangles using the Rectangle tool, fill them with different colors and then group 

them. 

 

b.) Create a circle in the middle of the rectangles using the Ellipse tool. 

 

c.) Select the circle and the rectangle group. Use Clipping Mask to clip the rectangle group inside the circle 

using Object > Clipping Mask > Make. 
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d.) Use the Pathfinder (Windows > Pathfinder) to trim the clipped shape. 
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Step 3: Replace spine on text with the blend 

Use this blend to replace spine that was created for the text in step #1 (Object > Blend > 

Replace Spine). For more details, see Change the spine of a blended object. 

Ensure you create a copy of the blended shape when you assign it to a particular spine. 

 

 

 



 

87 

 

 

Repeat this step and complete your typography. Group all letters in the word and then save 

the design. To open this design in other CC apps for further use, export it to Creative Cloud.  

 The final artwork 

 

Now, you can use this text on your poster, brochure, flyer, or any other artwork. 

 

7. Font attributes  

Font attributes refer to the various characteristics and settings that can be applied to text to 

alter its appearance. These attributes allow you to customize the font style, size, weight, 

color, spacing, and more. Here are some commonly used font attributes in Photoshop: 

 

Font Family: The font family refers to the specific typeface that determines the overall 

design and style of the characters. Photoshop offers a wide range of font families to choose 

from, such as Arial, Times New Roman, Helvetica, and many others. You can select the 

desired font family from the font dropdown menu in the options bar or the Character panel. 

 

Font Size: The font size controls the height of the characters. You can adjust the font size 

using the font size dropdown menu in the options bar or by typing a specific size value. 

Alternatively, you can use the Character panel to set the font size precisely. 

 

Font Style: Font styles include variations such as regular, italic, bold, and bold italic. These 

variations change the appearance and weight of the characters. You can select the desired 
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font style from the font style dropdown menu in the options bar or use the Character panel 

to apply the desired style. 

 

Font Weight: Font weight refers to the thickness or heaviness of the characters. It 

determines how bold or light the text appears. Some fonts offer different weight options, 

such as light, regular, medium, bold, and extra bold. You can access font weight settings 

through the font weight dropdown menu in the options bar or the Character panel. 

 

Text Color: The text color attribute allows you to change the color of the characters. You 

can select a color using the color picker in the options bar or the Character panel. 

Additionally, you can apply gradients, patterns, or special effects to the text using layer 

styles or blending modes. 

 

Kerning and Tracking: Kerning refers to the adjustment of the space between individual 

characters, while tracking controls the overall spacing between all characters in a block of 

text. You can adjust kerning and tracking using the Kerning and Tracking options in the 

Character panel or the options bar. 

 

Text Alignment: Text alignment determines the horizontal positioning of the text within a 

text box or paragraph. Photoshop offers options for left alignment, center alignment, right 

alignment, and justified alignment. You can adjust the text alignment using the alignment 

options in the options bar or the Paragraph panel. 
 

8. Appropriate file format 

Illustrator is a versatile graphic design software commonly used for creating and editing 

vector-based artwork. When working with Illustrator, it is essential to choose the 

appropriate file format to ensure compatibility, maintain the quality of your designs, and 

meet the requirements of your intended use. Here are some common file formats used in 

Illustrator: 

AI (Adobe Illustrator): The native file format of Adobe Illustrator. It supports all Illustrator 

features, including layers, text, and vector graphics. AI files can be edited, saved, and 

reopened in Illustrator without losing any data. However, AI files may not be compatible 

with other software applications. 

EPS (Encapsulated PostScript): EPS is a widely supported vector file format that can be 

opened by various design and illustration software. EPS files can contain both vector and 

raster elements, making them suitable for printing and high-resolution output. They can 

also preserve transparency and are often used for logos, illustrations, and print-ready 

artwork. 

PDF (Portable Document Format): PDF is a popular file format that can contain both vector 

and raster elements. It is widely compatible across different platforms and applications, 

making it suitable for sharing and printing artwork. PDF files can retain their quality and 

maintain vector properties, such as text and scalable graphics. Additionally, they can embed 

fonts and support interactive features. 

SVG (Scalable Vector Graphics): SVG is a web-friendly vector format that is widely 

supported by browsers and web applications. It is primarily used for displaying vector-

based graphics on the web and can be scaled without loss of quality. SVG files can be 

created in Illustrator and easily integrated into websites, animations, and user interfaces. 

PSD (Adobe Photoshop): While primarily associated with Adobe Photoshop, PSD files can 

also be imported and edited in Adobe Illustrator. This format is commonly used for designs 

that incorporate both raster and vector elements. Importing a PSD file into Illustrator allows 
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for further editing of vector elements and maintaining compatibility with Photoshop.  

9. Saving design 

Save a Logo as Vector File in Adobe Illustrator 

The best way to save a high-quality logo is by saving it as a vector file because as long as 

you didn’t rasterize it, you can scale the logo freely without losing its quality.  

When you design and save the logo in Adobe Illustrator, it’s already a vector file, because 

the default format is .ai, and .ai is a vector format file. You can also choose other vector 

formats such as eps, svg, and pdf. Yes, you can edit a pdf file in Adobe Illustrator too.  

There’s an important step before you save a logo as a vector file – outline the text. You 

MUST outline your logo text to finalize the logo before you send it to someone else. 

Otherwise, someone who doesn’t have the logo font installed will not see the same logo 

text as you.  

Once you outline the text, go ahead and follow the steps below to save or export it as a 

vector file. 

Step 1: go to the overhead menu File > Save As. I’ll ask you whether you want to save the 

file on your computer or Adobe Cloud. You can only choose the format when you save it 

to your computer, so choose On your computer, and click Save. 

 
After you click Save, you can choose where to save your file on your computer and change 

the format of the file.  

Step 2: Click the Format options and choose a format. All the options here are vector 

formats, so you can choose any one that you need and click Save.   

Depending on which format you choose, the next setting windows will show different 

options. For example, I’m going to save it as Illustrator EPS (eps) so the EPS options will 

appear. You can change the version, preview format, etc.  

https://illustratorhow.com/wp-content/uploads/save-logo-file2.png
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The default version is Illustrator 2020, but it’s a good idea to save the file as a lower version 

just in case someone with an Illustrator version lower than 2020 cannot open the 

file. Illustrator CC EPS works for all CC users.  
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Click OK once you’re done with the settings and you’ve saved your logo as a vector.   
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Self Check 4.1  

Answer the following questions: 

1 Write down the name of some shape tools 

 

 

 

 

2 What is content area? 

 

 

3 What are the uses of shape tool? 

 

 

4 What is typography? 

 

 

5 What is EPS? 
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Answer Sheet 4.1 

1. Write down the name of some shape tools 

Answer:  

i Rectangle Tool 

ii Rounded Rectangle Tool 

iii Ellipse Tool 

iv Polygon Tool 

v Star Tool 

2. What is content area? 

Answer: The term "content area" refers to the workspace or canvas where you 

create and manipulate your artwork. It is the main area where you can draw, 

design, and arrange your graphical elements. The content area in Illustrator is 

a rectangular space that represents the size and dimensions of your document. 

3. What are the uses of shape tool? 

Answer:  Shape tools in Adobe Illustrator offer a range of uses and functionalities for 

creating and manipulating geometric shapes and objects in your designs. Some specific 

uses of shape tools in Illustrator include: 

• Creating Basic Shapes 

• Designing Logos and Icons 

• Creating Custom Shapes 

4. What is typography? 

Typography refers to the art and technique of arranging typefaces, fonts, and other visual 

elements in a visually appealing and effective manner. 

 

 

5. What is EPS? 

EPS (Encapsulated PostScript): EPS is a widely supported vector file format that can be 

opened by various design and illustration software. EPS files can contain both vector and 

raster elements, making them suitable for printing and high-resolution output. 
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Activity Sheet 4-1:  

 

Activity: Create the shapes below on your own 

Working Procedure: 

1. Maintain OSH and PPE. 

2. Read specification sheet collect tools and equipment. 

3. Interpret the image to determine which software require for this job 

4. Create a folder on your own name. 

5. Create the shapes as per sample. 

6. Save the file as your own name. 
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Specification Sheet 4-1 

Condition for the job: 

1. Use the shape tool. 

2. Select Color mode CMYK. 

3. Save the image in .ai and .eps file. 

4. Turn off Computer  

 

To complete the above task you will need to following equipment per Trainee.  

List of Tools and equipment 

S/N Name of Item Specificarion Unit Quantity 

01 Personal Computer Latest 

configuration 

Nos 1 

02 Keyboard and Mouse Standard Nos 1 

03 Monitor Standard Nos 1 

04 Adobe Illustrator Latest version Nos 1 

 

 

Raw Materials 

• N/A 

Required PPE 

• Ergonomic chair 

• Eye protective glass 

• Rubber shoe 
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Learning Outcome 5: Identify career opportunities in the graphic 

design sector 

 

Content:  

1. Graphic design and Desktop Publishing (DTP) houses 

2. Positions/jobs in the graphic design sector 

3. Hands on graphics arts designer  

Assessment Criteria:  

1. Local and international graphic design and Desktop Publishing (DTP) houses are 

identified. 

2. Positions/jobs in the graphic design sector are identified. 

3. Hands on graphics arts designer are identified. 

4. Graphic design and DTP houses are visited on site and through the internet. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 5 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1. Identify Graphic design and Desktop Publishing (DTP) houses 

2. Identify Positions/jobs in the graphic design sector 

3. Identify Hands on graphics arts designer  

 

1. Graphic design and Desktop Publishing (DTP) houses 

Graphic design and Desktop Publishing (DTP) houses refer to companies or agencies that 

specialize in providing graphic design and desktop publishing services to clients. These 

houses can be either local, serving clients within a specific geographic area or country, or 

international, catering to clients from around the world. Here's a breakdown of these terms: 

Local Graphic Design and Desktop Publishing (DTP) Houses: 

Local graphic design and DTP houses are companies or agencies that primarily operate 

within a specific geographic area or country. They provide graphic design and DTP services 

to clients located in their immediate vicinity or within the same region. These houses 

typically have a physical presence, such as a studio or office, where designers and DTP 

professionals work on various design projects. They have a deep understanding of the local 

culture, language, and design preferences, allowing them to create designs that are tailored 

to the specific needs and preferences of their local clientele. Local houses often have a 

strong network within the local business community and may have established 

relationships with local printers, publishers, or other related service providers. 

International Graphic Design and Desktop Publishing (DTP) Houses: 

International graphic design and DTP houses are companies or agencies that have a global 

reach and cater to clients from different parts of the world. These houses may have offices 

or remote teams in multiple countries, enabling them to serve a diverse clientele. They 

possess a broader perspective and experience working with clients from different cultures, 

industries, and markets. International houses often have a wider range of design styles and 

capabilities due to their exposure to a global clientele. They may have specialized teams or 

designers who are knowledgeable about international design trends, cultural nuances, and 

localization requirements. International houses can offer services to clients located 

anywhere and are well-equipped to handle projects with an international scope or target 

audience.  

The graphic design sector offers a wide range of positions and job roles that cater to 

different aspects of the design process. Here are some common positions you can find in 

the graphic design sector: 
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2. Career opportunities of Graphics Designer  

There are many career opportunities for skilled and talented design professionals. For this 

study, we look some of broad professional categories: 

1. Photo editor - Photo editors work with real-life images to color-correction, adjust or 

combine images to create the desired final image. It can be limited into color balance and 

adjusting the lighting on a photograph or as sharp as changing garment colors or adding 

banners or logo information to the image. 

Careers focusing on editing photography have less of an emphasis on graphic design, but 

they require a complete knowledge of Photoshop, which is typically covered in a graphic 

design program. It is often beneficial for companies to employ a designer who can alter 

images when the product image does not accurately represent the final product, as images 

may need to be taken before a design is finalized. 

2. Logo/ Corporate designer: Now a day it become a very important sub sector under 

Graphics Design. Logo designers develop visually compelling graphics or symbols to 

represent a company, product, brand or service. They research the target demographic to 

gain a strong understanding of what symbols they find appealing and memorable. Designer 

must choose distinct colors and shapes that relate to and establish the brand identity of the 

company or product. Logo designers must also be aware of not copying or recreating a 

trademarked logo. A corporate designer has to design verity item for corporate presentation 

and brand promotion for company or product or service like flyer, brochure, leaflet, ID 

card, product catalogue, banner, festoon etc. 

3. Packaging designer: Packaging designers develop the labels, box, carton, container and 

other packaging materials of a product to protect the product during shipping and 

communicate important features to the customer. They use Illustrator/ CAD software to 

write product details in an appropriate style and font, add graphics to explain the functions 

and show what the product looks like or how to use it. They often design the package as a 

marketing tool as well to convey the important product feature to the customer.  

4. Web designer: By creating individual web pages, developing graphical content and 

designing page layouts, designing the navigation menus, drop-down options and the 

website's structure a web designers assist to develop websites. They may have coding and 

programming skills, which would allow them to completely develop the website on their 

own. Web designers’ associate with the website's brand or marketing team to determine 

what content is included on each page and where to place graphics, as well as to ensure 

continuity as consumers browse the website. 

5. Multimedia designer: Multimedia designers create animated images and videos using 

art and computerized animation programs. They are responsible for plan out the animation 

by sketching, creating scale models and developing the graphics for the story's characters, 

background scenes and props. Multimedia designers can work in a variety of fields 

including television, set design or film production and video game development. In film 
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work or set design, they may also be responsible for directing set assistants and lighting 

crew in the execution of their design intent. 

6. Advertising designer: Advertising designers use graphic design, sketching and 

photography to create visually compelling marketing materials for a brand or company. 

They create billboards, magazine advertisements, website advertisements, digital 

marketing materials and any other requested promotional materials. They sketch or use 

design software to develop an initial concept based on marketing and public relations 

strategies. They may create a few variations of a concept to present to the advertising 

leadership or art director, and they listen to the leadership's feedback to perfect the final 

design. 

7. Publication designer: Publication designers develop the layout, visual appearance and 

graphics for a range of printed publications. Companies that create annual reports, research 

papers, books, catalogs and user manuals use internal or freelance publication designers to 

add images and graphics to the written information. These images help make the data easier 

to read and can elaborate on written topics by showing a graph or step-by-step instructions 

to complete a task in a manual. The designer is responsible for developing the images and 

graphs and incorporating them into the publication in a visually appealing manner. 

8. User interface (UI) designer: The user interface designer is responsible for ensuring 

every webpage or operational step of the final product follows the user experience (UX) 

designer's intent. They typically have basic coding skills and can develop the designer's 

vision by working with software programming experts. UI designers make webpages, 

advertisements and electronic programming easy for the consumer to interact with. They 

must ensure that the UX design is feasible and well-executed. 

9. User experience (UX) designer: To make products, services and websites enjoyable 

and smooth accessible for users are main responsibility of UX designers. They consider the 

intended end-use of the product and how the product feels to the consumer to ensure it is a 

user-friendly product or service. UX designers most commonly work in web design or apps 

development to make them visually pleasing and easy for customers to navigate. They also 

work with other technology-based products, including software, gaming systems, 

computers and automobiles to develop visual aesthetics and graphics. They test the product 

under normal usage and resolve any inconsistencies in the appearance or flow. UX 

designers ensure the product has a logical flow from one step to the next.  

10. Art director: The art director is a higher level executive responsible for guiding the 

design team's vision, directing the theme concept and overseeing all design artwork. They 

can work in a variety of industries including fashion, print publications, advertising, 

television, video games, software development and consumer products developments. The 

director may be employed by the brand or as a freelancer, but they always work closely 

with the client or marketing and sales team to understand their artistic vision. 

The art director is responsible for reviewing and approving designs completed by the art 

and graphics teams. As an executive, the art director also works closely with the marketing, 
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financial, creative and customer service directors to coordinate projects and maintain a 

consistent brand image. 

Hierarchy of a Graphic Designer 

Graphic designing is such a huge expanding field in the market today. This field offers 

enormously broad array of service opportunities crafted amorously by the media and 

technology sector. These professionals fulfill numerous diverse positions requiring visual 

designs, solutions and also materials. These professionals work for MNCs, organizations, 

magazine, newspaper along with small scale companies means in every sector of the 

market. 

These professionals are majorly responsible for the planning layout, designing and 

production of the graphic publications. They create website pages, multimedia and 

interactive displays. These career levels can be classified broadly in three levels. Graphic 

Design career hierarchy is described as below in this article in a mode of downhill order 

means the highest career level of the Graphic Design career hierarchy is placed at the 

pinnacle and the lowest one is placed at the end. 

Senior Level  

These are the uppermost level Graphic Design Job profiles that a graphic design 

professional can grow to during the course of his career. These professionals are more 

associated with the organization’s decision making successions and administrative 

functions. Following are the profiles that get hold of the highest levels in the graphic design 

career hierarchy: 

1. Chief Graphic Technology Officer 

2. Graphic Art Managers 

3. Creative Director 

4. Senior Art Director 

5. Art Production Manager 

6. Hands on Graphic Designer 

7. Brand Identity Developer 

8. Print Production manager 

Middle Level  

This career level incorporates professionals from the middle level of the hierarchy who 

have crucial experience of the field and work for the development of the company. These 

professionals are answerable for the outcomes of the lower level officials who work under 

the supervision of these officials. 

The job profiles are: 

1. Assistant Art Director 

2. Assistant Art Production Associate 
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3. Broadcast Designer 

4. Logo Designer 

5. Senior Illustrator Manager 

6. Associate Broadcast Designer 

7. Senior Multimedia Developer 

8. Head of Photography Department 

9. Visual Image Developer 

10. Head Content Developer 

Junior Level  

This is the lowest level in the graphic design career hierarchy. The officials at this level are 

those personnel who are experts of their respective field. This level incorporates numerous 

job profiles related to field of graphic designing but are equally important. Some of the 

lower level job profiles of this level of the graphic design career hierarchy are even fresher 

who have just finished their study and work to gain experience. These professionals handle 

the work provided to them by their respective seniors of the middle level. These career 

ranks are described as below: 

1. Illustrator Assistant Manager 

2. Visual Journalist 

3. Senior Layout Artist 

4. Interface Designer 

5. Layout Designer 

6. Head Web Designer / Developer 

7. Associate Web Designer 

8. Associate Content Developer 

9. Assistant Layout Artist 

10. Graphic Design Analyst 

11. Graphic Package Designer 

12. Photographer 

13. Junior Multimedia Developer 

14. Graphic Design Associate 

15. Graphic Design Trainee 

These are just a few examples of positions in the graphic design sector. Depending on the 

company and industry, there may be additional specialized roles, such as motion graphic 

designer, illustration artist, typographer, or multimedia designer.  

1. Graphic Designer: Creates visual designs for various projects such as logos, 

advertisements, brochures, websites, and more. 

2. Art Director: Oversees the artistic and visual direction of projects, working closely 

with clients and creative teams to ensure the overall visual concept is executed 

effectively. 
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3. UI/UX Designer: Designs user interfaces and user experiences for digital platforms, 

ensuring they are visually appealing, user-friendly, and functional. 

4. Web Designer: Creates visually engaging and functional website designs, utilizing 

skills in web design principles, HTML, CSS, and sometimes JavaScript. 

5. Branding Specialist: Develops and maintains consistent brand identities for 

companies or products, including logos, brand guidelines, and marketing collateral. 

6. Packaging Designer: Designs attractive and functional packaging solutions for various 

products, considering factors such as product positioning and manufacturing 

requirements. 

7. Motion Graphic Designer: Specializes in creating animated visual content, combining 

graphic design elements with motion to convey messages and engage viewers. 

8. Illustrator: Creates hand-drawn or digital illustrations for various purposes, such as 

book illustrations, editorial illustrations, character design, and infographics. 

9. Print Production Specialist: Prepares design files for printing, ensuring they meet 

technical requirements and handling tasks such as color calibration and file setup. 

10. Creative Director: Oversees the overall creative direction of projects or organizations, 

providing guidance and making strategic decisions to align the creative vision with 

business goals. 

11. Visual Designer: Focuses on creating visually appealing designs for both digital and 

print media, including websites, social media graphics, and marketing materials. 

12. UX Researcher: Conducts user research to understand user behavior and preferences, 

applying findings to improve the user experience and inform design decisions. 

13. Prepress Technician: Prepares digital files for printing, ensuring they are correctly 

formatted, color-corrected, and properly prepared for the printing process. 

14. Production Artist: Works on the technical aspects of design, preparing files for print 

or digital production, and ensuring consistency and accuracy in design implementation. 

15. Information Designer: Specializes in presenting complex information and data in a 

visually clear and engaging manner, using infographics, data visualizations, and 

interactive media. 

16. Social Media Designer: Creates graphics and visuals specifically tailored for social 

media platforms, including posts, banners, and advertisements. 

17. User Interface Designer: Focuses on designing intuitive and visually appealing user 

interfaces for software applications, considering usability and user interaction. 

18. Typeface Designer: Designs fonts and typefaces, creating unique and visually 

appealing letterforms for various applications. 

19. Environmental Graphic Designer: Creates designs for physical spaces, such as 

signage, wayfinding systems, and environmental branding, to enhance the user 

experience in the built environment. 

20. Creative Illustrator: Specializes in creating imaginative and visually striking 

illustrations for books, magazines, advertising campaigns, and other creative projects.  
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3. Hands on graphics arts designer 

Calligrapher: A calligrapher specializes in the art of beautiful and decorative handwriting. 

They use various tools such as pens, brushes, and ink to create intricate and stylized 

letterforms. Calligraphers may design custom lettering for invitations, certificates, signage, 

and other projects that require an elegant and personalized touch. 

Bookbinder: A bookbinder is skilled in the craft of creating and binding books by hand. 

They work with materials such as paper, leather, fabric, and thread to assemble pages, cover 

materials, and decorative elements into finished books. Bookbinders ensure that the design 

and structure of the book align with its content and purpose. 

Paper Sculptor: A paper sculptor creates three-dimensional artwork using paper as the 

primary medium. They manipulate and shape paper through techniques such as cutting, 

folding, and layering to create intricate and detailed sculptures. Paper sculptors may create 

artwork for displays, installations, or product packaging, showcasing their ability to 

transform a flat material into dynamic and visually striking forms. 

Silk Screen Printer: A silk screen printer employs the technique of screen printing to 

create designs on various surfaces such as fabric, paper, or even wood. They use a stencil 

and a mesh screen to transfer ink onto the desired medium, layering colors and textures to 

achieve unique visual effects. Silk screen printers may produce limited edition prints, 

apparel designs, posters, or other printed materials with a distinct handmade quality. 

Collage Artist: A collage artist creates artworks by combining and layering different 

materials such as photographs, papers, fabrics, and found objects. They assemble these 

materials to form a cohesive composition, often exploring themes of juxtaposition, texture, 

and storytelling. Collage artists employ their hands-on skills to cut, tear, arrange, and 

adhere various elements to create visually captivating and thought-provoking artworks. 

These hands-on graphic arts designers demonstrate the fusion of traditional artistic 

techniques and graphic design principles, showcasing the artistry, craftsmanship, and 

tactile nature of their work. They contribute to the diverse and rich landscape of graphic 

design by exploring alternative mediums and bringing a unique aesthetic to their designs.   
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Self Check 5.1  

 

Answer the following questions: 

1. What is grahphics design? 

Answer: 

 

2. Local Employment Market of graphics design? 

Answer:  A. Supper Shop  B. Software firm 

  C. School & College D. Shopping mall  

 

3. Photoshop is a editor software. 

Answer: 

 

4. Illustrator is a vector graphics creator. Y / N 

Answer: 

 

5. Personal Qualification of graphics designer- 

Answer: A. Analytical Skill  B. Honesty 

  C. Sinsiarity   C. Photography 
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Answer Sheet 5.1 

1. Graphic design is the process of visual communication through the use 

of typography, photography, iconography and illustration.  

 

2. B. Software firm  

 

 

3. Photoshop is a raster graphics editor software. 

 

 

4. Illustrator is a vector graphics creator. Y.  

 

 

5. Personal Qualification of graphics designer- 

Answer: A. Analytical Skill 

 

 

  

https://en.wikipedia.org/wiki/Typography
https://en.wikipedia.org/wiki/Photography
https://en.wikipedia.org/wiki/Iconography
https://en.wikipedia.org/wiki/Illustration
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Learning Outcome 6: Interpret Online Market places  

 

Content:  

1 Source of carrier opportunities. 

2 Account opening procedure 

3 Standard profile structure 

4 Bidding procedure for the jobs 

5 Design submission procedure 

6 Payment collection methods  

Assessment Criteria:  

1 Source of carrier opportunities are identified. 

2 Account opening procedure is interpreted. 

3 Standard profile structure is outlined. 

4 Bidding procedure for the jobs are interpreted. 

5 Design submission procedure is interpreted. 

6 Payment collection methods are identified. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

•  Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 6 

Learning Objectives 

After completion of this information sheet, the learners will be able to 

1. Identify Source of carrier opportunities. 

2. Interpret Account opening procedure 

3. Outline Standard profile structure 

4. Interpret Bidding procedure for the jobs 

5. Interpret Design submission procedure 

6. Identify Payment collection methods 

 

1. Source of carrier opportunities 

There are several online marketplaces where graphic designers can find carrier 

opportunities. These platforms connect designers with clients who are looking for design 

services. Some popular online marketplaces for graphic design include: 

Upwork (www.upwork.com): Upwork is one of the largest freelancing platforms, offering 

a wide range of creative and professional services. Graphic designers can create a profile, 

showcase their portfolio, and bid on design projects posted by clients. 

Fiverr (www.fiverr.com): Fiverr is a popular platform where freelancers can offer their 

services at various price points starting from $5. Graphic designers can create "Gigs" 

specifying their design services, packages, and pricing, making it easy for clients to find 

and hire them. 

99designs (www.99designs.com): 99designs specializes in connecting designers with 

clients for various design projects, including logos, branding, web design, and more. 

Designers can participate in design contests or create their portfolio to attract clients. 

Freelancer (www.freelancer.com): Freelancer is a global freelancing platform that offers 

a wide range of job categories, including graphic design. Designers can create a profile, bid 

on design projects, and showcase their work to attract clients. 

Dribbble (www.dribbble.com): Dribbble is a community-driven platform where 

designers can showcase their work and connect with potential clients. It allows designers 

to create a portfolio, browse job listings, and apply for design opportunities. 

Toptal (www.toptal.com): Toptal is a selective freelancing platform that connects top-tier 

designers with clients. It has a rigorous screening process to ensure high-quality talent. 

Designers can apply to join the platform and access exclusive design projects. 

Creative Market (www.creativemarket.com): Creative Market is a platform for buying 

and selling design assets, including graphics, templates, fonts, and more. Designers can 

create their own shops to sell their digital products or contribute as authors.  
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Behance: Behance is a platform for creative professionals to showcase their portfolios, 

gain exposure, and potentially connect with clients and employers seeking talented graphic 

designers. 

DesignCrowd: DesignCrowd allows designers to participate in design contests, providing 

an avenue for showcasing their skills and winning projects for various graphic design 

needs. 

Guru: Guru is a freelancing platform where graphic designers can showcase their 

portfolios, bid on projects, and collaborate with clients to complete graphic design tasks. 

Envato Studio: Envato Studio is a marketplace where designers can offer their graphic 

design services, such as logo design, website design, and more, attracting clients who visit 

the platform for their design needs. 

Creative Market: Creative Market is a platform where designers can sell their design 

assets, such as graphics, templates, fonts, and more, and potentially attract clients who are 

in search of unique and customizable design elements. 

Designhill: Designhill is a platform that connects designers with clients seeking various 

graphic design services, allowing designers to showcase their work and win projects. 

PeoplePerHour: PeoplePerHour is a freelancing platform that offers graphic designers 

opportunities to find projects, collaborate with clients, and build their freelance careers. 

Crowdspring: Crowdspring is a platform that hosts design contests for various graphic 

design needs, enabling designers to showcase their skills and win projects through 

competitive entries. 

SimplyHired: SimplyHired is a job search platform that aggregates graphic design job 

listings from various sources, providing designers with opportunities to find full-time or 

part-time employment in the graphic design field. 

Online Marketplace  

An online marketplace is a type of e-commerce website where product or service 

information is provided by multiple third parties. Online marketplaces are the primary type 

of multichannel ecommerce and can be a way to streamline the production process. 

Graphic design marketplaces are platforms which specialize in showcasing the work of 

talented graphic designers and connecting creatives with new clients. If you're on the 

lookout for a creative prodigy for your next project, chances are you'll find them on one of 

such marketplaces. 

Some of leading online marketplace for graphic design- 

1. GraphicRiver 

2. Sutterstock 
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3. Hatchwise 

4. DesignCrowd 

5. ArtWeb 

6. DesignHill 

7. UpWork 

8. Fiverr 

9. 99design 

10. Behance 

Freelance Graphic Design: 

Becoming a freelance graphic designer is no easy task—but it’s completely worth the 

effort. Being a freelance designer can be freeing. Working on projects you care about; 

determining your own schedule; being your own boss. 

The pros and cons of a freelance career. 

You’ll have more freedom and flexibility, but also more responsibility. With the ability to 

set your own schedule you’ll be free to listen to your muse, which doesn’t always speak up 

during normal work hours. But this freedom can also be a burden, as you are the only person 

who can take responsibility for your work and your business as a whole. 

You get to choose who you work for, but that also means managing who you work for. 

Instead of having clients built into your work, you’ll have the chance to select and screen 

them (depending on how desperate you are for work). Once you choose them, however, 

you also have to manage them. This means running point on all communications, keeping 

them happy, and eventually chasing down payment, which isn’t always a walk in the park. 

You’ll learn new skills, but it’s pretty much required that you do. Freelancing is a 

bootstrapping endeavor. While you have the opportunity to pick up new design skills, you’ll 

also have to invest time to develop less glamorous skills like bookkeeping and time 

management. 

Your lifestyle could improve, or it could be consumed. The flexibility of freelance means 

you have more time for the things you truly want to do. But if you don’t work towards an 

appropriate work-life balance, it can easily consume your life – sometimes more than a full-

time job. 

2. Account opening procedure 

The account opening procedure may vary slightly depending on the specific online 

marketplace or platform you choose. However, here is a general outline of the steps 

involved in opening an account for graphic design in an online marketplace: 

Choose a Platform: Select an online marketplace that aligns with your goals and 

preferences. Consider factors such as the platform's reputation, user base, fee structure, and 

available opportunities for graphic designers. 
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Sign Up: Visit the chosen online marketplace's website and look for the sign-up or create 

an account option. Click on it to begin the registration process. 

Provide Basic Information: Fill out the required fields with your basic information, such 

as your name, email address, and password. Some platforms may also ask for additional 

details like your location or contact information. 

Create a Profile: Once registered, you'll typically be prompted to create a profile. This is 

an important step as it allows you to showcase your skills, portfolio, and expertise to 

potential clients. Fill in all relevant sections of your profile, including a bio, professional 

background, and portfolio samples. 

Verify Your Account: In some cases, the platform may require you to verify your account. 

This could involve confirming your email address through a verification link sent to your 

email or following other identity verification procedures. 

Set Your Services and Rates: Determine the graphic design services you want to offer 

and set your rates or pricing structure. Be clear and transparent about what clients can 

expect when they hire you. 

Review Platform Guidelines and Policies: Familiarize yourself with the platform's terms 

of service, guidelines, and policies to ensure you understand the rules and expectations for 

using the marketplace. This includes any payment terms, communication protocols, dispute 

resolution procedures, or code of conduct. 

Customize Your Profile: Take the time to customize your profile to make it visually 

appealing and professional. Use high-quality images, showcase your best work, and write 

a compelling bio that highlights your skills and experience. 

Explore Opportunities: Once your profile is set up, you can start exploring the available 

opportunities on the platform. Browse through job listings, project postings, or contests to 

find suitable projects or clients. 

 

Submit Proposals or Bids: For platforms that require bidding or proposals, carefully read 

the project requirements and submit your proposals accordingly. Tailor your proposals to 

showcase how your skills and expertise align with the client's needs. 

Communication and Collaboration: Once you've secured a project or client, engage in 

clear and timely communication. Understand the client's requirements, ask clarifying 

questions if needed, and maintain professionalism throughout the collaboration.  
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3. Standard profile structure  

When creating a profile as a graphic designer in an online marketplace, it's important to 

make it compelling and professional to attract potential clients. While the specific structure 

may vary based on the platform and personal preferences, here's a standard profile structure 

that can help you showcase your skills effectively: 

Profile Picture: Upload a professional profile picture that represents you as a graphic 

designer. Choose an image that presents you in a friendly and approachable manner while 

maintaining a level of professionalism. 

Introduction/Bio: Write a concise and engaging introduction that highlights your 

experience, expertise, and what sets you apart as a graphic designer. This section should 

give clients an overview of who you are and what you can offer. 

Skills and Specializations: List your core graphic design skills and any specialized areas 

you excel in. This could include logo design, branding, illustration, web design, print 

design, etc. Be specific about your abilities to help clients understand your expertise. 

Experience and Education: Provide information about your relevant experience and 

education in the field of graphic design. Include any degrees, certifications, or courses you 

have completed, as well as details of past projects or clients you have worked with. 

Portfolio: Showcase your best work through a well-curated portfolio section. Include a 

variety of samples that demonstrate your range of skills and styles. Aim for a diverse 

selection that represents different types of projects and industries. 

Testimonials/Reviews: If you have received positive feedback or testimonials from 

previous clients, consider including them in this section. Testimonials can help build trust 

and credibility with potential clients. 

Services Offered: Clearly outline the specific graphic design services you offer. This could 

include logo design, brand identity, packaging design, social media graphics, etc. Specify 

what clients can expect when they hire you for each service. 

Pricing and Packages: Provide information about your pricing structure and any packages 

you offer. Be transparent about your rates, whether it's an hourly rate or a fixed price for 

specific services. If you offer different packages, outline what each package includes. 

Software and Tools: List the graphic design software, tools, and technologies you are 

proficient in. This could include Adobe Creative Suite (Photoshop, Illustrator, InDesign), 

Sketch, Figma, or any other relevant software. 

Contact Information: Make it easy for potential clients to get in touch with you. Include 

your professional email address, website (if applicable), and any other preferred methods 

of communication. 
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Call to Action: Conclude your profile with a clear call to action, inviting clients to contact 

you for their graphic design needs. Encourage them to reach out for more information, 

project inquiries, or collaborations. 

 

Starting your freelance graphic design career 

Signing Up for Behance 

When signing up for Behance, you’ll need an Adobe ID to create a profile. You can create 

an Adobe ID and sign up for Behance by: 

1. Navigating to Behance.net 

2. Click Sign Up With Email or select the Social Network login option (Apple, 

Facebook, Google) to create your Adobe ID 

3. You’ll be asked to fill out a few fields - including your name, email address, and 

other basic information. 

4. Select your Behance URL and location 

Because your Adobe ID credentials are managed within your Adobe account, you can make 

changes to these details from the Adobe site. These credentials are important and allow you 

to access the breadth of Adobe applications and platforms that you might use. 

Logging into Behance 

To login to your Behance profile, navigate 

to Behance.net and click Sign In in the 

top right corner of the page: 

• If you signed up with an Adobe ID 

and password, enter them and 

click Sign In  

• If you signed up using Facebook or 

Google, select that account and 

follow the prompts 

Unless you’ve changed your login 

method, you’ll log in the same way you 

signed up. For example, if you signed up 

with a Google account, you’ll log in using your Google account. 

Remember to use the same Adobe ID to keep all your Adobe memberships, subscriptions, and 

products associated with a single account. 

*Note: If you don’t yet have a Behance profile but do have an Adobe ID, simply login to 

Behance.net with your Adobe ID to create a profile. If you’ve already logged into your Adobe 

ID via another site, you can simply visit behance.net and click Activate.  

 

Common Sign-In Issues 

• Caps and Num lock: Make sure that caps lock and num lock are off, then enter your 

email and password. 

 

• Multiple emails or changed email? If you have multiple email accounts or have 

changed emails since signing up, try using your other or previous email address(es). If 

https://helpx.adobe.com/manage-account/using/create-update-adobe-id.html
https://help.behance.net/hc/en-us/articles/accounts.adobe.com
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you think you have Adobe IDs associated with different email addresses, or are unclear 

which email address is associated with your Behance profile, please contact us. 

 

Be ready to send us the Behance URL you're hoping to access. For security reasons, we 

can only reveal account information to users with access to the registered email address, 

so if you don't have the password or email access, the support team will need to verify 

your identity before helping you regain access to your account. 

 

• I tried to login but ended up in an empty or new profile: If you login to Behance 

with an Adobe ID that isn't the Adobe ID connected to your Behance account, you'll 

end up creating an additional account rather than logging into your existing Behance 

account. 

 

• Browser conflict? Confirm you are using the latest version of your browser. Try 

signing in using a different internet browser. If cookies are disabled, enable cookies, 

and clear your browser’s existing cookies and cache. (See your browser’s guidelines 

for instructions.) 

 

• Signing in with Facebook or Google? To resolve errors that occur when you sign in 

with your social (Facebook or Google) account, click here for more help. 

 

Verifying your Adobe ID 

An Adobe ID 

Your Adobe ID is your email address. Use the same Adobe ID to keep all your Adobe plans 

and products associated with a single account. An Adobe ID is essential for a secure and 

personalized experience with Adobe apps and services, and is required when you want to 

buy Adobe products. 

To have access to all features of Behance (including uploading projects, messaging users, 

and more), you'll need to verify your email address. If you signed up for Behance but didn't 

receive a verification email, visit your Adobe Account Settings and click resend 

verification email under the Adobe ID section. 

Still didn't receive your verification email? Click here for troubleshooting tips. 

  

Reset or Change Your Password 

Since you login to Behance with your Adobe ID, you'll reset a forgotten password 

or change an existing password by making changes to your Adobe ID password. For 

instructions on how to reset or change your password, click here. 

When logged into Behance, please visit your Account Settings to manage your email 

address and password setting. 

 

  

https://helpx.adobe.com/manage-account/kb/no-email-received.html
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Staying Logged In  

Behance does not support 

browsers that have third-party 

cookies disabled. Some 

advertisers use these types of 

cookies to track your visits to 

the various websites on which 

they advertise. Disabling third-

party cookies will block this 

kind of tracking. Unfortunately, 

this feature interferes with the 

way login works on Behance. 

Please re-enable third-party 

cookies in your browser settings 

in order to use Behance. 

 

 

Key points to required to sustain in marketplace. 

1 – Be Passionate About Graphic Design 

Graphic design is one of the fields that you will not survive unless you are passionate about 

the work. Freelance designers require much creativity. You must be attentive to details and 

think like the consumers of your graphics. You should see errors in posters and find 

solutions to poorly done work. You must also have the capacity to appreciate an excellent 

piece of design.  

In the freelancing industry, you need the desire to help you grow a reliable brand.  

2 – Learn the Software Necessary For Graphic Design 

Graphic design is highly reliant on software. The features you add to your projects will 

depend on the finesse of the tools at your disposal. Designing graphics and visuals is also 

a matter of mastery. One designer could possess the most sophisticated software yet fail to 

deliver on a project because he or she has not mastered it. The best graphic design 

software helps you to produce advanced images and posters as well as meet customer 

expectations.  

3 – Invest in The Tools Required By Graphic Designers 

Buy the essential graphic design tools that will enable you to meet the needs of your target 

customers. The tools include computers or laptops, software, printers, and the internet, 

among others. Some projects can be completed using phones and tablets because they are 

not as sophisticated. However, some projects require the best computer for design with 

a fantastic monitor that will give you the advantage of viewing details. A freelance 

graphics designer needs discipline to meet customer deadlines.  

Prepare a work station with the necessary equipment and amenities to work on the projects 

at hand.  

The best freelancer work station should meet the following conditions. 

• Spacious enough to accommodate all your apparatus and gadgets 

• Comfortable to allow you to work long hours 

• Well lit to avoid straining your eyes 

• Warm and aerated  

• Quiet so that you can concentrate on your project 
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It takes time to buy all the equipment you need to run a successful freelance graphics design 

profession.  

Improve your equipment and work station gradually until you can meet the standards of the 

most lucrative clients in the market.  

4 – Work Under A Mentor 

A freelance graphic designer comes with much learning on the job because you will not 

be working under any organisation or boss. It can lead to numerous mistakes that slow 

down your progress. The best step is to identify a mentor who will guide you through the 

steps. A mentor ensures that you do not make obvious or costly mistakes. Choose a mentor 

who has been in the industry for a while. He or she understands what it takes to succeed.  

The mentor will also introduce you to amateur gigs and show you the fastest path through 

freelancing. A mentor should have a proven track record so that the tips provided have been 

tested. A mentor will give you confidence that your work meets the standards required in 

the industry. 

5 – Expose Your Talent 

If people have never seen your work or do not know about your existence, they will never 

order services from you. Expose your work and skills by talking to friends, using social 

media, and marketing your business. freelancer does not have a strong brand behind their 

name or work. It is, therefore, upon you to work towards exposing the skills for potential 

clients to notice.  

Create a design portfolio and share it with potential customers. Have a strong social media 

presence, and promote the page for business. 

Participate in competitions and exhibitions so that people can see your work. The exposure 

will result in customers ordering your services. 

6 – Enroll on Websites That Provide Graphic Design Gigs 

Look for websites that provide 

gigs to a freelance graphic 

designer. The sites have such 

jobs as designing a logo, 

creating posters, brochures, and 

such other tasks that graphic 

designers are known to do. The 

websites will allow you to work 

on commission since clients will 

come to the platform looking for 

your skills.  

Create the best profile on the 

website or platform such that you attract high profile clients.  

Bid for jobs and deliver high quality so that the clients can give you favourable ratings.  

Use these platforms to establish yourself as a highly-skilled and experienced freelance 

graphic designer. Such a platform forms part of your sources of gigs. You will still look for 

clients on other platforms. 
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7 – Create an Online Portfolio 

Clients will not always look for you on freelancing websites. Some will do independent 

searches to capture graphic designers offering their services independently. Others are 

looking for designers in a particular area. An online portfolio for a graphic designer helps 

the clients to find you. Create a portfolio that captures your work, skills, and reviews from 

the clients you have already served. 

Promote the profile on social networks. Request the clients you serve to leave positive 

reviews on your profile to give confidence to others who land on your page. The profile 

will increase your visibility online so that you can capitalise on traffic looking for services 

similar to what you offer. 

8 – Request for Referrals 

Take advantage of the networks that your clients and friends have to get referrals. Referrals 

will only come when you deliver quality services to the existing clients. They are happy to 

recommend professionals if they get the best services. If you fail to deliver quality services, 

referrals will not be forthcoming.  

4. Building Your Graphic Design Career on Fiverr  

Being a freelance graphic designer is a dream job for many people with creative and artistic 

know-how. But how can you make the leap from dreaming do doing and join the ranks of 

successful graphic designers? Here’s some good news: You can launch and grow your 

graphic design career on Fiverr. 

A leading global marketplace that connects freelancers with buyers, Fiverr is always a hub 

of activity. Many companies—from start-ups to major global brands—rely on Fiverr as 

their go-to source to find freelance graphic design professionals. 

Sign up and learn why Fiverr is considered one of the best freelance graphic design sites in 

the world. 

Not sure how to begin? Just follow these seven success tips to make your mark in the 

thriving Fiverr graphic design community. 

Step 1: Optimize Your Fiverr Profile 

Every freelancer who signs up for Fiverr receives a personal seller profile. Your profile 

includes personal and professional information, along with links to social accounts. Your 

profile also lets you provide a profile description and a photo. 

Keep in mind that your profile description is one of the first glimpses potential buyers have 

of you. Your profile characters are limited, so you’ll need to be succinct, but sell yourself 

too. Why should buyers choose you for freelance graphic design services? Describe your 

core focus areas, too. Are you a freelance flyer designer, freelance magazine designer, or 

have other specialties? Tell buyers in your profile description. 
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And don’t neglect the value of a great picture! If you have a professional headshot, that’s 

great—but no worries if you don’t. A smartphone photo of yourself against a neutral 

background can work well. Smiling and exuding confidence in your photo is going to 

capture the attention of prospective buyers, so feel free. 

Step 2: Create Winning Fiverr Gigs 

Each service you sell on Fiverr is called a “Gig” Although originally Fiverr Gigs started at 

$5, nowadays you can command higher pricing. Your experience, the complexity of the 

service you provide, and add-on services can net you hundreds to thousands of dollars per 

Gig. 

Here are a few things to focus on to create Fiverr gigs that get noticed: 

Title: Start with a clever, descriptive gig title. Your title is what buyers see in search, so 

you want to make it grab their attention. Find relevant keywords that accurately describe 

the services you're offering and add them to your title to give yourself the best chance of 

being found in search. 

Tags: Find the most common and relevant keywords for your service category and put 

them to use. Add them to your gig to help buyers find you. 

Description: Tell potential buyers exactly what services you're offering and why they 

should choose you. Do you have specialized skills or talents? What makes you different 

from other designers? Remember to be super clear about exactly what you're offering, any 

upsells, and other custom service packages you can provide. 

Price: Make sure you have a good idea of current freelance graphic design rates when 

pricing your project. Search the Fiverr marketplace to understand what other designers 

charge. Use these average rates as a baseline, then consider factors like your experience 

and job complexity and duration to set fair graphic design rates. It pays to do your 

homework on pricing before you set up a new gig! 

Step 3: Showcase Your Best Work 

On Fiverr, you also have an opportunity to create a “Gig Gallery” for each gig. Your gallery 

can house a portfolio to highlight your talents. As a designer, you should make the most of 

these visuals! If you’re a Photoshop designer, add some pictures that you’ve edited and 

enhanced. Brand-focused designers may want to add samples of freelance brochure design, 

advertisements, or web graphics. Choose your best, most relevant pieces to show off your 

skills. 

Make sure each image in your gallery is high resolution. Pick original images that highlight 

your creativity and design capabilities. Have more images you want to share? You can 

upload a showreel video to feature your work samples. 
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Step 4: Use Videos to Make Your Talents and Personality Shine 

Here’s an insider success tip every Fiverr seller needs to know: Gigs with videos 

outperform gigs with images alone. 

Buyers often appreciate it when freelancers use videos to showcase their personality. You 

can create a short, friendly video to introduce yourself and share more about your 

experience and skills. All you need is your computer and free video recording software. Be 

sure to record yourself in front of an uncluttered background and use good lighting. Write 

a five to ten sentence script in advance and memorize it before you record. Look directly 

at the camera and smile. 

As mentioned above, a showreel can let you highlight multiple design pieces in one video. 

Not sure how to create your own showreel? You can hire a freelancer to create a showreel 

right on Fiverr. 

And if you’re a motion graphic designer, adding videos to every gig is a must! 

Step 5: Clarify Project Expectations Up Front 

As a freelance creative designer, you know what you need to make each project a success. 

Clarify these needs by adding FAQs to your gig. This lets potential buyers know what to 

expect when they hire you. 

Fiverr provides options for you to include buyer requirements for each gig. You can think 

of buyer requirements as a data-collection tool. Use them to get the information you need 

for your gig. As a designer, you may need access to any standard colors or fonts and insight 

on buyer's design likes and dislikes, along with any files to incorporate into your design. 

Be as specific as possible with your requirements. For example, you may need to tell buyers 

to upload a file, but it can help to provide instructions on how to upload to help buyers out. 

Remember, it could be the first time your new client has ever sought to hire freelance 

graphic design talent online. Put yourself in their shoes and make the gig start-up process 

easy on them. 

Also, tell buyers to be as specific as possible in their instructions to you. Clear, upfront 

communications help every project get off to a great start.   

Step 6: Build Positive Relationships with Buyers 

Delivering high-quality work on time is always going to make buyers happy. But there are 

other steps you can take to build good working relationships with Fiverr buyers. 

First, be responsive. Answer promptly when buyers reach out to hire you or if they ask any 

questions. You’ll make your customers feel appreciated and think of you the next time they 

want to find a graphic designer online. 

And you’ve probably heard the phrase “under-promise, over-deliver.” That is an excellent 

strategy for all of your freelance graphic design projects. Can you wrap the project up a day 
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early? Buyers are sure to be impressed. How about adding in something extra—maybe 

multiple sizes of the same image to save buyers time? Those little touches can have a 

significant impact. 

Step 7: Keep Learning New Skills 

Every graphic artist and designer knows that the field is evolving all the time. You need to 

keep up with trends and expand your software know-how. Cutting-edge skills will help you 

stand out to buyers looking to hire graphic designers online. 

Through education, you can take your career in any direction. As a new seller, you may 

want to focus on a narrow niche like Fiver flyer design. Often, creating flyers is a great 

path to start out as a freelance print designer. Over time, you can look to take on more 

complex and strategic projects. You can transform yourself into a freelance digital designer 

focused on websites, apps, or videos. Or you could become a freelance branding designer 

who helps companies create their visual identity. 

While every gig can help you learn, taking courses can help you level up your skills quickly. 

Through Learn from Fiverr, you can access on-demand courses taught by knowledgeable 

professionals. Fiverr offers a suite of Design and Branding courses, along with courses on 

popular Adobe Creative Cloud software. You can even take courses in complementary 

fields—such as digital marketing and storytelling—to make yourself even more valuable 

to buyers. 

Accelerate Your Freelance Graphic Design Career on Fiverr 

Whether you’re a new designer or a seasoned veteran, you can give your freelance career 

a boost on Fiverr. New companies and buyers sign on to Fiverr every day to hire freelance 

graphic designers. 

What are these buyers seeking from the Fiverr community? Anything you can imagine — 

brochure design, game design, menu design—and much more. 

If you’ve ever dreamed of finding success as a freelance graphic artist Fiver is the go-to 

freelance marketplace for companies of all sizes who need a freelance graphic design 

project completed. By following our seven steps for success, you can use Fiverr as the 

springboard to a successful freelance graphic design career. 

7 Steps for Freelance Graphic Design Success on Fiverr 

1. Optimize Your Profile 

2. Create Winning Fiverr Gigs 

3. Showcase Your Best Work 

4. Use Video to Make Your Talents and Personality Shine 

5. Clarify Project Expectations Up Front 

6. Build Positive Relationships with Buyers 

7. Keep Learning New Skills   
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Self Check 6.1  

 

Answer the following questions: 

1 What is Online Marketplace? 

Ans:  

 

 

2 Write Some of leading online marketplace for graphic design? 

Ans:  

 

 

3 What required to sustain in marketplace? 

Ans:   
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Answer Sheet 6.1 

1. What is Online Marketplace? 

Ans: An online marketplace is a type of e-commerce website where product 

or service information is provided by multiple third parties. 

 

2. Write Some of leading online marketplace for graphic design? 

Ans: Some of leading online marketplace for graphic design- 

•GraphicRiver 

•Sutterstock 

•UpWork 

•Fiverr 

•99design 

•Behance 

3. What required to sustain in marketplace? 

Ans: 1 – Be Passionate About Graphic Design  

2 – Learn the Software Necessary for Graphic Design 

3 – Invest in The Tools Required by Graphic Designers 

4 – Work Under a Mentor 

5 – Expose Your Talent 

6 – Enroll on Websites That Provide Graphic Design Gigs 

7 – Create an Online Portfolio 

8 – Request for Referrals 
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Review of Competency 

Below is yourself assessment rating for module “Applying Graphic Design Concepts and 

Guidelines” 

S/N Assessment of performance Criteria  Yes No 

1.  Types of graphic design are comprehended.   

2.  Uses of graphic design are identified.   

3.  Structure of graphics are interpreted.   

4.  Software for graphic design is identified.   

5.  Basic design guidelines are Interpreted.   

6.  Design brief is interpreted.   

7.  Appropriate Image modification software is identified and opened.   

8.  Image sources are identified.   

9.  Images are successfully Imported from appropriate source.   

10.  Image separation tools are identified and applied.   

11.  Separated image is saved.    

12.  Image properties are identified.   

13.  Image resolution are identified and interpreted.   

14.  Image format are identified and selected.   

15.  Required designs are specified.   

16.  Appropriate shape and size are identified.   

17.  Content area is defined.   

18.  Contents are inserted and composed.   

19.  Shapes are modified as per requirements.   

20.  Typographical design is applied as per requirements.   

21.  Font attributes are applied as per requirements.   

22.  Design and color are applied as per requirements.   

23.  Design is saved in appropriate file format.   

24.  Local and international graphic design and Desktop Publishing (DTP) houses are 

identified. 
  

25.  Positions/jobs in the graphic design sector are identified.   

26.  Hands on graphics arts designer are identified.   

27.  Graphic design and DTP houses are visited on site and through the internet.   

28.  Source of carrier opportunities are identified.   

29.  Account opening procedure is interpreted.   

30.  Standard profile structure is outlined.   

31.  Bidding procedure for the jobs are interpreted.   

32.  Design submission procedure is interpreted.   

33.  Payment collection methods are identified.   

I now feel ready to undertake my formal competency assessment. 

Signed: 

Date: 
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How to use this Competency Based Learning Materials (CBLMs) 
  

The module, Create Professional Designs using Illustration Software contains training 

materials and activities for you to complete. These activities may be completed as part of 

structured classroom activities or you may be required you to work at your own pace. These 

activities will ask you to complete associated learning and practice activities in order to gain 

knowledge and skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or 

tasks you are going to learn how to do. Once you have finished reading the 

Information Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to 

help you know how you are progressing.  If you are unable to answer the questions 

in the Self-Check you will need to re-read the relevant Information Sheet. Once 

you have completed all the questions check your answers by reading the relevant 

Answer Keys found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step 

by step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be 

provided where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of 

others in the training room. Should you require assistance or clarification please consult 

your trainer or facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved 

competency in the specified learning outcomes. You will then be ready to move onto 

the next Unit of Competency or Module  
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Module Content 
 

Unit of Competency: Create Professional Designs using Illustration Software 

Module Title: Creating Professional Designs using Illustration Software 

Module Description: This module covers the knowledge, skills and attitudes required to 

create professional designs using Illustration software. It specifically 

includes preparing for design work, creating Design, and reviewing 

and Finalizing design works.  

Nominal Duration: 60 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Prepare for design work 

2. Create Design 

3. Review and Finalize design works 

Assessment Criteria: 

1.1. Required Professional Design work are selected. 

1.2. Appropriate Tools, Palette and arrange them as needed are identified. 

1.3. Ruler/unit/Grids/Guides/Smart Guides as per requirement are set 

1.4. Key Drawing / Design Layout are prepared 

1.5. Marks are interpreted. 

1.6. Layer lock is applied 

2.1 Contents are inserted. 

2.2 Color/Design/Pattern is applied. 

2.3 Pathfinder to create complex Objects are used. 

2.4 Font Attributes are applied as per requirement. 

2.5 Zoom In-Out and Panning are used. 

2.6 Design for further use is saved. 

3.1. Artwork and Preview is used. 

3.2. Layer Hide-Unhide option is used. 

3.3. Appropriate marks are used. 

3.4. Outline and Group Created. 

3.5. appropriate File Format Saved. 

3.6. The image to recipient is transferred 
 

Contents  

This learning package includes the following:  

1. Preparation for design work 

2. Design Creation 

3. Reviewing and Finalizing design works 
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Learning Outcome 1: Prepare for design work  

Content: 

1. Professional Design work 

a. Brochure 

b. Invitation Card 

c. Envelop 

d. Folder 

e. Poster 

f. Complex Logo 

2. Tools, and Palette 

3. Ruler/Grids/Guides/Smart Guides/ Unit 

4. Key Drawing / Design Layout  

5. Marks. 

a. Crop/ Cutting marks 

b. Creasing 

c. Registration mark 

d. Gripper mark 

6. Layer lock  

Assessment Criteria:  

1. Required Professional Design work are selected. 

2. Appropriate Tools, Palette are identified as needed. 

3. Ruler/unit/Grids/Guides/Smart Guides as per requirement are set 

4. Key Drawing / Design Layout are prepared 

5. Marks are interpreted. 

6. Layer lock is applied 
 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 1: Prepare for design work 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Develop 

Competency Based 

Training Curriculum. 

1. Instructor will provide the learning materials “Create 

Professional Designs using Illustration Software 

2. Read the Information 

sheet/s 

2. Information Sheet No:1 Prepare for design work 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 1 Prepare for design work 

 

Answer key No. 1 Prepare for design work  

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:1- Prepare for design work 

 

Specification Sheet1 Prepare for design work 
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Information Sheet 1: Prepare for design work 
 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Select required Professional Design work. 

2. Identify appropriate Tools, Palette and arrange them as needed. 

3. Set Ruler/unit/Grids/Guides/Smart Guides as per requirement  

4. Prepare Key Drawing / Design Layout  

5. Interpret Marks. 

6. Apply Layer lock  

1. Professional Design 

Professional design refers to the creation of high-quality, polished, and visually appealing 

designs using the software's extensive features and tools. It involves utilizing Illustrator's 

capabilities to produce designs that meet industry standards and effectively communicate 

the intended message or purpose. 

Here are some key aspects of professional design in Illustrator: 

Mastery of Tools and Features: A professional designer in Illustrator is proficient in using 

the various tools and features available in the software. This includes a deep understanding 

of shape tools, pen tool, anchor point manipulation, layers, gradients, brushes, typography 

tools, and more. Familiarity with these tools allows designers to create complex 

illustrations, precise shapes, and sophisticated effects. 

Attention to Detail: Professional design requires a keen eye for detail. It involves paying 

close attention to alignment, spacing, proportions, and consistency throughout the design. 

Designers meticulously refine shapes, adjust anchor points, align objects, and ensure 

consistency in color usage, typography, and visual elements. 

Composition and Layout: A professional Illustrator designer understands the principles of 

composition and layout. They arrange elements in a visually balanced and aesthetically 

pleasing manner. Consideration is given to hierarchy, focal points, white space, and the 

overall flow of the design. Good composition and layout enhance the readability and impact 

of the design. 

Color Theory and Management: Professional designers are knowledgeable about color 

theory and effectively apply it in their designs. They understand color harmonies, contrast, 

and color psychology. They utilize Illustrator's color tools to create visually appealing color 

schemes and manage color consistency across different design elements. 
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Typography and Text Handling: Typography plays a crucial role in design. Professional 

designers are skilled in selecting appropriate fonts, managing typographic hierarchy, and 

ensuring readability. They effectively use Illustrator's text tools to format and manipulate 

text, create text effects, and integrate typography seamlessly into the overall design. 

Vector Graphics and Scalability: Illustrator is renowned for its vector-based capabilities, 

allowing designers to create scalable and resolution-independent artwork. Professional 

designers leverage this feature to produce designs that can be resized without losing quality. 

They understand the advantages of vector graphics and utilize them to create smooth, clean, 

and professional-looking designs. 

File Management and Organization: Organized file management is essential in professional 

design. Designers create a well-structured layer hierarchy, use naming conventions, and 

organize their files to facilitate easy editing and collaboration. This ensures efficient 

workflow and smooth project management. 

Understanding Design Objectives: Professional designers in Illustrator have a clear 

understanding of the design objectives and the target audience. They effectively translate 

concepts and ideas into visually compelling designs that align with the desired message, 

brand identity, or project requirements. 

Some Professonal Design Works are: 

a. Brochure 

A brochure is a type of 

printed material used for 

advertising, promotion, or 

information purposes. It is 

typically a folded piece of 

paper or cardstock that 

contains text, images, and 

graphics arranged in a 

visually appealing manner. 

Graphics play a crucial role in 

enhancing the overall design 

and effectiveness of a 

brochure. 
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b. Invitation Card 

An invitation card is a printed 

material used to invite 

individuals or groups to a 

specific event or occasion. 

Graphics play a crucial role in 

designing an invitation card, as 

they help convey the theme, 

set the tone, and create visual 

interest.  

  

c. Envelop  

An envelope is a folded paper 

or cardstock enclosure used to 

hold and protect documents, 

letters, or other printed 

materials. While the primary 

function of an envelope is 

practical, graphics can still be 

incorporated to enhance its 

visual appeal and convey 

important information.  

  

d. Folder 

Folder design in graphics refers 

to the visual elements and layout 

used to create an appealing and 

functional folder for organizing 

documents or promotional 

materials. Graphics play a 

significant role in designing a 

folder, as they help 

communicate information, 

enhance brand identity, and 

create a professional and 

visually engaging presentation 
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e. Poster 

A poster is a visual medium used for various 

purposes, such as advertising, promoting events, 

conveying information, or creating awareness. 

Graphics play a fundamental role in designing a 

poster, as they help capture attention, 

communicate messages effectively, and create an 

impactful visual experience  

  

 

f. Complex Logo 

A complex logo refers to a logo design that 

incorporates intricate and detailed graphical 

elements, typography, or a combination of both. 

It often involves multiple colors, intricate shapes, 

patterns, or intricate illustrations.  

 

 

2. Tools and Palette 
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• Selection Tool (V) 

The selection tool is the black arrow icon that you use all the time. It 

functions as a typical cursor, allowing you to select, click and drag objects 

and text around your screen. 

 

• DIRECT SELECTION TOOL (A) 

The direct selection tool allows you to individually select and edit specific anchor points 

of vector shapes or lines. 

Where the regular selection tool would select the entire shape, the Direct Selection Tool 

enables you to edit one angle, side, point or curve at a time.  

 

-GROUP SELECTION TOOL 

This tool allows you to easily select a specific object within a group in order to move, edit, 

or resize it individually. 

 

 

 

 

 

 

•  MAGIC WAND TOOL (Y) 

This tool allows you to click on a single object in order to automatically 

select everything in your workspace with that same fill color. 

This would come in handy if you ever needed to adjust the same color on 

a bajillion different shape. By using the magic wand tool, you only have 

to click once to do so, instead of clicking on every object individually! 

 

• LASSO TOOL (Q) 

The lasso tool works similarly to the Direct Selection Tool in that it 

allows you to select individual anchor points within a shape or object. 

However, the Lasso Tool allows you to draw around an area of points you 

want selected so that you’re able to easily select several at a time. 

 

• PEN TOOL (P) 

The pen tool is probably the most 

important tool of the entire program. 

This Illustrator tool allows you to click 

in your workspace to create anchor 

points. By clicking and dragging these 

anchor points, you can maneuver their 

“handles”, which give your paths 

curvature and shape. By connecting several anchor points with this tool, you can create 

unique, hand drawn vector shapes.  
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This tool takes some practice, but once you have it down, you will be able to draw freaking 

awesome vector illustrations. I use the pen tool every single time I open Illustrator, so if 

there is any tool to master, it’s definitely this one! 

 

- ADD ANCHOR POINT TOOL (+) 

The add actor point tool allows you to click in the middle of an existing path to add an extra 

anchor point to your shape or line. 

 

You would use this tool if you needed to add an extra curve or angle to your shape, without 

having to fully redraw it. Once you’ve added the new anchor point to your path, use the 

direct selection tool and/or the anchor point tool to manipulate it into the curve or angle 

you want to create. 

 

- DELETE ANCHOR POINT TOOL (-) 

The delete anchor point tool deletes anchor points from paths. 

 

- ANCHOR POINT TOOL 

This tool allows you to add or maneuver handles of existing anchor points in order to add 

curvature to shapes you’ve already created. 

 

• CURVATURE TOOL (SHIFT+) 

The curvature tool is another great way to create vector shapes, 

especially if your shape has mostly curved edges. 

It's harder to have perfect control over your curves using this tool 

than is with the pen tool, BUT the curves of this tool are also more 

perfectly round than the curves you would create using the pen tool. Using this tool in 

combination with the pen tool create the perfect shape.  

• TYPE TOOL (T) 

This tool allows you to add text to your 

Illustrator document. 

To use this tool, either click on your artboard 

and begin typing – which allows you to type 

without any boundaries; or you can click and 

drag to create a text box and THEN begin typing 

– which will restrict your text to stay within that 

text box. 

- AREA TYPE TOOL 

The area type tool allows you to convert an existing shape into a text box and type within 

it.  

- TYPE ON A PATH TOOL 

This tool allows you to use an existing line or shape as a path to type on. 

- VERTICAL TYPE TOOL 

The vertical type tool allows you to type your text vertically instead of horizontally. 
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- VERTICAL AREA TYPE TOOL 

This is exactly like the area type tool, but this tool allows you to type vertically instead of 

horizontally.  

 

- VERTICAL TYPE ON A PATH TOOL 

This tool is exactly like the type on a path tool, but allows you to type vertically instead of 

horizontally.  

- TOUCH TYPE TOOL 

This it allows you to select individual letters of existing text and move them around. 
 

• LINE SEGMENT TOOL (\) 

This tool does exactly what you think it does 

– draws lines! Unlike the pen tool however, 

you cannot make connected lines, only 

individual ones. 

 

For this tool and the ones nested under it, 

you can either click and drag to create your 

lines, or you can click one single time on the 

artboard and specify it's dimensions first. If 

you hold down the shift key you can create a line at a 0, 45, or 90 degree angles.  

 

- ARCH TOOL 

This tool makes arches – imagine that! However, I personally don’t find it the easiest to 

control and would recommend using the curvature tool instead – but try them both out and 

see which you prefer! 

 

- SPIRAL TOOL 

Another obvious one – this tool makes spirals! This is actually a super fun tool, however I 

don’t know that I’ve actually ever used it for a real project before. But if you can find a 

practical use for this – kudos!  

 

- RECTANGULAR GRID TOOL 

This tool is actually be super helpful because it allows you to create create tables or 

anything else you’d need a grid with rows and columns for. 

 

Once the tool is selected, you can click one time on your artboard, which will bring up a 

window where you can specify the size and number of rows and columns you want. Hit 

okay and your grid will appear!  

 

- POLAR GRID TOOL 

This tool makes a polar grid, which apparently is a circular target looking thing, with 

perpendicular lines that meet in the middle.  
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• RECTANGLE TOOL (M) 

This tool makes squares and rectangles. 

 

If you want a perfect square you can 

hold down the shift key as you click and 

drag. Otherwise just click and drag 

normally to make a rectangle. If you 

need your shape to be an exact size, just 

click one time and specify the size you 

want your shape to be in the box that 

will pop up. 

 

- ROUNDED RECTANGLE TOOL 

This tool works exactly the same as the rectangle tool, but the corners are rounded instead 

of squared. 
 

If you want to adjust the roundness of the corners, use the direct selection tool and click 

and drag on the little circular points that show up on the insides part of the corners and 

adjust them accordingly.  
 

- ELLIPSE TOOL (L) 

Fun fact: an ellipse is a circle. So any time you want a circle or an oval, this is the tool 

you’ll need. 
 

To create a circle, hold down the shift key. If you want an oval, just click and drag. Like 

the rectangle tool(s), if you want a specific sized circle, just click once on the artboard and 

adjust your settings accordingly.  
 

- POLYGON TOOL 

The polygon tool makes any number of sided shapes – from triangles to hexagons to 

octagons and beyond. 
 

With the tool selected, all you need to do is click once on your artboard and define how 

many sides you want your shape to have.  

- STAR TOOL 

This tool obviously makes stars. With this tool, you can choose how many points you want 

your star to have, as well as how far in the inner points go towards the center. 
 

The star tool is super fun to play around with, given how many different variations you can 

come up with. Again, just click in your workspace with the tool selected to define the 

number of points you want your star to have, as well as the distance you want between 

them. 
 

-FLARE TOOL 

This is another random tool that makes this weird multi-circular shape with some weird 

gradient flares.   
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• PAINT BRUSH TOOL (B) 

The paint brush tool makes thicker, 

paint-like strokes that you can 

change the width, shape and texture 

of. 
 

This tool creates brush strokes that are made up of actual lines, so after you’ve “painted” 

them, you can use the direct select tool to can move around the points and smooth out any 

curves that aren’t quite perfect. You can also change the width of the stroke after it’s already 

been drawn by changing the line weight. 
 

- BLOB BRUSH TOOL 

The blob brush tool is the same as the paint brush tool, but instead of creating lines down 

the middle of your brushstrokes, it creates a vector shape AROUND the brushstroke. So 

instead of creating a single path, it creates an entire an area instead. 
 

• SHAPER TOOL (SHIFT+N) 

The shaper tool allows you to draw general 

shapes by hand, but then will automatically 

clean them up and create the shape you 

intended. So if you used this tool to draw a 

super crappy rectangle, the moment you 

release your finger from the mouse pad, it 

will automatically create a non-crappy 

rectangle for you.  

- PENCIL TOOL 

The pencil tool is similar to the brush tool in that you can draw lines by hand without using 

the pen or line tools.  
 

- SMOOTH TOOL 

This tool smooths out lines, making them less rigid and bumpy. 
 

By clicking and dragging the smooth tool over top of a line you’ve drawn, it will 

automatically change around the anchor points to create a smoother transition between 

them.  
 

- PATH ERASER TOOL 

With a line selected, you can use the path eraser tool to draw along segments of the line 

you want to be erased.  
 

- JOIN TOOL 

The join tool allows you to take two paths and join them together to create one single path. 

With the join tool selected, just click and drag a circle around the two end points of the path 

you want to be connected, and Illustrator will join them together for you. 
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• ERASER TOOL (SHIFT+E) 

The eraser tool erases. This tool really does 

come in handy if you want to get rid of a 

section of a vector object or path.  

Unlike the path eraser tool, this tool can erase 

entire sections of shapes, causing your vector 

shape to redraw its outside bounding lines.  

- SCISSORS TOOL 

The scissors tool can be used to cut apart a vector object or path. 

If you want to slice apart an object, use the scissors tool to click on one side and then click 

on the other. Now your shape is cut into two pieces which you can move around 

individually. You can also use this tool on a path by clicking once on the section of the path 

you want to be separated. 

- KNIFE TOOL 

The knife tool allows you to do the same thing as the scissors tool, but instead of only 

cutting straight lines, the knife tool can cut in any jigsaw manner you want Just click and 

drag the knife through the shape.  

 ROTATE TOOL (R) 

The rotate tool allows you to rotate shapes 

in a circular manner. 

To use it, select the tool and click once in 

the middle of the shape, defining your axis 

point (that blue dot) of which you want your shape to rotate around. Then click and drag 

outside of the shape to rotate it around!. 

- REFLECT TOOL (O) 

The reflect tool works similarly to the rotate tool, but instead reflects the image or object 

instead of just rotating it. 

Again, you need to select an axis point, then click and drag outside of the shape to reflect 

it.  

• SCALE TOOL (S) 

This tool works similarly to the reflect and 

rotate tools, in that you have to define an 

axis point, then resize by clicking and 

dragging outside the shape. I find it easier 

to forgo using this tool by just resizing the 

shape as normal while holding down option 

and shift (which resizes it proportionately and centered to where the object already resides). 

- SHEAR TOOL 

The shear tool angles and skews your objects to look like they are going back into space. 

This tool works the same as the previous, where you select and axis point, then click and 

drag outside of the shape to shear it.  

- RESHAPE TOOL 

The reshape tool allows you to select multiple anchor points on a line or shape, and move 

them all in the same direction. 
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It’s essentially the same as the direct selection tool but is easier in maneuvering several 

points at the same time, especially if you want them all to move in the same direction.  

 

• WIDTH TOOL (SHIFT+W) 

This tool only works on lines, not shapes. It allows 

you to click on areas of a line and make the stroke 

thicker or thinner.  

- WARP TOOL (SHIFT+R) 

The warp tool works on both shapes and lines and 

creates warped indents into your vector drawings. 

The amount you click, hold and drag will adjust the 

strength or depth of the indents. 

- TWIRL TOOL 

The twirl tool distorts shapes by creating a swirl within them. This tool only works on 

shapes and not lines, and the shape you want to twirl must be selected before you select the 

actual tool itself.  

To use, just click and hold on the shape you want twirled.  

- PUCKER TOOL 

The pucker tool creates weird, pointed divots in your shape. 

Again, the longer you hold down the tool on the shape and the more you click and drag the 

tool over the shape, the more prominent these features become. This tool works on both 

shapes and lines. 

- BLOAT TOOL 

This tool also works on both shapes and lines, and in contrast to the pucker tool, it bloats 

the shape, adding extra bumps to the outside of your shapes or lines.  

- SCALLOP TOOL 

The scallop tool works on both shapes and lines, and it makes both indents and outward 

bumps, depending on which area of the shape you place the tool. This tool adds 3 little 

peaks and valleys to your shape or line every time you click. The intensity of these bumps 

increases the more you click and drag.  

- CRYSTALIZE TOOL 

The crystalize tool looks similar to the scallop tool, but with stronger peaks and shallower 

valleys. It also works on both shapes and lines and can be increased by clicking and 

dragging. 

- WRINKLE TOOL 

This tool makes your shape or line wavy, adding uneven bumps and squiggles into your 

paths.  

  

• FREE TRANSFORM TOOL (E) 

This tool essentially lets you resize your shape in all ways possible. 

When you select a shape to transform, a second little toolbar will 

appear in the upper left hand corner, floating next to your main toolbar. 

Here you can select Constrain, Free Transform, Perspective Distort, or 
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Free distort. They all are obviously ways to transform your object but are best understood 

by just playing around with them to see how they work.  

• SHAPE BUILDER TOOL (SHIFT+M) 

The shape builder tool allows you to easily combine multiple, overlapping shapes in order 

to create one large, combined shape. 

Once all of the shapes selected, select the 

shape builder tool and click and drag a line 

between every shape you want to combine. 

Once you release your mouse, your new 

shape will be created. 

 

- LIVE PAINT BUCKET (K) 

The live paint bucket allows you to fill shapes quickly and easily with color or patterns. 

The one important step to this process, however, is to make sure that the object(s) you want 

to be filled is selected first. 

The cool thing about this tool is that you can fill sections of shapes that are separated by 

individual lines. For example, if you had a circle with a big line going through the middle 

of it, you could fill each side of that circle, even though that line isn’t actually connected to 

the shape itself.  

- LIVE PAINT SELECTION TOOL (SHIFT+L) 

This tool allows you to select individual segments from your live paint area, and change 

their attributes (color, line weight, etc.). 

This tool makes more sense when you play around with it. 

     PERSPECTIVE GRID TOOL (SHIFT+P) 

This tool is sort of confusing to use at first, but it can be really helpful in making perspective 

drawings. The perspective grid allows you to make your drawing look 3D by giving them 

depth and spatial awareness.  

To use this tool, first select the tool itself, which will make a grid appear on your artboard. 

Using the cube in the upper left-hand corner, select which side of your grid you want an 

object to snap to. Then, select that object and drag it onto the grid, anywhere you want. 

Continue this step until all of your objects are on the perspective grid and look as if they 

are going back into space. 

 

- PERSPECTIVE SELECTION TOOL (SHIFT+V) 

The perspective selection tool allows you to edit and change around the perspective grid 

that appears on your artboard. Select the three points that appear on the bottom of the grid, 

and slide them around to adjust the grid.  
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To get out of the perspective grid altogether, click on the x in the corner of the cube pop-

up using this tool.  

•  MESH TOOL (U) 

This is another highly advanced tool in Illustrator that can be extremely 

powerful if used correctly. This tool allows you to select certain points 

within a specific section of your shape to add another color. The two colors 

will create a gradient in-between them, acting as highlights, shading, and natural color 

progression. This is how extremely advanced digital artists make realistic digital drawings. 

They have a bajillion of these points with a bajillion different colors.  

Use this tool by clicking on different parts of your shape, which then creates a point in the 

middle of your shape with a line connecting it to each side, horizontally and vertically. Use 

the direct selection tool to select this point and then change the color by changing the color 

swatch. Continue with this process until you have the desired gradient shading throughout 

your shape.  

  

• GRADIENT TOOL (G) 

The gradient tool creates either linear or radial gradients within a 

shape or line. The actual tool allows you to click and drag within 

your shape to specify where you want your gradient to start and 

end, and how large the spread in-between is. It also allows you to 

choose the angle by hand, rather than by choosing specific 

degrees.  

In order to change the colors and edit these variables more specifically, however, you need 

to open the gradient window in the workspace panel on the right-hand side of your 

workspace. Here you can choose which colors to start and end with, add colors in between, 

adjust the spread, decide whether it’s a radial or linear gradient and what angle and direction 

it goes in.  

  

• EYEDROPPER TOOL (I) 

The eyedropper tool allows you to pick 

colors from other shapes, lines, objects 

or images so you can use that same 

color in other parts of your design. All 

you have to do is click the eyedropper 

tool on the areas of your artboard with the particular color you want to be selected.  

- MEASURE TOOL 

The measure tool allows you to click and drag between two different areas of your 

workspace in order to measure the distance between the two points. This distance will then 

show up in the pop-up window for you to reference.  

•  BLEND TOOL (W) 

This tool allows you to take two different colored objects and create a 

gradient in-between them by blending the two objects together. 
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Use this tool by first selecting both objects and then selecting the blend tool. Once the tool 

is selected click on the first object and then the second which will create your blend.   

  

• SYMBOL SPRAYER TOOL (SHIFT+S) 

To use the symbol sprayer tool, you have to first 

open the symbol panel and select what symbol 

you want to be sprayed. You can do this by 

either clicking on the spade shape in the toolbar 

on the right, or by going to Window > Symbols. 

Now, with the symbol sprayer selected, click 

and drag it around on your workspace to spray 

the symbols onto your artboard.  

- SYMBOL SHIFTER TOOL 

This tool allows you to move around symbols that have already been sprayed, by clicking 

and dragging the shifter around. 

- SYMBOL SCRUNCHER TOOL 

The scruncher tool scrunches the symbols in towards the center (essentially doing the 

opposite of the shifter tool). 

- SYMBOL SIZER TOOL 

This tool allows you to resize individual symbols after they have already been sprayed.  

- SYMBOL SPINNER TOOL 

The symbol spinner allows you to rotate individual or multiple symbols at once.  

- SYMBOL STAINER TOOL 

This tool allows you to recolor individual symbols. Make sure you select a fill color first, 

otherwise this tool won’t actually do anything.  

- SYMBOL SCREENER TOOL 

This tool changes the opacity of individual symbols, making them lighter and lighter each 

time you click on them.  

- SYMBOL STYLER TOOL 

This tool allows you to style your symbols more specifically by first using the Graphic 

Styles panel. Open this panel by going to Window > Graphic Styles. Here you can select a 

graphic style or create your own. Once you’ve selected a style, use the symbol styler and 

click on individual symbols or areas of symbols to change their appearance.   
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• COLUMN GRAPH TOOL (J) 

This tool, along with all of the other graphing tools 

nested beneath it, allows you to easily make graphs 

within Illustrator. You have the opportunity to build 

it within Illustrator OR you can import data from an 

excel spreadsheet.  

The column graph is your typical lineup of columns 

which correspond to values indicated by the Y axis.  

 

- STACKED COLUMN GRAPH TOOL 

This graph looks similar to the column graph, but the columns are segmented within itself, 

outlining more data from within that particular segment.  

- BAR GRAPH TOOL 

A bar graph is a column graph flipped horizontally instead of vertically, with the values of 

the bars aligning with the x-axis instead of the y-axis. 

- STACKED BAR GRAPH TOOL 

This is a bar graph but includes segmented versions of each individual bar, to indicate more 

data than a typical bar graph otherwise would. 

- LINE GRAPH TOOL 

A line graph uses points on the graph which are connected by a line.  

- AREA GRAPH TOOL 

An area graph is similar in structure to a line graph but instead has shaded areas to include 

broader values of information. 

- SCATTER GRAPH TOOL 

A scatter graph is made up of several points, scattered across the graph.  

- PIE GRAPH TOOL 

This is a classic pie chart where a circle is divided up into sections to a complete 100%. 

- RADAR GRAPH TOOL 

A radar graph is similar to an area graph, but instead is round and can, therefore, have more 

variables than just two or four.  

  

• ARTBOARD TOOL (SHIFT+O) 

One of my favorite features of Illustrator is that you can have 

multiple artboards within one document. By using the artboard 

tool, you can add a new artboard or resize your current arboards. 

You can also copy existing artboards by clicking and dragging 

it, while holding down the command key.  
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• SLICE TOOL (SHIFT+K) 

The slice tool allows you to separate your 

artboard into squared off sections for you to 

save out individually. That way, if you have 

a large image that you need to piece down 

into sections, you can click and drag the slice tool to divide up the area(s) you want as 

individual files. 

- SLICE SELECTION TOOL 

The slice selection tool allows you to change, move, edit and resize the slices you’ve 

already made with the slice tool. 

•  HAND TOOL (H) 

The hand tool gives you another option to 

move around the screen. Just click and 

drag with the hand tool selected, and you 

will be able to view different areas of your 

workspace.  

- PRINT TILING TOOL 

This tool is to help you print full images that are larger than the paper you’re printing on. 

In order to print your entire image, you may need tile your printing onto multiple sheets of 

paper. This tool allows you to specify more accurately where the first page in the tiling 

process starts. Otherwise, Illustrator will set this up for you automatically when you turn 

on tile printing in the print window. Either way, you can adjust the tiling further within the 

print window by dragging your artwork between multiple sheets of paper.  

If you’re using this tool and you feel like nothing is happening on your artboard, make sure 

you go to View > Show Print Tiling. 

In order for this feature to actually work when you try printing it, make sure “File Full 

Pages” is selected from the Scaling drop down menu underneath Options.  

  

• ZOOM TOOL (Z) 

The zoom tool zooms in and out of your workspace. You can zoom in 

by either clicking or clicking and dragging, and zoom out by either 

clicking and dragging the magnifying glass to the upper left-hand corner, 

or by holding down the Option key while you click or click and drag.  

You can also zoom in and out by holding down Cmd + (zoom in) or Cmd 

- (zoom out) for Mac users.  

  



 

22 

 

 

• Shape tool 

The Offset Path 

Whether you’re trying to create a larger copy of an already existing object or give your 

shapes an outline, the Offset Path has you covered. 

As the name implies, the tool works by pushing the path 

of a selected object towards the outside, thus creating a 

larger version underneath that object that is identical in 

form and color, but not in size. 

I really love working with Offset Paths when creating 

line icons, since using just a couple of clicks I can easily 

achieve nice thick outlines that are far easier to select 

compared to stroke paths. 

You can find the tool under the Object > 

Path submenu, and once you have an object selected 

and click on Offset Path you’ll be greeted with all the 

options that you need, from the size of your Offset to 

the type of Joins and the Miter Limit. 

 

• The Clipping Mask 

A Clipping Mask is, as Adobe perfectly puts it, an “object 

whose shape masks other artwork so that only areas that lie 

within the shape are visible”. 

Usually, when creating complex compositions, you might 

be quick to think that the Pathfinder panel with its Shape 

Modes is the way to go if you need to adjust the shape of 

your objects. The Clipping Mask can actually be a better 

solution almost every time since it gives you complete 

power over your masked shapes. 
 

First, it’s incredibly easy to use once you get the hang of it, giving you the power to create 

complex and intricate shapes. 

Secondly, the resulting shapes are unbelievably easy to edit on the fly, since all shapes from 

within a Clipping Mask can be resized, repositioned and adjusted as long as you enter 

the Mask, which is something that you can’t do with Pathfinder. 

You can read more about the advantages of using Clipping Masks over Pathfinder’s Shape 

Modes and see for yourself how to use it, and most importantly why you should give it a 

try. 
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• Pannel 

The Artboards Panel 

Next on our list is the Artboards panel, which is 

probably one of the biggest features 

that Illustrator has to offer, since you can create 

projects with multiple assets within one 

document, and view them all at the same time. 

This way, you can create variations of a 

composition, explore different styles, and have 

a direct comparison between them, making it 

easier to decide which road to take. 

 

Now, since the Artboard is the actual canvas 

onto which we lay our artwork, it can also be a 

powerful exporting tool, especially when 

dealing with icon packs, since you can create 

multiple Artboards, and assign one to each 

icon. 
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• The Layers Panel 

If the Artboards panel let you 

create a multi-asset document, 

the Layers panel gives you the 

power to create detailed 

compositions, using a logical 

structure that allows you to easily 

identify and adjust the different 

sections of your artwork without 

having to worry that you erased or 

misplaced an element by mistake. 

We can use the panel with every 

project, since to establish a shape-

details hierarchy from the 

beginning, by labeling each 

section of composition, which in 

the end allows you to gradually 

work way up until you have a 

finished product. 

 

You can lock, hide, rename and 

reposition each layer, which gives 

you a better view and 

understanding of what you’re 

creating. This way, you can focus 

on one thing at a time and explore 

different style options, which of course can be deleted or hidden until you’ve made a final 

decision. 

If you’re used to having just one layer, you probably know that it’s really hard to keep up 

with each shape, especially when you have groups and masks, so you might want to rethink 

your workflow by using multiple layers, which will make your life a lot easier. 

Learn how you can become more efficient by reading this tutorial on how to organize your 

document using layers for a cleaner workflow. 

 

• The Pathfinder Panel 

Number four off our list is the Pathfinder panel, or more exactly its four different Shape 

Modes, which allow you to create new shapes by manipulating the paths of two or more 

objects.  
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At this point, you might be thinking something’s off, since a few lines ago I said that 

the Clipping Mask is a better solution to Pathfinder. Well, if you need to adjust shapes and 

add effects and other elements, Clipping Masks will always be the more efficient way to 

go. But if you need to create an entirely new shape from something as simple as a rectangle, 

then Pathfinder is the way to go. 

 

You can use Unite, Subtract, Intersect and Exclude to create new and interesting shapes as 

long as you figure out which Mode is better suited for the job. 

 

The Minus Front Mode can be used when you need to cut things in half since can easily 

create a rectangle, position it over shape and then use it to create a cutout. 

Sure, there probably is a better solution for this, but as you’ll come to see in time, each tool 

can become a means to something entirely different from one creative tinkerer to another. 
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By default, the panel is hidden, so if you want to play with it you’ll have to go to 

the View top menu and scroll down until you find it within the list. As soon as you click 

on it, it will appear within your screen, giving you the possibility to position it wherever 

you want. 

You can combine vector objects to create shapes in a variety of ways in Illustrator. The 

resulting paths or shapes differ depending on the method you use to combine the objects. 

 

• Pathfinder effects 

Pathfinder effects let you combine multiple objects using interaction modes. When you use 

Pathfinder effects, you can’t edit the interactions between objects. See Combine objects 

using Pathfinder effects. 

Combine objects using Pathfinder effects 

Navigate the Pathfinder panel 

You use the Pathfinder panel (Window > Pathfinder) to combine objects into new shapes. 

Summary of Pathfinder effects 

Add 

Traces the outline of all objects as if they were a single, merged object. The resulting shape 

takes on the paint attributes of the top object. 

Intersect 

Traces the outline of the region overlapped by all the objects. 

Exclude 

Traces all nonoverlapping areas of the objects, and makes overlapping areas transparent. 

Where an even number of objects overlap, the overlap becomes transparent. Where an odd 

number of objects overlap, the overlap becomes filled. 

Subtract 

Subtracts the frontmost objects from the backmost object. You can use this command to 

delete areas of an illustration by adjusting the stacking order. 

Minus Back 

Subtracts the objects in back from the frontmost object. You can use this command to delete 

areas of an illustration by adjusting the stacking order. 

Divide 

Separates a piece of artwork into its component-filled faces (a face is an area undivided by 

a line segment). 

Note: When you use the Divide button in the Pathfinder panel, you can use the Direct 

Selection or Group Selection tool to manipulate the resulting faces independently of each 

other. You can also choose to delete or preserve unfilled objects when applying the Divide 

command. 
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Trim 

Removes the part of a filled object that is hidden. Removes any strokes and doesn't merge 

objects of the same color. 

Merge 

Removes the part of a filled object that is hidden. Removes any strokes and merges any 

adjoining or overlapping objects filled with the same color. 

Crop 

Divides artwork into its component-filled faces, and then deletes all the parts of the artwork 

that fall outside the boundary of the topmost object. It also removes any strokes. 

The Align Panel 

Whether you want to align an object to the Artboard or distribute multiple shapes at a 

specific distance, the Align panel is the best tool to handle the job. It’s easy to use and 

blazing fast in every way. 

You can use it every time with every project, since you can easily center the shapes to one 

another, or align them to a specific side without having to worry that the alignment isn’t 

perfect. 

By default, some of the panel’s options are hidden, so you will have to click on the little 

down-facing arrow and enable Show Options to make them visible. 

Once you do that, you’ll have a new function called Distribute Spacing, which will allow 

you to precisely position two or more shapes at a specified distance from one another. 

 

 

You’ll also gain control over the way the alignment is done, since you can choose between 

a Key Object or the Artboard itself. Otherwise, Illustrator will always align your objects to 

the first option. 

keep the Align To set to Artboard, since if you need to align an object to another one, you 

will simply select them and then click on the one that you want to act as the Key Object in 

order to set the alignment to it. 

Unit 

In Illustrator, a "unit" refers to the measurement system used to define the size and position 

of objects within the software. Illustrator offers several unit options, allowing users to work 

with their preferred measurement system.  
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3. The Ruler 

Whether you need to delimit your 

composition using precise guides or 

measure different objects off 

your Artboard, the Ruler should be your 

“go to tool”, since it was designed 

exactly for that use. 

Now, by default, the tool is hidden, but 

you can easily make it visible by 

pressing Control-R or by going to View 

> Rulers > Show Rulers. 

 

 

 

 

Once you turn it on, you can easily measure or set reference points by clicking on the top 

or left ruler bar and then dragging to create one or more guides, depending on what you are 

trying to achieve. 

I use rulers in combination with the Grid almost all the time, since they allow me to achieve 

balance within my compositions. They also make the process a lot easier, since I can 

precisely position everything using just a couple of clicks. 

If you’ve never played with the tool before, I honestly encourage you to try it out. I’m 

positive it will find a place within your workflow as soon as you start seeing its potential. 

You can give this quick tip a go since it will get you started with everything that you'll need 

to know in order to master Illustrator's Ruler tool.  

The Grid 

I talked about Illustrator's Grid system some 

time ago when I tried to go as in-depth as 

possible and explain all there is to know 

about what it is, and how it can be used in 

order to create better compositions. 

 

Even though it’s been out there for some 

time, all the information in that article is still valid, so I advise you check it out since I’m 

sure it will help you better understand how Illustrator works. Everything you create sits on 

top of a Grid, be it the default one or a custom one of your own choosing. 
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Snap to Grid / Pixel Grid 

The Grid itself is a strong tool, but once 

you start dabbling with pixel-perfect 

compositions, you’ll have to combine 

its power with that of the Snap to 

Grid / Pixel Grid in order to bring your 

game to the next level. 

I remember when I started out I used to 

create without giving any attention to 

the whole “is it pixel-crisp?” nature of 

my designs. Luckily for me, it didn’t 

take me long to realize that in my line 

of work (which is icon design), being 

detail oriented and obsessed with the 

way your objects snap to the Pixel Grid 

can set your work apart. 

So, if you’ve never used the Snap to 

Grid / Pixel Grid option from within 

the View menu before, I strongly 

advise you start learning and playing 

with it since at some point, in some 

project, you’ll find that having the 

ability to create with perfection is a 

must. 

For some months now I’ve been part of Adobe’s official test bench, where we’ve gotten 

the chance to see the future of the Snap to Pixel Grid, and even though things will change 

a bit, you’ll still be ahead of the rest if you spend a couple of hours and read what you can 

on the subject. 

Guide/ Smart Guide 
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4. Design Layout 

Design layout in Adobe Illustrator refers to the arrangement and organization of visual 

elements within a design project. It involves positioning and structuring various design 

components, such as text, images, shapes, and other graphic elements, to create a visually 

appealing and balanced composition. 

Design Principles: 

Here are some key aspects of design layout in Illustrator: 

Composition and Structure: Design layout in Illustrator focuses on creating a well-balanced 

and visually pleasing arrangement of elements. This involves considering the placement, 

size, and proportion of different design components. Designers use tools like grids, guides, 

and rulers to establish a solid foundation for organizing elements within the design space. 

Hierarchy and Readability: Design layouts aim to guide the viewer's eye and convey 

information effectively. Establishing a clear hierarchy ensures that important elements are 

emphasized and easily noticeable. Typography choices, text formatting, and visual cues 

such as size, color, and placement help create a logical flow and enhance readability. 

Alignment and Spacing: Proper alignment and spacing contribute to a visually cohesive 

and professional design. Elements should be aligned along vertical or horizontal axes, or 

based on a consistent grid system, to create a sense of order. Adequate spacing between 

elements, known as negative space or white space, helps to prevent clutter and allows the 

design to breathe. 

Visual Balance and Symmetry: Achieving visual balance is crucial in design layouts. It 

involves distributing visual weight evenly throughout the design to create a sense of 

equilibrium. Designers consider elements such as color, size, shape, and density to create a 

balanced composition. Symmetry, asymmetry, or radial balance can be employed to create 

different visual effects and dynamics. 

Grid Systems and Guides: Grid systems provide a framework for creating consistent and 

organized design layouts. Designers can use Illustrator's grid tools or establish their own 

custom grid to align elements and maintain visual harmony. Guides help in precise 

positioning and alignment of elements within the design. 

Responsive and Adaptive Design: With the rise of various devices and screen sizes, 

designing layouts that are responsive and adaptable has become essential. Designers in 

Illustrator can create flexible designs by utilizing tools like artboards, responsive resize, 

and liquid layout techniques. This ensures that the design maintains its integrity and 

readability across different devices and orientations. 

Prototyping and Mockups: Design layouts in Illustrator can be utilized to create prototypes 

and mockups of websites, apps, or printed materials. By placing design elements within a 

layout, designers can simulate the final look and feel of the project, allowing for better 

evaluation and feedback. 
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Essentials for layout design  

Jump-start your project with 

essential tips for creating a 

layout design in Illustrator. 

Illustrator is a powerful tool for 

designing icons, logos, posters, 

flyers, web and app designs, 

product packaging—and so 

much more. Here’s the general 

process for creating a layout 

design in Illustrator to jump-

start your project. 

 

Define your project 

Before diving into your design, consider what you're creating. A layout for print? Online 

ad? Both? When creating a layout in Illustrator, you first select a new document category: 

Print, Web, and more. Each category comes with important options, including the specific 

color mode required for each output type. 

 

Tip: Take advantage of the multitude of free templates available through Adobe Stock as a 

great way to kick-start your project! 
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Set up your artboards (pages) 

After creating your new document, you’ll need to set up artboards, which are like pages in 

a document, except with a lot more flexibility. Using the Artboard tool and Artboard 

Editing mode, you can organize them, overlap them, duplicate them (to create different 

versions, for instance), delete them, edit them, and more. 

 

Adding images and other graphics 

In Illustrator, you can add vector shapes and paths and bring images and other types of 

graphics into your layout. Images can be resized, rotated, traced, converted into shapes and 

paths, and transformed in other ways.  

Add graphic elements 

Create simple and complex shapes with shape tools, draw smooth lines and freehand curves 

with the Pencil tool, create elegant curves and precise angles with the Curvature tool. The 

options are almost endless. 
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Add and format text 

Illustrator’s powerful typographic features turn text into a unique design element. Combine 

text you create with the vast library of high-quality fonts in Adobe Fonts, included with 

your Adobe Creative Cloud membership.  

 

Align content for visual appeal 

By aligning content with a visible grid, individual guides or lines, or visual alignment tools 

like the Align panel options, you can create more appealing, streamlined designs. 
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Create versions 

Quickly create multiple versions of one project or multiple pieces, like a flyer, ad, and 

brochure, within the same Illustrator file using artboards. 

 

5. Marks 

a. Crop/ Cutting Marks 

Crop marks refer to the tick marks positioned on the corners of your file that indicate 

final trim. Since we print on oversized paper with bleeds, these tick marks help to guide 

us when we are trimming the print job down to the final size. 
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Creating Crop Marks Around Objects 

Step 1 

Select the Selection Tool (keyboard shortcut V) from the left toolbar. 

 

Step 2 

Select the object you want to create crop marks around using the selection tool. 

Step 3 

Go to the Object menu from the overhead toolbar and select Create Trim Marks. You'll see 

an editable set of corner marks at the four corners of your artwork. 
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Step 4 

You can also create 

crop marks as a live 

effect. To do so, go to 

the Effect menu from 

the overhead toolbar 

and select Crop Marks. 

 

 

 

Crop marks are the best way to guide the printer about where to trim the paper. I hope this 

article helped you to understand the notion of crop marks in Illustrator.  

b. Registration mark 

In Illustrator, a "registration mark" refers to a special type of mark used in printing to 

ensure accurate alignment of different color separations. Registration marks are 

typically small cross-shaped symbols that are placed outside the printable area of a 

design. 

Crop Marks Or Trim Marks: 

Crop marks — also called trim marks — thin lines placed at the corners of your artwork 

that indicate where to trim your finished project. If your paper is larger than your final 

cutting size, it is helpful and sometimes crucial to include them. Crop marks help the 

person cutting to know precisely where to cut your piece. 

When might it be important to have paper that is larger than your final size rather than 

a pre-cut size? For presses that grip the paper, using a larger sheet and making a finish 

cut allows you the paper edge or space to grip and guide the paper while printing, and 

provides space for you to use a guide pin (which may leave a mark on the paper). 

 

Crop marks become crucial if you are printing a bleed (which is a design that runs to 

the edge of the finished piece). A design with a bleed is one where the artwork extends 

a minimum of 1/8″ past the edge of the finished design. Extending your artwork past 

that point prevents a blank or unprinted area from showing up along the edges of your 

design. 
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Crop marks are added during the design stage of a project, and are an option in most 

design software. We’ll share tips for adding them below. 

Registration Marks: 

Registration marks are used when you have a piece that will have multiple applications 

during production. This could mean two or more letterpress ink colors, die cutting, foil 

stamping, or embossing. Registration marks are important for precision and placement. 

 

A piece that is mis-registered (as shown above) will show elements that may be side by 

side when they should have been on top of each other. There are many different forms 

of registration marks, but the most common are the “crosshairs” or “target” style marks, 

color bars and even using the lines of crop marks. 

 

These marks will eventually be trimmed off the final piece, and registration marks 

should also have crop marks added, too. Registration marks will appear on each plate 

that you make, and they should be aligned to overlap perfectly. 

Creating Crop Marks 

When creating crop marks in Adobe Illustrator there are two ways to make them: 

Option One 

Create crop marks in Adobe Illustrator by drawing a box using the rectangle tool (M) 

with no stroke or fill color the same size and position as the final trim. Using the direct 
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selection arrow (the white arrow tool), click on the box. In your color window, turn off 

the stroke by clicking the red diagonal line (none). 

 

Now click EFFECT > CROP MARKS (for all versions of Adobe Illustrator). You 

may also use OBJECT > CREATE TRIM MARKS (this is only available for Adobe 

CS6 and above). Lines will appear on each corner of the box. 

 

With the box still selected, click OBJECT > EXPAND APPEARANCE. You can now 

modify your crop marks, if needed. 
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6. Layer lock 

In Adobe Illustrator, layer lock is a feature that allows you to protect the content on a 

specific layer from being accidentally modified or edited. When you lock a layer, it 

prevents any changes to the objects or elements within that layer, such as moving, resizing, 

deleting, or editing them. 

Lock an Object in Illustrator: 

Select the object you want to lock then 

From the menu choose Object > Lock > Selection, or 

 

 
From the Layers panel, click the empty square in the lock column, or 

 
Use the keyboard short cut Ctrl + 2 (Windows) | Cmd + 2 (mac) 
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Locking an object makes it not selectable. You will not be able to move, edit or delete that 

object until you unlock it. Locked objects will show the lock icon in the Layers panel 

Unlock Objects in Illustrator: 

From the menu choose Object > Unlock All, or 

 
From the Layers panel, click the lock icon next to the object you wish to unlock, or 

Use the keyboard shortcut Ctrl + Alt + 2 (Windows) | Cmd + Opt + 2 (Mac) 

Using the menu or keyboard shortcut works fine for locking objects but for unlocking those 

methods unlock everything which is not always what you want. For simple designs with 

limited objects, no problem, but if you just spent the last 15 minutes locking various teeny, 

tiny shapes used in a grunge effect you are going to be frustrated! When working on more 

complex designs you are going to want to use the Layers panel to unlock your objects. 
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Self Check Sheet 1 

1. What is Professional Design? 
 

 

 

 

2. Write Some Professonal Design Works. 

 

  

3. What is rular? 

 

 

 

4. What is bleed marks? 
 

 

 
5. What is brochure? 

 

 

6. What is pen tool? 

 

 

7. What is eraser tool?  
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Answer Key 1 

 

1. What is Professional Design? 
Answer: Professional design refers to the creation of high-quality, polished, and 

visually appealing designs using the software's extensive features and tools. It involves 

utilizing Illustrator's capabilities to produce designs that meet industry standards and 

effectively communicate the intended message or purpose. 

2. Write Some Professonal Design Works. 
Answer: Some Professonal Design Works are: 

• Brochure 

• Invitation Card 

• Envelop 

• Folder 

• Poster 

• Complex Logo  
3. What is rular? 

Answer: Whether you need to delimit your composition using precise guides or 

measure different objects off your Artboard, the Ruler should be your “go to tool”, since 

it was designed exactly for that use. 

4. What is bleed marks? 
Answer: A bleed refers to the image beyond the final trim that will be cut off after the 

material has been printed and cut down. Bleeds are an important part of the printing 

process because even the smallest amount of misregistration or knife draw could leave 

finished work with white edges. 

 

5. What is brochure? 

A brochure is a type of printed material used for advertising, promotion, or 

information purposes. It is typically a folded piece of paper or cardstock that contains 

text, images, and graphics arranged in a visually appealing manner 

 

6. What is pen tool? 

The pen tool is probably the most important tool of the entire program. This Illustrator 

tool allows you to click in your workspace to create anchor points. By clicking and 

dragging these anchor points, you can maneuver their “handles”, which give your paths 

curvature and shape. 

7. What is eraser tool? 

The eraser tool erases. This tool really does come in handy if you want to get rid of a 

section of a vector object or path. Unlike the path eraser tool, this tool can erase entire 

sections of shapes, causing your vector shape to redraw its outside bounding lines.  
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Activity sheet: 1 

 

1. Follow OSH  

2. Check Connection and computer  

3. Start the Computer.  

4. Open Illustrator software.  

5. Use the design elements as per sample.  

6. Select the Pen Tool from the toolbar. 

7. Click and release on your artboard to create the first anchor point. 

8. Click and release to create another anchor point Save the file in ai format.  

9. Send the image file as JPEG format to the recipient.  

10. Shutdown computer and clean your workplace 

Sample 
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Learning Outcome 2: Create Design 

Content: 

1. Contents. 

1.1. Text 

1.2. Image 

1.3. Vector 

1.4. Logo 

2. Color/Design/Pattern. 

3. Pathfinder. 

4. Font Attributes. 

4.1 Font Face 

4.2 Font Style 

4.3 Font Size 

4.4 Alignment 

4.5 Case 

4.6 Indent 

4.7 Leading 

4.8 Tracking 

4.9 Baseline Shift 

4.10 Expand 

4.11 Condensed 

4.12 Tab Setting 

5. Zoom In-Out and Panning. 

Assessment Criteria:  

1. Contents are inserted. 

2. Color/Design/Pattern is applied. 

3. Pathfinder to create complex Objects are used. 

4. Font Attributes are applied as per requirement. 

5. Zoom In-Out and Panning are used. 

6. Design for further use is saved. 

 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 
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Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
  



 

46 

 

Learning Experience 2: Create Design 

In order to achieve the objectives stated in this learning guide, you must perform the learning steps 

below. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Apply 

Graphic Design Concepts 

and Guidelines. 

1. Instructor will provide the learning materials “Create 

Professional Designs using Illustration Software 

2. Read the Information 

sheet/s 

2. Information Sheet No:2 Create Design 

3. Complete the Self Checks 

& Check answer sheets. 

3. Self-Check/s 

Self-Check No: 2 Create Design 

Answer key No. 2 Create Design 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:2.1- Create visiting card procedure.    

 

Specification Sheet 2 – Create visiting card procedure.    
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Information Sheet 2: Create Design 
Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Insert Contents. 

2. Apply Color/Design/Pattern. 

3. Use Pathfinder to create complex Objects. 

4. Apply Font Attributes as per requirement. 

5. Use Zoom In-Out and Panning. 

6. Save design for further use. 

1. Contents 

In Adobe Illustrator, content refers to the visual elements and assets that make up a design. 

It includes various components such as shapes, text, images, colors, and patterns that are 

combined to create a visually appealing and engaging composition. 

Here are some key aspects of content in Illustrator design: 

Shapes and Paths: Illustrator allows you to create and manipulate various shapes and paths, 

such as rectangles, circles, polygons, and custom shapes. These can be used as the building 

blocks of your design or to create outlines for objects. 

Text: Illustrator provides powerful text tools for adding and formatting text in your designs. 

You can create both artistic and typographic text, adjust font styles, sizes, colors, and apply 

effects like outlines, shadows, and gradients. 

Images: You can import and manipulate raster images (such as photographs) or vector 

graphics (such as illustrations) in Illustrator. It supports file formats like JPEG, PNG, GIF, 

and AI (Adobe Illustrator's native format). Images can be scaled, rotated, cropped, and 

combined with other elements. 

Colors: Illustrator offers a wide range of color options. You can use solid colors, gradients, 

or patterns to fill shapes and text. The program also provides color palettes, swatches, and 

the ability to create custom color schemes. 

Effects and Styles: Illustrator includes a variety of effects and styles to enhance your design. 

These include drop shadows, glows, gradients, strokes, and various artistic filters. Effects 

can be applied to individual elements or the entire composition. 

Layers: Illustrator uses a layer-based system that allows you to organize and manage 

different elements of your design. Layers help you separate and edit objects independently, 

control their visibility, and rearrange their order. 

Symbols and Patterns: Illustrator enables you to create and save reusable elements called 

symbols. Symbols are objects or groups of objects that can be easily replicated and edited 

throughout your design. Similarly, you can create repeating patterns to fill areas with 

seamless designs. 

Artboards: Artboards are like canvas areas within Illustrator where you create your designs. 

They allow you to work on different sections or variations of your design within a single 

document. Artboards can be resized, rearranged, and exported as separate files. 
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Arrangement and Alignment: Illustrator provides tools for aligning and arranging objects 

precisely. You can align objects relative to each other or to the artboard, distribute them 

evenly, and group or ungroup elements for easier manipulation. 

1.1. Text: 

Text refers to a collection of characters, symbols, and numbers that convey meaning 

and can be read and understood by humans. It is a fundamental element of written 

communication and is used to express ideas, convey information, and facilitate 

understanding between individuals. 

In the context of digital technology, text is typically represented and stored as a 

sequence of encoded characters based on specific character encoding standards such as 

ASCII (American Standard Code for Information Interchange) or Unicode. Each 

character is assigned a unique numerical value, allowing computers to interpret and 

display text correctly. 

Text at a point 

Entering text this way is useful for adding a few words to your artwork. 

 

1. Select the Type tool or the Vertical Type tool. 

2. The pointer changes to an I-beam within a dotted box. The small horizontal line 

near the bottom of the I-beam marks the position of the baseline, on which the text 

rests. 

3. (Optional) Set text-formatting options in the Control panel, Character panel, or 

Paragraph panel. 

4. Click where you want the line of text to begin. 

5. Enter the text. Press Enter or Return to begin a new line of text within the same 

type object. 

6. When you finish entering text, click the Selection tool     to select the type object. 

Alternatively, Ctrl-click (Windows) or Command-click (Mac OS) the text. 
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Enter text in an area: 

 

Define the bounding area: 

• Select the Type tool        or the Vertical Type tool      and drag diagonally to define a 

rectangular bounding area. 

• Draw the object you want to use as the bounding area. (It doesn’t matter if the object 

has stroke or fill attributes, because Illustrator automatically removes them.) Then 

select the Type tool        , the Vertical Type tool            the Area Type tool         or 

the Vertical Area Type tool  and click anywhere on the object’s path. 

• (Optional) Set text-formatting options in the Control panel, Character panel, or 

Paragraph panel. 

• Enter the text. Press Enter or Return to begin a new paragraph. 

• When you finish entering text, click the Selection tool        to select the type object. 

Alternatively, Ctrl‑click (Windows) or Command-click (Mac OS) the text. 
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If you enter more text than can fit within an area, a small box containing a plus symbol 

(+) appears near the bottom of the bounding area. 

You can resize the text area or extend the path to display the overflow text. You can 

also thread the text into another object. 

Import text into a path/shape 

Place text from a supported file right inside an object, such as a shape. You can place 

text from files in the .txt or .rtf formats, or files from word-processing applications. For 

example, you can place text from a .rtf file into a polygonal shape. 

• Create a path/shape using any drawing tool, such as the Rectangle tool, Shaper tool, 

or the Pen tool. You'll place the text file within this shape. 

• Choose File > Place and select the text file you want to place. 

• Click Place. 

• After the text file is loaded in the place gun, click the path of the shape. 

• The text is placed inside the shape. You can now apply the desired styles and effects 

to it.  
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Typographic design 

Typographic design in Illustrator refers to the process of creating and manipulating text 

elements to visually communicate messages or enhance the overall design aesthetic. 

Illustrator offers a wide range of tools and features that allow for precise control over 

typography. 

1. Setting up the document 

Open Adobe Illustrator and create a new document (Ctrl+N) with the dimensions of 210 x 

297mm. 

 

With the Rectangle Tool (M), draw a rectangular of the document size and fill it with: 

R: 108, G: 179, B: 185 (#6cb3bb) 

If the layer has a stroke, remove it. 

Go to the Layers tab (Window › Layers or click F7), rename the current layer to “bg” (short 

for background), and lock it (Toggles Lock). Next, create a new layer called “text”. 
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2. Adding the text 

I’m going to use the famous quote by Rebecca Reubens, “Design is to invent with intent”. 

Feel free to choose another phrase that is close to your heart. It should be a short quote in 

order to keep the poster design crisp and balanced. 

Select the Type Tool (T), then pick a white fill color and remove the stroke. 

I use the following fonts: 

FabfeltScript Bold Regular (150 pt) for the word “Design” 

Roboto Slab Bold (42 pt) for the words “IS TO” 

Big John for the words “INVENT” (72 pt) and “INTENT” (70 pt) 

Roboto Slab Regular (30 pt) for the word “WITH”. Also, put Tracking=300 in the 

Character tab (Window › Type › Character or click Ctrl+T) 

 

Once all that is entered, you have the following mockup: 
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3. Creating a fancy arrow 

It’s now time to work on the details. Let’s add an arrow behind “IS TO”. 

Go to the Layers tab and lock the current layer. Create a new layer called “elements” and 

move it under the text layer. 

Set the fill color: 

R:244, G:206, B:47 (#f4ce2f) 

Pick the Rectangle Tool (M) and right-click on the layout. In the pop-up window, set the 

dimensions to 110 х 16mm. 

 

Use the Rectangle Tool (M) once again. Let the fill color remain R:244 G:206 B:47 

(#f4ce2f) and create a 124х10 mm rectangular. 
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Put a ruler guide in the layout center to align all the elements. To make sure that the guides 

are active, click View › Guides > Show Guides. Set the guide vertically at 105 mm and 

align the boxes according to this guide line. 

 

Now select the lower rectangular and use the Pen Tool (P) to add a point in the middle of 

the lower part of the box. With the same tool, remove the bottom corners to get an upside-

down triangle. 

Select it with the box above and in the Pathfinder tab (Window › Pathfinder or 

Shift+Ctrl+F9) pick Shape Modes: Unite. 

 

Right-click on the arrow, go to Transform › Move (or Shift+Ctrl+M) and set the following 

values: Position Horizontal – 2 mm and Position Vertical – 2 mm. Click Copy. Now you 

have a new element slightly shifted to the right and down. 

Fill the duplicate arrow with color: 

R:199, G:86, B:65 (#c75641) 



 

55 

 

Right-click on it and go to Arrange › Send to Back (or Ctrl+Shift+[) to move it to the 

background. 

You will need to modify the lower arrow to add some volume to the element. You will need 

the Pen Tool (P) to add necessary points and the Direct Selection Tool (A) to move them. 

 

It’s time to create the inner shadows. 

With the Rectangle Tool (M), create a 106 х 2mm rectangular. Align it in the center of the 

top border of the upper arrow. Hit Shift+Ctrl+M and shift it vertically by 2mm: Position 

Vertical – 2mm. This time click ОК, because you need to move this element without 

creating a copy. 

Now create a 2 х 14mm rectangular and align it to the top left corner of the previously 

created rectangular. With the Direct Selection Tool (A), select the lower right corner of the 

newly created box and drag it a little bit down until the lower part of this rectangular is 

parallel to the lower shadow of the arrow. 

 

4. Adding a shadow text effect 

In the Layers tab, lock the current layer, go to the text layer and activate it. Select the layer 

with “IS TO” and go to Object › Expand. 

 

Call the Move window, Transform › Move (or Shift+Ctrl+M), and set the same parameters 

as for the arrow shadow: 2 mm horizontally and 2 mm vertically and then click Copy. 
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Fill the shadow layer with: 

R:91, G:42, B:24 (#5b2a17) 

Hit Ctrl+Shift+[ and move it to the background. 

Apply the following color to the main text: 

R:44, G:139, B:139 (#2c8b8b) 

Here’s what you get: 

 

Now let’s edit this text shadow. Just like for the arrow shadow, use the Pen Tool 

(P) and Direct Selection Tool (A) to get the following effect. 
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As you can see, the shadows of the “I” and “T” don’t look right. You can easily fix this by 

adding one element to each letter. Remove the selection from all layers, take the Pen Tool 

(P) and add two triangles to make the shadow look real. Then hit Ctrl+Shift+] to move the 

green text over all layers. 

On the screenshot below I made the new elements red so you can see the shape I created. 

Of course, they should be the same color as the text shadow so they are not visible. 

 

5. Adding curved text 

Let’s proceed to the word “Design”. Delete it. That’s right. 🙂 Take the Pen Tool (P), 

remove the fill color and make the color of the stroke white. 

Draw a curve like on the screenshot below: 
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Using the Type Tool (T), left-click on the newly created arc. You will see the text cursor 

on the curved line. Type the word “Design” using the FabfeltScript Bold Regular font at 

150 pt size. 

 

Select this text and go to Object › Expand menu. Click ОК. Slightly center the text and 

move the left corner a little lower. Now it looks like this: 
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Now let’s add a shadow. The text style is different, so it would be nice to have a special 

shadow too. Select the word “Design” and in the Pathfinder tab (Shift+Ctrl+F9) select 

Shape Modes: Unite. 

Once again, open the Move pop-up (Shift+Ctrl+M) and set Position Horizontal – 2 mm and 

Position Vertical – 2 mm. Click Copy. 

Fill the new layer with the following color: 

R:199, G:86, B:65 (#c75641) 

Hit Shift+Ctrl+M and set Position Horizontal – 1mm and Position Vertical – 1mm. 

Click Copy again. Fill this layer with: 

R:33, G:77, B:90 (#214d5a) 

Here’s what you have now: 

 

To make it easier to work with the shadow, cut (Ctrl+V) the white “Design” layer. Create 

a new layer in the Layers window and paste the word “Design” there (Ctrl+F). Lock this 
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layer and turn its visibility off. Then go back to the text layer. Select the dark “Design” 

layer and hit Ctrl+Shift+[ to move it to the very bottom. 

You need to apply one of the overlay modes in the Pathfinder tab. Because of the font 

peculiarities you can see that the letter “D” is not connected to other letters. The same is 

true with the dot in the letter “i”. If you try to apply the effect now, you won’t get the 

necessary result. You’ll need to do it step by step. 

First, select both “Design” words and ungroup them hitting Ctrl+Shift+G. Now you can 

see that each element can be edited separately. 

Let’s start with the “D”. Select both layers and in the Pathfinder tab (Shift+Ctrl+F9) 

select Shape Modes: Minus Front. 

 

Do the same with the rest of the word. Then go back to the Layers tab, turn on the visibility, 

unlock the layer, and cut the white word “Design”. Press Ctrl+F to paste it to the text layer. 

Now select all the elements of the word “Design” and group them by clicking Ctrl+G. 

The fancy shadow is ready: 
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6. Creating a ribbon 

First, lock the current text layer in the Layers panel and unlock the “elements” layer. Apply 

the fill color: 

R:79, G:142, B:137 (#4f8e89) 

Hover the mouse over the Rectangle Tool in the Tools panel and select the Rounded 

Rectangle Tool from the list. 

 

Left-click on the poster layout and set the parameters of 124х28 mm with a corner radius 

of 100 mm. 

 

Using the Rectangle Tool (М) create a 14х14 mm square. Align it according to the upper 

left corner of the shape you created earlier. Copy this shape. Now select both of them and 

in the Pathfinder tab (Shift+Ctrl+F9) choose Shape Modes: Minus Back. 
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This shape will make corners for the ribbon. Hit Ctrl+F to reposition the basis of the ribbon 

that you copied earlier. Right-click on the corner and select Transform › Rotate. In the pop-

up, set the value to 90 degrees and click “OK”. Then create another 14×14 mm square using 

the Rectangle Tool (М). 

Using the Rectangle Tool (М) again, create a square with the dimensions of 14х14 mm. 

Adjust the shape like on the screenshot below: 

 

Select the square and the new triangle, go to the Pathfinder and choose Shape Modes: 

Unite. Duplicate the designed element and place it on the other end of the ribbon. 
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Select all elements of the ribbon, go to the Pathfinder and select Shape Modes:  

Unite. 

Select the created element and press Shift+Ctrl+M. In the pop-up set the Position 

Horizontal – 0 mm, Position Vertical – 32 mm, and click Copy. Select this element once 

again and set Position Horizontal – 0 mm, and Position Vertical – 32 mm in 

the Move window. Then click Copy. 

As a result, you get three identical elements with the same amount of space between them. 

Apply the following color to the top and bottom parts of the ribbon: 

R:72, G:165, B:160 (#48a5a0) 

Then select the top element. Right-click on it and select Transform › Reflect. Set 90 for 

Vertical. 

 

Select the bottom element and press Ctrl+D to repeat the previous action and turn the 

element. Using the Pen Tool (P), remove the right points from this part of the ribbon. 
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Take the Anchor Point Tool (Shift+C) and remove the guides from the corner points. With 

the Direct Selection Tool (A) make the length of this ribbon part the same as the other 

elements. Using the Pen Tool (P) put a point in the middle of the right side of the ribbon. 

Select this point with the Direct Selection Tool (A) and call the Move 

window (Shift+Ctrl+M). Set Position Horizontal -8 mm, Position Vertical – 0 mm, and 

click OK. 

Here’s what the element looks like now: 

 
Repeat the same actions for the other end of the ribbon, but instead of the value Position 

Horizontal – 8 mm set 8 mm in the Move window. 

If you’ve done everything right, you should get a ribbon like this. 
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7. Playing with invent and intent 

Let’s get back to the text. Lock the elements layer and go to the text layer. 

Choose the “INVENT” text and align it according to the ribbon. Then go to Object › 

Expand. In the pop-up window click OK. 

Fill this layer with: 

R:199, G:86, B:65 (#c75641) 

Hit Shift+Ctrl+M and enter Position Horizontal – 2, Position Vertical – 2, and click Copy. 

Fill the new layer with the following color: 

R:168, G:41, B:45 (#a8292d) 

Next, move it to the background with Shift+Ctrl+[. 

 

Just like with the “IS TO” shadow, use the Pen Tool (P) and Direct Selection Tool (A) to 

get a nice, realistic shadow. 
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To make the text more bright and fun, let’s add some dots. First, create a custom brush. 

Take the Ellipse Tool (L) and set Ellipse Width – 1.5 and Ellipse Height – 1.5. 

Apply the following color to the circle: 

R:248, G:235, B:220 (#f8ebdc) 

In the Brushes tab (Window › Brushes or F5) click on the drop-down list icon and 

select New Brush. 

 

In the New Brush window select Pattern Brush and click OK. 

In the next pop-up Pattern Brush Options name the brush “Dotter”, then set the value 

Spacing – 60% and click OK. 
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The brush is ready and you can delete the circle you created before. With the Pen Tool 

(P) draw a line in the middle of the letter “i”. Make sure that the line doesn’t have the main 

filling. Then click on your new brush in the Brushes panel and see what you get. 

 

Then we add dots to other letters. 
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Apply the same effects to the word “INTENT”: 

 

8. Adding a simple text effect 

Select the word “WITH” and go to Object › Expand. Click OK and apply the color: R:244 

G:206 B:47 (#f4ce2f). Hit Shift+Ctrl+M and set Position Horizontal – 1, Position Vertical 

– 1, and click Copy. 

Add the following color: 

R:78, G:46, B:32 (#4e2e20) 

Then send it to the background with Shift+Ctrl+[. 

Now you need to fix the shadow. You already know how that works. You’ll need the Pen 

Tool (P) and Direct Selection Tool (A). It’s almost ready! 
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9. Adding textures 

Go to the Layers tab and lock the current text layer. Create a new layer called “texture” and 

put it above the “bg” layer. 

 

Take the Rectangle Tool (M) and draw a rectangular of the document size. In 

the Swatches tab (Window › Swatches) choose Super soft Black Vignette. 
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Now let’s fix this gradient a little bit. In the Gradient panel (Window › Gradient or 

Ctrl+F9), create a gradient that goes from black in the center to white on the edges. Opacity 

should be 100% in both cases. 

 

Use the Gradient Tool (G) and adjust the new gradient. Make it oval and slightly wider than 

the poster layout. 
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Go to Effect › Pixelate › Color Halftone. In the pop-up window, set Max Radius to 20 px. 

In the Screen Angles fields set any identical values. 

 

Click ОК. Go to Object › Expand Appearance. To turn this raster layer to vector, 

click Image Trace in the top panel. 
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Then hit the Image Trace Panel icon and enter the following parameters: Model – Black 

and White. The Threshold should be close to maximum, 235 in our case. The Paths value 

should also be set to maximum. The Corners and Noise should be set to a minimum. Don’t 

forget to put a check mark to Ignore White. Close the window and hit Expand. 

 

Apply the following color: 

R:126, G:186, B:187 (#80c2c3) 

Now poster is ready 
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1.2. Image 

An image refers to a visual representation or depiction of something, typically 

captured, created, or displayed in a digital or physical format. It is a visual 

representation of an object, scene, concept, or idea that can be seen and interpreted 

by humans. 

In the context of digital technology, an image is often referred to as a digital image, 

which is made up of a grid of pixels (picture elements). Each pixel contains 

information about the color or grayscale value at a specific location within the image. 

Digital images can be stored, processed, and displayed using various file formats, 

such as JPEG, PNG, GIF, or TIFF. 

Images can be captured using cameras, scanners, or other imaging devices, or they 

can be created digitally using graphic design software, such as Adobe Photoshop or 

Adobe Illustrator. They can be photographs, illustrations, paintings, diagrams, charts, 

or any other visual representation. 

2. Color 

Select Color in Illustrator 

When working with complex designs or elaborate patterns, it’s daunting to have to 

individually select each vector object. Cut down on this process by learning how to select 

by color in Illustrator. With the Select dropdown menu located at the top of the program, 

you can activate specific colors with just two clicks. 

Begin by clicking a vector object with the Selection Tool (V), then navigate to the Select 

dropdown and choose from Fill Color, Fill & Stroke, or Stroke Color. You can achieve 
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the same effect by clicking Appearance, which will match vectors that closely mimic the 

selected object’s fill, stroke, or both.  

The Fill Color command will select objects that contain the exact hue as the vector object 

you have originally selected. The Stroke Color command activates vectors with the exact 

same stroke color regardless of its fill color. When the Fill & Stroke command is enabled, 

objects with both the same fill and stroke colors will be activated. These options give you 

acute control over selection, especially if you are working on patterns or designs with 

repeated colors. 

You can choose to recolor these selected vector shapes with the Color or Swatches panels, 

or you can compile them into a group for quicker selections in the future with Command + 

G.  

 

3. Design/Pattern 

In Adobe Illustrator, a pattern refers to a repeating design or motif that can be applied to fill 

an area or shape. Patterns are created using a combination of elements, such as shapes, lines, 

colors, or textures, that repeat in a regular or predictable manner. 

Patterns in Illustrator offer a versatile way to add texture, interest, and repetition to your 

designs. They can be used to create backgrounds, textures, clothing patterns, decorative 

elements, and more. Illustrator provides a variety of tools and options to create, edit, and apply 

patterns. 

Step 1: Create the shapes that you want to make the pattern of. If you have an existing 

image, that would work as well, but later you’ll have less flexibility for editing raster 

images.  

For example, I want to make a pattern from these objects.  
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Step 2: Select the image or shapes and go to the overhead menu Object > Pattern > Make.  

 

You’ll see this window telling you that your new pattern is added to the Swatches panel, 

etc.  

 

Now you’ll see the pattern in your document and a Pattern Options dialog box.  

https://illustratorhow.com/wp-content/uploads/make-pattern16.png
https://illustratorhow.com/wp-content/uploads/make-pattern1.png
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The box in the center showing the shapes you selected, is the Tile Type. In the next step, 

you’ll see the options to edit the pattern based on the tile type. 

If you’re happy with how the pattern looks right now, you can skip Step 3.  

Step 3 (Optional): Adjust the settings on the Pattern Options dialog box. You can start by 

changing the name of the pattern.  

 
Choose the Tile Type. It determines how the pattern will show. The default is Grid, which 

is a pretty common option, so you can keep it as is it.  
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The Width and Height are referring to the size of the tile type box.  

 
If you check Size Tile to Art, the box will attach to the artwork edges closest to the box.  

 

If you want to add some spacing, you can put the H Spacing and V Spacing values. If you 

put a negative value, the shapes can overlap.  

https://illustratorhow.com/wp-content/uploads/make-pattern8.png
https://illustratorhow.com/wp-content/uploads/make-pattern13.png
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Choose the copies of tile type, the default one is 3 x 3, you can add more if needed.  

 
Explore the options, and when you’re happy with how the pattern looks, go to the next 

step.  

Step 4: Click Done on top of the document window.  

https://illustratorhow.com/wp-content/uploads/make-pattern11.png


 

79 

 

 

The pattern will disappear from your window, but you can find it on the Swatches panel.  

 

 

 

4. Pathfinder 

Unite 

The 'Unite' option, understandable by its name, unites two objects or shapes as one with the 

same outline. The final object or form gets the color of the object that is on top. This tool 

is perfect for creating complex vector forms and putting them together. 

 

  

https://illustratorhow.com/wp-content/uploads/make-pattern10.png
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For example, take a look at the image. There are two circular objects of different 

colors. The blue object comes on top of the other object to unite and become a single 

form that acquires a full blue color.  

Minus Front 

Minus Front allows you to divide the object in the back by the object in the front. This 

means it removes the top shape layers and overlaps, leaving only the bottom form and 

color. 

  

 

In the image, you can see that the portion that was overlapped by the blue object was 

removed.  

Intersect 

Intersect traces the outline of the region that is overlapped by all of the objects. Its 

actions generate a new shape by displaying the overlapped portion and eliminating 

the top and bottom shape layers. 

 
Take a look at the image; when you use the Intersect option, you can see the portion 

excluding the common area that was shared by the two circular objects is eliminated. 

You will also find that the color of the intersected portion is that of the object on top. 

Exclude 

https://www.webdew.com/blog/layers-in-after-effects
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The name of the shape mode option says it all. The tool basically allows you to 

exclude the overlapped area and trace the rest of the objects together. The color of the 

final object gets the color of the top object like other options. 

 

  

In the image, you can see that the intersected area is eliminated using the Exclude 

option. Moreover, you might have also noticed that the color of the whole form is the 

color of the object that was originally on top.  

 

Pathfinders 

Divide 

When you select the divide option, all of the overlapped regions become their own 

independent piece of artwork. It divides the original shapes into three layers: top, 

overlap, and bottom, consisting of three separate paths. 

  

 

In the image, you may find some areas missing. These areas are the intersecting areas 

that are eliminated with the divide option.  

Trim 
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This option only removes the hidden part of the object in the back by the object at the 

top. Both the objects still have their own individual colors as a result. It doesn't merge 

the objects with the same color and removes the strokes. 

  

 

The image shows that the two shapes are separated, and the intersecting portion is 

trimmed off from the shape that lies at the bottom.  

Merge 

The Merge option also removes the hidden part of the object at the back by the object 

in the top like trim. But, the only difference in this option is that it merges the objects 

with the same color and removes the stroke, like the trim option. The difference 

between trim and merge is minute and confuses many designers. 

  

 

From the image, you can see that the shapes' merge' and form a single form just like 

it sounds. The color of the new form will be the same as the color of the shape on 

top.  



 

83 

 

Crop 

The crop option crops the bottom object and deletes elements of the artwork that fall 

outside the uppermost object's boundaries. It also gets rid of the strokes. 

  

 

From the image, you can see that I was able to crop the portions other than the 

intersecting portion by using crop. The new form, which is actually the intersecting 

portion, acquires the color of the shape lying below in the original.  

Outline  

As this option name says, it makes the objects into outlines or strokes. These outlines 

can then be individually selected using the Selection Tool (V) after being ungrouped 

with Shift+Command+G. 

  

 
From the image, you can see that the outlines of all images are traced using the outline 

option.  
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Minus Back 

It does the opposite of the minus front option. It subtracts the object at the top from 

the object in the back. 

  

 

From the image, you can see that the shape below and the overlapping portion get 

eliminated, leaving behind the rest of the shape on top.  

Font Attributes 

In typography and graphic design, a font attribute refers to a specific characteristic or 

style applied to a typeface. It modifies the appearance of the text, influencing factors 

such as the weight, style, size, spacing, and other visual properties of the characters. 

Here are some common font attributes: 

Typeface: A typeface is a particular design of characters, such as Arial, Times New 

Roman, or Helvetica. It defines the overall style and shape of the characters. 

 

Font Family: A font family refers to a group of typefaces that share similar design 

characteristics but may have variations in weight or style. For example, the Arial font 

family includes Arial Regular, Arial Bold, and Arial Italic. 

 

Font Style: Font style determines whether the characters are displayed in a regular 

upright position (roman), italicized, or in an oblique slanted position. Italic and 

oblique styles convey emphasis or a different tone. 

 

Font Weight: Font weight refers to the thickness or heaviness of the characters. 

Common weight variations include light, regular, bold, and extra bold. Different 

weights can be used to create visual hierarchy or emphasize certain text. 
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Font Size: Font size determines the overall height of the characters, measured in 

points. Larger font sizes make the text more prominent, while smaller sizes are used 

for finer details or smaller spaces. 

 

Kerning: Kerning refers to the adjustment of spacing between individual characters. 

It ensures that the spacing between adjacent letters appears visually balanced, 

improving legibility and aesthetics. 

 

Tracking/Letter-spacing: Tracking refers to the uniform adjustment of spacing across 

a range of characters or a block of text. It affects the overall density and appearance 

of the text, making it tighter or looser. 

 

Leading/Line-spacing: Leading refers to the vertical spacing between lines of text. It 

ensures proper readability and legibility by providing adequate space between lines, 

preventing them from appearing too crowded or too spaced out. 

 

Text Decoration: Text decoration attributes include underline, strikethrough, or 

overline, which add visual elements to the text to indicate emphasis, deletion, or 

decoration. 

 

Capitalization: Capitalization attributes determine whether the text appears in 

uppercase (all capital letters), lowercase (all lowercase letters), or a combination of 

both (title case or sentence case).  

Zoom In-Out 

In Adobe Illustrator, the Zoom In and Zoom Out functions allow you to adjust the 

view of your artwork, making it appear larger or smaller on the screen. Zooming in 

allows you to focus on details and work on precise elements, while zooming out 

provides an overview of the entire artwork or workspace.  
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Here's an explanation of how to use the Zoom In and Zoom Out functions in 

Illustrator: 

 

Zoom In: To zoom in and magnify your artwork, you can use one of the following 

methods: 

 

Using the Zoom Tool: Select the Zoom Tool from the Tools panel (shortcut key: Z) 

or press the Z key on your keyboard. Click on the area of the artwork you want to 

zoom in on, and Illustrator will magnify that portion. 

 

Using the Zoom In command: Go to the View menu at the top and choose "Zoom In" 

or use the keyboard shortcut: Command/Control + "+". Each time you use this 

command, the view will increase, making the artwork appear larger. 

 

Using the Zoom In tool in the Navigator panel: Open the Navigator panel by going to 

Window > Navigator. In the panel, click on the Zoom In button (plus sign icon) to 

magnify the artwork. 

 

Zoom Out: To zoom out and reduce the size of your artwork, you can use one of the 

following methods: 

 

Using the Zoom Out command: Go to the View menu and select "Zoom Out" or use 

the keyboard shortcut: Command/Control + "-". Each time you use this command, the 

view will decrease, making the artwork appear smaller. 

 

Using the Zoom Out tool in the Navigator panel: Open the Navigator panel and click 

on the Zoom Out button (minus sign icon) to reduce the view of the artwork. 

 

Using the Zoom Tool with Alt/Option key: When you have the Zoom Tool selected, 

holding down the Alt/Option key and clicking on the artwork will zoom out. 

 

Zoom Level Selection: You can also set a specific zoom level to quickly adjust the 

view. In the bottom-left corner of the document window, you'll find a zoom 

percentage indicator. Click on it and enter a specific value or choose from the 

available options in the drop-down menu. 

 

Fit to Screen: To quickly fit your entire artwork into the document window, you can 

use the "Fit Artboard in Window" command. Go to the View menu and select "Fit 

Artboard in Window" or use the keyboard shortcut: Command/Control + 0.  
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Panning 

In Adobe Illustrator, panning refers to the action of moving the viewable area of your 

artwork across the document window without changing the zoom level. It allows you 

to navigate and explore different parts of your artwork that may extend beyond the 

visible area.  

Make a Business Card in Adobe Illustrator 

After deciding what size you want your business card, the first thing to do is set up 

your document correctly.  

 

Step 1: Go to the overhead menu File > New or use the keyboard shortcut 

Command/Ctrl + N to create a document and change the document size. If you need 

to print them out, you should add bleeds. The standard bleed for the US is 0.25 inches 

or 6mm. 

 

For example, I’m going to make a US-standard business card size, so I’ll put 3.5 

inches x 2 inches for the Width and Height, and then 0.25 inches for the Bleeds. If 

you’re printing your business card, you should change the Color Mode to CMYK.  
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Click Create when you finish setting up your document. 

Step 2: Duplicate the Artboard as you’ll have the front and back sides of your business 

card. 

You can easily make a copy of the artboard by dragging a selected artboard to the 

New Artboard (plus sign) icon. If you don’t have your Artboard panel open, go to the 

overhead menu Window > Artboards to open it.  

 

Go ahead and fit the info and artwork within the artboard area.  

 
Step 3: Add text and design elements to the business card.  

Depending on the style of business card you create, this step really varies. You can 

create the simplest business card by only adding text and logo, and playing with the 

font, typography, color, and paper texture. Or you can create illustrations and add 

them to your business card.  

 
Step 4: Go to the overhead menu File > Save a Copy. If you want to print it out, 

choose to save the file on your computer instead of the Creative Cloud. Name your 

file if you haven’t already and change the file Format to Adobe PDF (pdf). 
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Once you click Save, you can edit the PDF settings. Go to Marks and Bleeds and 

change the Preset to a print preset. I usually choose High-Quality Print. 
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Self Check 2 

Answer the following questions: 

1. What is content in illustrator? 

 

 

 

 

 

 

2. What is file extention of vector image? 

 

 

 

 

 

3. What is EPS? 

 

 

 

 

 

4. What is Typographic design? 

 

 

 

5. Why we use design pattern in illustrator? 
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Answer Sheet 2 

1. What is content in illustrator? 

Answer: In Adobe Illustrator, content refers to the visual elements and assets that make 

up a design. It includes various components such as shapes, text, images, colors, and 

patterns that are combined to create a visually appealing and engaging composition 

2. What is file extention of vector image? 

Answer: .ai 

3. What is EPS? 

Answer:  An eps file is the gold standard for your logo files. It is a vector-based image, 

when exported from Adobe Illustrator, and is meant for print usage 

4. What is Typographic design 
Typographic design in Illustrator refers to the process of creating and manipulating text 

elements to visually communicate messages or enhance the overall design aesthetic  
5. Why we use design pattern in illustrator? 

Patterns in Illustrator offer a versatile way to add texture, interest, and repetition to your 

designs. They can be used to create backgrounds, textures, clothing patterns, decorative 

elements, and more. Illustrator provides a variety of tools and options to create, edit, and 

apply patterns  
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Job Sheet 2.1 

 

Job Title: Create Visiting Card Procedure.    Time:1 Hour 

 

 

 

 

 

 

Procedure/Steps  

1. Follow OSH  

2. Check Connection and computer  

3. Start the Computer.  

4. Open any graphics design software.  

5. Read the Specification Sheet.  

6. Use the design elements as Specification sheet.  

7. Save the file in PSD/ai format.  

8. Send the image file as JPEG format to the recipient.  

9. Shutdown computer and clean your workplace  
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Specification Sheet 2.1 

 

 

Follow the specification below:  

 

1. Set a 1024X1024px artboard  

2. Design a Visiting card by using design elements.  

3. Standard dimensions: 3.5 x 2 inches 

4. Bleed size: (Total size inc. bleed would be 3.75 x 2.25 inches) 

5. Font size:Larger than a 12pt and smaller than 8pt Font. 

6. Document Presets: Print 

7. Orientation: Horizontal 

8. Artboards: 2 

9. Color Mode: CMYK Color. 

10. Raster Effects: High (300ppi) 

11. Save File Format: Ai and JPEG. 
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Learning Outcome 3: Review and Finalize design works 

 

Content:  

1 Artwork and Preview. 

2 Layer Hide-Unhide. 

3 Outline and Group. 

4 Saving procedure with File Format. 

Assessment Criteria:  

1 Artwork and Preview is used. 

2 Layer Hide-Unhide option is used. 

3 Appropriate marks are used. 

4 Outline and Group Created. 

5 Appropriate File Format Saved. 

6 The image to recipient is transferred. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 3  

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Use and preview artwork. 

2. Use Layer Hide-Unhide option. 

3. Use Appropriate marks. 

4. Create Outline and Group. 

5. Save appropriate File Format. 

 

1. Artwork 

Artwork refers to the visual creations or designs that are created using the software. It 

encompasses all the graphical elements, compositions, and illustrations that are made 

within Illustrator's workspace. 

Artwork in Illustrator is typically created using vector graphics, which are based on 

mathematical equations and can be infinitely scaled without losing quality. This allows for 

precise control and flexibility in creating various shapes, lines, and curves.  

It refers to the visual designs, illustrations, graphics, and compositions created using the 

software. Illustrator is a powerful vector-based drawing program that enables artists, 

designers, and illustrators to create precise, scalable, and high-quality artwork for a wide 

range of purposes, such as print, digital media, branding, illustrations, and more. 

Art work set:  

Create New Document 

Go File>New Document to create your first document. Type in a Name for the document 

and click Advanced to select RGB for Color Mode as we will be working for the screen.  

Click Ok  after that. 

 



 

96 

 

 

 

Figer: step2 in illustrator 

 

figer: step3 in illutrator 

 

Figer: step1 in illustrator 
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2. Hide Objects in Illustrator 

Use the keyboard shortcut Ctrl + 3 (Windows) | Cmd + 3 (Mac), or 

In the Layers panel, click the eye icon to toggle it off next to the object you want to hide, 

or From the menu choose Object > Hide > Selection 

 

How to UnHide Objects in Illustrator (Show All) 

Unless you are using the Layers panel to hide and unhide objects, when you unhide you 

make EVERYTHING visible by “showing all”. 

Use the keyboard shortcut Ctrl + Alt +3 (Windows) | Cmd + Opt + 3 (Mac), or 

From the menu choose Object> Show All, or 

 
 

Toggle the eye icon on in the visibility column in the Layers panel (this will unhide that 

one object, group or layer) 
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How to Hide and Unhide Layers in Illustrator 

Using the Layers Panel gives us the most control over hiding and unhiding layers, groups 

and objects and the layers panel is the only place you can specifically hide layers.  It should 

be noted that the Layers panel has precedence over the menu and keyboard shortcut options. 

If you had hidden layers and objects choosing to unhide them from the menu or keyboard 

won’t work. The menu option will be greyed out. 

Click the Eye Icon to toggle it on or off in the visibility column of the Layers panel 

 

 

Show Hidden Layers 

Click the empty space in the visibility column next to the object you want to unhide to 

toggle the visibility on. 

3. Outline and group 

Step 1: Ensure that the object you’re applying the outline to is a vector path 

In order to create outlines in Illustrator we must first ensure that the subject we’re applying 

them to is a true vector path and not a bitmap, image, or text object. 
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For this demonstration I will be applying an outline to the following text object: 

 

In this tutorial we’ll be applying an outline to text. 

In order to apply an outline using the method in this lesson though we’ll need to convert 

this text object to a vector path. To do so, select it and navigate to: 

Type > Create Outlines 

Alternatively, you can use the keyboard shortcut, which is Shift + Control + O. 

Once applied, the text will no longer be an editable text object and will now simply be a 

vector path that is shaped like text. 

Create Group 

Step 1: 

Select the Objects with “Selection Tool”. 

The first thing you need to do is to select the objects, so go to the left toolbar and choose 

the “Selection Tool” (V). 
 

Drag the arrow over the objects you want to group to select them. You can group whatever 

type of object you want; there are no restrictions on shape, size, or other properties. You 

can also create a group that incorporates previously created groups. 
 

Keep in mind that you won’t be able to group the objects if they haven’t been previously 

selected. 

 

 
Step 2: 

Open your file or create a new one. 
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First, open the document that you want to work with by clicking on it, or once in Illustrator, 

you can go to “File”>“Open” on the top-menu and choose the file from there. 

 

If you aren’t currently working on a file, go to “File”>“New”. In this tutorial, we’ll be 

grouping objects, so you’ll need to create some in order to try this out.  

 

Select the “Rectangle Tool” from the left side toolbar and simply draw a few rectangles.  
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Step 3: 

Group the objects. 

You can now group the objects. It’s really simple, and there are a few different ways to go 

about it. I’ll go over everything with you. 

The first way is to right-click and select the “Group” option; it’s as simple as that. You can 

also use the “Ctrl+G” keyboard shortcut. 

 
 

Another way is to go to the top-menu, click on “Object,” and then select “Group.” 

 
Step 4: 

Open the “Layers” panel. 

When you create a group of different objects, you will then create a new layer for it, but all 

of the components will still be splitted on each of their layers inside. 

 

Layers are used in Illustrator, not at the same level as in Photoshop. But it is convenient to 

see the group’s layer in the “Layers” panel to see how they’re organized. 

 

To open the “Layers” panel, select “Window” in the main menu and then choose the 

“Layers” option.  
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You’ll notice that there is now a layer called “Group” in the “Layers” panel, which contains 

all of the layers that belong to the group you just created. 

 

 
4. Saving Procedure with file formats 

In Adobe Illustrator, file formats determine how the artwork and design elements are stored 

and shared. Different file formats have varying capabilities, compatibility, and intended 

uses. Illustrator supports various file formats for both saving and importing/exporting 

artwork. Here are some commonly used file formats in Illustrator: 

AI (Adobe Illustrator): AI is the native file format of Adobe Illustrator. It preserves all the 

editable vector-based elements, layers, effects, and other attributes of the artwork. AI files 

maintain the highest level of fidelity and are suitable for future editing and collaboration 

within Illustrator. 

PDF (Portable Document Format): PDF is a widely used file format that is compatible with 

many software applications and devices. When saving in PDF format from Illustrator, the 

resulting file preserves vector graphics, text, images, and other design elements. PDF files 

can be viewed, printed, and shared across different platforms while retaining the visual 

integrity of the artwork. 

EPS (Encapsulated PostScript): EPS is a file format that supports both vector and raster 

elements. It is commonly used for printing and is widely supported by many applications. 

EPS files can contain high-quality vector graphics, text, and images, making them suitable 

for professional printing purposes. 

SVG (Scalable Vector Graphics): SVG is an XML-based vector graphics format widely 

used for web and digital applications. It is supported by most web browsers and can be 

easily scaled without loss of quality. Illustrator can export artwork as SVG files, allowing 

for interactive and responsive graphics on the web. 

PSD (Adobe Photoshop Document): PSD is the native file format of Adobe Photoshop. 

Illustrator can import PSD files, preserving layers, text, and images, allowing for further 

editing or integration of Photoshop elements into Illustrator artwork. This is especially 

useful when working with complex designs that involve both raster and vector elements. 

JPEG (Joint Photographic Experts Group): JPEG is a commonly used image file format for 

web and digital purposes. While Illustrator primarily works with vector graphics, it can 

export artwork as JPEG files, which convert the vector elements to raster images. JPEGs 
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are widely supported and offer good compression, but they are not suitable for retaining 

vector-based editing capabilities. 

PNG (Portable Network Graphics): PNG is a lossless image file format commonly used for 

web graphics. Illustrator can export artwork as PNG files, which preserve transparency and 

support high-quality raster images. PNG files are ideal for images with sharp edges, logos, 

icons, or graphics that require a transparent background. 

DWG (AutoCAD Drawing): DWG is a file format used by AutoCAD for 2D and 3D 

drawings. Illustrator can import DWG files, allowing for collaboration and integration of 

AutoCAD drawings into Illustrator artwork. This is useful when working on architectural 

or technical designs that require both vector and CAD elements. 

 

Saving procedure: 

Saving Artboards in Adobe Illustrator 

Before we look at how to save files in specific formats, it's important to know how Adobe Illustrator handles 

artboards and how to save them as separate files. 

Artboards are like different pages within an Illustrator file. You can combine them into a single graphic, or 

save them as separate images. When you save an Illustrator file, you're normally asked how you want to 

handle artboards. What you decide affects how your final, exported image will look.  

  

In most cases, you decide through the File > Export > Export As option. Here's what you should do in 

different cases: 

If you want to save multiple artboards as separate files, check the Use Artboards box. Then select either All 

to save all the artboards, or enter a Range (such as 2-4) to specify which artboards to save. 

When you have objects placed outside of an artboard (like if it's overlapping the edge), check the Use 

Artboards box. This will ensure that your final image only contains what's inside the artboard and that the 

rest is cropped out. 

If all your artwork is within the artboard, and you only have one of them, simply uncheck the Use Artboards 

box. This will produce an image that is cropped to the bounds of the objects within it, with all white space 

removed. This is especially handy for outputting square or rectangular-shaped objects.  
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Save an Illustrator File as a JPEG 

For an illustration, infographic, or anything that needs to be printed (such as when you design a business card 

in Adobe Illustrator), the best option is to save it as a high-resolution JPEG. 

Ideally, you should design your artwork at roughly the size at which you want to output it. Although Illustrator 

images can be resized without any loss of quality, you'll find that the sizing between objects—and especially 

the spacing between the letters in your text—needs to be tighter at larger sizes than at smaller sizes.  

  

If you haven't previously worked in this way, create a new document, paste in your artwork, and tweak it to 

taste. You're now ready to save your high-resolution Adobe Illustrator (AI) as JPEG. 

Go to File > Export > Export As. Type in a filename and set Format to JPEG. 

Set how you want to save your artboards, then hit Export to continue. 

On the JPEG Options screen, change the Color Model if you need to, and choose quality. 

Under Options, set the output resolution. Screen (72 ppi) will produce a file the same size as your original 

document and should be good enough to use on the web. Choose High (300 ppi) for a high-res image. This 

will be good enough for printing. Click OK to save the file.  

Save an Illustrator File as a PNG 

When you need to save an image like a logo or icon for use on the web, especially if it has a transparent 

background, then you should save your AI file as a PNG. Even if you have a non-transparent background file, 

you can easily make a background transparent in Adobe Illustrator using the Image Trace tool.  
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To support standard and high-resolution displays, you should export your file at different sizes. Instead of 

manually exporting the file in different sizes, you can do this automatically. 

Follow the below steps to save your Adobe Illustrator file as PNG: 

Go to File > Export > Export for Screens. 

Select the Artboards tab. If there's more than one artboard in your image, choose the ones you want to output. 

Under Formats, set Format to PNG and Scale to 1x. 

Click on Add Scale. This will create the settings for a second image, so set the Scale option to a new relative 

size. 3x, for example, will output an image three times taller and wider than the original. 

Add more sizes if you need them. 

Click Export Artboard to save your images. 

Save Artboards as PDFs in Adobe Illustrator  

The simplest way to save an Illustrator file as a PDF is through the Save As option. However, if you are using 

more than one artboard, this will combine them all into a multi-page PDF.  

  

here's a simple trick to save artboards as separate PDF files: 

Go to Export > Export for Screens. 

In the dialog box that opens, click the Artboards tab and select those that you want to save. 

In the right-hand column, set Format to PDF, then hit Export Artboards. It may take a few 

seconds to output large or complex files. 

When done, your files will, by default, be saved in their own separate subfolder.   
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Self Check 3 

Choose the correct answer: 

Q1. In Adobe Illustrator we create our design and Illustrations on… 

A. Page 

B. Canvas 

C. Cardboard 

D. Artboard 

Q2. Maximum Number of artboards we can made in Adobe Illustrator CS6 are: 

A. 10  B. 100   C. 1000  D. 99 

Q3. Artwork in Adobe Illustrator which falls outside of printing box is known as 

A. Bleed  B. Slug  C. Margin  D. Spine 

Q4. How many types of Page Orientation is in Adobe Illustrator? 

A. 1  B. 2   C. 3   D. 4 

Q5. Can we Insert Gradients and Patterns in our stroke In Adobe Illustrator? 

A. Yes 

B. No 

Q6. Shortcut of Selection tool in Adobe Illustrator is… 

A. A  B. V   C. S   D. T 

Q7. For Hiding and Showing all Panels in Adobe Illustrator except Tool panel shortcut is… 

A. TAB 

B. CTR + TAB 

C. SHIFT + TAB 

D. ALT + TAB 

Q8. The Bar which appears in the lower left edge of Adobe Illustrator window is 

A. Tool Bar 

B. Document Bar 

C. Control Bar 

D. Status Bar 
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Answer Sheet 3 

Correct answers 

1. D 

2. B 

3. A 

4. B 

5. A 

6. B 

7. C 

8. D  
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Job Sheet 3-1:  

 

Job Title:  Make Editable transparent background  Time:1 Hour 

 

 

 

 

 

 

 

 

 

 

 

 

 

Procedure/Steps  

1. Follow OSH  

2. Check Connection and computer  

3. Start the Computer.  

4. Open any graphics design software.  

5. Read the Specification Sheet.  

6. Use the design elements as Specification sheet.  

7. Save the file in PSD/ai format.  

8. Send the image file as JPEG format to the recipient.  

9. Shutdown computer and clean your workplace  
  

 

Figure 01: transparent background 
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Specification Sheet 3-1 
 

Job Title:  Make Editable transparent background 

 

Condition for the job: Work must be carried out in a safe manner according to CS 

Level-3 standards 

To perform the follow the instruction below: 

1. Standard dimensions: 5 x 3 inches 

2. Document Presets: Print 

3. Orientation: Horizontal 

4. Artboards: 2 

5. Color Mode: CMYK Color. 

6. Raster Effects: High (300ppi) 

7. Save File Format: PDF and PNG. 
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Review of Competency 

Below is yourself assessment rating for module “Create Professional Designs using 

Illustration Software” 

 

Sl 

no 
Assessment of performance Criteria  Yes No 

1.  Required Professional Design work are selected.   

2.  Appropriate Tools, Palette and arrange them as needed are identified.   

3.  Ruler/unit/Grids/Guides/Smart Guides as per requirement are set   

4.  Key Drawing / Design Layout are prepared   

5.  Marks are interpreted.   

6.  Layer lock is applied   

7.  Contents are inserted.   

8.  Color/Design/Pattern is applied.   

9.  Pathfinder to create complex Objects are used.   

10.  Font Attributes are applied as per requirement.   

11.  Zoom In-Out and Panning are used.   

12.  Design for further use is saved   

13.  Artwork and Preview is used.   

14.  Layer Hide-Unhide option is used.   

15.  Appropriate marks are used.   

16.  Outline and Group Created.   

17.  appropriate File Format Saved.   

18.  The image to recipient is transferred.   

 

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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The Competency Based Learning Material (CBLM) of ‘Create professional design using 

illustration software’ (Occupation: Graphic Design, Level-3) for National Skills Certificate 

is developed by NSDA with the assistance of SIMEC System, ECF consultancy & SIMEC 

Institute JV (Joint Venture Firm) in the month of June 2023 under the contract number of 

package SD-9A dated 07th May 2023. 

 

Sl No. Name & Address  Designation Contact number  

1  Fatema Tuj Johura Arzu  Writer 01912 464 747 

2  Tania Akter Editor 01614 716 192 

3  Md. Amir Hossain  Co-Ordinator 01631 670 445 

4  Md. Saif Uddin Reviewer  01723 004 419 

 



 

    
 

 

 

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

  

 

 

 

 

 

Competency Based Learning Materials (CBLM) 

 

 

Graphic Design 
 

Level-3 

 

Module: Separate and Compose Images 

(Code: CBLM-ICT-GD-03-L3-EN-V1  

 

National Skills Development Authority (NSDA) 

Prime Minister’s Office, 

 People’s Republic of Bangladesh 

National Skills Development Authority 

Prime Minister’s Office 

Government of the People’s Republic of Bangladesh 



 

 

    
 

 



 

 

   
 

 
Copyright 

 

National Skills Development Authority 

Prime Minister's Office 

Level: 10-11, Biniyog Bhaban,  

E-6 / B, Agargaon, Sher-E-Bangla Nagar Dhaka-1207, Bangladesh. 

Email: ec@nsda.gov.bd 

Website: www.nsda.gov.bd. 

National Skills Portal: http:\\skillsportal.gov.bd 

 

Copyright of this Competency Based Learning Material (CBLM) is reserved by National Skill 

Development Authority (NSDA). This CBLM may not be modified or modified by anyone or 

any other party without the prior approval of NSDA. 

The CBLM on “Separate and Compose Images” is developed based on NSDA approved 

Competency Standards and Competency Based Curriculum under Graphic Design Level-3 

Occupation. It contains the information required to implement the Graphic Design Level-3 

standard.  

This document has been prepared by NSDA with the help of relevant experts, 

trainers/professionals. 

All Government-Private-NGO training institutes in the country accredited by NSDA can use 

this CBLM to implement skill-based training of Graphic Design Level-3 course. 

 

  

file:///C:/Users/md.amir%20hossain/OneDrive/Desktop/Review%20of%20AMIR%20HOSSAIN/Word%20File/www.nsda.gov.bd
file://///skillsportal.gov.bd


 

 

   
 

 

 

 

 

 

 

 

 

 

  



 

 

   
 

 

 

 

 

 

 

 

Approved by 

 

---th Executive Committee (EC) Meeting of NSDA 

 

Held on ------------------- 

 

 

 

 

 

 

 

 

 

 

 



 

ii 

 



 

iii 

 

Table of Contents 

 

Copyright ............................................................................................................................. ii 

List of Abbreviations ..................................................... Error! Bookmark not defined. 

How to use this Competency Based Learning Materials (CBLMs) ................................... 1 

Module Title: Separate and Compose Images ................................................................... 3 

Learning Outcome 1: Separate Images .............................................................................. 5 

Information Sheet 1.1: Separate Images .............................................................................................................7 

Learning Outcome 2: Create a Composition ...................................................................33 

Self Check 2.1 ................................................................................................................................................. 52 

Learning Outcome 3: Retouch Image ..............................................................................54 

Self Check 3.1 ................................................................................................................................................. 80 

Learning Outcome 4: Apply Color Correction ............................................................... 83 

Self Check 4.1 ............................................................................................................................................... 101 

Learning Outcome 5: Apply Effects .............................................................................. 103 

Self Check 5.1 ............................................................................................................................................... 119 

Learning Outcome 6: Evaluate own work .................................................................... 122 

Self Check 6.1 ............................................................................................................................................... 127 



 

 

 



 

 

 

 

How to use this Competency Based Learning Materials (CBLMs) 
  

The module, Separate and Compose Images contains training materials and activities for 

you to complete. These activities may be completed as part of structured classroom 

activities or you may be required you to work at your own pace. These activities will ask 

you to complete associated learning and practice activities in order to gain knowledge and 

skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning 

activities you will undergo. This page will serve as your road map towards the 

achievement of competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or 

tasks you are going to learn how to do. Once you have finished reading the 

Information Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to 

help you know how you are progressing.  If you are unable to answer the questions 

in the Self-Check you will need to re-read the relevant Information Sheet. Once 

you have completed all the questions check your answers by reading the relevant 

Answer Keys found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about 

how to do the job you are being trained in. Some Job Sheets will also have a series 

of Activity Sheets. These sheets have been designed to introduce you to the job 

step by step. This is where you will apply the new knowledge you gained by reading 

the Information Sheets. This is your opportunity to practise the job. You may need 

to practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be 

provided where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the 

required assessment criteria have been met. This record is for your own information 

and guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of 

others in the training room. Should you require assistance or clarification please consult 

your trainer or facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved 

competency in the specified learning outcomes. You will then be ready to move onto 

the next Unit of Competency or Module  
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Module Content 

 

Unit of Competency: Separate and Compose Images 

Module Title: Separating and Compose Images  

Module Description: This module covers the knowledge, skills and attitudes required to 

separate and compose images. It specifically includes separating 

images, creating a composition, retouching image, applying color 

correction, applying effects, and evaluating own work.    

Nominal Duration: 60 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Separate Images  

2. Create a composition  

3. Retouch Image 

4. Apply color Correction 

5. Apply Effects 

6. Evaluate own work  

 

Assessment Criteria: 

1.1. Image is selected 

1.2. Required tool is selected 

1.3. Clipping path is created 

1.4. Image is separated from background 

2.1 New document is created 

2.2 Images are pasted for edit 

2.3 Layers are created and selected. 

2.4 Images are edited and arranged. 

3.1 Appropriate retouch tools are identified 

3.2 Tools are calibrated as required 

3.3 Layers are created and preserved 

3.4 Retouch tools are used as per requirement 

3.5 Images are corrected and saved in appropriate file format 

4.1 Color correction methods are identified 

4.2 Appropriate image mode is selected 

4.3 Color correction methods are used 

4.4 Image enhancement is compared with the original one 

4.5 Design is saved in appropriate file format 

4.6 Final image is transferred to recipient 

5.1 Identify appropriate effect options 
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5.2 Proper image mode is selected 

5.3 Effects are applied to images/ layer as per requirements 

5.4 Effects are compared and adjusted 

5.5 Image is saved in appropriate file format 

5.6 Image is transferred to recipient 

6.1 Constructive criticism from others is applied to improve own works. 

6.2 Own works are evaluated against planned Strategy for own practice. 

Contents  

This learning package includes the following:  

1. Images separation  

2. Composition creation 

3. Image retouching 

4. Color correction 

5. Effects 

6. Own work evaluation 
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Learning Outcome 1: Separate Images 

 

Content: 

1. Image separation tools 

a. Magic wand tool 

b. Lasso tool 

c. Pen tool 

2. Clipping path  

Assessment Criteria:  

4. Image is separated from background 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

 Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
  

1. Image is selected 

2. Required tool is selected 

3. Clipping path is created 
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Learning Experience 1: Separate Images 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Develop 

Competency Based 

Training Curriculum. 

1. Instructor will provide the learning materials 

“Separate and Compose Images 

2. Read the Information 

sheet/s 

2. Information Sheet No:1 Interpret fundamentals of 

graphic design 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 1 Interpret fundamentals of graphic 

design 

Answer key No. 1 Interpret fundamentals of graphic 

design 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:1- Interpret fundamentals of graphic 

design 

Specification Sheet1 – Interpret fundamentals of 

graphic design 
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Information Sheet 1: Separate Images 

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Image is selected 

2. Required tool is selected 

3. Clipping path is created 

4. Image is separated from background 
1. Image 

An image is a visual representation or depiction of something, typically created or captured 

through various methods, such as photography, digital art, painting, or graphics. It is a 

two-dimensional representation that can be viewed or perceived by the human eye or by 

electronic devices. 

In Adobe Photoshop, there are several tools and techniques you can use to separate or 

isolate elements within an image. Here are some commonly used tools for image 

separation: 

Magic Wand Tool: The Magic Wand Tool allows you to select areas of similar color or 

tone in an image. By clicking on a specific area, the tool selects contiguous pixels with 

similar attributes, making it useful for selecting and separating specific regions of an 

image. 

Quick Selection Tool: The Quick Selection Tool helps you make quick selections based 

on the edges and contrast in an image. You can brush over the desired areas, and the tool 

automatically detects and selects similar regions. This tool is particularly effective for 

separating objects with well-defined edges. 

Pen Tool: The Pen Tool is a versatile tool that allows you to create precise paths and 

selections by placing anchor points and adjusting curve handles. You can manually trace 

the contours of an object to create a path, which can be used for separation or to create 

complex selections. 

Lasso Tool: The Lasso Tool enables you to manually draw selections around specific areas 

of an image. It offers different variations, including the standard Lasso Tool, Polygonal 

Lasso Tool, and Magnetic Lasso Tool. The Polygonal Lasso Tool allows you to draw 

straight-sided selections, while the Magnetic Lasso Tool snaps to the edges of objects for 

more accurate selections. 

a. The Magic Wand Tool 

Remove A Background with The Magic Wand Tool in Photoshop 

When making complex selections, you can alter the settings to correctly select the 

background. You can also use the Select and Mask workspace to touch up your 

selection, and achieve the best results possible. For this example, the background has 

more color tones, but there are also complex edges around the feathers to deal with. 
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To select the background, select the magic wand tool in the toolbar. 

 

 

 

Then, go up to the Options bar to adjust a few 

settings. In case you have different hues in your 

image, it is a good idea to increase the Sample 

Size so that you can add more pixels as the basis 

for your selection. 

 

In my case, I increased the sample size to 5×5 because my background has green, 

brown, and even gray tones. 

 

You can set tolerance to 32, which is the default tolerance value. You can change this 

value later if you need to. 
 

 
 

You should always leave Contiguous and Anti-alias checked when removing 

backgrounds. Anti-alias minimizes imperfections on the selection’s edges, and 

Contiguous will ensure that only the background is selected.  
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With all the magic wand tool settings adjusted, you can start making your selection by 

clicking anywhere in the background of your image.  

 

 
 

To add content to your selection, hold in Shift while clicking on other areas of your 

image. You can also press Shift and then drag over the area you want to add to the 

selection. The goal here is to select the entire background.  

 
 

While making your selection, you may end up selecting more than you should. In my 

case, I was selecting the background and ended up selecting parts of the eagle’s neck.  

 
 

If something like this happens to you, press Alt (Win) or Option (Mac) and click the 

area to subtract the extra content from your selection.  
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Repeat the steps until you finish selecting the entire background. When you’re finished 

selecting your image background, click the layer mask icon at the layers panel to create 

a new layer mask.  

 
 

 
 

 
 



 

11 

 

 

In the context of graphics, tolerance refers to the acceptable degree of variation or 

deviation allowed in the size, shape, position, or other characteristics of graphical 

elements or objects. It is an important concept in design and manufacturing processes 

to ensure that the final product meets specified standards and requirements. 

Tolerance is primarily applied in two areas: 

Geometric Tolerance: Geometric tolerance specifies the allowable variation in the 

form, size, orientation, and location of geometric features in a design. It ensures that 

the dimensions and relationships between different elements are within acceptable 

limits. Geometric tolerance is often represented using symbols and annotations on 

technical drawings or blueprints. 

For example, a geometric tolerance may specify that a hole should be within a certain 

diameter range, or that two surfaces should be parallel within a specified tolerance 

value. This allows for some degree of variation during the manufacturing process while 

still ensuring the functionality and fit of the final product. 

 

Color Tolerance: Color tolerance relates to the acceptable deviation in color 

reproduction or matching. In graphics and printing, it refers to the allowed difference 

in color between the intended design and the actual output. Color tolerances are defined 

using color spaces, such as RGB (Red, Green, Blue) or CMYK (Cyan, Magenta, 

Yellow, Black). 

Color tolerance accounts for variations in color reproduction due to different devices, 

printing processes, substrates, and lighting conditions. It ensures consistency and 

accuracy in color reproduction across different mediums and production environments. 

b. The Lasso Tool in Photoshop provides an easy way to draw freehand selections around 

an object. This selection tool’s advantage is that it feels a lot more intuitive than other 

selection tools. However, being that it creates freehand selections, it often needs a lot 

of refinement before you have an accurate selection. 

Even though refinement may be necessary, the Lasso Tool isn’t a lost cause. In reality, 

there are various reasons you might way to use this selection tool over others. Let’s 

dive into each of those reasons, as well as how to use the Lasso Tool in Photoshop. 

The Lasso Tool is best used to create selections along simple edges without too many 

bends or curves. Since it creates selections simply by dragging your mouse, it takes an 

extremely steady hand to get an accurate selection. That’s why this tool is best used in 

situations where you need a quick and painless selection method. Something like 

making a selection around a rectangular building or cutting out the smooth edges of a 

coffee cup. 
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Since the Lasso Tool creates paths by following the movement of your cursor, this tool is 

not ideal for making complicated selections. Something like tree branches or hair would 

be an absolute nightmare to cut out with this tool. Instead, it thrives where there are simple, 

well-defined edges that you can easily follow along. 

I tend to use the Lasso Tool for projects that I need to quickly see how a cut out will look 

in another photo. Rather than futzing with a more complicated selection method like the 

Pen Tool, the Lasso Tool gets the job done in less than half the time. Once you have an 

idea of the selection you want, you can always go back in and refine it with a more precise 

selection tool. 

The 3 Types of Lasso Tools 

The Lasso Tool, by itself, is pretty basic and limited in its uses. Luckily, there are three 

different types of Lasso Tool in Photoshop that help to make the selection process much 

easier. All of these tools can be found within the Lasso Tool option or by pressing L on 

your keyboard. You can hold Shift + L to cycle through each of these tools automatically.  
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Lasso Tool  

 
The Lasso Tool is the most basic version you can use. By clicking on a starting point in 

your canvas, simply drag your cursor around your object to create a path. The Lasso Tool 

will follow your mouse’s exact movements all the way back around to the starting point. 

From here, it will create a selection that you can use for layer masks or cutting out the 

image out from the background.  

Polygonal Lasso Tool  

 

Rather than drawing a freehand selection, the Polygonal Lasso Tool creates straight lines 

between each click of your mouse. With this tool selected, you can click on a point to 

begin your path. From here, drag your cursor to another point along your edge to create a 

second anchor point. The Polygonal Lasso Tool will automatically connect these two 

points with a perfectly straight line. If you need to cut out something that’s box-shaped or 

has flat edges, this is the Lasso Tool for you.  

Magnetic Lasso Tool  

 
 

The third type of Lasso Tool is called the Magnetic Lasso Tool. Rather than manually 

selecting where the path will follow, the Magnetic Lasso Tool is a bit more automated. As 

long as you’re going along a well-defined edge in your photo, this tool will automatically 

snap the Lasso Path to the edge. Best of all, this even works along complicated or uneven 

edges like the leaf shown below! The Magnetic Lasso Tool is my favorite version of the 

Lasso Tool in Photoshop and tends to be my go-to while making Lasso selections.  
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Use The Lasso Tool 

To access the Lasso Tool, press L on your keyboard or find it in your toolbar. This type 

of Lasso will be a simple Lasso icon like you’d expect to see in a wild west movie. 

Before you start to make a selection, take a quick look at your upper setting bar and set 

the feather radius you want for your selection. For a nice and sharp edge around your 

selection, leave the feather set to 0px. On the flip side, if you want a nice soft, blurred 

out edge, increasing the feather radius to something like 20px or 30px will do just that. 

Whatever you choose, you’ll need to settle on this before you start to make your 

selection!  

 

Next, make sure your selection type is set to “new selection” by clicking on the solid-

colored square icon. 

 

Now it’s time to create your selection. Click somewhere along the edge you want to 

select and begin to drag your cursor along that edge. The Lasso Tool will create a path 

behind your cursor to be used as your new selection area. 
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From here, you can delete the background, add your selection to a layer mask, or cut 

and copy your selection area for another image. Simply right-click inside of the Lasso 

Tool path to see the options you have available to you 

 

C. Pen tool  

The Pen Tool in Photoshop creates paths and shapes which can be duplicated and 

manipulated to create complex selections, masks and objects. Unlike the Brush Tool 

and Pencil Tools, which “draw” pixels onto your image, the Pen Tool always creates 

a vector path when used. 

You can create multiple paths within an image, and you can create multiple path 

segments within a path. These paths appear as either Work Paths or Shape Paths in the 

Paths Panel.  

The Pen Tool in Photoshop can become your go-to tool every time you need to isolate 

a portion of an image from its surroundings. 

Photoshop’s Pen Tool is an excellent way to remove a product from its background or 

select a portion of a product image to change its color. And you can modify, store, and 

reuse the paths created with the Pen Tool as often as you want. 
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The Pen Tool in Photoshop 

The Pen Tool in Photoshop creates paths and shapes which can be duplicated and 

manipulated to create complex selections, masks and objects. Unlike the Brush Tool 

and Pencil Tools, which “draw” pixels onto your image, the Pen Tool always creates 

a vector path when used. 

You can create multiple paths within an image, and you can create multiple path 

segments within a path. These paths appear as either Work Paths or Shape Paths in the 

Paths Panel. 

Shape Paths vs. Work Paths in Photoshop 

Shape Paths created with the Pen Tool allow you to create custom shapes on your 

image which you can use to call out specific portions of an image. Unlike shapes 

created with the standard Shape Tools (such as the Rectangle Tool or Ellipse Tool), 

shapes created with the Pen Tool can be manipulated any way you want. 

Work Paths, on the other hand, are Photoshop’s way of storing path information 

without applying any color to the path. Once these Work Paths are saved within the 

Paths panel, they can be made into selections, modified, and reused as many times as 

you need. 

By default, the Pen Tool is located in the lower half of the Toolbar. If you click and 

hold on the Pen Tool in the Toolbar, you’ll see six separate Pen Tool options in 

Photoshop CC 2022 (if you’re using an older version of Photoshop, you may only see 

five Pen Tool options).  

 

If you’re not working in the default workspace, some 

of these Pen Tool options may need to be accessed by 

clicking on the three dots at the bottom of the Toolbar 

and adding the extra Pen Tool options to the Toolbar.  

Types of Pen Tools in Photoshop 

In Photoshop CC 2022, there are four different Pen 

Tools you can use to create a new path: 

The standard Pen Tool 

The Curvature Pen Tool 

The Freeform Pen Tool 

The Magnetic Pen Tool (only visible by adjusting the settings of the Freeform Pen 

Tool) 

The other Pen Tool options are used to modify an existing path. Those tools are: 

The Add Anchor Point Tool 

The Delete Anchor Point Tool 

The Convert Point Tool  
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The Pen Tool in Photoshop can become your go-to tool every time you need to isolate 

a portion of an image from its surroundings. 

Photoshop’s Pen Tool is an excellent way to remove a product from its background or 

select a portion of a product image to change its color. And you can modify, store, and 

reuse the paths created with the Pen Tool as often as you want. 

The Paths Panel in Photoshop 

The Pen Tool and the Paths Panel go hand in hand, so you’ll need the Paths Panel to 

be visible when you begin to use the Pen Tool. 

In the Essentials (default) workspace, Paths are accessible by clicking on the Paths tab 

visible in the Layers Panel. If you don’t see a Paths Panel in your workspace, you can 

access Paths by clicking on the Windows dropdown menu and selecting Paths. 

 

The Standard Pen Tool 

We’ll use the standard Pen Tool for the paths we’ll be creating in this exercise. It’s the 

original Pen Tool and is very similar to the Pen Tool in Adobe Illustrator. You 

can create just about any kind of path with this tool. 

 

The Freeform Pen Tool 

The Freeform Pen Tool allows you to draw with the Pen Tool in the same way you 

would draw with the brush tool, creating a path as you draw. 

 
The Magnetic Pen Tool 

https://pathedits.com/blogs/tips/step-by-step-guide-remove-background-photoshop
https://pathedits.com/blogs/tips/how-to-create-a-clipping-path-in-photoshop-2021
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With the Freeform Pen Tool selected, you can check the Magnetic option at the top of 

the application window and access the Magnetic Pen Tool. 

 

The Magnetic Pen Tool works much like the Magnetic Lasso Tool, allowing you to 

trace the exterior of a shape within your image. It’s not perfect, however, so we suggest 

you work with the Standard Pen Tool whenever possible. 

The Curvature Pen Tool 

The Curvature Pen Tool automatically lays down curves between points as you draw 

your path. This is a great tool to use if the path or shape you want to create has curved 

edges. You can always adjust the curves after the path is created by using the selection 

tools and modifying tools discussed below. 

 
The Add Anchor Point Tool 

The Add Anchor Point Tool gives you the ability to add more points onto your path 

once it’s been created. Hover the Add Anchor Point Tool over the part of the path 

where you want to add a new point and click the mouse to create the point. 

 
The Delete Anchor Point Tool 

The Delete Anchor Point Tool removes points from your path after the path has been 

completed. Hover your cursor over the point you want removed and click the mouse to 

delete the point from the path. 

 

The Convert Point Tool 

The Convert Point Tool is extremely useful. If you have a point forming a sharp corner on 

your path and you want to convert that corner to a curve, clicking the Convert Point Tool 

will make that happen. Conversely, the Convert Point Tool will remove a curve from a 

point and convert the point to a corner. 

 

Paths vs. Shapes in Photoshop 

Path refers to a vector-based outline or shape created using the Pen Tool or Shape Tools. 

Paths are comprised of anchor points connected by straight or curved line segments, 

allowing for precise control over the shape and contour of an object. 
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When you access either the standard Pen Tool, the Curvature Pen Tool or the Freeform 

Pen Tool, you can set your Pen Tool setting to either Path or Shape in the options bar at 

the top of the application window. 

Drawing with the Pen Tool when Path is selected creates a new Work Path that appears in 

the Paths Panel. Drawing with the Pen Tool when Shape is selected creates a new Shape 

Path that appears in both the Paths Panel and the Layers Panel. 

 

When you choose Shape, you can also change a few different settings, including stroke 

color, thickness and fill color of the shape. We’ll go over the specifics of creating a shape 

with the Pen Tool at the end of this article.  

 

When you choose Path, you’ll see an icon that looks like two small overlapping squares 

(this icon is also available when Shape is chosen once you’ve already begun drawing your 

path). If you’re creating an initial path to become a selection, set this option to Combine 

Shapes. 

You’ll see a few other icons in the options bar, but for the purposes of this tutorial, you 

should leave those at their default values.  

To start your path, click on your image with your mouse where you want to begin your 

path. To keep things simple, choose a starting point that is at the edge of a straight line, 

such as the edge of the top of the sock in the image below. 

Click again along the edge of your object with the Pen Tool to draw the first segment of 

your path. You should now see a straight line appear. 

Also, note a Work Path appears in the Paths panel as soon as you place the second point.  

Create a curved path segment with the Pen Tool 

To create a curve with the standard Pen Tool (such as the curves at the ankle of the sock), 

click to create the next point and drag with the Pen Tool before you release the mouse 

button. You’ll see lines, called handles, appear.  
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Anchor Handles: Anchor handles, also known as direction handles or control handles, are 

used to control the curvature and direction of the path between anchor points. They extend 

from the anchor points and can be adjusted to modify the shape of the path. By dragging 

the handles, you can change the length and angle of the handles, thus altering the curvature 

of the path segment. 

Anchor handles come in two types: 

Hard Handles: Hard handles have a straight, linear shape without any curves. They provide 

a sharp and abrupt change in direction at the anchor point, creating a corner or straight 

segment in the path. 

Soft Handles: Soft handles have curved shapes. They allow for smooth transitions and 

gradual changes in direction, resulting in a curved segment in the path. 

The combination of anchor points and their associated handles allows you to create and 

manipulate complex paths with various shapes, curves, and angles using the Pen Tool in 

Photoshop. By adjusting the position and length of the handles, you can achieve precise 

control over the path's appearance, resulting in smooth curves or sharp corners, depending 

on the desired effect. 

These handles are tangential to the curve being formed by the path. Moving the mouse 

around will adjust the handles, which will then adjust the line’s curvature. Once you’re 

satisfied with the shape of the curve, release the mouse button. 

Note the handles formed from the curved line appear before and after the point. Therefore, 

the next portion of the path that you draw after creating a curved line will follow the 

trajectory of the handle from the last point.  
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When you click the next point, drag the mouse to create new handles and modify the curve 

that appears with your new point.  

 

Closing your path with the Pen Tool 

Once your path is complete, close your path by hovering the Pen Tool over the very first 

point you set down. When you see a small circle appear to the right of the Pen Tool, click 

on the point.  
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2. Clipping Path  

Create a Clipping Path in Photoshop 

Clipping path is a vector path or shape that creates an outline around the edges of an object 

to cut that out. It is called deep itching too. This is basically the process of separating one 

part of an image from another. 

In photoshop, we can mark the edges of an image by using a pen tool. The points that 

create lines around the intended area are called anchor points. Anchor points create 

clipping path by connecting one after another. 

There are three kinds of clipping paths – 

Single Layer 

Single layer clipping path means drawing a simple easy path around the hard edge of an 

image. This kind of layer is usually used to remove or change the background of an image. 

In the case of a single layer, the clipping path is drawn on the same layer. 

Multi-Layer 

Creating multiple paths on different layers in photoshop is called multi-layer. Multi-layer 

is most useful for retouching images or editing specific parts of an image. While a single 

layer cuts out one single subject from an image, multi-layer separates more than one 

subject from the same image. 

Illustrator Path 

Illustrator clipping path is making one or more vector shapes following the subjective path 

of the image. When you need to resize an image but you’re also concerned about the 

resolution and you don’t want to ruin it, you can use illustrator clipping path for that. 

Tutorial: How to Create Clipping Path in Photoshop 

It’s not that tough to create clipping path in photoshop. There is one tool that you need to 

learn to control to do clipping, and that is pen tool. Here, is the explanation of doing 

clipping in step by step: 

Step 1: Open file 

Launch photoshop on your pc and open the file in adobe photoshop. 

 
Step 2: Pick pen tool 

Next, go to the toolbar menu and select the pen tool. 
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Step 3: Create anchor points 

After taking the pen tool, at first, zoom your image to see the edges clearly. You can keep 

it around 300%. This will allow you to draw the path accurately. Now, start pointing the 

edges of the object you want to cut out. These points are called Anchor points. Keep 

marking till you reach the starting point. 

 
When you’re separating one object from another, you need to be careful with the edges to 

give it a natural look. So mark as perfectly as possible. 

Step 4: Inside Path 

The image that’s taken here, has another empty space inside the handle. So we’ll have 

to create another path inside. 

 
Step 5: Save path 

When you’re done with the marking, go to the layer panel. Then select the path tab. 

Now, go to the menu on the top left corner and select save path. And name the path as  
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‘Path 1’. 

 
Step 6: Clipping path 

Go to the same menu and select Clipping Path. 

 
A box will pop up showing some options. There is one box called Flatness. Flatness is the 

count of the closeness of the clipping path to the edge of the image. This determines the 

smoothness of the image. 

An increased value of the flatness makes the edge blur. If the value is lesser, the edge will 

be smoother and sharper. 

 
Step 7: Save your photo 
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Finally, save your image. You can use this file later to make any changes there. Or you 

can send it to someone else too, the path will be there and they can use it according to their 

need. 

 
Don’t forget to save both the psd and jpeg files. This will give you access to use this 

image in whichever way you want. 

 
To Remove Background  

After saving the photo, you can use the image anytime for whatever change you want to 

make. For example, you can change the background from this image. Once you’re done 

with making the clipping path, click on the right button of your mouse and click on ‘make 

selection’. 

 
Now add a layer mask and your background is removed. 
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Removing Image Background 

the "Feather" option refers to a feature that allows you to soften the edges of a selection, 

layer mask, or a shape. By applying feathering, you can create smooth transitions and 

blend selected areas or objects more seamlessly with their surroundings. 

The Feather option is typically accessed through the Selection Tool (such as the Marquee 

Tool or the Lasso Tool) or when creating a layer mask. Here's how it works: 

Selection Feathering: 

Make a selection using any of the selection tools in Photoshop. 

In the options bar at the top of the screen, you'll find the Feather field or Feather slider. 

Enter a pixel value or slide the slider to specify the amount of feathering you want to apply. 

A higher value will result in more significant feathering and softer edges, while a lower 

value will yield less feathering and sharper edges. 

Once you've set the feather value, make adjustments or apply effects within the selection, 

and the edges will appear blended or softened. 

Layer Mask Feathering: 

Create a layer mask on the layer you want to mask. You can do this by selecting the layer 

and clicking on the Layer Mask icon at the bottom of the Layers panel. 

With the layer mask selected, go to the Properties panel (Window > Properties) or right-

click on the layer mask and choose "Feather." 

Enter a feather value or adjust the feather slider to control the softness of the mask's edges. 

The layer mask will now have feathered edges, allowing for smoother transitions and 

blending with the underlying layers. 

 

First of all, this is mostly used to remove the background of an image. If you want to 

remove the background, change the color of the background or to make an image 

transparent background, you’ll have to do the clipping before that. 

Retouching or Color Correction 

Another use is while doing retouching or photo color correction. Clipping path lets us 

select a particular area or separate that from the image, that way we get to edit that 

particular place separately. 

Removing Unwanted Parts 

Moreover, removing unwanted parts from the image is another vital use of the clipping 

path. It’s not unusual to have unnecessary parts in an image while shooting. If you want 
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to remove those parts from your image, you’ll have to create the path first and then remove 

it from your image. 

Restoration or Manipulation 

The clipping path in photoshop is useful in the restoration and manipulation of the image 

too. Touch up in an image requires clipping. Same in masking. You’ll have to do clipping 

first if you want to do masking. 

Removing background, color correction or retouching, all are necessary in photoshop 

editing. In e-commerce product photography, the purpose of doing all these is to produce 

a high-quality, clean yet natural looking image. The image plays such an important role in 

the e-commerce business to attract viewers and increase sales.  
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Self Check Sheet 1.1 

1. Why we use Magic Wand Tool? 

 

 

2. What is Pen Tool  

 

 

 

3. Write the the name of 4 image separation Tools. 

 

 
4. Why we use Add Anchor Point Tool? 

 

 

 

5. What is Path? 
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Answer Key 1.1 

1. Why we use Magic Wand Tool? 

Answer: The Magic Wand Tool allows you to select areas of similar color or tone in 

an image. By clicking on a specific area, the tool selects contiguous pixels with similar 

attributes, making it useful for selecting and separating specific regions of an image. 

2. What is Pen Tool  

Answer: The Pen Tool is a versatile tool that allows you to create precise paths and 

selections by placing anchor points and adjusting curve handles. You can manually 

trace the contours of an object to create a path, which can be used for separation or to 

create complex selections 

3. Write the the name of 4 image separation Tools. 
Answer:  

1. Magic Wand Tool:  

2. Pen Tool:  

3. Lasso Tool 

4. Background Eraser Tool 
4. Why we use Add Anchor Point Tool? 

Answer: The Add Anchor Point Tool gives you the ability to add more points onto 

your path once it’s been created. Hover the Add Anchor Point Tool over the part of 

the path where you want to add a new point and click the mouse to create the point. 

5. What is Path? 

Answer: Path refers to a vector-based outline or shape created using the Pen Tool or 

Shape Tools. Paths are comprised of anchor points connected by straight- or curved-

line segments, allowing for precise control over the shape and contour of an object 
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Activity Sheet 1-1:  

 

Task Name: Saperate image from the background using Pen Tool. 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Remove background of the following sample image. 

5. Place it another background. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer. 
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Job Sheet 1.1 

 

Job Name: Retouch the image and separate the image from the background using the 

background erager tool  

 

Job Stepes/ Procedure 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Remove background of the following sample image. 

5. Place it another background. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer 

 

Sample job 
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Specification Sheet 1.1 

Job Name: Retouch the image and separate the image from the background using the 

background erager tool 

 

Condition for the job: 

 

1. Place it in a 4-inch rectangular frame on a different background. 

2. Frame Size: 4” × 4” 

3. Frame border: 0.5” 

4. Frame color: Blue  

5. File Save in PSD and JPEG format.  

To complete the above task, you will need to following equipment per Trainee. 

Required Tools and equipment 

S/N Name of item Specification Unit Quantity 

01 
Personal Computer Latest Configuration Nos 

1 

02 Keyboard and Mouse Standard Nos 1 

03 Monitor Standard Nos 1 

04 Adobe Photoshop Latest version Nos 1 

Raw Materials 

• N/A 

Required PPE 

• Ergonomic chair 

• Eye protective glass 

• Rubber shoe 
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Learning Outcome 2: Create a Composition  

Content: 

1. Image composition 

2. Images editing 

a. Transform 

b. Transparency 

c. Gradients 

d. Strokes 

e. Adjustment 

f. Crop 

g. Filter 

h. outline 

i. Blending option 

Assessment Criteria:  

1. New document is created 

2. Images are pasted for edit 

3. Layers are created and selected. 

4. Images are edited and arranged. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 
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Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 2: Create a composition 

In order to achieve the objectives stated in this learning guide, you must perform the learning steps 

below. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Apply 

Graphic Design 

Concepts and 

Guidelines. 

1. Instructor will provide the learning materials 

“Separate and Compose Images 

2. Read the Information 

sheet/s 

2. Information Sheet No:2 Create a composition 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 2 Create a composition 

Answer key No. 2 Create a composition 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:2-  

 

Specification Sheet 2 –  
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Information Sheet 2: Create a composition 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1. Create new document 

2. Edit pasted Images 

3. create and select Layers are. 

4. Edit and arrange Images. 

1. Image composition 

Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. It involves the deliberate placement, framing, and 

combination of subjects, objects, lines, colors, and other visual elements to convey a 

particular message, evoke emotions, or guide the viewer's attention. 

Layer: 

In Adobe Photoshop, a layer is a fundamental component of the software's workflow and 

refers to a transparent, stackable element within an image. Layers allow you to work on 

different parts of an image independently, making it easier to manage, edit, and manipulate 

various elements without affecting the rest of the image. 

Create New Document in Photoshop 

You can create a New Document by using one of several options available in Photoshop. 

Follow these steps to create a New Document: 

Open Photoshop If you are using Photoshop CC, you will have your Home Screen opened 

up. This screen keep on changing from time-to-time.  

 
Choose File – New or press Ctrl + N (cmd + N) Either way, the New Document dialog 

box opens. 
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Modify the setting, before creating the New Document, in the preset from right pane. You 

have several options as choice:  
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Preset: ‘Photo’, ‘Print’, ‘Art & Illustration’, ‘Web’, ‘Mobile’ and ‘Film & Video’ 

Name: Specify a file name for New Document 

Width and Height: Specify the size of the New Document. Also chose the unit from the pop-

up menu. 

Orientation: Preferred page orientation for the New Document: Landscape or Portrait. 

Artboards: This option adds artboard while creating the New Document. It can also be added 

later. 

Color Mode & Bit: Chose color mode for the New Document. Out of five color modes 

available, you will mostly use CMKY (for print purpose), RGB (for digital purpose) and 

Grayscale (for Black and White) (occasionally) in 8 bit. 

Resolution: It determines the quality of an image. For digital purpose, you should use 72 ppi 

(pixel-per-inch). For print purpose, you should use 300 ppi (industrial standard resolution). 

Background Contents: The default value for a New Document is White but you can choose a 

different color from the options. 
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To specify the extra options, click Advanced Options. 

 
Color Profile: Chose color profile for your New Document from a wide variety of options. 

Pixel Aspect Ration: The ratio of width to height of a single pixel. 

Click ‘Create’ button after setting all options to create the New Document.  

 

 

Create Composite Photography in Photoshop  

Composites are also heavily frowned upon in some photography competitions. It is especially 

evident in competitions like the Wildlife Photographer of the Year awards. The rules specify 

that ‘entries must not deceive the viewer’ or ‘attempt to disguise or misrepresent the reality of 

nature’. Therefore, you must be as transparent as possible in your use of composite 

photography and know when it’s appropriate to use it. Do not use it for editorial 

photography but use it freely with fine art photography. 
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Planning and Preparing to Create Composites 

Step 1:  

In composite photography, concept is everything. And you are only limited by what your mind 

can think of. The hardest thing will probably be managing what you have in your head and 

translating it into set images in a fixed frame. The easiest way to do this is to separate your 

vision into a few categories: 

• the subject 

• the background 

• the extras 

• the atmosphere 

The most important details are the subject and the background. Once you have a simple idea, 

you can build in other things that add to this idea. Maybe the person on the desk is sitting 

down with lego figures their size. It is all about creating a narrative through the control you 

have. 

 

Step 2: Choose Images With the Following Characteristics 

Collecting images for a composite is not as simple as choosing the best photographs. There 

are a few things you need to take into consideration: 

1. Appropriate File Sizes and Resolution 

Make sure that the background is big enough to zoom into the picture and work on the 

elements inside without the image pixelating. This also goes for the subject image you are 

choosing. Can it be scaled up to fit in the background without it pixelating? 

If it is just going to be used for web purposes, having images as little as 10cm in length at 
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72 dpi will work. You probably want around 20cm in length at 300 dpi for print. I would 

recommend the latter option as an excellent go-to size for composite images. 

2. Similar Perspectives 

Perspective is arguably the most crucial factor in making a composite image. If you have a 

photo of a subject looking up at them, but the background is taken level or at a high up 

perspective, it won’t look right putting them together. It is best already to have the final 

background image in your mind (or the other way round). This means you will be able to 

photograph your subject (or background) with the same perspective and in a believable way. 

For instance, if you’re photographing someone as if they have shrunk into the palm of a hand, 

you will most likely be looking down on them. So get up on a ladder or shoot out of a window 

to try and mimic this angle.When sourcing images, you will want to ensure that all the 

elements are taken with a similar perspective. 

3. Similar Lighting 

Lighting is the most common way that you will be able to spot a composite image. In 

advertisements, you can sometimes tell that the lighting is too perfect on someone in the 

middle of the frame. There is no way anyone could get this effect with studio lighting. In 

lesser, refined edits, there can be even clearer giveaways. There may be a background that is 

clearly in a basement with no windows, yet there is harsh directional lighting. Even if there is 

a light source in the image, people will sometimes mistakenly put the subject where the light 

cannot fall onto this person. Being meticulous in determining the direction of light in all 

images you use in your composite photography will go a long way. Of course, you will be 

able to get away with lighting not being 100% perfect. But, every tiny detail you cover will 

go a long way. 

4. Similar Color Temperatures 

The color cast in your photos will also profoundly affect your composite. Each separate image 

will most likely have been taken in a different light if you think about it. Different kinds of 

light have different color temperatures. This means cut out sections will not look like they are 

under the same light as the background image. Often, it will require just a tiny change to the 

color temperature to match. It is usually a case of making the subject warmer or colder (more 

yellow or blue). 
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2. Images editing 

Step-By-Step Guide to Create Photoshop Composites 

We will now go through a short step-by-step approach to a simple Photoshop composite. 

I will introduce a few quick and easy techniques to apply to various situations. This edit 

should take you under five minutes to do! 

I will use two stock images for this demonstration. Both I took from the stock image 

site Unsplash. I will also later use a brush I downloaded from Brusheezy. 

Step 1. Select Subject and Background Images 

First, I make a plan for my final image. I want to composite people doing yoga in an 

extreme place. So I find a yoga pose first (subject). 
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Now I want to find an extreme place like a cliff (background). When looking for the cliff 

image, I consider the camera’s perspective in the yoga photo. The yoga picture looks straight 

at the subject from their body height. This means I pick a location where I can place the 

subjects on the same level or even slightly higher. This cliff will work great. 

 

Step 2: Cut Out the Subject 

Now we start the editing process. First, open up your subject image in Photoshop. 

 

Then duplicate the background. 
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You can right-click the original image (Background layer) in the Layer panel and click 

Duplicate Layer. 

Or you can drag the Background layer over the Create new layer icon (+ sign) on the 

bottom. 

 

 
Now we will cut out the two women. There are many ways to do this. As this is a quick 

guide, I will use the Quick Selection tool in the toolbar (paintbrush icon with a dotted 

circle). Start to click on your subject so that the ‘marching ants’ snap to outline your 

subject.  

Do this for both people. Make sure to use the subtractive brush (with a minus sign) to take out 

the gaps between their bodies. 
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Now you want to inverse the selection. I do this by holding down Command or Ctrl+Shift+I. 

The ‘marching ants’ should now go around the border of your image as well. With the 

duplicate background layer selected, press the Backspace or Delete key to cut out your subject. 

This is how your duplicate layer should look. You can ‘hide’ the original image by pressing 

the Eye icon in the layers panel. 

Step 3: Move the Subject onto the Background 

Next, open your background image in Photoshop. You will have separate tabs of the two files 

you are working on. 

With the subject image selected, double-click on your cut out layer. Then drag it onto the tab 

of the new background image, which will open. 
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Step 4: Resize and Position the Subject Image 

First, you want to resize the subject. Press Command or Ctrl+T to open the transform box 

and resize the image. Make sure your subject is a believable size. In my example, I make 
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sure the height of the people is realistic.

 

Then use the Move tool (V) to place the subject correctly. Here, I put the women on top of 

the cliff. This is the base of our simple composite image. 

 

Step 5: Create a Layer Mask to Match Color Tones 
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Now you want to create a layer mask for your subject. I’ll use it to fine-tune the color of the 

subject images. But you can adjust many kinds of details using a masking technique. Grab 

your subject layer and drag it over the ‘Add a layer mask’ button at the bottom of the Layers 

panel. 

Next, in the Adjustments panel, click the Color Balance icon. This opens an adjustment layer 

for color balance 

Now you want to drag your layer mask onto this new adjustment layer. If a pop-up box comes 

up, press yes to replace the layer mask.As the background image has a cold and blue look, I 

add a blue tone to the subject. 
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This makes a subtle difference, but that difference goes a long way. 

Step Six: Add Extra Effects to Create a Compelling Scene 

I want to add some fog for an atmospheric effect. You can choose other effects based on 

your images.  

For this fog effect and others, you can find fog brushes online. Download the tools and 

import them into Photoshop. 

First off, you want to create a new layer (‘Layer 1’) for the effect. Click the new layer button 

(+ sign) at the bottom of the Layers panel. 

Then choose the Brush tool. And select the type of brush you want to use in the Brush 

Picker in the top menu bar. 
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When working with fog brushes, lower the opacity and flow of your brushes. This ensures a 

light effect and application.Gradually, start bringing in the fog by brushing it in. Make it 

look as natural as possible.  
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Do this all around the image. Make sure you use different brushes or change the brush 

direction to add variation.For illustrative purposes, this is what your layer should look like if 

you applied a black background for the fog. (You don’t have to apply a black background to 

this layer.) 

For fine-tuning the final image, you will want to erase the fog that’s in the way. Select the 

Eraser tool from the toolbar. 

Again, you will want to make sure the opacity and flow are low, so you can lightly blend the 

fog out. 

 
Now you have a quick and easy Photoshop composite photo 
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Self Check 2.1  

Answer the following questions: 

1 What is image composition? 

Answer: Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. 

2 What is layer in Photoshop? 

Answer: In Adobe Photoshop, a layer is a fundamental component of the software's 

workflow and refers to a transparent, stackable element within an image. Layers allow 

you to work on different parts of an image independently, making it easier to manage, 

edit, and manipulate various elements without affecting the rest of the image. 

3 Why we use filter to edit image?  

Answer: Filters are powerful tools that allow you to apply various effects and 

modifications to your images. Filters can alter the appearance, texture, color, or overall 

look of an image, providing creative enhancements or corrective adjustments. They can 

be applied to an entire image or specific layers, selections, or smart objects. 
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Answer Sheet 2.1 

1. What is image composition? 

Answer: Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. 

2. What is layer in Photoshop? 

Answer: In Adobe Photoshop, a layer is a fundamental component of the software's 

workflow and refers to a transparent, stackable element within an image. Layers allow 

you to work on different parts of an image independently, making it easier to manage, 

edit, and manipulate various elements without affecting the rest of the image. 

3. Why we use filter to edit image?  

Answer: Filters are powerful tools that allow you to apply various effects and 

modifications to your images. Filters can alter the appearance, texture, color, or overall 

look of an image, providing creative enhancements or corrective adjustments. They can 

be applied to an entire image or specific layers, selections, or smart objects. 
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Learning Outcome 3: Retouch Image 

Content:  

1 Retouching 

2 Retouch tools  

a. Healing brush tool 

b. Spot Healing 

c. Patch Tool 

d. Clone Stamp Tool 

3 Tools calibration  

4 Layers creation and preservation 

5 Images correction 

6 File format 

Assessment Criteria:  

1 Appropriate retouch tools are identified 

2 Tools are calibrated as required 

3 Layers are created and preserved 

4 Retouch tools are used as per requirement 

5 Images are corrected and saved in appropriate file format 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

Assessment Methods 

•  Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 3 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1 Appropriate retouch tools are identified 

2 Tools are calibrated as required 

3 Layers are created and preserved 

4 Retouch tools are used as per requirement 

5 Images are corrected and saved in appropriate file format 

1. Retouching 

Image retouching refers to the process of altering or enhancing an image to improve its 

appearance or correct imperfections. It involves making selective adjustments, removing 

or reducing flaws, and enhancing specific areas to achieve a desired visual result. Image 

retouching can be performed using various software applications, with Adobe Photoshop 

being one of the most popular tools for this purpose. 

Here are some common techniques used in image retouching: 

Skin Retouching: Skin retouching aims to create smooth and flawless skin by reducing 

blemishes, wrinkles, acne, and other imperfections. It involves techniques like spot 

healing, cloning, frequency separation, and dodge and burn to even out skin tones, remove 

spots, and enhance texture while maintaining a natural appearance. 

Color and Tone Adjustments: Image retouching often includes adjustments to colors, 

tones, and contrast to improve the overall visual impact. This can involve adjusting 

brightness, contrast, saturation, and levels, as well as selectively modifying colors to 

achieve a desired look or correct any color issues. 

Object Removal or Addition: Image retouching may involve removing unwanted 

objects, people, or distractions from the image. This can be achieved using tools like the 

Clone Stamp tool or Content-Aware Fill in Photoshop. Conversely, objects or elements 

can also be added to an image for creative purposes or to enhance the composition. 

Sharpening and Noise Reduction: Retouching can include sharpening specific areas to 

enhance details and make the image appear crisper. Conversely, noise reduction 

techniques can be applied to reduce unwanted digital noise or graininess in images, 

particularly in low-light or high-ISO photographs. 

Reshaping and Body Contouring: In portrait or fashion retouching, it is common to 

perform subtle reshaping or body contouring adjustments to enhance the subject's 

appearance. This can involve slimming down or sculpting body parts, adjusting facial 

features, or enhancing proportions while maintaining a natural look. 

Background and Composition Enhancements: Image retouching may also involve 

modifying or enhancing the background or composition of an image. This can include 

adjusting lighting, adding or removing elements, adjusting perspective, or creating a more 

visually pleasing and balanced composition.  
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2. Retouch tools 

Adobe Photoshop has some of the best tools for removing unwanted objects from your 

image. 

In this article, we take a deep dive into the Spot Healing Brush tool. This powerful tool is 

also the easiest one to use. Just click a spot, and Photoshop does the rest. Both the Spot 

Healing Brush and the Healing Brush are used for small blemishes in your photo. If you 

have a larger object to remove, use the Patch tool. 

Effective Editing Techniques 

 

Digital Dreamworlds 

Want to take your spot healing brush tool skills to the next level? Our eBook and Cheat 

Sheets provide expert instruction on creating surreal digital photo collages. 

Buy from ExpertPhotography 

Spot Healing Brush Tool vs. Healing Brush and Clone Stamp Tool 

It is easy to get the Spot Healing Brush and the standard Healing Brush tools confused in 

Adobe Photoshop. Even the icons look similar. The Spot Healing Brush is in the toolbar. 

It may be nested with other tools like the Healing Brush, Patch, and the Content-Aware 

Move tool. Click one of these tools to see a fly-out menu. 

 

When you select the Spot Healing Brush tool, an options bar appears above your image. 

You have control over the size and hardness of the brush, the blending mode, and the type 

of Spot Healing Brush. You also have the option to sample all layers and select a brush 

angle. 
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Both the Spot Healing Brush and the Healing Brush replace pixels in your image. First, 

identify a problem area in your photo. This can be a pimple, a dust spot, or a piece of trash. 

The difference in the tools lies in how the program chooses new pixels to replace the 

problem area. With the Healing Brush, you identify the replacement pixels. Click on a 

clean area holding the Option key. This tells Photoshop to use these pixels in place of the 

problem ones. With the Spot Healing Brush, Photoshop uses an algorithm to work out the 

best pixels to use. With both healing brushes, Photoshop blends the new and old pixels. 

The Clone Stamp tool is like the healing brushes. But Photoshop does not blend the new 

and old pixels for a seamless patch. 

You may feel like you have more control when using the Healing Brush. But Photoshop 

can search your image at the pixel level to find clean replacement pixels. These may be 

better than the ones you choose. 

How to Use the Spot Healing Brush 

The Spot Healing Brush is used to remove small blemishes or objects. Blemishes may 

include acne or dust spots in the sky. Small objects may include trash or power lines. We 

will start by removing a few dust spots. 

Step 1: Create a Blank Layer 

Create a blank layer by clicking the + sign below the layers panel, or you can go to the 

Layer drop-down menu and select Layer > New > Layer (shift + ⌘N). Rename this layer 

‘Spot Healing’. Healing on a separate layer safeguards your original photo. Toggle the 

Spot Healing layer off to see your original image. 

 

Create a new layer by clicking the + button or selecting New > Layer in the Layers drop-

down menu 
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Step 2: Zoom In 

You can see the edges of the spot more clearly when you zoom in. You are also less likely 

to miss spots if you magnify the image. Click the Magnifying Glass tool. Then click on 

the screen repeatedly until you can easily see the place that needs repair. 

You can also zoom in by pressing the Command key and the + symbol. To return to the 

full-sized image, click Command – or Command 0. 

 

Zoom in to see the problem area more clearly. Dust spot circled to make it more obvious. 

Step 3: Select Spot Healing Brush 

Select the Spot Healing brush from the Photoshop toolbar. Make sure you select the Spot 

Healing brush and not the Healing brush. In this image, I am going to remove dust spots 

in the sky. 
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Open the Spot Healing Brush tool found on the toolbar 

Step 4: Size the Spot Healing Brush 

The Spot Healing Brush tool appears as a circle in your workspace. Move the circle over 

the spot you want to remove. Then, make the Spot Healing Brush slightly larger than the 

spot. You can change the size on the Options bar. Click the fly-out menu. Slide the Size 

slider left to make the brush smaller and right to make the brush larger. You can also 

change the size of the brush using the bracket keys [ ]. The left bracket key [ makes the 

brush smaller. The right bracket key ] makes the brush larger. 
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Size the brush slightly larger than the spot using the menu on the options bar 

In the brush menu, you can also change the softness of the brush. A soft brush feathers the 

edges. With a harder brush, the edges will be sharp and noticeable. A softer brush usually 

gives better results. 

Step 5: Choose Brush Type 

There are three Spot Healing Brush types: Content-Aware, Create Texture, and Proximity 

Match. Content-Aware is the newest addition to the line-up. Photoshop looks at your 

image and figures out what content to use. When using Proximity Match, Photoshop looks 

at the pixels just outside of the Spot Healing Brush circle for replacement pixels. With the 

Create Texture option, Photoshop generates a pattern from the pixels around the area you 

want to replace. Content-Aware will usually give you the best results. But if you do not 

get results you like, try using one of the other types. 

 

Removing the rock with Content-Aware gave me the best results. Create Texture added 

artifacts to the water. Proximity Match made no difference. 

Step 6: Check Sample All Layers Box 

Check the Sample All Layers box. The tool will sample from the background layer. 

Unchecking the box limits sampling to the selected layer. In this case, the selected layer 

is blank. 

 

Check the Sample All Layers box 

Step 7: Remove Spot 

Make sure you have the Spot Healing layer selected. Click once on the spot that you want 

to remove. If the spot does not disappear, choose a different type of Spot Healing Brush, 

and click on the spot again. 
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How to Remove a Line 

The Spot Healing Brush tool works well to remove isolated dust spots or facial blemishes. 

But you can also drag the tool to remove a line, like power lines, from your image. 

The default settings in the options bar work well for removing a single spot. But when 

removing larger objects, or a line, you may need to change the spacing, mode, or the type 

of healing brush. 

Spacing 

When you drag the Spot Healing Brush, the tool creates multiple brush strokes. Spacing 

is how far apart two brush strokes are. Set to less than 25% for a clean repair. Spacing 

higher than that will leave gaps in the repair. 
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When dragging Spot Healing Brush, set the spacing to under 25% 

Blend Mode 

We have already talked about changing the type of Spot Removal Brush to get optimal 

results. On the Options bar, you can also change the blend mode. This is how the new 

pixels blend with existing pixels. Normal is the default, but you also have search, Multiply, 

Screen, Darken, Lighten, Color, and Luminosity. They will interact differently with your 

image. If you are not getting the result you want, change the blend mode. 

 

Compare the results when removing power lines using different blend modes 

Tips for using the Spot Healing Brush tool 

If you are not getting good results from the Spot Healing Brush, here are a few tips for 

using the Spot Healing Brush tool. 

Spot vs. Line 

The Spot Healing Brush will remove a line, but it works better when you click once to 

remove an object. When possible, make your Spot Healing Brush larger than the object 

you are removing and click once rather than dragging. 

Change Direction 

If you are removing a line, change the direction of the brush stroke. Instead of moving left 

to right, move right to left. If you are moving upwards, try starting at the top and move 

downwards. If you are moving from the center outwards, try starting at the edge of your 

frame. 

Change Size of Brush 

If your brush size is not quite large enough, the Spot Healing Brush may repair the center 

and leave a ring. Change the brush size to make it larger than the spot. 

Remove Smaller Sections 

If you are removing a large object or a long line, try healing smaller sections. When 

removing large patches of facial blemishes, start by removing smaller sections. When you 

have more clean skin, you can tackle the larger problem. Don’t be in a hurry. 
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Spot Remove Again 

Sometimes clicking on a spot a second time will give cleaner results. Try a different-sized 

brush or a different type of brush. But going over the same area too many times will 

introduce artifacts. 

Also, watch for a repeating pattern. This draws the eye and is a giveaway that you have 

changed the image. If Photoshop throws up a repeating pattern, go over the spot again to 

remove it. 
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Use the Clone Stamp Tool 

You can find the clone stamp in the tool bar on the left hand side. The shortcut for the 

clone stamp for both Mac OS and Windows is S.  

  

If you can’t see the tool bar on the left, make it visible using the ‘Window’ menu. 

Click on ‘Tools’ all the way down in the menu.  

 

  

Remove Unwanted Objects With the Clone Stamp Tool 

Imperfections or distractions could mess up a great fashion or publicity photo. Luckily, 

removing them with the clone stamp tool is easy. 

The clone stamp can remove anything from wires, dust spots, unwanted hair, and even 

people. It does this by cloning pixels from another part of the photo. 

Let’s say I want to remove the man’s sandals in the photo from a beach in India. I’ll show 

you how to do that with the clone stamp tool.  
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Step 1: Open the photo and zoom in 

Open the photo you want to clean up and zoom in on the area you want to work with. Not 

too close, so you can still see what’s going on. 

Click on the clone stamp tool in the tool bar on the left. 

Always duplicate the background layer before you start working. This way, you can 

always go back to the original photo. Right click on the background layer and select 

‘Duplicate Layer. 

 

Step 2: Select a clone source 

Pick a soft brush. Set the size of the clone stamp so it will cover the object you want to 

remove. It takes some practice to know how hard and big your brush should be. 

A good setting to start is a medium soft brush to achieve smooth edges.  
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Move the cursor to the area you want to take pixels from. In this case I need sand. Use 

Alt-click to confirm your source pixels. The cursor will change into crosshairs. 

The moment you click, the cursor will change and show the pixels you’ve cloned.  

 

Step 3: Paint over the object you want to remove 

Now start painting over the object you want to remove. Make sure it’s not obvious that 

you are duplicating another part of the photo. 

If it’s noticeable, go back to clone other pixels and continue painting.  
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Repeat this until everything looks natural. If you want to go a few steps back in Photoshop, 

use undo. Cmd + Z in Mac OS or Ctrl + Z in Windows. 

What you have to look out for is patterns. Patterns will give away the fact that you’ve 

cloned pixels and removed an object.  

 
Avoid patterns to make the cloning look natural 

The clone source panel comes in handy when trying to avoid patterns. Use the two mirror buttons to make 

your cloning look more natural. 

This will mirror the pixels you paint over the unwanted object. The result will look better.  
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Playing around with the opacity of the brush will also help. Always try to mix different 

clone sources and opacity settings to get the best result. 

The edges of the clone stamp have to be as smooth as possible.  
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3. Tools calibration 

In Photoshop, calibration refers to the process of adjusting and fine-tuning the color and 

tonal accuracy of your monitor, printer, or other input/output devices to ensure consistent 

and accurate color reproduction. Calibration is crucial because different devices can 

display or print colors differently due to variations in their hardware and settings. 

Photoshop provides various tools and settings to help you calibrate your devices: 

Color Settings: Photoshop's Color Settings dialog box allows you to customize the color 

management settings for your workflow. It lets you specify the color space (such as sRGB, 

Adobe RGB, or ProPhoto RGB) and the rendering intent (perceptual, relative colorimetric, 

etc.) for consistent color reproduction. 

Monitor Calibration: To ensure accurate color representation on your monitor, you can 

use external hardware calibration devices, such as colorimeters or spectrophotometers. 

These devices measure the characteristics of your monitor and create an ICC profile that 

Photoshop and other color-managed applications can use to adjust the displayed colors. 

Soft Proofing: Soft proofing allows you to simulate how your images will look when 

printed on different devices or using specific profiles. The Soft Proof feature in Photoshop 

enables you to preview the color shifts that may occur when you convert an image from 

one color space to another or when printing with different profiles. 

Printing Calibration: When it comes to printing, you can use printer profiles specific to 

your printer and paper combination. These profiles describe how your printer reproduces 

colors and help ensure accurate color output. Photoshop lets you select and assign printer 

profiles to your images to achieve more predictable and consistent results. 

Adjustment Tools: Photoshop offers a wide range of adjustment tools that allow you to 

fine-tune colors, tones, and contrast in your images. These tools, such as Levels, Curves, 

and Hue/Saturation, can help you correct any color imbalances or discrepancies that may 

occur during the calibration process or due to other factors.  

4. Layers creation and preservation  

You can think of layers as transparent panes of glass stacked on top of one another, which 

allow different parts of each layer to show through. There are several types of layers you'll 

use in Photoshop, and they fall into two main categories: 

Content layers: These layers contain different types of content, like photographs, text, 

and shapes. 

Adjustment layers: These layers allow you to apply adjustments to the layers below them, 

like saturation or brightness. Adjustment layers are a type of nondestructive 

editing because they don't actually change anything about the original image. 

When using layers, it may be helpful to turn individual layers on and off to see how they 

affect the image. You can do this by clicking the eye icon next to each layer name. 
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Click the eye icons in the interactive below to practice turning different layers on and off. 

Notice how hiding content layers like the Background layer has a more noticeable effect 

than hiding adjustment layers like the Adjust Levels layer. 

At this point, you may be wondering why you even need to use layers. Wouldn't it just be 

easier to work with everything in your image at once? The truth is, layers give you an 

amazing amount of flexibility and control because you can edit each layer 

independently from the rest of the image. Once you become comfortable with layers, you'll 

use them all the time. 

Layer basics 

You can view, create, and edit layers with the Layers panel. This will generally be found 

in the lower-right corner of the screen, although you can always go to Window > Layers to 

make sure it's turned on. 

In Adobe Photoshop, a "layer" refers to a fundamental concept used for organizing and 

manipulating elements within an image or design. 

Layers in Photoshop allow you to work on different parts of an image independently, 

stacking them on top of each other to create complex compositions. Each layer acts as a 

transparent sheet that can contain various elements such as images, text, shapes, or 

adjustments. 

By utilizing layers, you can make edits to specific areas of an image without affecting the 

rest. This non-destructive editing approach provides flexibility and allows you to 

experiment with different effects and changes while preserving the original image. 

Layers can be manipulated individually, allowing you to adjust their position, size, 

opacity, blending modes, and more. You can move layers up or down in the layer stack to 

change their order, which affects how they interact with other layers. Layers can also be 

organized into groups, making it easier to manage complex designs with multiple 

elements. 

Furthermore, Photoshop offers several features to enhance your work with layers. Layer 

masks allow you to hide or reveal specific parts of a layer, enabling you to selectively 

apply edits or create seamless composite images. Layer styles enable you to add various 

effects, such as shadows, strokes, gradients, or overlays, to individual layers. 

Additionally, adjustment layers are a powerful tool in Photoshop. They allow you to apply 

non-destructive adjustments, such as brightness/contrast, levels, hue/saturation, and more, 

to specific layers or the entire image. 
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Creating an adjustment layer 

If you've never used layers, we recommend trying adjustment layers first. Remember, an 

adjustment layer does not contain content; it simply allows you to apply adjustments to 

the layers below it. 

In the Layers panel, select the layer below where you want the adjustment layer to appear. 

In our example, we'll select the Cake layer. 

 

Click the Adjustment button at the bottom of the Layers panel, then choose the desired 

adjustment.  
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The adjustment layer will appear, and you can then customize the adjustment in 

the Properties panel. Any changes you make will affect every layer below the adjustment 

layer. We'll talk more about using the Properties panel for different adjustments 

throughout the tutorial. 

 

 

You can also use the buttons in the Adjustments panel to create an adjustment layer. 
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In the example file, select the Cake layer, then create a Hue/Saturation adjustment layer. 

Try using the sliders in the Properties pane to see the effect. 

Creating a blank layer 

There may be times when you'll want to create a new blank layer. For example, if you 

want to draw on an image with the Brush tool, you could create a new layer and then draw 

on that layer. 

To create a new layer, click the New Layer button near the lower-right corner of 

the Layers panel. The new layer will appear in the Layers panel. 

 

Duplicating a layer 

There will also be times when you'll want to duplicate an existing layer. This is an easy 

way to try out different edits without altering the original layer. 
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Right-click the layer, then select Duplicate Layer. 

 

A dialog box will appear. Click OK. The duplicate layer will appear. 
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Deleting a layer 

If you find that you no longer need a layer, you can delete it. To do this, simply select the 

layer and press the Delete key on your keyboard. You can also click and drag the layer to 

the Trash Can in the lower-right corner of the Layers panel. 

 

There are many ways to work with the layers in your file. For example, you can show and 

hide different layers or change the stacking order. 

Showing and hiding layers 

To hide a layer, simply click the eye icon next to the desired layer. Click it again to show 

the layer. In the image below, you can see that we've turned off the Text layer, so the text 

is no longer visible in the document window: 
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Reordering layers 

The order in which layers are stacked will determine how the document looks. There may 

be times when you need to change the stacking order. To reorder a layer, simply click and 

drag the layer to the desired position in the Layers panel. In the image below, you can see 

that we've moved the Cake layer to the very top, which completely covers up the layers 

below it. 

 

If you want to reorder the Background layer of the image, you will need to right-click it 

and select Layer from Background. This will convert the background to a regular layer, 

which can be reordered. 

 

 

5. Image correction 

Image correction refers to the process of enhancing or modifying digital images to improve 

their overall quality, appearance, or accuracy. It involves various techniques and 

adjustments aimed at correcting issues such as exposure problems, color inaccuracies, 

noise reduction, and other imperfections present in the original image. 
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Here are some common types of image correction techniques: 

Exposure Adjustment: This technique involves modifying the brightness and contrast 

levels of an image to improve visibility and highlight details. It helps in correcting 

underexposed or overexposed areas. 

Color Correction: Color correction aims to adjust the color balance and tones of an image. 

It helps in eliminating color casts, enhancing saturation, and achieving a more natural and 

visually pleasing color representation. 

White Balance Correction: White balance correction is used to ensure accurate 

reproduction of colors by eliminating any color cast caused by different light sources. It 

involves adjusting the temperature and tint to make whites appear truly white. 

Sharpening: Sharpening techniques are applied to enhance the clarity and sharpness of an 

image, making the details more pronounced. It helps to counteract blurriness caused by 

factors like lens imperfections or camera shake. 

Noise Reduction: Noise refers to the random pixels or grainy texture that can appear in 

images, especially in low-light conditions or high ISO settings. Noise reduction techniques 

help in reducing or eliminating such unwanted noise while preserving image details. 

Cropping and Straightening: Cropping involves removing unwanted parts of an image to 

improve composition or focus on specific subjects. Straightening corrects the image's 

horizon or vertical alignment to make it appear more level and balanced. 

Lens Distortion Correction: Lens distortion occurs when lenses introduce unwanted 

effects like barrel distortion or vignetting. Correction techniques can rectify these issues 

to make the image appear more natural and undistorted. 

Retouching: Retouching involves removing or minimizing imperfections in the image, 

such as blemishes, spots, or unwanted objects. It can also include tasks like removing red-

eye, adjusting skin tones, or enhancing specific features. 

6. File format 

File format refers to the specific file extension used to save and store images created or 

edited within the software. Photoshop supports a wide range of file formats, each with its 

own characteristics, capabilities, and intended use. Here are some common file formats 

used in Photoshop: 

PSD (Photoshop Document): PSD is the native file format of Adobe Photoshop. It 

supports all Photoshop features and preserves layers, masks, adjustment layers, and other 

editable elements. PSD files are typically used for saving and editing projects in 

Photoshop, allowing users to preserve the full editing capabilities of their work. 
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JPEG (Joint Photographic Experts Group): JPEG is a widely used lossy compression 

format for storing photographic images. It is commonly used for sharing images on the 

web or printing. When saving an image as a JPEG in Photoshop, you can adjust the 

compression level to balance between file size and image quality. 

PNG (Portable Network Graphics): PNG is a lossless compression format that supports 

transparency. It is commonly used for images with sharp lines, text, or graphics that 

require a transparent background. PNG files are often used for web graphics and logos 

that need to be placed on different colored backgrounds. 

TIFF (Tagged Image File Format): TIFF is a versatile file format that supports lossless 

compression and can store high-quality images with layers, transparency, and other 

Photoshop features. TIFF files are commonly used for print production or when maximum 

image quality and flexibility are required. 

GIF (Graphics Interchange Format): GIF is a compressed file format that supports 

animation and transparency. It is commonly used for small animations, icons, and simple 

graphics on the web. GIFs have a limited color palette, making them more suitable for 

simple images with solid colors or low-resolution graphics. 

PDF (Portable Document Format): While not exclusive to Photoshop, PDF is a widely 

used file format for sharing and archiving documents. In Photoshop, you can save your 

work as a PDF, which allows for multiple pages, layers, and vector elements to be 

preserved. PDFs are commonly used for creating digital portfolios or sending artwork for 

professional printing. 
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Self Check 3.1  

Answer the following questions: 

1 What are the uses of healing bruch tool? 

 

 

 

 

 

2 What are the uses of Clone Stamp Tool? 

 

 

 

 

 

3 What is tool calibration? 

 

 

 

 

 

4 What is image correction? 

 

 

 

 

  

 

5 What is file format in photoshop? 
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Answer Sheet 3.1 

1. What are the uses of healing bruch tool? 

Answer: The Healing Brush Tool is a powerful image editing tool in Adobe 

Photoshop that allows you to remove imperfections, blemishes, or unwanted 

objects from an image seamlessly. It works by sampling pixels from a source 

area and blending them with the surrounding pixels, resulting in a smooth and 

natural-looking repair. 

 

2. What are the uses of Clone Stamp Tool? 

Answer: The Clone Stamp Tool is a versatile and commonly used tool in 

Adobe Photoshop that allows you to sample pixels from one area of an image 

and replicate them in another area. It essentially creates a clone or duplicate 

of the sampled pixels and applies them to a new location. The Clone Stamp 

Tool has several practical uses in image editing and retouching 

 

3. What is tool calibration? 

Answer: In Adobe Photoshop, tool calibration refers to the process of 

adjusting or fine-tuning the settings of certain tools to achieve accurate and 

desired results. It involves configuring the tool's behavior, sensitivity, or 

response to better suit your specific needs and preferences. 

 

4. What is image correction? 

Answer:  Image correction in Photoshop refers to the process of adjusting and enhancing 

various aspects of an image to improve its overall appearance, color accuracy, tonal 

balance, and visual impact. It involves making precise edits to correct common issues or 

imperfections that may affect the quality or aesthetics of the image. 

 

5. What is file format in photoshop? 

File format refers to the specific file extension used to save and store images 

created or edited within the software. Photoshop supports a wide range of file 

formats, each with its own characteristics, capabilities, and intended use 
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Activity Sheet 3-1:  

Task: Retouch Image 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image. 

4. Perform image retouching. 

5. Use necessary tools for retouching. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer. 
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Learning Outcome 4: Apply Color Correction  

 

Content:  

1 Color correction methods  

a. Brightness and Contrast 

b. Hue and Saturation 

c. Level 

d. Curve 

e. Selective colour 

f. Variations 

g. Photo Filter 

2 Image mode  

a. RGB 

b. CMYK 

c. Grey scale 

d. LAB Colour 

e. Index Colour 

3 Image enhancement comparison 

4 Final image transferring procedure  

Assessment Criteria:  

1. Color correction methods are identified 

2. Appropriate image mode is selected 

3. Color correction methods are used 

4. Image enhancement is compared with the original one 

5. Design is saved in appropriate file format 

6. Final image is transferred to recipient 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

 

  

Methodologies  
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•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 4 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Identify color correction methods 

2. Select Appropriate image mode 

3. Use Color correction methods 

4. Compare Image enhancement with the original one 

5. Save Design in appropriate file format 

6. Transfer Final image to recipient 

1. Color correction methods 

Basic Color Correction Techniques Using Photoshop  

Our eyes are very similar and in a way, comparable to a camera. Our eyes are excellent 

when it comes to making an automatic white balance. But cameras are not as good as our 

eyes in doing this. Below are five color correction techniques using Photoshop CC.  

1. Add the Threshold Adjustment and Curves for color correction 

When creating a new layer, go to Edit and Fill then select the layer with 50% gray. The 

layer blend mode must be set to Difference. It is important to set the Threshold level to 10 

and grab the Eyedropper tool while holding down the Shift button. You need to click to 

drop the color over the black spots.What follows next is to delete Threshold and add 

Curves Adjustment Layer. While zooming in the eyedropper to the area of interest, click 

once to have a color balance.  

2. Skin Color adjustment 

To set skin color to perfect, you will be shown with the skin color breakdown of White, 

Black, Latin, and Asian while balancing a fair amount of magenta, yellow, black and cyan 

for a perfect skin. The real technique in this tool is to choose a great area from which 

colors are adjusted and measured. 

3. Adjust the White Balance tool in Camera RAW editor 

In using this tool, you need to open the image in the Camera RAW editor to change the 

image to a smart object and go to Filter then Camera Raw Filter. While choosing the White 

Balance tool the neutral point in the photo to automatically make the white balance 

corrected.  

4. Adjustment for Hue and Saturation Layer 

This is the fourth method of color correction with the use of Photoshop CC. It basically 

needs a /hue and Saturation adjustment layer. You need to utilize the channel drop down 

to point any color that is overwhelmingly seen in the photo. Shifting the hue to reduce the 

saturation will make a big difference. But there is a limitation in using this tool. This 
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method works amazingly when there is a color that is obviously affecting uniformity of 

the whole image.  

5. Free Hand adjustment 

Using the ‘finger’ icon, this will take a Curves adjustment layer while the channels can be 

Red, Green and Blue. You have to drag either up and down on any part of the photo to 

introduce Red/Cyan, Green/Magenta or Blue/Yellow whenever there is a need to do so. In 

a photo whose orientation is landscape, this technique is really effective.  

 Adjusting color hue, saturation, and brightness 

Based on the human perception of color, the HSB model describes three fundamental 

characteristics of color: 

Hue 

Color reflected from or transmitted through an object. It is measured as a location on the 

standard color wheel, expressed as a degree between 0° and 360°. In common use, hue is 

identified by the name of the color, such as red, orange, or green.  

Saturation 

Strength or purity of the color (sometimes called chroma). Saturation represents the 

amount of gray in proportion to the hue, measured as a percentage from 0% (gray) to 100% 

(fully saturated). On the standard color wheel, saturation increases from the center to the 

edge. 

Brightness 

Relative lightness or darkness of the color, usually measured as a percentage from 0% 

(black) to 100% (white).  

  

HSB color model 

H. Hue 

S. Saturation 

B. Brightness 

 

 

Color modes 

• RGB Color mode  

• CMYK Color mode  

• Lab Color mode  

• Grayscale mode  

• Bitmap mode  

• Duotone mode  

• Indexed Color mode  
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RGB Color mode 

Photoshop RGB Color mode uses the RGB model, assigning an intensity value to each 

pixel. In 8 bits-per-channel images, the intensity values range from 0 (black) to 255 (white) 

for each of the RGB (red, green, blue) components in a color image.  

CMYK Color mode 

In the CMYK mode, each pixel is assigned a percentage value for each of the process inks. 

Although CMYK is a standard color model, the exact range of colors represented can vary, 

depending on the press and printing conditions.  

Lab Color mode 

Lab is based on the human perception of color. The numeric values in Lab describe all the 

colors that a person with normal vision sees. Because Lab describes how a color looks 

rather than how much of a particular colorant is needed for a device (such as a monitor, 

desktop printer, or digital camera) to produce colors. 

Grayscale mode 

Grayscale mode uses different shades of gray in an image. In 8-bit images, there can be up 

to 256 shades of gray. Grayscale values can also be measured as percentages of black ink 

coverage (0% is equal to white, 100% to black).  

Bitmap mode 

Bitmap mode uses one of two color values (black or white) to represent the pixels in an 

image. Images in Bitmap mode are called bitmapped 1-bit images because they have a bit 

depth of 1. 

Duotone mode 

Duotone mode creates monotone, duotone (two-color), tritone (three-color), and quadtone 

(four-color) grayscale images using one to four custom inks. 

Indexed Color mode 

Indexed Color mode produces 8 bit image files with up to 256 colors. When converting to 

indexed color, Photoshop builds a color lookup table (CLUT), which stores and indexes 

the colors in the image.  

 

Indexed color files can be saved in Photoshop, BMP, DICOM (Digital Imaging and 

Communications in Medicine), GIF, Photoshop EPS, Large Document Format (PSB), 

PCX, Photoshop PDF, Photoshop Raw, Photoshop 2.0, PICT, PNG,  

About channels  

Channels are grayscale images that store different types of information: 

The Channels panel lists all channels in the image—composite channel first (for RGB, 

CMYK, and Lab images). A thumbnail of the channel’s contents appears to the left of the 

channel name; the thumbnail is automatically updated as you edit the channel. 
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Channel types  

A.  Color channels 

B.  Spot channels 

C. Alpha channels 

 

Color information channels are created 

automatically when you open a new image. The 

image’s color mode determines the number of 

color channels created. For example, an RGB 

image has a channel for each color (red, green, 

and blue) plus a composite channel used for 

editing the image. 

 

Alpha channels store selections as grayscale 

images. You can add alpha channels to create 

and store masks, which let you manipulate or 

protect parts of an image. Spot color channels 

specify additional plates for printing with spot 

color inks. 

 

 

Method#1. Choosing A Gray Color for Color Correction: 

This method works by determining the perfect gray color for an image. To fix an image’s 

color, we must first determine which parts of the image should have been gray in real life. 

Then we’ll have to save that color as a Photoshop reference. 

If there isn’t any place in your photo that should have been gray in real life, we’ll have to 

designate the nearest area to gray. Following the discovery of that area, Photoshop will alter 

the other colors depending on a gray color guideline. 

Step-1: Open The Image In Photoshop. 

To open a file you wish to work on, go to File from the top menu and select Open. 
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Step-2: Select A Gray Reference: 

Next, we’ll select a gray pointer. Add a ‘New’ layer by pressing on the ‘Plus’ sign in the layer 

panel. 

  

 To make the layered gray, hit ‘Shift+Backspace’ on your keypad. A box will appear on the 

screen. On the ‘Contents Menu’, pick 50% Gray and press OK. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Open-The-Image-In-Photosho.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Select-A-Gray-Reference.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/To-make-the-layered-gray-hit-ShiftBackspace-on-your-keypad.-A-box-will-appear-on-the-screen.-On-the-Contents-Menu-pick-50-Gray-and-press-OK.jpg
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Now, choose ‘difference’ from the Blending Mode drop-down menu. 

  

 

Step-3: Locate The Darkest Spot: 

Select ‘Threshold’ from the ‘Adjustment’ Layer menu (right next to the Layer mask icon). 

There will be a diagram. 

  

 

Right now, determine which section is the darkest by moving the slider. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Now-choose-difference-from-the-Blending-Mode-drop-down-menu.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Locate-The-Darkest-Spot.jpg
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 Step-4: Eliminate The Layers: 

Delete all the remaining layers except for the primary layer. Select ‘Delete Layer’ from the 

context menu when you right-click on the Layer. 

  

 

Step-5: Curves: Choose Curves from the ‘Adjustment’ Layer. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Right-now-determine-which-section-is-the-darkest-by-moving-the-slider.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Eliminate-The-Layers.jpg
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 There are three Eye-droppers directly next to the curve, as you can see. Now choose the Gray 

point with the middle-eyedropper. 

  

 

Step-6: Select The Darkest Spot You Discovered Previously. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Curves-Choose-Curves-from-the-Adjustment-Layer.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/There-are-three-Eye-droppers-directly-next-to-the-curve-as-you-can-see.-Now-choose-the-Gray-point-with-the-middle-eyedropper.jpg
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 It will fix the image’s color. Remember that, even though we’re focusing on the darkest part 

of the image, it could not work for all of them. In that case, experiment with some other aspects 

of the image. It’s determined by how you wish to view the image. So, try to achieve the desired 

color. 

Step 7: Save Your Work: 

To save the photograph, go to File and Save As. 

  

  

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Select-The-Darkest-Spot-You-Discovered-Previously.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Save-Your-Work.jpg
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Here is the final output with your desired color. 

  

Method#2. Color Correction Using Color Balance: 

There is another approach to correct color. That’s how the Color Balance feature works. To 

do so, you’ll need a rudimentary understanding of color. As a result, we’ll use complementary 

colors in this project. 

If an image has a specific color cast (an excessive amount of one color), we’ll need to adjust 

the amount of the contrasting color. Look at the complementing colors first. 

Cyan – Red 

Magenta – Green 

Yellow – Blue 

 Assume the image has a red cast. It has an enormous amount of red in it. As you know, the 

cyan color is the polar opposite of red. As a result, we’ll boost the cyan, which will reduce the 

red. 

Let’s have a look at the procedure! 

 Step-1: Open The Photo File. 

To open the file you wish to work on, go to ‘File’ from the top menu and select ‘Open. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Here-is-the-final-output-with-your-desired-color.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Open-The-Photo-File.jpg
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Step-2: Make A Duplicate Layer. 

Duplicate the Background Layer by right-clicking it and selecting Duplicate Layer—

alternatively, press Ctrl+J on your keyboard. 

  

  

Step-3: Achieve Color Harmony. 

Select Color Balance from the Adjustment Layer menu (right next to the Layer mask icon). 

  

 Step-4: Balancing The Slider. 

Look at the photo below. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Make-A-Duplicate-Layer.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Achieve-Color-Harmony.jpg
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 It’s obvious that it’s cast in magenta. As a result, adjust the slider to make the green color 

brighter. When you’re through, come to a halt. 

  

 Now, there appears to be a yellow tint. As a result, we’ll also enhance the blue color. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Balancing-The-Slider.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Its-obvious-that-its-cast-in-magenta.-As-a-result-adjust-the-slider-to-make-the-green-color-brighter.-When-youre-through-come-to-a-halt.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Now-there-appears-to-be-a-yellow-tint.-As-a-result-well-also-enhance-the-blue-color..jpg
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 Step-5: Modify the Image’s Light. 

You can use Curves to change the image’s illumination. 

  

  

Step-6: Make A Backup. 

To save the picture, go to File and Save As. 

  

Layers  

Photoshop layers are like sheets of stacked acetate. You can see through transparent areas of 

a layer to the layers below. You move a layer to position the content on the layer, like sliding 

a sheet of acetate in a stack. You can also change the opacity of a layer to make content 

partially transparent. 
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• Layer Selection & Creating layer 

• Grouping, and linking layers 

• Moving, stacking, and locking 

layers 

• Delete & Hide layers 

• Setting opacity and blending 

• Layer effects and styles 

• Adjustment and fill layers 

• Layer comps 

• Masking layers 

 

 

4. Image transferring procedure 

Import an Image into Photoshop 

You can import an image to Photoshop from both a computer and other device as camera, 

scanner or you will nedd to download form internet. 

1. Open Photoshop on your PC It’s in the All-Apps area of the Start menu in Windows. 

Use this method if you want to import a single image into your Photoshop project. 

2. To create a new file, press Ctrl+N(Windows) name the file, then click OK. 

 

 
 

3. Click the New Layer icon. It’s near the bottom-right corner of the Layers panel. It 

looks like a square sheet of paper with an upturned corner. This creates a new layer. 
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4. Click the File menu. It’s at the top-left corner of the screen. 

5. Click Place It’s near the center of the menu. This opens your computer’s file browser. 

 
 

6. Select the image you want to import and click Place. 
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7. Click the checkmark. It’s at the top of the screen. The image is now placed on the 

new layer. 
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Self Check 4.1 

 

Answer the following questions: 

1. What is hue and saturation? 

 

 

2. What is color correction? 

 

 

 

3. What is CMYK? 
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Answer Sheet 4.1 

1. What is hue and saturation? 

Hue refers to the pure color itself, often represented as a specific point on the color wheel. 

It determines the basic color family or category, such as red, blue, green, yellow, etc. Hue 

is essentially what we perceive as the "color" of an object or light source. The color wheel 

is a circular representation of hues, with the primary colors (red, blue, and yellow) evenly 

spaced around the wheel, and the secondary and tertiary colors in between. 

Saturation, on the other hand, refers to the intensity or purity of a color. It represents how 

vivid or dull a color appears. A highly saturated color is vibrant, rich, and intense, while 

a desaturated color is more muted, pale, or washed out. Saturation is often represented as 

a percentage, with 100% indicating full saturation and 0% indicating a completely 

desaturated or grayscale color. 

2. What is color correction? 

Answer: color correction refers to the process of adjusting and enhancing the colors of an 

image to achieve a desired look or to correct any color issues. Photoshop provides various 

tools and techniques to perform color correction, allowing you to modify the hue, 

saturation, brightness, contrast, and other color attributes of an image. 

3. What is CMYK? 

Answer: CMYK is an acronym that stands for Cyan, Magenta, Yellow, and Key 

(Black). It is a color model used primarily in printing and is often referred to as a 

subtractive color model. CMYK is based on the concept that when these four ink colors 

are combined at varying levels, they can produce a wide range of colors.   
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Learning Outcome 5: Apply Effects  

Content:  

1 Effect options 

2 Image mode  

3 Effects comparison and adjustment 

4 Image transferring procedure 

Assessment Criteria:  

1 Identify appropriate effect options 

2 Proper image mode is selected 

3 Effects are applied to images/ layer as per requirements 

4 Effects are compared and adjusted 

5 Image is saved in appropriate file format 

6 Image is transferred to recipient 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 5 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1 Identify appropriate effect options 

2 Proper image mode is selected 

3 Effects are applied to images/ layer as per requirements 

4 Effects are compared and adjusted 

5 Image is saved in appropriate file format 

6 Image is transferred to recipient 

The Effect 

In Adobe Photoshop, the Effect options refer to a variety of visual enhancements and 

modifications that can be applied to an image or graphic element. These options allow you to 

manipulate and transform the appearance of your artwork in creative ways. Here are some of 

the commonly used Effect options in Photoshop: 

  

Drop Shadow: Adds a shadow behind an object to create a sense of depth or realism. You can 

control parameters like opacity, distance, angle, and size of the shadow. 

Inner Shadow: Similar to drop shadow, but the shadow is applied inside the boundaries of the 

object, creating a recessed or engraved effect. 

Outer Glow: Creates a soft halo of light around the edges of an object. You can adjust the 

glow's color, size, and opacity. 

Inner Glow: Similar to outer glow, but the light effect is applied inside the boundaries of the 

object. 

Bevel and Emboss: Adds a three-dimensional effect to an object by simulating highlights and 

shadows on its edges. You can control the depth, size, angle, and shading style. 

Satin: Applies a silky or metallic texture to an object, giving it a soft sheen. You can adjust 

parameters such as color, size, and blending mode. 

Gradient Overlay: Overlays a gradient fill on an object, allowing you to blend multiple colors 

smoothly across its surface. 

Pattern Overlay: Applies a pattern fill to an object, allowing you to use custom patterns or 

textures. 
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Stroke: Adds an outline or border around the edges of an object. You can specify the color, 

size, and position of the stroke. 

Drop Shadow: Applies a realistic shadow behind an object, simulating its interaction with 

light sources. You can control the shadow's opacity, angle, distance, and size.  

Image Mode 

In Photoshop, "image mode" refers to the color space or color model in which an image is 

represented. It determines the range and number of colors that can be used in an image. 

Photoshop provides several different image modes, each suited for specific purposes. The 

most common image modes in Photoshop are: 

RGB (Red, Green, Blue): This is the default mode for most images used on screens and in 

digital media. RGB mode uses combinations of red, green, and blue light to create a wide 

range of colors. Each pixel in the image is composed of three color channels (red, green, and 

blue) that can vary in intensity from 0 to 255. The combination of these channels determines 

the overall color of each pixel. 

CMYK (Cyan, Magenta, Yellow, Black): CMYK mode is primarily used for print purposes. 

It is a subtractive color model, where colors are created by subtracting varying amounts of 

cyan, magenta, yellow, and black inks. Unlike RGB, which uses light, CMYK represents 

colors using ink on paper. When working in CMYK mode, it's important to note that some 

colors visible on a computer screen might not be achievable in print. 
 

Grayscale: Grayscale mode represents images using shades of gray, ranging from black to 

white. It's commonly used for black and white photography or when color is not necessary. In 

grayscale mode, each pixel is represented by a single channel of varying intensity from 0 

(black) to 255 (white). 
 

Lab Color: Lab Color mode is a color model designed to encompass the full range of human 

vision. It separates the lightness (L) component from the color information (a and b axes), 

allowing for more accurate color adjustments and conversions. Lab Color mode is often used 

for advanced color correction and editing tasks. 
[ 

Indexed Color: Indexed Color mode uses a limited palette of colors to reduce the file size of 

an image. It assigns an index value to each color in the palette and stores the image data based 

on those indices. This mode is commonly used for web graphics or images with a limited 

number of colors, such as logos or icons.  

 

  



 

106 

 

Effect in Photoshop 

Step 1 – Preparing your Image  

First, you need to open your image on Photoshop and duplicate your layer.  

 
Use the Lasso tool on your background layer to cover your subject.  

 
Right-click within the lasso outline and click on Fill. 

Choose ‘content-aware’ and click OK. 
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Now you should be left with just the image background. 

 
Step 2 – Selecting your Subject 

Now you can use the Quick Selection tool to mark out a rough outline of your subject. This 

can be done in many ways, but the Quick Selection tool works well for this technique.  
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With your subject is selected, click ‘select + mask’ at the top. 

Now, you want the Refine Edge brush toward the left of your screen.  

 
Select ‘show edge’ to the right of your screen and draw a simple line around the outskirts of 

your subject. This will help with loose hairs and other more challenging-to-define edges in 

your image.  
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Then select ‘layer mask’ from the Output drop-down menu and press OK. 

 
 

Now duplicate the layer. Drag your layer to the bottom of the Layers panel and drop it onto 

the ‘new layer’ icon. 

 

 
Step 3 – Preparing the Dispersion Effect 
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Select the top image. Then, right-click on the new layer mask and select ‘apply layer mask’.  

 
The top layer should now be the isolated subject. Rename this layer ‘Dispersion’. This will 

make identifying your layers a lot easier.  Make a copy of your ‘Dispersion’ layer. You can  

 

now rename this to ‘Foreground’.  With the ‘Dispersion’ layer selected, go to Filter in the top 

bar, then select ‘liquify‘.  This will bring up a new window. Toward the top left of this 

window, there’s a Forward Warp tool. Select this tool, and now you will be able to drag out  

the area you want to disperse.   In this section, you can increase or decrease the size and 

strength of the Liquify brush. You want to warp the image to mimic the way ashes would fly 
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away from your subject. Be sure to use swooping motions to reflect 

this.  

Once you are happy, click OK. You will then see an image similar to this.  

 
Step 4 – Create the Dispersion Effect 

Now you need to get your layers ready for the dispersion effect. Click on your ‘Dispersion’ 

layer, and add a layer mask. For the ‘Dispersion’ layer, you want to Alt click (or Option click 

for Mac) when selecting the ‘Add Layer Mask’ icon in the lower layers panel. This 

automatically hides everything on your ‘Dispersion’ layer.  

 
Now create a layer mask for your ‘Foreground’ layer without the alt-click. This should leave 

your workspace looking like this.  
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Make sure your new Dispersion Effect Brush tool is in Photoshop.  

With these new brushes, start working away at the edges that go in the direction of the effect. 

Remember you are working on the new layer mask. You want to be painting with black 

selected.  

 
With these brushes, you can change the size and direction they face. Be sure to have your 

opacity and flow at 100%. When you have finished this, click on the mask for your 

‘Dispersion’ layer. We will now start adding the ‘ashes’. Invert your Brush tool color from 

black to white by clicking ‘x’. Now you can start revealing the bits you dragged out. Play 

around with this bit by changing brush sizes. You might also want to add a brush with the 

opacity reduced to fine-tune your effect.  
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Make sure you constantly switch between the ‘Dispersion’ and ‘Foreground’ layers to make 

the transition look refined. Remember that each time you swap masks, you need to be cautious 

of your brush color.  

Once you are happy with the dispersion effect you’ve created, you can further refine the 

image.  

Select the ‘Foreground’ image and use a brush to remove the bits that don’t fit. You want to 

use a white brush tool for this part. Here, I have left her face and shoulder intact. This makes 

it look like the model is just starting to disappear.  

 
You are now able to make any further edits, like sharpening or anything else you want! This 

is the most basic way to make a dispersion effect in Photoshop. 
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Saving options 

When saving a file in Photoshop, you have several options and file formats to choose from: 

PSD: This is the default file type for Photoshop documents, although you won't necessarily 

use it for every image. It will save your layers and all of the other information in your image 

so you can easily re-edit it later. PSD files are designed to be opened in Photoshop, so if you 

want to share the image with others you'll also need to save a copy of the image in a common 

file format, like JPEG. 

Common file formats: You can save images in a variety of common file types, 

including JPEG and PNG. These file formats can be viewed and edited on almost any 

computer or mobile device, which makes them well-suited for sharing with others. However, 

unlike PSD files these formats aren't as useful if you plan to continue editing the file, and they 

also can't preserve layer information. 

Save for Web: If you're planning to upload an image to the Web, like on a blog or website, 

you'll want to use the Save for Web feature. This tool allows you to save images that 

are optimized for the Web, which will make them easier to download and view online. Save 

for Web also includes several helpful features for preparing images for the Web, including the 

option to resize images. 

In the image below, you can see three different versions of an image file: the original JPEG 

file, an edited PSD version, and a final JPEG version that's been resized and saved for the 

Web. You can see that the Web version has a much smaller file size than the original and PSD 

versions. 
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Ultimately, the saving option you choose will depend on what you need to do with the image. 

Let's take a look at a couple of scenarios to see why you might choose different saving options. 

Scenario 1 

Let's say you're asked to create a new header image for a company website. You've been given 

a photo to include, and you need to add some text with the company name. Because you'll 

likely edit and revise this type of project, you'll want to save it as a PSD file. This way, you 

can easily continue editing the file later on. And because it will eventually be posted online, 

you'll also want to use Save for Web to create a new JPEG version of the finished image. 

Scenario 2 

Let’s say you're planning to share some photos from a recent vacation with your friends. You'd 

just like to make some quick adjustments in Photoshop, like cropping and rotating, before 

sharing them. In this case, you could open the original image files in Photoshop, make the 

necessary adjustments, then save a new version of the edited photos as JPEGs. Because none 

of these edits are too complicated, you probably don’t need to save a separate PSD version of 

each image. 

As you can see, the saving option you choose will vary from project to project. Before saving 

an image, take a moment to consider the type of files you'll need. As you start to gain more 

experience with Photoshop, this process will begin to feel quick and natural. 

Using Save As 

You'll use the Save As command to save files in the PSD format, as well as other common 

formats like JPEG and PNG. 

With the image open in Photoshop, select File > Save As. 

 

 

A dialog box will appear. Type the desired file name, then choose a location for the file. You'll 

want to use a new file name to avoid accidentally overwriting the original file. 
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Click the Format menu, then choose the desired file format. In our example, we'll save this 

image as a JPEG file. If you're saving as a PSD file, make sure the Layers option is checked. 

However, most other formats won't allow you to select this option. Click Save.  

 

Some file formats, such as JPEG and TIFF, will give you additional options when saving. 

Select the desired quality level, then click OK to save the image. 

 



 

117 

 

If you've already saved your project as a PSD file, you can select File >Save or 

press Ctrl+S (or Command+S on a Mac) to save your progress at any time. However, if you're 

working with another format like JPEG, we recommend using Save As to avoid overwriting 

your original file. 

Save for Web  

Go to File>Export>Save for Web (Legacy)... 

A dialogue box will appear. Select JPEG and lower your quality down to 60%. Make sure you 

have the checkbox for “Progressive” checked. (Progressive means that when you first get to 

your web page, it will show a low quality version of the full picture that will progressively 

gets sharper as the page loads. Otherwise, the picture will load in full quality, but only a bar 

of information at a time.) 

Check to make sure your photo size is around 100K or less before you save it. If it is too big, 

you might need to lower the quality down to 50%. 
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Click save. Choose where you want to save the image and then click save again. 
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Self Check 5.1  

Answer the following questions: 

1 What is effect in photoshop? 

 

 

 

2 Why we use drop shado? 

 

 

 

3 What is Bevel and Emboss? 

 

 

 

4 Write some image mode. 
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Answer Sheet 5.1 

1. What is effect in photoshop? 

Answer: Effect options refer to a variety of visual enhancements and 

modifications that can be applied to an image or graphic element. These 

options allow you to manipulate and transform the appearance of your 

artwork in creative ways 

2. Why we use drop shado? 

Answer: Adds a shadow behind an object to create a sense of depth or realism. You 

can control parameters like opacity, distance, angle, and size of the shadow. 

3. What is Bevel and Emboss? 

Answer:  Adds a three-dimensional effect to an object by simulating highlights and 

shadows on its edges. You can control the depth, size, angle, and shading style. 

4. Write some image mode. 

Answer: 

•  RGB (Red, Green, Blue) 

• CMYK (Cyan, Magenta, Yellow, Black):  

• Grayscale 

• Lab Color:  

• Indexed Color 
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Activity Sheet 5-1:  

Task: Apply effect in a jpeg image. 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Apply effect as per the sample image. 

5. Save your work at PSD and JPEG file format 
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Learning Outcome 6: Evaluate own work 

Content:  

1 Constructive criticism 

2 Own works evaluation  

Assessment Criteria:  

1 Constructive criticism from others is applied to improve own works. 

2 Own works are evaluated against planned Strategy for own practice. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 6 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1 Apply constructive criticism from others to improve own works. 

2 Evaluate own works against planned Strategy for own practice 

Constructive criticism 

Constructive criticism is a feedback approach that focuses on providing helpful and valuable 

insights to improve someone's work, skills, or behavior. It involves offering thoughtful and 

specific suggestions for improvement while maintaining a respectful and supportive tone. The 

purpose of constructive criticism is to assist the person receiving feedback in recognizing areas 

of weakness or opportunities for growth and providing guidance on how to address them 

effectively. 

Key elements of constructive criticism include: 

Specificity: Constructive criticism should be specific and focused on particular aspects of the 

work or behavior being evaluated. Vague or general comments may not provide enough 

guidance for improvement. Instead, pinpoint specific areas that require attention or suggest 

alternative approaches. 

Clarity: It is important to clearly communicate the feedback, ensuring that the person receiving 

it understands the issues being addressed. Use clear and concise language to avoid confusion 

or misinterpretation. 

Balance: Constructive criticism should strike a balance between pointing out areas for 

improvement and acknowledging the strengths and positive aspects of the work. By 

highlighting both the positives and negatives, the person receiving feedback can gain a more 

well-rounded understanding of their performance. 

Respect and Empathy: Constructive criticism should be delivered in a respectful and 

empathetic manner. Recognize the effort and intentions behind the work and acknowledge the 

person's skills and capabilities. It is crucial to provide feedback that motivates and inspires 

rather than demoralizes or discourages. 

Solution-Oriented: Constructive criticism should not only identify problems but also offer 

potential solutions or suggestions for improvement. Providing actionable recommendations 

helps the person receiving feedback understand how to address the identified issues and make 

progress. 

Open Dialogue: Encourage a two-way conversation by inviting the person to share their 

perspective, ask questions, and provide their insights. This fosters a collaborative and 

constructive environment, allowing for a deeper understanding of the feedback and fostering 

a sense of ownership over the improvement process. 
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Timing and Relevance: Consider the timing and context in which you provide constructive 

criticism. Choose an appropriate moment where the person is receptive and open to feedback. 

Also, ensure that the feedback is relevant and aligned with the goals or objectives of the work 

or project. 

Evaluation 

Evaluation refers to the systematic process of assessing and determining the value, worth, 

effectiveness, or quality of something. It involves gathering information, analyzing data, and 

making judgments or conclusions about the object or subject being evaluated. Evaluation is 

conducted to understand the strengths, weaknesses, impacts, and outcomes of a program, 

project, product, process, or any other entity. It helps in making informed decisions, improving 

performance, and informing future actions. 

Evaluating your own work in graphic design is an essential part of the creative process. It 

helps you identify strengths and weaknesses, make improvements, and grow as a designer. 

Here are some steps to effectively evaluate your own work in graphic design: 

Define the objectives: Start by clarifying the objectives of the project. Understand what you 

were trying to achieve and the intended message or purpose of the design. This will provide a 

clear framework for evaluation. 

Take a break: After completing a project, take some time away from it. Step back and give 

yourself a fresh perspective. This break will help you detach emotionally and view your work 

more objectively. 

Review the brief: Revisit the initial project brief or requirements. Compare your final design 

with the original goals and see if you have effectively met them. Evaluate whether the design 

meets the needs of the target audience and aligns with the desired message. 

Consider the context: Think about the context in which your design will be used. Consider the 

medium, platform, or environment in which it will be presented. Evaluate how well your 

design fits within that context and if it effectively communicates its intended message. 

Assess the visual elements: Analyze the visual aspects of your design, including layout, 

composition, color palette, typography, and imagery. Evaluate if they work harmoniously 

together, convey the desired mood or tone, and create visual impact. Consider principles of 

design, such as balance, contrast, hierarchy, and unity. 

Seek feedback: One of the most valuable ways to evaluate your work is to seek feedback from 

others. Reach out to fellow designers, mentors, or clients to get their perspective. Ask for 

constructive criticism and specific suggestions for improvement. Be open to different 

viewpoints and learn from the insights of others. 

Test with the target audience: If possible, conduct user testing or gather feedback from the 

target audience. This can provide valuable insights into how well your design communicates 

and resonates with the intended users. Consider conducting surveys, focus groups, or usability 

tests to gather feedback directly. 
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Compare with industry standards: Evaluate your work in comparison to industry standards 

and current design trends. Stay updated with the latest design practices, techniques, and styles. 

Assess if your design is innovative, unique, and competitive within the field. 

Reflect on your process: Evaluate not only the final outcome but also your design process. 

Assess if you effectively managed your time, resources, and workflow. Reflect on the 

decisions you made, the challenges you faced, and the lessons learned along the way. 

Iterate and improve: Based on your evaluation, identify areas of improvement and create an 

action plan. Implement the necessary changes, refine your design, and iterate as needed. 

Remember that evaluation is an ongoing process, and each project provides an opportunity for 

growth and learning.  

When evaluating your own work in graphic design, it can be helpful to have a structured 

approach. Here's a technique you can follow to assess and improve your designs: 

1. Initial Assessment: 

• Take a step back and look at your design with fresh eyes. 

• Note your initial thoughts and feelings about the design. 

• Consider the project's objectives and whether you believe you've met them. 

2. Analyze the Design Elements: 

• Evaluate the visual elements of your design, such as layout, color, typography, 

imagery, and composition. 

• Assess how well these elements work together to convey the intended message or 

evoke the desired emotions. 

• Consider the principles of design (e.g., balance, contrast, hierarchy, unity) and 

determine if they have been effectively applied. 

3. Assess the User Experience: 

• Put yourself in the shoes of the target audience. 

• Evaluate how the design communicates and engages with the users. 

• Consider the clarity of the message, ease of navigation, and overall user-

friendliness. 

• Identify any potential usability issues or areas for improvement. 

4. Evaluate the Impact: 

• Reflect on the design's effectiveness in achieving its purpose. 

• Consider whether it grabs attention, communicates the intended message clearly, 

and elicits the desired response. 

• Assess its visual impact and whether it stands out within its intended context. 

5. Seek Feedback: 

• Share your work with others, such as fellow designers, mentors, or clients. 

• Request specific feedback and constructive criticism on various aspects of your 

design. 

• Consider their perspectives and insights, and use them to gain a broader 

understanding of the strengths and weaknesses of your work. 
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• Compare with Competitors and Industry Standards: 

• Research and analyze the work of other designers or competitors in the field. 

• Compare your design to industry standards and current design trends. 

• Assess whether your design stands out, is competitive, and pushes boundaries in a 

positive way. 

6. Iterate and Improve: 

• Based on your evaluation and feedback received, identify areas for improvement. 

• Prioritize the changes or adjustments that will have the most significant impact. 

• Make necessary revisions and refinements to enhance your design. 

7. Document and Learn: 

• Keep a record of your evaluation process, including the feedback received and the 

improvements made. 

• Reflect on what you've learned from the evaluation and how it can inform your 

future work. 

• Continuously seek opportunities to develop and grow as a designer. 
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Self Check 6.1  

Answer the following questions: 

 

1. What is Constructive criticism? 

 

 

 

 

2. What are key elements of constructive criticism? 

 

 

 

 

3. What is Evaluation? 
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Answer Sheet 6.1 

1. What is Constructive criticism? 

Answer: Constructive criticism is a feedback approach that focuses on 

providing helpful and valuable insights to improve someone's work, skills, or 

behavior. It involves offering thoughtful and specific suggestions for 

improvement while maintaining a respectful and supportive tone. 

2. What are key elements of constructive criticism? 

Answer: Key elements of constructive criticism include: 

• Specificity 

• Clarity 

• Balance 

• Respect and Empathy 

• Solution-Oriented 

• Open Dialogue 

• Timing and Relevance 

3. What is Evaluation? 

Answer: Evaluation refers to the systematic process of assessing and determining the value, 

worth, effectiveness, or quality of something. It involves gathering information, analyzing 

data, and making judgments or conclusions about the object or subject being evaluated.   
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Review of Competency 

Below is yourself assessment rating for module “Developing Competency Based Training Curriculum” 

Sl no Assessment of performance Criteria  Yes No 

1.  Image is selected   

2.  Required tool is selected   

3.  Clipping path is created   

4.  Image is separated from background   

5.  New document is created   

6.  Images are pasted for edit   

7.  Layers are created and selected.   

8.  Images are edited and arranged.   

9.  Appropriate retouch tools are identified   

10.  Tools are calibrated as required   

11.  Layers are created and preserved   

12.  Retouch tools are used as per requirement   

13.  Images are corrected and saved in appropriate file format   

14.  Color correction methods are identified   

15.  Appropriate image mode is selected   

16.  Color correction methods are used   

17.  Image enhancement is compared with the original one   

18.  Design is saved in appropriate file format   

19.  Final image is transferred to recipient   

20.  Identify appropriate effect options   

21.  Proper image mode is selected   

22.  Effects are applied to images/ layer as per requirements   

23.  Effects are compared and adjusted   

24.  Image is saved in appropriate file format   

25.  Image is transferred to recipient   

26.  Constructive criticism from others is applied to improve own works.   

27.  Own works are evaluated against planned Strategy for own practice.   

I now feel ready to undertake my formal competency assessment. 

Signed: 

Date: 
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How to use this Competency Based Learning Material (CBLM) 
  

The module, Maintaining and enhancing professional & technical competency contains 

training materials and activities for you to complete. These activities may be completed as part 

of structured classroom activities or you may be required you to work at your own pace. These 

activities will ask you to complete associated learning and practice activities in order to gain 

knowledge and skills you need to achieve the learning outcomes.  

 

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  
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Module Content 

 

Unit Title: Develop materials for output 

Unit Code: OU- ICT-GD-05-L3-V1 

Module Title: Developing materials for output 

Module Description: This module covers the knowledge, skills and attitude required to 

develop materials for output. This covers competencies on verifying design work, preparing 

output template and preparing for final output. 

 

Nominal Duration: 60 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Verify design work 

2. Prepare output template 

3. Prepare for final output 

 

Assessment Criteria: 

1. Design work is opened in relevant Software. 

2. Design is verified against the design brief. 

3. Design is adjusted as required. 

4. Design output is interpreted. 

5. Template for the output is created. 

6. Contents are set accordingly. 

7. Printing Marks are set. 

8. Output Templates are saved. 

9. Text is outlined to objects. 

10. Design Objects are grouped. 

11. Colors are separated according to output.  

12. Final designs are saved. 
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Learning Outcome 1: Verify design work 

 

Assessment Criteria 

 

1. Required Professional Design work are selected. 

2. Appropriate Tools, Palette and arrange them as needed are 

identified. 

3. Ruler/unit/Grids/Guides/Smart Guides as per requirement 

are set 

4. Key Drawing / Design Layout are prepared 

5. Marks are interpreted. 

6. Layer lock is applied 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 Contents 1 Design work  

2 Design verification against the design brief. 

3 Design adjustment as required  

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 1: Verify design work 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about develop materials for 

output 

1. Instructor will provide the learning materials 

develop materials for output  

2. Read the Information sheet/s 
2. Information Sheet No:1- Verify design work 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 1- Verify design work 

 

Answer key No. 1- Verify design work 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Task Sheet No:1-1: Verify and quality-checking 

design work. 
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Information Sheet 1: Verify design work  

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

1.1 Design work  

1.2 Design verification against the design brief. 

1.3 Design adjustment as required. 

1.1 Design work  

 

Design work in graphics refers to the creation of visual elements, compositions, and 

layouts using graphic design principles and techniques. Graphic design encompasses 

various areas such as branding, advertising, marketing materials, user interface (UI) 

design, publication design, and more. Designers in this field use their creativity and 

technical skills to communicate messages, evoke emotions, and solve visual problems. 

 

Open Design work with Illustrator:  

 

Method 1: 

 

To open the original format of an Adobe Illustrator file that has the .ai format, first, 

double click on your Adobe Illustrator app. With the app opened, go to the top menu, 

and click File. Then, click on the Open button. A file browser window opens for you to 

select files. Select the graphic file you want to open that has the .ai file extension with 

the file name, for example, “myartwork.ai”. 

 

Method 2: 

 

Click on your file with the AI file extension, without letting go of your cursor, drag the 

file to the Adobe Illustrator application. Once it hovers above the Illustrator app icon, 

let go of your cursor to drop the file onto the app icon and your file opens right away. 

 

Method 3: 

 

Right-click on your file with the AI file extension, go to Open With, and in the 

dropdown bar, click Adobe Illustrator. 

Any of the above three methods can help you open your AI format file with the Adobe 

Illustrator app. 
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1.2 Design verification against the design brief 

 

Verifying design work involves ensuring its accuracy, quality, and adherence to the 

required specifications or design brief.  
 

Here are some steps you can follow to verify your design work: 
 

▪ Review the design brief: Start by revisiting the initial design brief or project 

requirements. Understand the goals, objectives, and specifications outlined in the 

brief. This will serve as a reference point for evaluating the design. 

 

▪ Check for errors and consistency: Carefully examine the design for any errors, 

such as spelling mistakes, grammatical errors, or visual inconsistencies. Check that 

the design elements, typography, colors, and layout are consistent throughout the 

project. 

 

▪ Assess visual hierarchy: Evaluate the visual hierarchy of the design to ensure that 

important elements are appropriately emphasized and that the overall composition 

guides the viewer's attention effectively. Verify that the design effectively 

communicates the intended message or information. 

 

▪ Test functionality (if applicable): If the design involves interactive elements, such 

as a website or app interface, test the functionality to ensure it works as intended. 

Click through links, buttons, or interactive elements to verify that they are responsive 

and lead to the correct destinations. 

 

▪ Seek feedback: Share the design with a trusted colleague, client, or target audience 

for feedback. Ask for their input regarding the overall effectiveness of the design, its 

clarity, and whether it meets the intended objectives. Consider incorporating 

constructive feedback to improve the design. 

 

▪ Validate technical specifications: If the design is intended for a specific medium 

or format, verify that it meets the required technical specifications. This includes 

aspects such as resolution, file format, color mode, and dimensions. Ensure that the 

design is prepared and optimized for its intended use. 

 

▪ Conduct usability testing (if applicable): For user interface (UI) or user experience 

(UX) designs, consider conducting usability testing with representative users. 

Observe how users interact with the design and gather feedback on its usability, 

intuitiveness, and user satisfaction. 

 

▪ Proofread and finalize: Before declaring the design as complete, carefully 

proofread the text, captions, or any written content. Ensure that all necessary 

revisions and improvements have been implemented. Save a final version of the 

design, ready for delivery or distribution.  
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1.3 Design adjustment as required 

 

Document adjustment in Illustrator refers to modifying the settings and properties of an 

existing document to suit specific requirements or to match the desired output. These 

adjustments can include changing the document size, orientation, color mode, 

resolution, and other settings.  

 

Here's an explanation of the document adjustment process in Illustrator: 

 

▪ Open the document: Launch Adobe Illustrator and open the document you want to 

adjust. You can do this by selecting "File" from the menu bar, choosing "Open," and 

selecting the desired document file. 

 

▪ Document Setup: To adjust the document settings, go to the menu bar and select 

"File" > "Document Setup." Alternatively, you can use the keyboard shortcut 

Ctrl+Alt+P (Windows) or Command+Option+P (Mac). 

 

▪ Adjusting document size: In the Document Setup dialog box, you can modify the 

document size by changing the width and height values. You can enter the 

dimensions manually or choose from preset sizes in the "Preset" drop-down menu. 

Enable the "Constrain Proportions" option to maintain the aspect ratio while 

adjusting one dimension. 

 

▪ Changing document orientation: You can switch between landscape and portrait 

orientation by selecting the desired option in the "Orientation" section of the 

Document Setup dialog box. 

 

▪ Modifying color mode: Illustrator supports different color modes such as RGB, 

CMYK, and others. You can select the appropriate color mode based on your 

intended output. Choose the desired color mode from the "Color Mode" drop-down 

menu in the Document Setup dialog box. 

 

▪ Adjusting resolution: If you are working on a document for print or digital 

purposes, you may need to adjust the resolution. Specify the desired resolution value 

in pixels per inch (ppi) or dots per inch (dpi) in the "Resolution" field of the 

Document Setup dialog box. 

 

▪ Additional adjustments: The Document Setup dialog box offers other options for 

adjusting the document, such as the number of artboards, bleed settings, and more. 

Modify these settings as needed based on your requirements. 

 

▪ Apply the adjustments: Once you have made the necessary adjustments, click the 

"OK" button in the Document Setup dialog box to apply the changes to the 

document. 
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It's important to note that adjusting the document settings in Illustrator may have 

implications on existing artwork, layout, and alignment. Therefore, it is 

recommended to double-check the positioning and size of elements within the 

document after making adjustments to ensure everything remains visually 

consistent. 

 

▪ Document Size Specifications 

▪ To set up the Bleed: 

▪ Click File > Document Setup. 

▪ Type in 0.125 in all 4 boxes shown below 
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▪ Click OK 

▪ To set up the Safety Zone: 

▪ Select the Rectangle tool 

 

 

Now click once anywhere on your document 

 

 
 

▪ In the "Rectangle" window, type in the boxes the size of your page MINUS .25 

inch. 

▪ For example, if your page is 8.5 x 11, you would enter in the Rectangle box 

Width: 8 in and Height: 10.75 in. 

▪ Click OK 

▪ Now with that box selected, you will center it precisely on the page: 

▪ Press Shift+F7 on the keyboard to bring up the ALIGN box. 

 

Follow these steps: 
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Now make the box a guideline by pressing Ctrl+5 (Command+5 on a Mac) 
 

 

The box will show up as a light-blue margin that you can see but will not print. Keep 

anything important inside of this Safety Zone. 
 

Color must be CMYK 

To ensure your illustrator file is in CMYK: Click File > Document Color Mode > CMYK 
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This only sets the color mode for the file, there may still be artwork and/or photos in RGB 

mode in your file. 

 

To convert artwork or photos in Illustrator to CMYK: With the item selected, click Edit > Edit 

Colors > Convert to CMYK 

 

 

 

To convert everything in the document you can select All first and do this. 

To create rich black for black bacgrounds and other large areas of black, Set all four CMYK 

sliders to100%. 
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For black text you should only use 100% K (black) 

Resolution 

▪ To ensure your outputted PDF from Illustrator is at 300DPI: 

Click the Effect > Document Raster Effects Settings... 

Set all options as below: 
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Click OK 

 

▪ To check the resolution of a photographic image: 

With the image selected, 

Press Shift+F3 to bring up the DOCUMENT INFO window. 

 

▪ Click the menu button in the window 

▪  

Choose Embedded Images in the list (if the image is linked, choose Linked Images) 

The resolution will show in the DOCUMENT INFO window. If the image is below 

300DPI it will print pixelated. You can either use a higher resolution image, or make 

the image smaller until it reaches 300DPI. 
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Self-Check Sheet - 1: Verify design work  

 

Questionnaire: 

 

 

1. What is professional design? 

  Answer: 

  

 

2. Write some professional design works? 

    Answer: 

 

 

3. What is rular? 

Answer: 

 

 

4. What is bleed marks? 

Answer: 
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Answer Key - 1: Verify design work  

 

 

1. What is professional design? 

 

  Answer: Professional design refers to the creation of high-quality, polished, and visually 

appealing designs using the software's extensive features and tools. It involves utilizing 

Illustrator's capabilities to produce designs that meet industry standards and effectively 

communicate the intended message or purpose. 

  

 

2. Write some professional design works? 

 

    Answer: Some Professonal Design Works are: 

 

▪ Brochure 

▪ Invitation Card 

▪ Envelop 

▪ Folder 

▪ Poster 

▪ Complex Logo  
 

3. What is rular? 

Answer: Whether you need to delimit your composition using precise guides or measure 

different objects off your Artboard, the Ruler should be your “go to tool”, since it was 

designed exactly for that use 

 

 

4. What is bleed marks? 

Answer: A bleed refers to the image beyond the final trim that will be cut off after the 

material has been printed and cut down. Bleeds are an important part of the printing process 

because even the smallest amount of misregistration or knife draw could leave finished 

work with white edges. 
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Task Sheet-1.1: Verify and quality-checking design work 

 

 

Working Procedure:  
 

1. Review the Design Brief and Specifications 

2. Compare the Design with the Project Requirements 

3. Check for Design Consistency 

4. Assess Typography and Readability 

5. Verify Color Accuracy and Reproduction 

6. Proofread the Text and Content 

7. Test the Design on Different Devices (if applicable) 

8. Seek Feedback and Validation 

9. Make Revisions and Iterate 

10. Finalize and Document Design Approval  
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Learning Outcome 2: Prepare output template 

 

Assessment Criteria 

 

1. Design output is interpreted. 

2. Template for the output is created. 

3. Contents are set accordingly. 

4. Printing Marks are set. 

5. Output Templates are saved. 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 Contents 1 Design output. 

1.1 Stationary 

1.2 Collaterals 

1.3 Flyers and leaflets 

1.4 Brochure, catalogue 

1.5 Book design, magazine 

1.6 Poster, Banner, Festoon etc. 

2 Template for the output. 

3 Printing Marks. 

3.1 Crop Marks (trim marks) 

3.2 Bleed Marks 

3.3 Registration Marks 

3.4 Color bars (densitometer scales) 

3.5 Star target 

4 Templates saving procedure. 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   

 



 

17 
 

Learning Experience 2: Prepare output template 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about develop materials for 

output 

1. Instructor will provide the learning materials 

develop materials for output  

2. Read the Information sheet/s 
2. Information Sheet No:2- Prepare output template 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 2- Prepare output template 

 

Answer key No. 2- Prepare output template  

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet No:2-1: Create a template for out put 

 

Specification sheet No: 2-1: Create a template for 

out put  
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Information Sheet 2: Prepare output template 

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

2.1 Design output. 

2.2 Template for the output. 

2.3 Printing Marks. 

2.4 Output Templates. 

 

2.1 Design output 

 

Design output in Illustrator refers to the process of exporting or saving your design files 

in a format suitable for their intended use or distribution. The design output stage ensures 

that your Illustrator design is converted into a file format, resolution, color mode, or size 

that aligns with the requirements of the final output medium or platform.  

 

Here's an explanation of the design output process in Illustrator: 

 

▪ Finalize your design: Before proceeding with the design output, ensure that your design 

is complete and ready for export. Double-check for any errors, typos, or inconsistencies, 

and make any necessary adjustments. 

 

▪ Select the appropriate file format: Determine the file format that best suits your 

intended output. Illustrator offers various file formats for different purposes, such as 

JPEG, PNG, PDF, SVG, EPS, and more. Consider the requirements of the medium or 

platform where the design will be used, whether it's for web, print, or other digital 

purposes. 

 

▪ Set the desired resolution: Determine the appropriate resolution for your output. For 

print, use a higher resolution, typically 300 dpi (dots per inch), to ensure sharp and 

detailed prints. For web or digital use, lower resolutions like 72 or 96 dpi are usually 

sufficient. Adjust the resolution in the export settings accordingly. 

 

▪ Choose the color mode: Select the appropriate color mode based on the intended output. 

RGB is commonly used for digital or screen-based designs, while CMYK is typically 

used for print. Choose the appropriate color mode to ensure accurate color representation 

in the final output. 
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▪ Set the dimensions or size: If you need to specify specific dimensions or size for your 

design output, adjust the dimensions accordingly. You can set the size in pixels, inches, 

centimeters, or other measurement units based on the requirements of the output medium. 

 

▪ Adjust other settings: Depending on the format and requirements of your output, you 

may have additional settings to adjust. For example, when exporting to PDF, you can set 

compression options, security settings, and page range. Explore the export options and 

adjust them as needed. 

 

▪ Preview and save: Before finalizing the design output, use the preview option to check 

how your design will appear in the exported file. Make sure all elements and details are 

intact and as expected. Once satisfied, save or export the design file using the specified 

settings and location. 

 

▪ Verify the output: Open the exported file in the appropriate software or viewer to verify 

that the output matches your expectations. Check for any unexpected changes or issues 

in color, resolution, or layout. Make adjustments if necessary and repeat the export 

process as needed.  
 

Stationery 
 

Stationery design refers to the creation of visual assets and templates for various printed 

materials that are used for business or personal correspondence. It involves designing 

cohesive and visually appealing elements such as letterheads, envelopes, business cards, 

notepads, and other items typically associated with office or personal stationery.  
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Collaterals 

  

In graphic design, collaterals refer to a collection of printed or digital materials that are 

designed to promote a brand, company, product, or event. These materials are often 

created as a set and work together to communicate a consistent message and visual 

identity. Collaterals play a crucial role in marketing and communication strategies.  

 

Flyers and leaflets are common marketing materials used to promote products, services, 

events, or organizations. They are designed to convey concise information in a visually 

appealing and easily distributable format. While there is some overlap in their purpose 

and usage, there are slight differences between flyers and leaflets: 

 

Flyers: 

 

▪ Size and Format: Flyers are typically smaller in size, ranging from a quarter of a letter-

sized sheet (5.5 x 8.5 inches) to a half of a letter-sized sheet (8.5 x 11 inches). They can 

be single-sided or double-sided, depending on the amount of information to be 

communicated. 

▪ Content and Design: Flyers focus on delivering key information succinctly. They 

include a compelling headline, concise text, visuals, and contact details. Flyers often 

utilize eye-catching graphics, vibrant colors, and attention-grabbing typography to 

capture the reader's attention and communicate the central message effectively. 

▪ Distribution: Flyers are commonly distributed by hand in public spaces, posted on 

bulletin boards, or handed out at events. They are designed to quickly convey information 

to potential customers or event attendees. They are also sometimes inserted in 

newspapers or included in direct mail campaigns. 

Leaflets: 

 

▪ Size and Format: Leaflets are usually larger in size compared to flyers, ranging from a 

half-letter size (5.5 x 8.5 inches) to a letter-sized sheet (8.5 x 11 inches) or even larger. 

Leaflets can be single-folded, bi-folded, or multi-folded to create multiple panels or 

sections for information. 

 

▪ Content and Design: Leaflets provide more space for information, allowing for a more 

comprehensive presentation. They can include sections for detailed descriptions, product 

features, images, pricing, and additional contact information. The design of leaflets 

follows a logical flow of information across multiple panels or sections. 

 

▪ Distribution: Leaflets are distributed through various channels, including direct mail 

campaigns, events, trade shows, exhibitions, or as inserts in magazines or newspapers. 

They are suitable for situations where more detailed information needs to be provided to 

the audience.  
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Brochure 

 

Brochures often known as pamphlets, they distinguish themselves from flyers and 

leaflets because they tend to be folded. You’re probably most familiar with the trifold 

brochure, but feel free to explore other folding options which are available in different 

sizes. 

 

 

While flyers are usually used for large volume hand-outs, brochures are designed to be 

read and to help readers absorb important information. You’ll want to distribute them to 

customers or potential clients that are already interested in what you’re offering (this also 

applies to booklets). That way, you can justify the cost and then spend more on resources 

where it counts. You can order brochures for: 

▪ Fairs 

▪ Trade shows 

▪ Corporate meetings 

▪ Open houses 

▪ Restaurant Menus 

▪ Community brochure racks 

▪ And much more! 
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▪ Marketing teams love brochures because they boost sales and can be a great way to get 

the word out about your brand, company, or event. If you have plan on mailing out your 

brochures, we offer mailing services that are fast and efficient. They need to look 

professional, be well written and include a strong call to action. We have ready-made 

folding and mailing templates to help you design a brochure that looks beautiful and 

essential and will end up paying for itself. 

 

Flyer 

 

Flyers are sometimes known as handbills or posters, and they are one of the most 

popular print marketing products. They are inexpensive and easy to distribute wherever. 

They are typically flat and rectangular, and the most cost-effective size is 8 ½” by 11”, 

the typical printer paper size. However, they can be printed in all sizes and formats. 

 

 

 

Flyers are typically designed to be colorful and impactful, as people only look at them 

for a brief moment. You want it to stand out so that it is visually effective and quickly 

tells people what you need them to know. The great thing about flyers is that it’s hard 

to over-invest. You can print a lot for not a lot of money, and you don’t have to think 

too hard about paper options or ink. We’ll show you the most cost-effective options. 

We also love that you can effectively use them for nearly any cause. 

Remember to think about where you’re distributing them. Flyers work great in smaller 

regions because you can get your message out to a lot of people at a low cost. 
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Leaflet 

 

A leaflet is very similar to a flyer, so we understand why it can be hard to tell the 

difference. In most instances, leaflet is just a synonym for flyer, but some printers and 

designers say there are some differences between the two. Some say the distinction is 

that leaflets tend to be made with high-quality materials and are made to outlast flyers. 

Flyers don’t have a long lifespan, whereas many people will hold onto a leaflet and 

refer back to the information on it when needed. 

 

Though this makes them slightly more expensive to order, it also can be a powerful 

strategy when promoting a product or when used as a tool to educate current and 

prospective customers. Leaflets can be used to target a more exclusive audience, so 

spending a little bit more can help you reap bigger rewards down the road. They can be 

inserted into newspapers and magazines, be stored in shops and restaurants so that more 

people have access to them, and so much more. It boils down to this – flyers are for one 

time events and sales, while leaflets are better used for content that won’t expire right 

away. 

 

 

The Bottom Line – Order High Quality and Affordable 

 

For the differences between leaflets, flyers, brochures and booklets, it all comes down 

to how you’re using those products. Companies will commonly utilize all of these 

promotional materials for different purposes, and not use one exclusively. Successful 

businesses will use several marketing techniques to leverage their budget in the most 

efficient way. 
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Book Design 

 

Book design is the art of incorporating content, format, style, and all the components of 

a book into a coherent unit. It turns a manuscript into a finished product that can be 

printed, sold, and distributed.  

 

Before the digital era, this task was left to the experts at publishers and print shops. 

Nowadays, specialized software makes this process available for anyone that wants to 

try it. And book layout templates really help to speed up the process. 

 
 

Magazine 
 

A magazine is a collection of articles, stories, photographs, and often advertisements 

sandwiched between attention-getting front and back covers. Magazines are typically 

published on a regular schedule, be that once a month, bi-monthly, quarterly, etc. 

Originally, magazines were always printed, but today they can be distributed digitally 

as well. Magazines generally finance themselves by a combination of advertisements, 

prepaid subscriptions, and their purchase price. 
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Poster 

 

A poster is a large printed paper that is designed to be attached to a wall or other vertical 

surface. Posters can typically include both graphics and text; however, they can also be 

completely textual or graphical. They are usually designed to be attractive and 

informative at the same time. Since posters are printed on paper, they are cost effective, 

but they also don’t last long outdoors. 

 

Posters are used for many purposes. They are intended to act as notices or 

advertisements. They can advertise various events, films, musical shows and they are 

also used by protestors, propagandists and similar groups trying to communicate a 

message to the public. There are different types of posters. Some of these include. 

 

Banner 

 

A banner is a long strip of cloth or vinyl bearing a slogan or design. They are carried in 

demonstrations, protests or processions or are hung in a public place. They are also used 

by companies to market their products and services. Banners can be found as billboards, 

behind window screens, on skyscrapers, and even towed by helicopters. They are often 

hung much higher than posters. 

 

Banners often contain only a few words such as a slogan. The size of the font is also 

large. This is probably because they are hung in places where people move quickly. 

Banners also often stand alone, which make them more noticeable. 

 

When compared to posters, banners are much larger in size. They are rectangular in size 

and the banners that are hung from someplace are often longer in height. Although 

banners are more expensive to produce, they are more durable since they are made from 

vinyl. 
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A poster and a banner are both types of printed materials that can be used to display 

information or promote a message, but they have some key differences. A poster is 

typically a larger format than a banner, and is designed to be hung on a wall or displayed 

in a frame. Posters are often used for art, advertising, or educational purposes. 

 

A banner is typically a long, thin piece of fabric or paper that is hung or suspended in a 

public place. Banners are often used to display information or promote a message in a 

public space, such as a street or park. They can be made in a variety of sizes and can be 

hung vertically or horizontally. In summary, a poster is typically larger, meant to be 

hung on a wall, and used for art, advertising, or educational purposes. A banner is 

typically a long, thin piece of fabric or paper that is hung in a public space, and used to 

display information or promote a message. 

 

2.2 Template for the output 

 

A template for the output in Illustrator refers to a pre-designed file that serves as a starting 

point or framework for creating consistent and standardized designs. Templates provide 

a structure, layout, and design elements that can be reused or customized for various 

projects, ensuring visual consistency and saving time in the design process.  

 

Here's an explanation of templates for output in Illustrator: 

 

▪ Structure and Layout: Templates define the overall structure and layout of the design. 

They establish the placement of key elements such as headers, footers, sidebars, and 

content areas. Templates can include predefined grids, guides, and margins to help align 

elements consistently across different designs. 
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▪ Design Elements: Templates may include pre-designed design elements such as logos, 

background graphics, dividers, icons, or typography styles. These elements contribute to 

the visual identity and style of the design. Templates often have placeholders for images 

or text that can be easily replaced with actual content. 

 

▪ Standardized Formatting: Templates maintain standardized formatting and styling. 

They specify fonts, font sizes, colors, and other design attributes to ensure consistency 

throughout the design. This consistency is crucial for branding purposes and to maintain 

a professional and cohesive look across various designs. 

 

▪ Reusability: Templates are created with the intention of being reused for multiple 

projects. They provide a starting point or foundation that can be customized and adapted 

to suit specific needs. Designers can modify the template by adding or removing 

elements, changing colors or typography, and incorporating project-specific details while 

retaining the overall structure and design framework. 

 

▪ Efficiency and Time-Saving: Templates streamline the design process by eliminating 

the need to recreate design elements or layouts from scratch. They save time and effort 

by providing a ready-made structure that designers can work with. Templates also 

facilitate consistency across different projects and allow for quicker turnaround times. 

 

▪ Branding Consistency: Templates play a significant role in maintaining branding 

consistency. By using templates that incorporate brand elements such as logos, colors, 

and typography, designers ensure that the output aligns with the brand's visual identity. 

This consistency helps reinforce brand recognition and reinforces the brand's image in 

the minds of the audience. 

 

Creating templates in Illustrator 

Step 1: Create a New Document  

 

▪ Launch the Adobe Illustrator application. 

▪ Choose File > New. 

▪ Set the Width & Height of your document to the final trim size of the product you are 

printing. 

▪ Set the Bleed to 1/8" (0.125") on all four sides of the artwork. This will allow an extra 

1/8" (0.125") on each side of the document to ensure accurate cutting. 

▪ Set the Color Mode to CMYK Color. 

▪ Set the Raster Effects to High (300ppi). 

▪ All other settings will depend on your finished design, including the orientation. 

▪ Click Create. 
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Step 2: Convert your Text to Outlines 

 

▪ After completing your design, convert your text to outlines. Unlock any text layers 

before selecting to ensure they are included. 

▪ From the Select menu, choose All. 

▪ From the Type menu, choose Create Outlines. 

 

Step 3: Saving Your File 

 

▪ When you have completed your design, removed any design guidelines/templates 

and created your outlines, choose File > Save As. 

▪ Enter a file name for your design. 

▪ Select the Format: Adobe PDF 

▪ Click Save to show the Adobe PDF window. 
 

 

 

Step 4: Saving Your File as a Print-Ready PDF  
 

▪ PrintSource360 processes all print files through a PDF workflow, which is proven the 

most reliable format for processing design files for high-quality print production. 

▪ In the Save Adobe PDF window, select our preferred settings for saving a print-ready 

PDF file. To ensure the finest printing quality,  

▪ Please match the settings exactly as displayed below: 
 

General: 
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Compression: 

 

 
 

Marks and Bleeds: 
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Output: 

 
 

Advanced: 
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Security: 

 

 
 

Summary: 
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Step 5: Save Your Settings  

 

After you complete the above settings, click Save PDF. 

If you click the Templates button located in the bottom left corner of the New Dialog 

window, you can see the location of the existing templates. 
 

 

 

Simply save your Illustrator files as. ait to that same location. Then clicking the 

Templates button will open that folder. 

 

You can also always simply double-click any .ait file to open a new document based 

upon that template. 

 

As for properly creating a template... essentially you can create any Illustrator file with 

any set up you desire and simply save it as a .ait file. There are no restrictions for template 

creating. The only thing I'd caution against is using linked files within the template. 
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2.3 Printing Marks 

 

When you prepare artwork for printing, a number of marks are needed for the printer 

device to register the artwork elements precisely and verify correct color.  

You can add the following kinds of printer’s marks to your artwork: 

 

Set Crop and Trim Marks in Illustrator  

  

 

The interchangeable terms "crop marks" and "trim marks" point to short line segments 

arranged at the corners of a printed piece of artwork to define where to trim away the outer 

edges of the paper, leaving only the artwork behind. Most graphics software, including 

Adobe Illustrator, provides features and functions that automate the placement of these 

marks so you don't have to create them manually. Illustrator's artboards -- the page-like 

areas on which you draw -- define the printable area of your artwork, but crop marks only 

provide guides for hand trimming or commercial print production. 

Steps-1 

Press "V" to switch to the Selection tool. Click on or marquee around an object or set of 

objects to make them the active selection in your Adobe Illustrator file. To include an 

object that you've hidden or locked, press "F7" to reveal the Layers panel, twirl open the 

disclosure triangle for the layer that contains the artwork, and turn on the visibility eyeball 

or click off the padlock icon that denotes an object's status. 
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Step-2: Open the "Object" menu and choose "Create Trim Marks" to display an editable set 

of corner marks at the four corners of the invisible bounding box that defines the overall 

height and width of your artwork. 

 

Step 3 

Click on or marquee around the crop marks to edit or delete them. To hide them the same 

way you would hide any Adobe Illustrator object, select them and press "Ctrl-3." 
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▪ Registration Marks 

Small targets outside the page area for aligning the different separations in a color 

document. 

 

▪ Color Bars 

Small squares of color representing the CMYK inks and tints of gray (in 10% 

increments). Your service provider uses these marks to adjust ink density on the 

printing press. 

 

▪ Page Information 

Labels the film with the name of the artboard number, the time and date of printout, the 

line screen used, the screen angle for the separation, and the color of each particular 

plate. These labels appear at the tops of the images. 
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Printer’s marks 

A. Star target (not optional) B. Registration mark C. Page information D. Trim 

marks E. Color bar F. Tint bar 

Add printer’s marks 

 

▪ Choose File > Print. 

▪ Select Marks & Bleed on the left side of the Print dialog box. 

▪ Select the kinds of printer’s marks you want to add. You can also choose between 

Roman and Japanese-style marks. 

▪ (Optional) If you select Trim Marks, specify the width of trim-mark lines and the 

offset distance between the trim marks and the artwork. 

 

Note: To avoid drawing printer’s marks on a bleed, be sure to enter an Offset value 

greater than the Bleed value. 

About bleeds 
 

Bleed is the amount of artwork that falls outside of the printing bounding box, or 

outside the crop area and trim marks. You can include bleed in your artwork as a margin 

of error—to ensure that the ink is still printed to the edge of the page after the page is 

trimmed or that an image can be stripped into a keyline in a document. Once you create 

the artwork that extends into the bleed, you can use Illustrator to specify the extent of 

the bleed. Increasing the bleed makes Illustrator print more of the artwork that is 

located beyond the trim marks. The trim marks still define the same size printing 

bounding box, however. 

 

The size of the bleed you use depends on its purpose. A press bleed (that is, an image 

that bleeds off the edge of the printed sheet) should be at least 18 points. If the bleed is 
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to ensure that an image fits a keyline, it needs to be no more than 2 or 3 points. Your 

print shop can advise you on the size of the bleed necessary for your particular job. 

 

Add a bleed 

 

1. Choose File > Print. 

2. Select Marks & Bleed on the left side of the Print dialog box. 

3. Do one of the following: 
 

▪ Enter values for Top, Left, Bottom, and Right to specify the placement of the bleed 

marks. Click the link icon  to make all the values the same. 

▪ Select Use Document Bleed to use the bleed settings defined in the New Document 

dialog box. 

  

The maximum bleed you can set is 72 points; the minimum bleed is 0 points. 

 

Proofing 

In the printing industry, a print proof is a print that is an exact replica of what the result 

will be. This proof is the last item to be examined prior to an order being sent to 

production. 

 

Print proofs are essential because they are the last chance for any errors to be caught 

prior to an order being executed. Before production begins on a large order, you want 

the proof to be examined thoroughly so materials, effort and money are not wasted on 

a faulty product. 

 

Proofs use all the same materials and calibrations as the final job will to provide a 

perfect representation of what to expect from the batch. The end results of the proof 

should be a sample that is indistinguishable from the final product. Although the 

proofing process may seem unnecessary, it is one of the most important parts of the 

printing job. 

 

2.4 Output Templates 

 

You could also save any .ai file as a new template. Go to File -> Save as Template. as 

shown below to save as a new template. 
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Self-Check Sheet - 2: Prepare output template 

 

Questionnaire: 

1. What is design output in illustrator? 

  Answer: 

  

 

2. What is flyer? 

    Answer: 

 

 

3. What is magazine? 

Answer: 

 

4. What is importance of print prrofing? 

Answer: 

 

 

5. What is Registration Mark? 

Answer:  
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Answer Key - 2: Prepare output template 

 

 

1. What is design output in illustrator? 

  Answer: Design output in Illustrator refers to the process of exporting or saving your design 

files in a format suitable for their intended use or distribution. The design output stage 

ensures that your Illustrator design is converted into a file format, resolution, color mode, 

or size that aligns with the requirements of the final output medium or platform 

 

  

2. What is flyer? 

   Answer: Flyers are sometimes known as handbills or posters, and they are one of the most 

popular print marketing products. They are inexpensive and easy to distribute wherever. 

They are typically flat and rectangular, and the most cost-effective size is 8 ½” by 11”, the 

typical printer paper size. However, they can be printed in all sizes and formats. 

 

 

 

3. What is magazine? 

Answer: A magazine is a collection of articles, stories, photographs, and often 

advertisements sandwiched between attention-getting front and back covers. Magazines are 

typically published on a regular schedule, be that once a month, bi-monthly, quarterly, etc. 

 

 

 

4. What is importance of print prrofing? 

Answer: Print proofing is a very important process that can save businesses a ton of time 

and effort while minimizing the chance of errors. Not only that, but it also leads to a better-

quality product project after project. 

 

5. What is Registration Mark? 

Rregistration mark refers to a specific type of marking or symbol that is used in the design 

and printing industry to indicate the alignment and registration of different colors or 

elements in a multi-color print job. These marks are typically used in professional printing 

processes like offset printing to ensure that the different ink colors or printing plates are 

properly aligned and that the final printed output appears as intended. 
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Job Sheet-2.1: Create a template for output 

 

 

Working Procedure:  
 

1. Follow OSH  

2. Check Connection and computer  

3. Start the Computer.  

4. Open any graphics design software.  

5. Read the Specification Sheet.  

6. Create a New Document  

7. Convert your Text to Outlines 

8. Set Marks and Bleeds  

9. Save Your File as ai format 

10. Save Your File as a Print-Ready PDF  

 

Follow the specification below:  

 

1. Set a 1024X1024px artboard  

2. Document Presets: Print 

3. Orientation: Horizontal 

4. Artboards: 2 

5. Color Mode: CMYK Color. 

6. Raster Effects: High (300ppi) 

7. Save File Format: Ai and JPEG. 

  



 

41 
 

Specification Sheet-2.1: Create a template for output  

 

Necessary Personal Protective Equipment (PPE) 

 

Sl. No Name of PPE Unit Quantity 

1  Ergonomic Chair No 1 

2  Eye protective glass No 1 

3  Rubber shoe Pair 1 

 

 

Necessary tools and equipment 

 

Sl. No 
Name of Tools & 

Equipment 
Specification Unit Quantity 

1  Personal Computer or 

Laptop 

 Set   1 

2  Keyboard and Mouse Optical mouse No. 1 

3  Monitor  No. 1 

4  Adobe Photoshop  No. 1 

5  Printer diver software  No. 1 

6  Printer  No. 1 

 

Necessary materials 

 

Sl. No. Name of materials Specification Unit Quantity 

1  Simple Image A4 Paper No. 1 

2  MS- Office Software No. 1 
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Learning Outcome 3: Prepare for final output 

 

Assessment Criteria 

 

1. Text is outlined to objects. 

2. Design Objects are grouped. 

3. Colors are separated according to output.  

4. Final designs are saved. 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 
Contents 

1 Text outline to objects. 

2 Grouping design Objects. 

3 Separating colors according to output.  

4 Saving procedure of final designs. 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 3: Prepare for final output 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about develop materials for 

output 

1. Instructor will provide the learning materials 

develop materials for output  

2. Read the Information sheet/s 
2. Information Sheet No:3- Prepare for final output  

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 3- Prepare for final output 

 

Answer key No. 3- Prepare for final output  

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet No:3-1: Separate color of an artwork 

 

Specification sheet No: 3-1: Separate color of an 

artwork 
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Information Sheet 3: Prepare for final output 

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

3.1 Text outline  

3.2 Grouping design Objects. 

3.3 Separating colors according to output.  

3.4 Saving procedure of final designs. 

 

3.1 Text outline  
 

In Illustrator, outlining text refers to converting editable text into vector shapes or 

outlines. When text is outlined, it is no longer editable as text, but rather becomes a 

collection of individual vector shapes that retain the appearance of the original text. 

 

3.1.1 Outline Text in Illustrator  

Before using any of the methods below to outline text, the first thing to do is 

to duplicate your artwork that includes all live text. There are two ways to do this: 

 

Save another file with the exact same artwork as a backup 

Select the whole artwork, then copy and paste it outside your artboard 

Next, you will have to select the text boxes you wish to outline. 

You can’t outline selected text that is highlighted within the text box. But you can Select 

All including shapes, objects, and text. Nothing will happen to the images and objects 

(except if you use the Expand method). It’s just for your convenience to Select 

All without having to pick out individual text manually. 

 

Select everything on your artboard or canvas by clicking on Select in the top menu. If 

you have your duplicated artwork with live text outside your artboard, you wouldn’t want 

to include that in the selection. In this case, select All on active board in the drop-down 

menu. Illustrator will automatically only select everything that’s on the artboard only. 
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Method 1: Create Outlines from Top Menu 

Select Type from the top menu and select Create Outlines from the drop-down menu. 

 
 

Or select Type > Create Outlines. 

 

Your text will immediately be converted to vector format. 

Method 2: Right-Click Text Box 

Bring your cursor over the text box and right-click on it. 
 

 
 

In the pop-up box that appears, select Create Outlines. 
 

Method 3: Expand 

 

When using the Expand method, you will have to individually select the text boxes you 

wish to convert to vectors. The Expand function can change the properties of strokes or 

borders around objects too. If you don’t wish for that to happen, you should not select 

everything you have on your artboard. 

Select only the text boxes you want to Expand by holding down the Shift key and clicking 

on each of the text boxes one time. Then, select Object from the top menu and 

select Expand from the drop-down menu. 
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Check the Object and Fill options in the Expand section of the Expand dialog box. Then 

click the OK button. 
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3.2 Grouping design Objects 
 

Grouping objects in Illustrator allows you to combine multiple objects into a single entity. 

When objects are grouped, they are treated as a single unit, making it easier to manage 

and manipulate them collectively. 
 

Group Objects in Illustrator 

Step 1: 

Select the Objects with “Selection Tool”. 

The first thing you need to do is to select the objects, so go to the left toolbar and choose 

the “Selection Tool” (V). 

Drag the arrow over the objects you want to group to select them. You can group 

whatever type of object you want; there are no restrictions on shape, size, or other 

properties. You can also create a group that incorporates previously created groups. 

Keep in mind that you won’t be able to group the objects if they haven’t been previously 

selected. 

 

Step 2: 

Open your file or create a new one. 

First, open the document that you want to work with by clicking on it, or once in 

Illustrator, you can go to “File”>“Open” on the top-menu and choose the file from there. 

If you aren’t currently working on a file, go to “File”>“New”. In this tutorial, we’ll be 

grouping objects, so you’ll need to create some in order to try this out.  

Select the “Rectangle Tool” from the left side toolbar and simply draw a few rectangles. 
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Step 3: 

Group the objects. 

You can now group the objects. It’s really simple, and there are a few different ways to 

go about it. I’ll go over everything with you. 

The first way is to right-click and select the “Group” option; it’s as simple as that. You 

can also use the “Ctrl+G” keyboard shortcut. 

 

 

 

Another way is to go to the top-menu, click on “Object,” and then select “Group.” 
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3.3 Separating colors according to output 

 

3.3.1 Color separation  

 

Color separation is the process by which original full-color digital files are separated into 

individual color components for four-color (cyan, magenta, yellow, and black) process 

printing. it is important to separate the colors first as this is a crucial part of screen 

printing. Every element in the file is printed in a combination of four colors: cyan, 

magenta, yellow, and black, known as CMYK in the world of commercial printing. 

Recently there has been software that helps in making the whole process easier.  

 

    

Separated 

Cyan 

Separated 

Magenta 

Separated 

Yellow 

Separated Black 

 

3.3.2 Important of Color Separation 

 

The goal of the color separation procedure is to prepare the file for printing. The type 

of color separation procedure used is determined by the image and the surface it will 

be printed on. Color separation software divides images into the individual elements 

required to recreate them.  

 

3.3.3 Types of Color Separation 

 

Color separations are vital to the screen-printing process, but they can be tricky! Here 

we discuss about color separation types -  

There are a handful of separation processes that screen printers use. Understanding the 

different types of separations, and the challenges they present, can help you execute 

successful separations on a routine basis. Common screen-printing color separations 

include: 
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▪ Spot color: The most common type of color separations used in screen printing is spot 

color separation. Spot color separations are done for vector images. While they are 

typically solid, spot color separations can include some halftone dots to create a shading 

effect. Spot color separations are usually created in CorelDRAW or Illustrator. 

 

▪ Four-color process: The four-color process uses halftone dots of CMYK — cyan, 

magenta, yellow and black — to create detailed, photorealistic images. These types of 

separations are usually done in Photoshop and creating a process color separation and 

printing four-color process correctly can be tricky. 

 

▪ Simulated-process color: Like traditional four-color process separations, simulated-

process color separations make use of halftone dots to create highly detailed or 

photorealistic images. The difference is that simulated process color separations utilize 

a range of ink colors. They tend to be more vivid than four-color process prints and can 

be printed on darker materials, unlike four-color process separations. Like four-color 

process separations, simulated-process color separations are done in Photoshop. 

 

▪ Index color. Index color separations use square pixels of the same size, rather than 

halftone dots, to create color shading. Performing and printing and index color 

separation can be easier to perform than process separations. However, it often takes 

more colors to create a photorealistic print. The separations are performed in 

Photoshop, but images can be easily transferred from other programs, such as 

CorelDRAW or Illustrator. 

 

3.3.4 Color In Process Printing 

 

In commercial printing presses print with cyan, magenta, yellow and black (CMYK) 

ink, known as process printing, instead of RGB light, and therefore produce a different 

range of color. 

 

4-Color Process: 

4-Color Process is the most widely used 

method for printing full-color images. 

All commercial printers use the 4-Color 

Process method for projects that 

contain multi-colored designs or 

photographs. This includes books, 

catalogs, manuals, magazines, 

brochures, postcards and any other 

printed items that contain full color 

images. Because of its widespread use 

in both offset and digital printing,  
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The result of 4 color separation of a 

images transferred to printing plates 

and sequentially printed on a printing 

press with the colored inks cyan (blue), 

magenta (red), yellow and black (the k 

in CMYK), reproduces the original 

color image. Most of the entire 

spectrum or gamut of colors are 

reproduced with just the four process 

ink colors. The four-color printing 

process is universally used in the 

graphic arts and commercial printing 

industry for the reproduction of color 

images and text. 

 

3 color process: 

 

When CMY “secondary” are 

combined at full strength, the resulting 

“primary” mixtures are red, green, and 

blue. Mixing all three gives an 

imperfect black or a perfect grey. This 

is also called 3 color process.  

 

2 Color Process: 

In 2 color printing, two ink colors are 

used instead of one on lower end 

marketing materials, vs four on 

higher-end commercially printed 

pieces. The inks used are typically 

Pantone® colors, and are frequently 

used to print a logo, design or symbol 

in a unique color. Pantone inks are the 

industry standard in two-color printing 

because they are part of a standardized 

color matching system to help 

different manufacturers in different 

locations or industries reproduce the 

exact same color by referring to 

the Pantone Matching System Color 

Guides. 

 

https://en.wikipedia.org/wiki/File:CMYK_subtractive_color_mixing.svg
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Single color: 

If your print project only needs a single 

color, then it's considered a one spot 

color printing method. Single color 

designs, or even designs with a shade 

of a single color, look brilliant when 

this technique is used. To achieve the 

shaded look, halftone dots are used to 

represent the shaded areas of your 

designs. This is the least expensive 

color model to print on an offset press 

because it requires only one ink.  

Spot color: 

Spot color is a unique, readily 

identifiable which sometimes used by 

companies to create a brand color that 

is used on all their marketing and 

product materials. 

 

In offset printing, a spot color or solid 

color is any color generated by 

an ink (pure or mixed) that is printed 

using a single run, whereas a process 

color is produced by printing a series of 

dots of different colors. 

 

This color model requires a minimum 

of two inks and can increase the cost of 

printing on an offset press with each ink 

that you add. 

 

 

 

    

 

 

 

 

 

 

 

 

 

https://en.wikipedia.org/wiki/Ink
https://en.wikipedia.org/wiki/Process_color
https://en.wikipedia.org/wiki/Process_color
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3.4 Saving procedure of final designs 
 

Export as Package file 

 

This feature is available in Adobe Illustrator CS6, CC, and later. To join Adobe 

Creative Cloud.  

 

You can gather the files you’ve used, including fonts (except Chinese, Korean, and 

Japanese) and linked graphics, for easy handoff. When you package a file, you create 

a folder that contains the Illustrator document, any necessary fonts, linked graphics, 

and a package report. This report, which is saved as a text file, includes the information 

about the packaged files.  

 

 
 

 

1. Choose File > Package. 

2. Specify the folder and location settings: 

➢ Location 

Specify the location to create the packaged folder 

  

➢ Folder Name 

Specify a name for the package. By default, the name of the folder is derived 

from the name of the Illustrator document. 

 

3. Specify the following options: 

  

➢ Copy Links 

Copies linked graphics and files to the package folder location. 

  

Fig: Package dialog box 
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➢ Collect Links in a Separate Folder 

Creates a Links folder and places all linked assets in that folder. If not 

selected, assets are copied to the same folder level as the .ai file. 

  

➢ Relink Linked files to the Document 

Changes links to the package folder location. If not selected, a packaged 

Illustrator document maintains links to assets in the original location, and 

assets are collected in the package anyway. 

  

➢ Copy Fonts used in the Documents (Except CJK) 

Copies all necessary font files, not the entire font family. 

  

Note: A warning displays when you package fonts. Check your license agreement 

to see if you’re permitted to copy fonts. 

  

4. Click Package. The following folder structure is created, with assets placed in their 

respective folders. 

 

 

 

 

▪ Create Adobe PDF files 

You can create different types of PDF files from within Illustrator. You can create 

multipage PDFs, layered PDFs, and PDF/x-compliant files. Layered PDFs allow 

you to save one PDF with layers that can be used in different contexts. 

PDF/X-compliant files ease the burden of color, font, and trapping issues. 

 

➢ Create an Adobe PDF 

1. Choose File > Save As or File > Save A Copy. 

2. Type a filename and choose a location for the file. 

3. Choose Adobe PDF (*.PDF) as the file format and click Save. 

Fig: Package folder structure 
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4. Either choose a preset from the Adobe PDF Preset menu or select a 

category from the list on the left of the dialog box and then customize 

the options. 

5. Click Save PDF. 

Note: To reset options to the default, hold down Alt (Windows) or Option (Mac OS) 

and click Reset. 

 

➢ Create a multiple-page Adobe PDF 

 

1. Create multiple artboards in a document. 

2. Choose File > Save As, and select Adobe PDF forSave As Type. 

3. Do one of the following: 

o  To save all of the artboards to one PDF, select All. 

o To save a subset of the artboards to one PDF, select Range, and type 

the range of artboards. 

4. Click Save and set additional PDF options in the Save Adobe PDF 

dialog box. 

5. Click Save PDF. 

 

➢ Create a layered Adobe PDF 

 

Adobe InDesign and Adobe Acrobat both provide features for changing the 

visibility of layers in an Adobe PDF file. By saving a layered PDF file in 

Illustrator, you allow your illustration to be used in different contexts. For 

example, rather than creating multiple versions of the same illustration for a 

multilanguage publication, you can create one PDF file that contains text for all 

languages. 

 

1. Set up your illustration so that the adjustable elements (those you want 

to show and hide) are in separate top-level layers, not nested within 

sublayers. 

For example, if you’re creating an illustration to be repurposed for 

multiple languages, put the text for each language in a different top-level 

layer. 

2. Save the file in Adobe PDF format. 

3. In the Save Adobe PDF dialog box, choose Acrobat 8 (1.7) or Acrobat 

7 (1.6) for Compatibility. 

4. Select Create Acrobat Layers from Top-Level Layers, set additional 

PDF options, and click Save PDF. 

 

➢ Create an Adobe PDF/X-compliant file 

 

PDF/X (Portable Document Format Exchange) is an ISO standard for graphic 

content exchange that eliminates many of the color, font, and trapping variables 

that lead to printing problems. Illustrator supports PDF/X-1a (for a CMYK 
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workflow), PDF/X-3 (for a color-managed workflow), and PDF/X-4 (for a color-

managed workflow with added support for preserving transparency as live rather 

than flattened). 

 

You can create a PDF/X-compliant file during the process of saving a PDF file. 

 

1. In the Save Adobe PDF dialog box, choose a PDF/X preset, or choose a 

PDF/X format from the Standard menu. 

2. Click Output on the left side of the Save Adobe PDF dialog box, and set 

PDF/X options. 

 

➢ Create compact PDF documents 

Illustrator provides the option to save a document in the smallest file size. To 

generate a compact PDF from Illustrator, do the following: 

 

1. Click File > Save As and select PDF. 

2. In the Save Adobe PDF dialog box, select the Smallest File Size option 

from Adobe PDF Preset. 

Make sure that you deselect the Preserve Illustrator Editing Capabilities 

check box to avoid saving the Illustrator resources along with the 

document. 

 

➢ Customize PDF presets 

Although the default PDF presets are based on best practices, you may discover 

that your workflow, or perhaps your printer’s workflow, requires specialized PDF 

settings that aren’t available via any of the built-in presets. If this is the case, you 

or your service provider can create custom presets. 

 

1. Choose Edit > Adobe PDF Presets. 

2. Do one of the following: 

  

o To create a new preset, click New. If you want to base the new preset 

on an existing preset, select the preset first. 

o To edit an existing custom preset, select the preset and click Edit. 

(You cannot edit the default presets.) 

o To delete a preset, select it and click Delete. 

o To save a preset in a location other than the default Settings folder 

in the Adobe PDF folder, select it and click Save As. Specify a 

location and click Save. 

3. Set the PDF options, and click OK. 

 

Alternatively, you can create a custom preset when you save a PDF file by 

clicking Save Preset at the bottom of the Save Adobe PDF dialog box. 
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➢ Load PDF presets 

 

Illustrator comes with supplementary PDF presets (joboptions) files. You may 

also receive custom PDF presets files from service providers and colleagues. 

 

1. To load PDF presets into all of your Creative Suite applications, do one 

of the following: 

2. Double-click the. joboptions file. 

Choose Edit > Adobe PDF Presets. Click Import, and select the joboptions file 

you want to load. 
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Self-Check Sheet - 3: Prepare for final output 

 

Questionnaire: 

 

 

1. What is text outline? 

  Answer: 

  

 

 

2. What is grouping objects? 

    Answer: 

 

 

 

3. What is the importance of color separation? 

Answer: 
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Answer Key - 3: Prepare for final output 

 

 

1. What is text outline? 

 

Answer: In Illustrator, outlining text refers to converting editable text into vector shapes or 

outlines. When text is outlined, it is no longer editable as text, but rather becomes a 

collection of individual vector shapes that retain the appearance of the original text. 

 

  

 

 

2. What is grouping objects? 

 

Answer: Grouping objects in Illustrator allows you to combine multiple objects into a single 

entity. When objects are grouped, they are treated as a single unit, making it easier to manage 

and manipulate them collectively 

 

 

 

 

3. What is the importance of color separation? 

 

Answer: The goal of the color separation procedure is to prepare the file for printing. The 

type of color separation procedure used is determined by the image and the surface it will 

be printed on. Color separation software divides images into the individual elements 

required to recreate them. 
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Job Sheet-3.1: Separate color of an artwork 

 

Working Procedure:  
 

1. Collect activity and specification sheet. 

2. Read the mentioned activity and Tasks. 

3. Ensure all the necessary materials, supplies according to the provided activity and task 

sheet. 

4. Ensure a suitable work environment according to the provided activity. 

5. Read the case story given at specification sheet 

6. Generate color separation: Confirm the texts and effects are expanded 

7. Ready the file as per specification sheet for transferring to clients. 

8. Keep / store used materials, supply, and workplace reusable in accordance with 

workplace standards. 

 

Follow the specification below:  

 

1. Confirm the texts and effects are expanded 

2. Make Spot Color Swatches 

3. Using the Magic Wand tool, select each color one by one in the design and create a 

color new color swatch 

4. Select a color with the Magic Wand tool. 

5. Set the color type to Spot Color. Repeat this process for each color in your design. 

6. Print the Color Separation 
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Specification Sheet-3.1: Separate color of an artwork 

 

Necessary Personal Protective Equipment (PPE) 

 

Sl. No Name of PPE Unit Quantity 

1  Ergonomic Chair No 1 

2  Eye protective glass No 1 

3  Rubber shoe Pair 1 

 

 

Necessary tools and equipment 

 

Sl. No 
Name of Tools & 

Equipment 
Specification Unit Quantity 

1  Personal Computer or 

Laptop 

 Set   1 

2  Keyboard and Mouse Optical mouse No. 1 

3  Monitor  No. 1 

4  Adobe Photoshop  No. 1 

5  Printer diver software  No. 1 

6  Printer  No. 1 

 

Necessary materials 

 

Sl. No. Name of materials Specification Unit Quantity 

1  Simple Image A4 Paper No. 1 

2  MS- Office Software No. 1 
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Review of Competency 
 

 

Below is yourself assessment rating for module “Developing materials for output” 

 
 

Assessment of performance Criteria Yes No 

Design work is opened in relevant Software.   

Design is verified against the design brief.   

Design is adjusted as required.   

Design output is interpreted.   

Template for the output is created.   

Contents are set accordingly.   

Printing Marks are set.   

Output Templates are saved.   

Text is outlined to objects.   

Design Objects are grouped.   

Colors are separated according to output.    

Final designs are saved.   

 

 

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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https://design.tutsplus.com/tutorials/prepare-for-print-indesign-illustrator-photoshop--cms-107351
https://design.tutsplus.com/tutorials/prepare-for-print-indesign-illustrator-photoshop--cms-107351
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How to use this Competency Based Learning Material (CBLM) 

  

The module, Creating Mock Up and Print contains training materials and activities for you to 

complete. These activities may be completed as part of structured classroom activities or you 

may be required you to work at your own pace. These activities will ask you to complete 

associated learning and practice activities in order to gain knowledge and skills you need to 

achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  
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Module Content 

 

Unit Title: Create Mock Up and Print 

Unit Code: OU- ICT-GD-04-L3-V1 

Module Title: Creating Mock Up and Print 

Module Description: This module covers the knowledge, skills and attitude required to create 

mock up and print. This covers competencies on preparing the work environment, creating mock 

up and printing draft. 

 

Nominal Duration: 40 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Prepare the work environment 

2. Create mock up 

3. Print draft 

 

Assessment Criteria: 

1. Design details of the graphic design project are reviewed to identify preference setting 

requirements. 

2. View magnification is set for ease of working with the graphics application. 

3. Product shots are collected/taken. 

4. A separate layer is prepared. 

5. Screen layer is made. 

6. Housekeeping/organizing work is done. 

7. Mock up is completed and saved. 

8. Printer is selected 

9. Print preview option is accessed 

10. Document is adjusted where necessary 

11. Printout is taken 
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Learning Outcome 1: Prepare the work environment 

 

Assessment Criteria 

 

1. Design details of the graphic design project are reviewed to 

identify preference setting requirements. 

2. View magnification is set for ease of working with the 

graphics application. 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 Contents 1. Design details of the graphic design project  

▪ Stationary 

▪ Collaterals 

▪ Flyers and leaflets 

▪ Brochure, catalogue 

▪ Book design, magazine 

▪ Billboard, signage 

▪ Packaging, label, sticker 

▪ T-shirt Graphics 

2. View magnification.  

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 1: Prepare the work environment 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about creating mock up and 

print 

1. Instructor will provide the learning materials 

creating mock up and print 

2. Read the Information sheet/s 

2. Information Sheet No:1- Prepare the work 

environment 

 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 1- Prepare the work environment 

 

4. Answer key No. 1- Prepare the work environment 

4. Read the Job/ Task sheet and 

Specification Sheet  

5. Job/ task sheet and specification sheet  

 

Task Sheet No:1-1: Design details of the graphic 

design project.  
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Information Sheet 1: Prepare the work environment 

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

1.1 Design details of the graphic design project to identify preference setting 

requirements. 

1.2 View magnification for ease of working with the graphics application 

 

1.1 Design details of the graphic design project  
 

1.1.1 Stationary 
 

The term "stationary" refers to 

a design element or layout that 

remains fixed or unchanged, 

typically used for stationery 

items such as letterheads, 

business cards, envelopes, and 

other printed materials. A 

stationary design often 

includes the company or 

individual's logo, contact 

information, and other 

branding elements. 

When creating a stationary 

design in Illustrator, the stationary components are typically placed in a fixed 

position on the artboard. This allows for consistent placement of elements across 

different pieces of stationery, maintaining a cohesive and professional look. 

 

Here are some key considerations when designing stationary in Illustrator: 

 

Artboard setup: Begin by creating an appropriately sized artboard for the 

specific stationery item you are designing, such as a letterhead or business card. 

Logo placement: Position the company or individual's logo in a prominent and 

consistent location across all stationary items. This helps reinforce brand 

identity and recognition. 

 

Contact information: Include relevant contact details, such as company name, 

address, phone number, email, and website. Place this information strategically, 

ensuring it is easily readable and not cluttered. 
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Typography and fonts: Use consistent typography and fonts throughout the 

stationary design to maintain visual harmony. Choose fonts that reflect the 

brand's identity and are legible across different printed materials. 

 

Color scheme: Apply a consistent color scheme that aligns with the brand's 

visual identity. This includes using the brand's primary and secondary colors 

throughout the stationary design. 

 

Layout and alignment: Pay attention to the overall layout and alignment of the 

elements on the stationary items. Ensure proper spacing, alignment, and balance 

to create a visually appealing design. 

 

Bleed and margins: Consider the bleed and margins when setting up the artwork 

for printing. Bleed refers to the extra area beyond the actual size of the stationary 

item to account for any trimming that may occur during the printing process. 

Margins are the safe zones within the artwork where essential information 

should be placed to avoid any risk of being cut off. 

 

File formats: Save your stationary design in appropriate file formats, such as 

PDF, EPS, or high-resolution raster formats like TIFF or PNG. This ensures 

compatibility with various printing processes and allows for easy sharing with 

print vendors. 

 

1.1.2 Collaterals 

  

In the context of graphic design and 

marketing, "collaterals" refer to a 

collection of promotional materials or 

assets that are used to support a brand or 

communicate a specific message. These 

materials are typically designed to be 

consistent with the brand's identity and 

serve various purposes such as 

advertising, information dissemination, 

or brand recognition. Adobe Illustrator is 

commonly used to create collaterals due 

to its versatile vector-based design 

capabilities 
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1.1.3 Flyers and leaflets 

 

Flyers and leaflets are popular promotional materials used to advertise events, 

products, or services. They are typically printed on a single sheet of paper and 

distributed to a wide audience. Adobe Illustrator is a powerful tool for designing 

flyers and leaflets due to its versatile design capabilities. 

 
 

1.1.4 Brochure, catalogue 

 

Brochures and catalogs are printed marketing materials used to provide detailed 

information about products, services, or businesses. They are designed to 

showcase multiple products or services in a visually appealing and organized 

manner. Adobe Illustrator is a powerful tool for creating brochures and catalogs 

due to its versatile design capabilities. 
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1.1.5 Book design, magazine 

 

Book design and magazine layout are important aspects of graphic design that 

involve arranging text, images, and other visual elements in an appealing and 

cohesive manner. While Adobe InDesign is commonly used for extensive book 

and magazine layouts, Adobe Illustrator can also be used effectively for specific 

design elements within these projects.  

 

 

1.1.6 Billboards and signage 

 

Billboards and signage are large-scale advertising and informational displays 

that are typically placed outdoors or in public spaces. They are designed to 

capture attention, convey messages clearly, and promote brands, products, or 

events. Adobe Illustrator can be used to design billboards and signage, 

leveraging its vector-based design capabilities. 
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1.1.7 Packaging, label, sticker 

 

Packaging design, label design, and sticker design are important aspects of 

product branding and marketing. Adobe Illustrator is a powerful tool for creating 

these designs due to its vector-based capabilities and versatile design features. 

 

 
 

1.1.8 T-shirt graphics 

 

T-shirt graphics are designs or illustrations that are printed or embroidered onto 

T-shirts to create visually appealing and unique apparel. Adobe Illustrator is a 

popular tool for creating T-shirt graphics due to its vector-based design 

capabilities. 
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1.2 View magnification  
 

View magnification refers to the ability to zoom in or zoom out on your design to see 

it at a larger or smaller scale. It allows you to focus on specific details or get an overall 

view of your artwork.  

 

Here's how you can use the view magnification feature in Illustrator: 

 

Zoom In: To magnify your design and see it in more detail, you can use the 

following methods: 

 

Press the "+" key on your keyboard to zoom in. 

 

Select the Zoom Tool from the Tools panel on the left side of the Illustrator interface.  

 

Click on the area you want to zoom in on. You can also click and drag to define a 

specific area to zoom in on. 

 

Hold down the Alt key (Windows) or Option key (Mac) and use the scroll wheel on 

your mouse to zoom in and out. 

 

Zoom Out: To view your design at a smaller scale, use the following methods: 

 

Press the "-" key on your keyboard to zoom out. 

 

Select the Zoom Tool from the Tools panel and click on the area you want to zoom 

out from. You can also click and drag to define a specific area to zoom out from. 

 

Hold down the Alt key (Windows) or Option key (Mac) and scroll down on your 

mouse scroll wheel to zoom out. 

 

Actual Size: To view your design at its actual size, which is the size it will be 

printed or displayed at, use one of these methods: 

 

Press Ctrl+1 (Windows) or Command+1 (Mac) on your keyboard to view the actual 

size. 

 

Select the View menu at the top of the Illustrator interface, then click on "Actual Size". 

 

Fit to Screen: To fit your entire design within the Illustrator window, use one of 

these methods: 
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Press Ctrl+0 (Windows) or Command+0 (Mac) on your keyboard to fit the artboard to 

the screen. 

 

Select the View menu, then click on "Fit Artboard in Window" 

Custom Zoom Levels: Illustrator also allows you to enter specific zoom levels to view 

your design at a precise magnification. You can do this by selecting the percentage 

value in the bottom left corner of the Illustrator interface and entering a custom value. 

The view magnification feature in Illustrator gives you control over the level of detail 

you want to see in your design. By zooming in or out, you can work on intricate 

elements, inspect fine details, or get a comprehensive view of your artwork. 
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Self-Check Sheet - 1: Prepare the work environment 

 

 

Questionnaire: 

 

 

1. What is stationary design? 

  Answer: 

  

 

 

2. Write some professional design work? 

    Answer: 

 

 

 

3. Which purpose we use billboards and signage? 

Answer: 

 

 

 

4. What is view magnification? 

Answer: 
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Answer Key - 1: Prepare the work environment 

 

1.  What is stationary design? 

 

  Answer: The term "stationary" refers to a design element or layout that remains fixed or 

unchanged, typically used for stationery items such as letterheads, business cards, 

envelopes, and other printed materials. 

 

  

 

2. Write some professional design work? 

    Answer: Collaterals refer to a collection of promotional materials or assets that are used to 

support a brand or communicate a specific message.   

 

 

 

3. Which purpose we use billboards and signage? 

Answer: Billboards and signage are large-scale advertising and informational displays that 

are typically placed outdoors or in public spaces. They are designed to capture attention, 

convey messages clearly, and promote brands, products, or events 

 

 

 

4. What is view magnification? 

Answer: View magnification refers to the ability to zoom in or zoom out on your design 

to see it at a larger or smaller scale. It allows you to focus on specific details or get an 

overall view of your artwork. 
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Task Sheet-1.1: Design details of the graphic design project 

 

Objective: The objective of this job sheet is to guide you through the process of focusing on 

the design details of a graphic design project. By following the steps outlined below, you will 

learn how to pay attention to the crucial elements that contribute to the overall success and 

impact of your design. 
 

Working Procedure:  
 

1 Understand the project requirements 

2 Research and gather inspiration 

3 Sketch and conceptualize ideas 

4 Develop a visual hierarchy 

5 Choose appropriate typography 

6 Select color palettes 

7 Refine imagery and graphics 

8 Incorporate branding elements (if applicable)  

9 Seek feedback and iterate 

10 Prepare final deliverables 
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Learning Outcome 2: Create mock up 

 

Assessment Criteria 

 

1. Product shots are collected/taken. 

2. A separate layer is prepared. 

3. Screen layer is made. 

4. Housekeeping/organizing work is done. 

5. Mock up is completed and saved. 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 

Contents 1. Product shots 

2. layer preparation. 

3. Screen layer 

4. Mock up 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 2: Create mock up 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about creating mock up and 

print 

1. Instructor will provide the learning materials 

creating mock up and print 

2. Read the Information sheet/s 
2. Information Sheet No:2- Create mock up 

 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 2- Create mock up 

 

Answer key No. 2- Create mock up 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet No:2-1: Create a mock up Design 

 

Specification Sheet: 2-1 Create a mock up Design 
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Information Sheet 2: Create mock up 

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

2.1 Product shots. 

2.2 Layer preparation. 

2.3 Screen layer. 

2.4 Mock up. 

 

2.1 Product shots 

 

Product shots refer to visual representations or images of a product that are created 

using the software's tools and features. Product shots are often used for marketing 

materials, e-commerce websites, catalogs, or any other medium where showcasing the 

product's appearance is important. 

 

To create product shots in Illustrator, you can follow these general steps: 

 

▪ Set up the document: Start by creating a new document with appropriate dimensions 

and settings for your intended use. Consider the desired size and resolution of the 

product shots. 

 

▪ Import or create the product image: If you have a high-quality photograph of the 

product, you can import it into Illustrator using the File > Place command. 

Alternatively, you can draw the product from scratch using Illustrator's drawing tools 

if you prefer a more illustrative or stylized representation. 

 

▪ Refine the product image: Use Illustrator's tools to refine and enhance the product 

image. This can include adjusting colors, applying gradients or textures, adding 

shading or highlights, and adding details to make the product visually appealing and 

accurate. You can also use blending modes, transparency settings, and layering 

techniques to achieve the desired effects. 

 

▪ Create backgrounds or context: Depending on the purpose of the product shots, you 

may want to create backgrounds or contextual elements to provide a sense of 

environment or usage. Illustrator offers a range of tools and features to create 

backgrounds, patterns, textures, or even simulate lighting effects to enhance the 

visual impact of the product. 
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▪ Add text and branding: If needed, incorporate text elements such as product names, 

descriptions, or branding elements like logos or slogans. Illustrator provides various 

typography options to customize the appearance of the text to match your design 

concept. 

 

▪ Arrange and organize: Utilize Illustrator's layering system to organize different 

elements of the product shot. This helps in maintaining a structured and editable file, 

allowing you to easily modify or rearrange components as necessary. 

 

▪ Export the product shot: Once you are satisfied with your product shot, you can 

export it in a suitable format, such as JPEG or PNG, for use in your marketing 

materials, website, or other mediums. Consider the required resolution and file size 

based on the intended usage. 

 

2.2 Layer Preparation 

 

Create a New Layer: 

Go to the bottom of the Layers Panel and click on the Create New Layer button that is 

represented by a plus (+) icon. A new layer appears in the Layers Panel. 
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Method 2 to Create a new layer: 

 

Go to the top right corner of the Layers Panel. Then, click on the Layers Panel menu 

represented by three horizontal lines. Next, click on New Layer in the dropdown 

submenu. 
 

 

 

Create a new layer via the Layers Panel menu 

 

Once you click New Layer, you will see another layer appears above the first original 

layer in the Layers Panel. At the same time, the Layers Option dialog box appears. Key 

in your desired layer name into the Name field of the Layers Option dialog box. You 

can also change the color of the layer’s tag if you wish by clicking on the toggle 

represented by a triangular arrow pointing downwards. 

 

It’s a good idea to give each layer a different color and label every layer to differentiate 

them. In this way, if your file has many layers, you can easily find the layers you want 

to edit by referring to the Layers Panel. 

 

Next, leave the other options as per default and click the OK button. 
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Separate the Object from the First Layer 

 

Now that you’ve created another layer, bring your cursor to the object that you’d like 

to separate from the main layer. Next, click on the object, hold and drag the layer to the 

new layer. Then, release your mouse or cursor and your object will be added to the new 

layer. 

 

 

Repeat the same steps for the other objects under the same layer. You’ve successfully 

separated your objects from the main layer into separate individual layers. 

 

2.3 Screen layer 

 

the term "screen layer" refers to a blending mode that can be applied to a layer or 

multiple layers in a design. The Screen blending mode is one of the many blending 

modes available in Photoshop that determines how the pixels of one layer interact with 

the pixels of the underlying layers. 

 

Here's what you need to know about using the Screen layer blending mode in 

Photoshop: 

 

Blending Mode: In Photoshop, blending modes determine how the colors and tones of 

different layers interact with each other. The Screen blending mode specifically 

enhances the brightness and lightness of the underlying layers while preserving the 

highlights. It is often used to create a brightening effect or to overlay images with a 

light, glowing appearance. 

 

Effect: When you apply the Screen blending mode to a layer, the dark areas of that layer 

become transparent, while the light areas blend with the layers below, creating a 

brightened effect. The brighter the pixels in the layer, the more they will affect the 

underlying layers. 
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Application: The Screen blending mode is commonly used in various design scenarios, 

including adding light effects, creating soft glows, blending multiple images 

seamlessly, or enhancing the brightness of an image without affecting the colors. 

 

Layer Stacking: The effect of the Screen blending mode is influenced by the stacking 

order of the layers in the Layers panel. Layers positioned below the layer with the 

Screen blending mode will be affected, while layers above will not. Adjusting the 

opacity of the screen layer can also control the intensity of the effect. 

 

To apply the Screen blending mode to a layer in Photoshop: 

 

▪ Open your design in Photoshop and ensure that the Layers panel is visible. 

▪ Select the layer you want to apply the Screen blending mode to. 

▪ In the Layers panel, click on the drop-down menu that displays the blending mode 

(by default, it is set to "Normal"). 

▪ Scroll down and choose the "Screen" blending mode from the list. 

▪ Observe the changes in the appearance of the layer and its interaction with the 

layers below. 

 

Remember that the Screen blending mode is just one of many blending modes available 

in Photoshop. Exploring different blending modes and experimenting with layer 

combinations can help you achieve a wide range of creative effects and enhancements 

in your designs. 

 

2.3.1 Screen layer in Illustrator 

 

Screen layer refers to a layer that is used to simulate the appearance of a printed halftone 

screen or a digital screen effect in your artwork. It is commonly used when creating 

illustrations, designs, or artwork that needs to replicate the look of a printed or digital 

screen, such as retro-style graphics or comic book illustrations. 

 

2.3.2 Create a screen layer in Illustrator, you can follow these steps: 

 

▪ Create or import your artwork: Start by creating or importing the artwork 

that you want to apply the screen effect to. This can be any vector artwork, 

shapes, or text. 

 

▪ Create a new layer: Open the Layers panel in Illustrator (Window > Layers) 

and create a new layer above the artwork layer. This new layer will be used to 

apply the screen effect. 

 

▪ Apply the screen pattern: Select the new layer and choose the "Appearance" 

panel (Window > Appearance) to access the layer's appearance settings. In the 
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Appearance panel, click on the "Add New Fill" button to add a new fill attribute 

to the layer. 

 

▪ Choose the screen pattern: With the new fill selected, you can modify its 

attributes in the Appearance panel. Click on the "Opacity" option and reduce the 

opacity to a value that suits your desired screen effect. Then, click on the "Fill" 

option and choose "Pattern" from the drop-down menu. 

 

▪ Access the pattern options: Once you have selected the pattern fill, click on 

the "Pattern Options" link in the Appearance panel to access the pattern settings. 

 

▪ Select a screen pattern: In the Pattern Options dialog box, you can choose from 

a variety of predefined screen patterns available in Illustrator. These patterns 

simulate the appearance of printed halftone screens or digital screens. You can 

select the pattern that best matches the effect you want to achieve. 

 

▪ Adjust pattern settings: Customize the pattern settings as needed. You can 

modify the size, spacing, angle, and other attributes of the screen pattern to 

control the intensity and appearance of the effect. Preview the changes in real-

time to achieve the desired result. 

 

▪ Fine-tune the appearance: After applying the screen pattern, you can further 

refine the appearance by adjusting other attributes in the Appearance panel. You 

can modify the blending modes, opacity, and other effects to enhance the overall 

visual impact. 
 

2.4 Mock up 

 

In graphic design, a mockup refers to a visual representation or prototype of a design 

concept. It is essentially a realistic or scaled-down model of a design idea that allows 

designers to showcase how the final product may look and feel. Mockups are widely 

used in various design disciplines, including web design, product packaging, 

advertising, and branding. 

 

Mockups serve several purposes in the design process: 

 

▪ Visualization: Mockups help designers and clients visualize the design concept in a 

more tangible and realistic manner. By presenting a design in a mockup, designers 

can convey their ideas effectively and enable clients to provide feedback based on a 

visual representation. 

 

▪ Design Evaluation: Mockups allow designers to evaluate the aesthetics, 

composition, and overall effectiveness of a design before investing time and 
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resources into the final production. They provide an opportunity to identify potential 

design flaws or areas that need improvement. 

 

▪ Communication and Collaboration: Mockups serve as a common ground for 

designers, clients, and stakeholders to discuss and collaborate on design ideas. They 

provide a shared visual reference, facilitating clearer communication and 

minimizing misunderstandings. 

 

▪ User Testing: In digital design, such as web and app interfaces, mockups are often 

used for user testing. By creating interactive or clickable prototypes, designers can 

simulate user interactions and gather valuable feedback on usability and 

functionality. 

 

Mockups can be created using various design tools, such as graphic design software, 

prototyping tools, or even physical materials like paper and foam boards. They can 

range from low-fidelity sketches or wireframes to high-fidelity, pixel-perfect 

representations with detailed visual elements.  

 

2.4.1 Creating a Mockup  

 

Create the First Pouch Bag Design Template 

Step 1 

 

▪ To begin drawing the first part of the first plastic pouch packaging mockup, 

create a rectangle, coloring it with #EEEEEE. Then, take the Mesh Tool 

(U) and, following the picture below, create a mesh grid. 

 

▪ Next, using the Mesh Tool (U), bend the rectangle to resemble the shape in the 

third section of this step. You can achieve it by moving the edge Mesh nodes. 

 

▪ To get rounded corners just like those in the bottom part of the shape, I 

recommend first converting the corner nodes with the Convert Anchor Point 

Tool (Shift-C). 
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Step 2 

 

▪ Now let's start coloring the mesh grid! Using either the Mesh Tool (U) or the 

Direct Selection Tool (A), select the mesh nodes selected in section 1 of the 

screenshot below. Color these nodes with #DBDBDB via the Color Picker 

panel. 

 

▪ Next, add some more mesh nodes and bend them accordingly to achieve the 

shape shown in the second section below. 

 

▪ When you're happy with your shape, color some more nodes (selected in the 

third section) with #D1D1D1.  

 

 
 

 

Step 3 

 

Finish this part of the plastic pouch packaging mockup by coloring the remaining nodes 

according to the screenshot below. You will need these colors: 

 

▪ #C6C6C6 

▪ #F2F2F2 

▪ #D0D0D0  
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Step 4 

 

To make the second part of the flat bottom pouch mockup, create a grey (#DADADA) 

rectangle with a mesh grid, and then bend it and color it according to the screenshot 

below. You will need these colors: 

 

▪ #DADADA 

▪ #C6C6C6 

▪ #E4E4E4 

▪ #F2F2F2 

 

 

 

Step 5 

 

Attach both parts of the packaging bag mockup we've made so far. Bend and color the 

edge nodes so that they overlap and create a seamless illusion! 

 

For easier manipulation, you can Group (Control-G) both elements. 
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Step 6 

 

Create the third part of the plastic pouch packaging mockup with Gradient Mesh, 

following similar steps as in Steps 1 to 5. Use these colors: 
 

▪ #D3D3D3 

▪ #7B7B7B 

▪ #929292 

▪ #9D9D9D 

▪ #9F9F9F 

▪ #BDBDBD 

 

 
 

Step 7 

 

Add the third part of the pouch packaging mockup to the others, just like in Step 5, 

completing the pouch mockup! 
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Step 8 

 

Use the Rotate Tool (R) to rotate the finished flat bottom pouch mockup by -4°. 

 

 

 

Step 9 

 

Draw a shadow with a Radial Gradient from #979797 to white. Change 

its Transparency mode to Multiply. Then, place the shadow under the stand-up pouch 

template. 

 

 

 

 

Step 10 

 

 

The first packaging bag mockup should come out looking like this!  
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Create the First Pouch Bag Design Template 

 

Step 1 

 

Let's start the creation of the second packaging bag mockup by drawing a rectangle! For 

this element, we will need to use a rectangle with rounded edges. 

 

You can use my measurements below with the Rounded Rectangle Tool. Once you're happy 

with your shape, color it with #D9D9D9. 

 

▪ Width: 122 px 

▪ Height: 253 px 

▪ Corner Radius: 4 px  

 

 

Step 2 

 

Continue by bending and coloring the shape with Gradient Mesh, creating the first piece of 

the stand-up pouch template. 

 

▪ #F0F0F0 

▪ #C3C3C3 

▪ #CCCCCC 

▪ #E4E4E4 

▪ #E3E3E3 

▪ #D7D7D7 

▪ #C7C7C7 

▪ #D3D3D3  
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Step 3 
 

Next, create the side of the pouch mockup. You will need these colors: 
 

▪ #B6B6B6 

▪ #9A9A9A 

▪ #ABABAB 

▪ #AAAAAA 

▪ #969696 

▪ #C7C7C7 
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Step 4 

 

For the third element of the packaging bag mockup, use these measurements: 

 

▪ Width: 220 px 

▪ Height: 150 px 

▪ Corner Radius: 10 px  

 

 
Step 5 

 

Bend the rectangle and then color it with Gradient Mesh. 

 

▪ #CCCCCC 

▪ #FFFFFF 

▪ #9D9D9D 

▪ #AFAFAF 

▪ #ECECEC 

▪ #969696  
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Step 6 

 

In the Transparency panel, change the resulting element's Transparency Mode to Multiply 

and its Opacity to 40%.  

 

 

 

Step 7 

 

To create the pouch mockup, put all the elements together, as shown below. Make sure that 

element 3 stays on top of the other pieces! 
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Step 8 

 

To finish the pouch packaging mockup, place a shadow under it, just as we learned in the 

previous section.  
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Self-Check Sheet - 2: Create mock up 

 

 

 

Questionnaire: 

 

 

1. What is product shot? 

  Answer: 

  

 

 

2. What is Mockup? 

    Answer: 

 

 

 

3. What is EPS? 

Answer: 
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Answer Key - 2: Create mock up 

 

 

 

1.  What is Content in Illustrator? 

 

Answer: Product shots refer to visual representations or images of a product that are created 

using the software's tools and features. Product shots are often used for marketing materials, 

e-commerce websites, catalogs, or any other medium where showcasing the product's 

appearance is important. 

 

  

 

 

2. What is Mockup? 

 

  Answer: Mockup refers to a visual representation of a design or layout that is created using 

the software's tools and features. Illustrator is a powerful vector graphics editor that allows 

designers to create precise and scalable artwork, making it a popular choice for creating 

mockups for various design projects. 

 

 

 

3. What are the uses of screen layer? 

 

Answer: Screen layer refers to a layer that is used to simulate the appearance of a printed 

halftone screen or a digital screen effect in your artwork. It is commonly used when creating 

illustrations, designs, or artwork that needs to replicate the look of a printed or digital screen, 

such as retro-style graphics or comic book illustrations. 
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Job Sheet-2.1: Create a Mockup Design  

 

Working Procedure:  
 

1 Follow OSH and use Personal Protective Equipment (PPE).  

2 Start the Computer.  

3 Read and follow the Specification Sheet. 

4 Open Adobe Photoshop and create a new document and set up the workplace. 

5 Separate images as per specification. 

6 Retouch images as per specification. 

7 Apply color correction images as per specification. 

8 Apply effects as per specification. 

9 Save the document using the default file format of your Photoshop software.  

10 Turn off the computer and clean your workplace 

 

Sample job 
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Specification Sheet-2.1: Create a Mockup Design 

 

Necessary Personal Protective Equipment (PPE) 

 

Sl. No Name of PPE Unit Quantity 

1  Ergonomic Chair No 1 

2  Eye protective glass No 1 

3  Rubber shoe Pair 1 

 

 

 

Necessary tools and equipment 

 

Sl. No 
Name of Tools & 

Equipment 
Specification Unit Quantity 

1  Personal Computer or 

Laptop 

 Set   1 

2  Keyboard and Mouse Optical mouse No. 1 

3  Monitor  No. 1 

 

Necessary materials 

 

Sl. No. Name of materials Specification Unit Quantity 

1  Simple Image A4 Paper No. 1 

2  MS- Office Software No. 1 
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Learning Outcome 3: Print Draft 

 

Assessment Criteria 

 

1. Printer is selected 

2. Print preview option is accessed 

3. Document is adjusted where necessary 

4. Printout is taken  

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

 

Contents 1. Printer selection 

2. Print preview option 

3. Document adjustment 

4. Printing procedure 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   

 

 

  



 

37 
 

Learning Experience 3: Print Draft 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the instructor 

about creating mock up and 

print 

1. Instructor will provide the learning materials 

creating mock up and print 

2. Read the Information sheet/s 
2. Information Sheet No:3- Print Draft 

 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No: 3- Print Draft 

 

Answer key No. 3- Print Draft  

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet No:3-1: Print a document using printer 

 

Specification Sheet: 3-1 Print a document using 

printer 
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Information Sheet 3: Print Draft 

 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 
 

3.1 Printer selection 

3.2 Print preview option 

3.3 Document adjustment 

3.4 Printing procedure 

.  

3.1 Printer selection 

 

Printer selection refers to the process of choosing the appropriate printer settings and 

configurations when preparing your artwork for printing. The printer selection ensures 

that your design is compatible with the specific printer you plan to use, and it helps 

optimize the output quality and accuracy of your printed materials. 

 

To select the printer settings in Illustrator, you can follow these general steps: 

Open the Print dialog box: Go to File > Print or use the keyboard shortcut Ctrl+P 

(Windows) or Command+P (Mac) to open the Print dialog box in Illustrator. 

 

Choose the printer: In the Print dialog box, select the printer from the available list of 

installed printers. Make sure the selected printer is the one you intend to use for printing 

your artwork. 

 

Set the paper size and orientation: Specify the paper size and orientation that matches the 

size and orientation of the paper you plan to use for printing. You can choose from a list 

of standard paper sizes or set custom dimensions if necessary. 

 

Configure print options: Depending on your printer and the desired output, you can adjust 

various print options in the Print dialog box. These options may include print quality, 

color management, paper type, print mode (e.g., duplex printing), and other printer-

specific settings. Refer to your printer's documentation for guidance on the specific 

settings it supports. 

 

Preview and adjust print settings: Use the Print Preview option in the dialog box to get a 

preview of how your artwork will appear when printed. Take this opportunity to review 

the page layout, scaling, and other settings. If needed, make adjustments to ensure the 

desired appearance and fit on the printed page. 
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Print the artwork: Once you are satisfied with the printer settings and preview, click the 

"Print" button to initiate the printing process. Ensure that your printer is properly 

connected, powered on, and loaded with the appropriate paper. 

 

 

 

3.2 Print preview option 

 

The Print Preview option allows you to preview how your artwork will appear when 

printed before actually sending it to the printer. It provides a visual representation of the 

layout, colors, and overall appearance of your design as it would appear on the printed 

page. The Print Preview option helps you identify and address any potential issues or 

adjustments needed before printing, ensuring that you achieve the desired output. 

 

To access the Print Preview option in Illustrator, you can follow these steps: 

 

▪ Open the Print dialog box: Go to File > Print or use the keyboard shortcut Ctrl+P 

(Windows) or Command+P (Mac) to open the Print dialog box in Illustrator. 

 

▪ Enable Print Preview: In the Print dialog box, you will find a checkbox or option 

labeled "Print Preview" or "Preview" (the exact wording may vary depending on the 

version of Illustrator). Ensure this option is checked or enabled. 

 

▪ Adjust print settings if necessary: Before proceeding to the Print Preview, you can 

configure the printer settings, paper size, orientation, and other options in the Print 

dialog box according to your requirements. Make any necessary adjustments before 

proceeding to the next step. 
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▪ View the Print Preview: Once you have enabled the Print Preview option, you can see 

a preview of your artwork as it would appear on the printed page. The Print Preview 

window displays your design within the defined page boundaries, taking into account 

the selected printer settings and paper size. 

 

▪ Zoom and navigate the preview: In the Print Preview window, you can use the zoom 

and navigation tools to examine different parts of your artwork. This allows you to 

closely inspect details, check alignment, verify colors, and ensure the overall layout 

matches your expectations. 

 

▪ Make adjustments if needed: While in Print Preview, you can identify any issues that 

may affect the printed output, such as improper scaling, overlapping elements, or 

unexpected color variations. If necessary, return to the Print dialog box to adjust 

settings or make changes to your artwork in Illustrator to address these issues. 

 

▪ Exit Print Preview: After reviewing the Print Preview and making any necessary 

adjustments, you can close the Print Preview window. 
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3.3 Document adjustment 

 

Document adjustment refers to the process of modifying the settings and properties of an 

existing document to meet specific requirements or preferences. These adjustments can 

include changing the document size, orientation, color mode, artboard settings, and other 

aspects that affect the overall appearance and functionality of the document. 

 

To perform document adjustments in Illustrator, you can follow these steps: 

 

▪ Open the document: Launch Adobe Illustrator and open the document you want to 

adjust. You can do this by selecting "Open" from the File menu or by using the 

keyboard shortcut Ctrl+O (Windows) or Command+O (Mac). 

 

▪ Modify document size: To adjust the document size, go to the "Document Setup" 

menu by selecting File > Document Setup. In the Document Setup dialog box, you 

can change the width and height of the document in different units of measurement. 

Remember to maintain the aspect ratio if you want to preserve the proportions of your 

artwork. 

 

▪ Adjust orientation: In the Document Setup dialog box, you can also change the 

document orientation between portrait and landscape. Simply select the desired option 

under the "Orientation" section. 

 

▪ Modify color mode: If you need to change the color mode of the document, go to the 

Document Setup dialog box and select a different color mode from the "Color Mode" 

drop-down menu. Common color modes include RGB (for screen-based designs) and 

CMYK (for print-based designs). 

 

▪ Adjust artboard settings: The artboard represents the printable area of your document. 

To modify the artboard size or position, select the "Artboard Tool" from the Tools 

panel. With the tool selected, you can click on the artboard and adjust its dimensions 

or position using the handles and controls that appear. 

 

▪ Additional document adjustments: Depending on your specific needs, there may be 

other adjustments you can make to the document. For example, you can change the 

ruler units, set the document resolution, adjust the bleed settings, or specify the 

number of artboards if you need multiple pages or views. 

 

▪ Save the adjustments: Once you have made the necessary adjustments to the 

document, remember to save your changes by selecting "Save" or "Save As" from the 

File menu. This ensures that your modifications are retained for future use. 
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3.4 Printing procedure 

 

Step-1:  

 

Click File from the tab bar at the top of the window and click Print once your document 

is ready for printing.  

 

 
 

 

Step-2: 

 

Select the printer you wish to use under the Printer heading. Here, a self-serve laser 

printer is selected.  

 

Step-3: 

 

To change the default duplex print setting to single-sided printing, click Setup located in 

the bottom left corner of the Print window. 
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Step-4: 

 

Once the Print menu appears, select the printer you wish to use from the drop-down menu 

provided under the Printer heading. In this tutorial, a Self-Serve Laser printer is selected. 

 

 

 
Step-5: 

Make sure the correct printer is selected before proceeding. Different Adobe applications 

use different commands to access the Printing Preferences window. 

▪ For Adobe Acrobat XI Pro, Flash, Dreamweaver, and Fireworks click Properties. 

▪ For InDesign and Illustrator click Preferences. 

▪ For Photoshop click Print Settings. 

▪ See the images below for an example of each. 

▪ Printing from Adobe Acrobat XI Pro 
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Step-6: 
 

From the Printing Preferences window, select your preferred 2-sided printing method of 

printing. 

 

• To print single-sided, select Print on one side only. 

• To print double-sided (duplex), select Print on both sides. 

Note: This dialog box will look the same for all printers that support duplex and 

single-sided printing. 

 

 

Step-7: 

Click OK to close the printing preferences window. 

 

Step-8: 

Click Print to send the document to the selected printer. 
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Self-Check Sheet - 3: Print Draft 

 

 

 

Questionnaire: 

 

 

1. What is printer selection? 

  Answer: 

  

 

 

2. What is print preview? 

    Answer: 

 

 

 

3. Why we need to adjust document before printing? 

Answer: 

 

 

 

 

 

  



 

46 
 

Answer Key - 3: Print Draft 

 

 

1. What is printer selection? 

 

  Answer: Printer selection refers to the process of choosing the appropriate printer settings 

and configurations when preparing your artwork for printing. 

 

  

 

 

2. What is print preview? 

 

Answer: The Print Preview option allows you to preview how your artwork will appear 

when printed before actually sending it to the printer. It provides a visual representation of 

the layout, colors, and overall appearance of your design as it would appear on the printed 

page 

 

 

 

 

3. Why we need to adjust document before printing? 

 

Answer: Document adjustment refers to the process of modifying the settings and properties 

of an existing document to meet specific requirements or preferences. These adjustments 

can include changing the document size, orientation, color mode, artboard settings, and 

other aspects that affect the overall appearance and functionality of the document 
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Job Sheet-3.1: Print a Document Using Printer 

 

 

Working Procedure:  
 

1. Connect printer with computer. 

2. Install printer software. 

3. Adjust printer settings. 

4. Select paper 

5. Print the document 

6. Turn off computer safely. 

 

Specification Sheet 

 

1. Collect printer and printer driver 

2. Install driver software in c drive 

3. Set printer as default 

4. Set A4 paper for printing 

5. Print the document from photoshop. 
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Specification Sheet-3.1: Print a Document Using Printer 

 

 

Necessary Personal Protective Equipment (PPE) 

 

Sl. No Name of PPE Unit Quantity 

1  Ergonomic Chair No 1 

2  Eye protective glass No 1 

3  Rubber shoe Pair 1 

 

 

 

Necessary tools and equipment 

 

Sl. No 
Name of Tools & 

Equipment 
Specification Unit Quantity 

1  Personal Computer or 

Laptop 

 Set   1 

2  Keyboard and Mouse Optical mouse No. 1 

3  Monitor  No. 1 

4  Adobe Photoshop  No. 1 

5  Printer diver software  No. 1 

6  Printer  No. 1 

 

Necessary materials 

 

Sl. No. Name of materials Specification Unit Quantity 

1  Simple Image A4 Paper No. 1 

2  MS- Office Software No. 1 
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Review of Competency 
 

Below is yourself assessment rating for module “Creating Mock Up and Print” 
 

Assessment of performance Criteria Yes No 

Required Professional Design work are selected.   

Appropriate Tools, Palette and arrange them as needed are identified.   

Ruler/unit/Grids/Guides/Smart Guides as per requirement are set   

Key Drawing / Design Layout are prepared   

Marks are interpreted.   

Layer lock is applied   

Contents are inserted.   

Color/Design/Pattern is applied.   

Pathfinder to create complex Objects are used.   

Font Attributes are applied as per requirement.   

Zoom In-Out and Panning are used.   

Design for further use is saved   

Artwork and Preview is used.   

Layer Hide-Unhide option is used.   

Appropriate marks are used.   

Outline and Group Created.   

appropriate File Format Saved.   

The image to recipient is transferred.   

 

 

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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